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Chapter 1 Introduction

1.1 Introduction

Congratulations on your purchase of this outstanding product: 4G PoE-WAN Extender. For M2M (Machine-to-
Machine) applications, AMIT 4G PoE-WAN Extender is absolutely the right choice. With built-in world-class
3G/4G module, you just need to insert SIM card from local mobile carrier to get to Internet. The redundant
SIM design provides a more reliable WAN connection for critical applications. By VPN tunneling technology,
remote sites easily become a part of Intranet, and all data are transmitted in a secure (256-bit AES encryption)
link. To meet a variety of M2M application requirements, AMIT M2M Cellular Gateway products are based on
modular design.

This IDG700 series product is loaded with luxuriant security features including VPN, firewall, NAT, port
forwarding, DHCP server and many other powerful features for complex and demanding business and M2M
(Machine-to-Machine) applications.

Main Features:

. Provide various and configurable WAN connection.

e  Support dual SIMs for the redundant wireless WAN connection.

e  Provide Ethernet ports for comprehensive LAN connection and LAN-1 port can be configured to be
another WAN interface.

e Equip 802.11b/g/n 2T2R WiFi access point.

. Feature with VPN and NAT firewall to have powerful security.

e  Support the robust remote or local management to monitor network.

. Lowered deployment cost with integrated Power over Ethernet (via LAN-1 port) for areas where
power source is unavailable.

. Designed by solid and easy-to-mount metal body for business and loT environment to work with a
variety M2M (Machine-to-Machine) applications.

Before you install and use this product, please read this manual in detail for fully exploiting the functions of
this product.
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1.2 Contents List

1.2.1 Package Contents
#Standard Package

|_ltems _____ Descripton ____________ Contents | Quantity

1 IDG700-0TP23 _ \ .
4G PoE-WAN Extender e pes

2 Cellular Antenna 2pcs
3 WiFi Antenna 2pcs
Power Adapter
4 (DC 12V/1A) 1pcs
(*%)
5 RJ45 Cable 1pcs
6 2 Pin Terminal Block A 1pcs
. ~ 4
7 DIN-Rail Bracket 1pcs

1.2.2 Optional Accessories
#Optional parts (these parts are sold separately)

Items Description Contents

802.3at Compliant
1 PoE Injector Standard 802.3 af/at compliant
(Gigabit, 30W)

1 The maximum power consumption of IDG700 series product is 9.5W.
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Compatible Passive PoE Injector

(Gigabit, 30W) Passive PoE Injector

Proprietary Passive PoE Power

Supply (Gigabit) Passive PoE Injector.

These parts are sold separately. If necessary, please contact us via sales@amit.com.tw



mailto:sales@amit.com.tw
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1.3 Hardware Configuration

> Front View

GPS Ant.
(optional)

Auto MDI/MDIX RJ45 Ports
1x FE LAN to connect local

P PRV P

LED
Indicators

Reset
Button

sXReset Button

The RESET button provides user with a quick and easy way to restore the default setting. Press the RESET

button continuously for 6 seconds, and then release it. The device will restore to factory default settings.

3¢ GNSS Antenna

The GNSS Antenna is an optional accessory, and not included in the standard package. If you intend to use
the provided GNSS function, please purchase additional passive-type GNSS antenna and install it to the
corresponding SMA connector in advance.

10
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3G/4G (Main)
Antenna

> Left View
3G/4G (Aux)
Antenna
Power Terminal
Block
> Right View

WiFi
Antenna

WiFi
Antenna

11
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1.4 LED Indication

Power Source

WiFi

SIM A
(*?)

SIM B

WAN/LAN1~LAN2

. Cellular Signal

Blue

Blue

Blue

Blue

Blue

Green

Steady ON: Device is powered on by power source

Flash: Data packet transferred.
OFF: Wireless Radio is disable

OFF: SIM card A not detected

Flash: SIM card A is chosen for connection

Steady ON: Cellular connection already established (under SIM A)
OFF: SIM card B not detected

Flash: SIM card B is chosen for connection

Steady ON: Cellular connection already established (under SIM B)
Steady On : Signal Strength is more than 61%

Flash(per second) : Signal Strength is 31~60%

Flash(per 0.5 second) : Signal Strength is 0~30%

Flash(very fast): Device is in Recovery Mode or abnormal

Steady ON: Ethernet connection of LAN WAN is established
Flash: Data packets are transferred

4 The SIM LED indicates which SIM socket will be chosen for connection by system setting, no matter SIM card is inserted or not.

12
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1.5 Installation & Maintenance Notice

1.5.1 SYSTEM REQUIREMENTS

e  Afast Ethernet RJ45 cable

e 3G/4G cellular service subscription
Network Requirements . IEEE 802.11b/g/n wireless network

. IEEE 802.11b/g/n wireless clients

e 10/100 Ethernet adapter on PC

Computer with the following:

e  Windows®, Macintosh, or Linux-based operating

system

e Aninstalled Ethernet adapter
Web-based Configuration Utility Requirements Browser Requirements:

. Internet Explorer 6.0 or higher

o Chrome 2.0 or higher

e  Firefox 3.0 or higher

e  Safari 3.0 or higher

1.5.2 WARNING

/ ® Only use the power supply that complys with the \
power specification of the gateway. Using an out-of-
spec voltage rating power source is dangerous and
may damage the product.

® Do not open or repair the case yourself. If the

Attention
product is too hot, turn off the power immediately

\ and have it repaired at a qualified service center. /

13
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1.5.3 HOT SURFACE CAUTION

Burn hazard.

Hot surface inside.

Allow to cool before
servicing.

CAUTION: The surface temperature for the metallic enclosure can be very high!
Especially after operating for a long time, installed at a closed cabinet
without air conditioning support, or in a high ambient temperature
space.

DO NOT touch the hot surface with your fingers while servicing!!

14
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Federal Communication Commission Interference Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may
not cause harmful interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct
the interference by one of the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance could void the

user's authority to operate this equipment.
This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

FOR PORTABLE DEVICE USAGE (<20m from body/SAR needed)

Radiation Exposure Statement:

The product comply with the FCC portable RF exposure limit set forth for an uncontrolled environment and are safe for
intended operation as described in this manual. The further RF exposure reduction can be achieved if the product can be
kept as far as possible from the user body or set the device to lower output power if such function is available.

FOR MOBILE DEVICE USAGE (>20cm/low power)
Radiation Exposure Statement:
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This

equipment should be installed and operated with minimum distance 20cm between the radiator & your body.

FOR COUNTRY CODE SELECTION USAGE (WLAN DEVICES)

Note: The country code selection is for non-US model only and is not available to all US model. Per FCC regulation, all
WiFi product marketed in US must fixed to US operation channels only.

15
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1.5.4 Product Information for CE RED Requirements

The following product information is required to be presented in product User Manual for latest CE RED

requirements. 3

(1) Frequency Band & Maximum Power
1.a Frequency Band for Cellular Connection (for ME3630 E1C version) 4

Band number

Operating

Frequency

Max output power

LTE FDD BAND 1

Uplink:
Downlink:

1920-1980 MHz
2110-2170 MHz

LTE FDD BAND 3

Uplink:

1710-1785 MHz

Downlink: 1805-1880 MHz
LTE FDD BAND 7 Uplink: 2500-2570 MHz
+
Downlink: 2620-2690 MHz 23 £2.7 dBm
LTE FDD BAND 8 Uplink: 880-915 MHz
Downlink: 925-960 MHz
LTE FDD BAND 20 Uplink: 832-862 MHz
Downlink: 791-821 MHz
WCDMA BAND 1 Uplink: 1920-1980 MHz
Downlink: 2110-2170 MHz
24 +1/-3 dB
WCDMA BAND 8 Uplink: 880-915 MHz 4+1/-3 dBm
Downlink: 925-960 MHz
E-GSM Uplink: 880-915 MHz
+
Downlink: 925-960 MHz 33 £2.dBm
DCS Uplink:  1710-1785 MHz 30 +2 dBm

Downlink:

1805-1880 MHz

requency Band for Cellular Connection (for EC25-E version)

Band number

Operating Frequency

Max output power

LTE FDD BAND 1 Uplink:  1920-1980 MHz 731 dBm

Downlink: 2110-2170 MHz )
LTE FDD BAND 3 Uplink:  1710-1785 MHz

Downlink: 1805-1880 MHz 23.0 dBm
LTE FDD BAND 7 Uplink:  2500-2570 MHz

Downlink: 2620-2690 MHz 22.8 dBm
LTE FDD BAND 8 Uplink:  880-915 MHz

Downlink: 925-960 MHz 23.2.dBm
LTE FDD BAND 20 Uplink:  832-862 MHz 23.5 dBm

3 The information presented in this section is ONLY valid for the EU/EFTA regional version. For those non-CE/EFTA versions, please
refer to the corresponding product specification.

4 There can be different cellular module intrgrated in the device for EU/EFTA regional version. Refer to the cellular module identifier
printed on the device label for the purchased device.

16
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Downlink: 791-821 MHz

LTE FDD BAND 38 Uplink: 2570-2620 MHz 1.7 dBm
Downlink: 2570-2620 MHz )
LTE FDD BAND 40 Upllnk.: 2300-2400 MHz 1.5 dBm
Downlink: 2300-2400 MHz
WCDMA BAND 1 Uplink: 1920-1980 MHz
Dov_vnllnk: 2110-2170 MHz »3.3 dBm
WCDMA BAND 8 Uplink: 880-915 MHz
Downlink: 925-960 MHz
E-GSM Uplink: 880-915 MHz
Downlink: 925-960 MHz 32.9 dBm
DCS Uplink:  1710-1785 MHz 9.9 dBm

Downlink: 1805-1880 MHz

1.c Frequency Band for Cellular Connection (for UC20-G version)
Band number Operating Frequency

Max output power

WCDMA BAND 1 Uplink:  1922.4-1977.6 MHz

Downlink: 2112.4-2167.6 MHz 22.47 dBm
WCDMA BAND 8 Uplink:  882.4-912.6 MHz

Downlink: 927.4-957.6 MHz 22.48 dBm
E-GSM Uplink:  880.2-914.8 MHz

Downlink: 925.2-959.8 MHz 32.1dBm
DCS Uplink:  1710.2-1784.8 MHz 789 dBm

Downlink: 1805.2-1879.8 MHz

1.d Frequency Band for WiFi Connection

Band Operating Frequency Max. Output Power (EIRP)
2.4G 2.4 -2.4835 GHz 100 mW
5G Not supported NA

(2) DoC Information
You can get the DoC information of this product from the following URL:
http://www.amitwireless.com/products-doc/

(3) RF Exposure Statements
The antenna of the product, under normal use condition, is at least 20 cm away from the body of user.

(4) Unit Mounting Notice
The product is suitable for mounting at heights <= 2m (approx. 6 ft), or in a cabinet.
Ensure the unit is fixed tightly to reduce the likelyhood of injury due to exposure to mechanical hazards if
dropped.

17
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(5) Manufacture Information
Manufacture Name: AMIT Wireless Inc.
Manufacture Address: No. 28, Lane 31, Sec. 1, Huandong Rd., Xinshi Dist., Tainan 74146, Taiwan (R.0.C.)

18
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1.6 Hardware Installation

This chapter describes how to install and configure the hardware.

1.6.1 Mount the Unit

The IDG700 series can be placed on a desktop, or mounted on the DIN Rail, and wall. The DIN-rail bracket is
not screwed on the product when out of factory. Please screw the DIN-rail bracket on the product first if
necessary.

1.6.2 Insert the SIM Card

WARNING: BEFORE INSERTING OR CHANGING THE SIM CARD, PLEASE MAKE SURE
THAT POWER OF THE DEVICE IS SWITCHED OFF.

The SIM card slots are located at the bottom side of the housing. You need to unscrew and remove the outer
SIM card cover before installing or removing the SIM card. Please follow the instructions to insert a SIM card.
After SIM card is well placed, screw back the outer SIM card cover.

Step 1: Step 2: Step 3:

Follow red arrow to Lift up SIM holder, Put back SIM holder, and

unlock SIM socket and insert SIM card follow red arrow to lock
SIM socket

- = |

St

A @ Siv B

19
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1.6.3 Connecting Power

The IDG700-0TP23 product can be powered by connecting a power source to either 802.3af PoE PD via LAN-1
port, or the terminal block power connector.

(1) For Powering through PoE cabling, the IDG700-0TP23 can also be powered by 802.3af or 802.3at compliant
PoE Injector, PoE Switch, or proprietary passive PoE Injector that is listed in optional parts in Section 1.2.2.
Use other 3rd-party’s passive PoE Injector is dangerous and may cause damage to the device.

(2) For using an external DC power supply, the IDG700 supports 9 to 36V DC power input. Following picture is
the power terminal block pin assignments. Please check carefully and connect to the right power
requirements and polarity.

dNO
dMd

There is a DC12V/1A power adapter” in the package for you to easily connect DC power adapter to this
terminal block.

WARNNING: This commercial-grade power adapter is mainly for ease of powering up the purchased
device while initial configuration. It’s not for operating at wide temperature range environment. PLEASE
PREPARE OR PURCHASE OTHER INDUSTRIAL-GRADE POWER SUPPLY FOR POWERING UP THE DEVICE.

You can choose the proper one to power the gateway for your application. If both PoE power and DC power via
terminal block port are applied to the gateway simultaneously, the PoE power gets higher priority to supply the
required power to the gateway.

5 The maximum power consumption of IDG700 series product is 9.5W.
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1.6.4 Connecting to the Network or a Host

The IDG700 series product provides RJ45 ports to connect 10/100Mbps Ethernet. It can auto detect the
transmission speed on the network and configure itself automatically. Connect the Ethernet cable to the RJ45
port of the device. Plug one end of an Ethernet cable into your computer’s network port and the other end
into the LAN port on the front panel. If you need to configure or troubleshoot the device, you may need to
connect the gateway directly to the host PC. In this way, you can also use the RJ45 Ethernet cable to connect
the gateway to the host PC’s Ethernet port.

1.6.5 Setup by Configuring WEB Ul

You can browse web Ul to configure the device.

Type in the IP Address (http://192.168.123.254)°

& Windows Internet Explorer

() [ 10216812305 -] x]

When you see the login page, enter the user name and password and then click ‘Login’ button.
The default setting for both username and password is ‘admin’.

Welcome to the device's configuration Ul.
Enter your Username & Password, then
click 'Login".

Username

Password
|
—

For the security consideration, you will be asked to change the loging password while the first
time login to the device.

6 The default LAN IP address of this gateway is 192.168.123.254. If you change it, you need to login by using
the new IP address.
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Change Password

For security consideration, you are being asked to change the password
while the first time login to the device.

Enter the new password below.
Keep the new password properly for further device configuration.

New Password:

New Password Confirmation:

oK

After that, you will be asked to login again with the new password.

Note 1: Keep the login password properly for further device configuration.

Note 2: If, someday, you lose or forget the login password, the ONLY way to remedy is to
recover the device to its factory default settings via long-pressing the Reset button.

Note 3: Under such situation, your device configuration will be erased accordingly. So, In
addition to keep the login password, you may have to backup the device
donfiguration and keep it properly for any unexpected accidence.
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Chapter 2 Basic Network

2.1 WAN & Uplink

[ wang uplink |

Internet Setup

Load Balance

Physical Interface

Interface Name

Physical Interface Operation Mode Action
Internet Setup WAN-1 Ethernet Always on Iﬂ/
WAN-2 3G/4G Always on | Edit |
Loading Balance WAN-3 Disable | Edit |
WAN-4 Disable | Edit |

The gateway provides multiple WAN interfaces to let all client hosts in Intranet of the gateway access the
Internet via ISP. But ISPs in the world apply various connection protocols to let gateways or user's devices dial
in ISPs and then link to the Internet via different kinds of transmit media.

So, the WAN Connection lets you specify the WAN Physical Interface, WAN Internet Setup and WAN Load
Balance for Intranet to access Internet. For each WAN interface, you must specify its physical interface first
and then its Internet setup to connect to ISP. Besides, since the gateway has multiple WAN interfaces, you can

assign physical interface to participate in the Load Balance function.
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2.1.1 Physical Interface

g
Physical Interface -
Interface Name Physical Interface Operation Mode
Physical WAN-1 Ethernet Always on
Interface List
WAN-2 GG Always on
Interface WAN-3 Diszable
Configuration
VIAN-4 Diszble
J, Select
Physical
Interface -
¥ Select [tem Setting
Operation Mode
.Aﬂ,“s on ¥ Physical Interface Ethemet M
wralk Always on ¥

» Operation Mede
% b VLAN Tagging

Enable [2 (1-4095)

Action

Edit
Edit

E

Edit

E

Edit

E

M2M gateways are usually equipped with various WAN interfacess to support different WAN connection
scenario for requirement. You can configure the WAN interface one by one to get proper internet connection
setup. Refer to the product specification for the available WAN interfaces in the product you purchased.

The first step to configure one WAN interface is to specify which kind of connection media to be used for the
WAN connection, as shown in "Physical Interface" page.

In "Physical Interface" page, there are two configuration windows, "Physical Interface List" and "Interface
Configuration". "Physical Interface List" window shows all the available physical interfaces. After clicking on
the "Edit" button for the interface in "Physical Interface List" window the "Interface Configuration" window
will appear to let you configure a WAN interface.

Physical Interface:

« Ethernet WAN: The gateway has one or more RJ45 WAN ports that can be configured to be WAN

connections. You can directly connect to external DSL modem or setup behind a firewall device.

+ 3G/4G WAN: The gateway has one built-in 3G/4G cellular as WAN connection. For each cellular WAN,
there are 1 or 2 SIM cards to be inserted for special failover function.

-

Please MUST POWER OFF the gateway before you
insert or remove SIM card.
The SIM card can be damaged if you insert or

remove SIM card while the gateway is in operation.

J
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Operation Mode:
There are three option items “Always on”, “Failover”,

and “Disable” for the operation mode setting.

Always on: Set this WAN interface to be active all the time. When two or more WAN are established at
"Always on" mode, outgoing data will through these WAN connections base on load balance policies.

Failover:

Diagram For Failover

ISP-DSLAM

(D))

@Dlsconnected

'WAN-1

) Failover
WAN-2 Gateway

(D)) /
Cellular!& @ Change Routing to WAN-2

“WAN-2 Failover WAN1

D LB

WAN
@FailbacktoWAN-l'
WAN-2 Gateway
(&)

Cellular 1

()

@ Connection Recovery

(B WAN-2 Terminate Connection

WAN-1
Physical Interface: Ethernet
Operation Mode: Always on

WAN-2
Physical Interface: 3G/4G
Operation Mode: Failover (WAN-1)

"WAN-1 Failback, WAN-2 Terminate

Seamless Failover:

Diagram For Seamless Failover

S lu

ISP-DSLAM

(D)

@Dlsconnected

WAN-1

®@ Fallover
WAN-2 Gateway

Cellular/& @ Change Routing to WAN-2

*WAN-2 Failover WAN1

DL\

(5) Failback to WAN-1

—_—
\

WAl\l_-,z Gateway

-

«) .

Cellular ‘_e_

@ Keep alive, no traffic

"WAN-1 Failback, WAN-2 Keep Alive

A failover interface is a backup connection to the
primary. That means only when its primary WAN
connection is broken, the backup connection will be
started up to substitute the primary connection.

As shown in the diagram, WAN-2 is backup WAN for
WAN-1. WAN-1 serves as the primary connection with
operation mode "Always on". WAN-2 won’t be
activated until WAN-1 disconnected. When WAN-1
connection is recovered back with a connection, it will
take over data traffic again. At that time, WAN-2
connection will be terminated.

In addition, there is a "Seamless" option for Failover
operation mode. When seamless option is activated
by checking on the "Seamless" box in configuration
window, both the primary connection and the
failover connection are started up after system
rebooting. But only the primary connection executes
the data transfer, while the failover one just keeps
alive of connection line. As soon as the primary
connection is broken, the system will switch,
meaning failover, the routing path to the failover
connection to save the dial up time of failover
connection since it has been alive.

When the “Seamless” enable checkbox is activated, it
can allow the Failover interface to be connected
continuously from system booting up. Failover WAN
interface just keeps connecting without data traffic.
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The purpose is to shorten the switch time during failover process. So, when primary connection is
disconnected, failover interface will take over the data transfer mission instantly by only changing routing

path to the failover interface. The dialing-up time of failover connection is saved since it has been
connected beforehand.

VLAN Tagging

Sometimes, your ISP required a VLAN tag to be inserted into the WAN packets from Gateway for specific
services. Please enable VLAN tagging and specify tag in the WAN physical interface. Please be noted that only
Ethernet and ADSL physical interfaces support the feature. For the device with 3G/4G WAN only, it is disabled.
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Physical Interface Setting

Go to Basic Network > WAN > Physical Interface tab.

The Physical Interface allows user to setup the physical WAN interface and to adjust WAN’s behavior.

Note: Numbers of available WAN Interfaces can be different for the purchased gateway.

Interface Name Physical Interface Operation Mode Action
VVAN-1 Ethernet Always on
WAN-2 3G/4G Always on
WAN-3 - Disable
WAN-4 - Disable

When Edit button is applied, an Interface Configuration screen

example.

Interface Configuration:

will appear. WAN-1 interface is used in this

Item Setting
» Physical Interface | Ethernet v |
» Operation Mode
» VLAN Tagging [ Enable {1-4095)

Interface Configuration

Item Value setting

Description

Select one expected interface from the available interface dropdown list. It
can be 3G/4G, or Etherent.

Depending on the gateway model, Disable and Failover options will be

1. A Must fill setting
2. WAN-1 is the primary

Physical Interface ) )
interface and is factory ] . .
available only to multiple WAN gateways. WAN-2 ~ WAN-4 interfaces are
set to Always on.

only available to multiple WAN gateway.s

Define the operation mode of the interface.

Select Always on to make this WAN always active.

Select Disable to disable this WAN interface.

Select Failover to make this WAN a Failover WAN when the primary or the

Operation Mode A Must fill setting
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secondary WAN link failed. Then select the primary or the existed
secondary WAN interface to switch Failover from.

(Note: for WAN-1, only Always on option is available.)
Check Enable box to enter tag value provided by your ISP. Otherwise
uncheck the box.

VLAN Tagging Optional setting Value Range: 1 ~ 4095.

Note: This feature is NOT available for 3G/4G WAN connection.
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2.1.2 Connection Setup

= Internet Connection List

Internet Setup

Interface Name Physical Interface Operation Mode WAN Type Action
WAN-1 Ethernst Always on Static IP
Internet WAN-2 3G/4G Always on 3G/4G
Connection List . =
WAN-3 Disable Edit

‘b%e peat Edit WAN-4 Disable

WAN-x = Internet Connection Configuration { WAN - 1) °
Item Setting
» WAN Type Dynamic IP »
Internet Connect

Configure (WAN-x = Dynamic IP WAN Type Configuration °

Item

Setting

» Host Name ‘

< WAN Type )

| (Opiienal)

, ISP Registered MAC Address I

| (Optional)

Popu
4 pue » Connection Control

Auto-reconnect v

4%

» MTU Setup O Enable

» NAT [« Enable

»IGMP

» WAN IP Alias

) Enable (10.0.0.1

After specifying the physical interface for each WAN connection, administrator must configure their
connection profile to meet the dial in process of ISP, so that all client hosts in the Intranet of the gateway can

access the Internet.

In "Internet Setup" page, there are some configuration windows: "Internet Connection List", "Internet
Connection Configuration", "WAN Type Configuration" and related configuration windows for each WAN type.
For the Internet setup of each WAN interface, you must specify its WAN type of physical interface first and

then its related parameter configuration for that WAN type.

After clicking on the "Edit" button of a physical interface in "Internet Setup List" window, the "Internet
Connection Configuration" window will appear to let you specify which kind of WAN type that you will use for
that physical interface to make an Internet connection. Based on your chosen WAN type, you can configure
necessary parameters in each corresponding configuration window.
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Internet Connection List - Ethernet WAN

= Internet Connection Configuration { WAN -1 ) e
Item Setting
Internet Connection List .
» WAN Type [ Dynamic IP « |
Static IF
=« Dynamic IP WAN Type Confi D¥namic IP .
PPPoE
Item FFTF Setting
Internet Connect » Host Name L2TP | (Optional)
Configure -
v oy registered MAC | | [ Clone | (optional)
» Connection Control [ Auto-reconnect |
Y » MTU Setup [ Enable
DynamicIP | » NAT # Enable
Static IP
i » IGMP | Disable * |
i » WAN IP Alias [0 Enable [10.0.0.1 |
i L4 Setup — -
X( WAN Type = Network Monitoring Configuration -
Configuration Item Setting
3 Networl-f Monitoring & Enable
L4 Setup Configuration
Ethernet Connection » Checking Method DMNS Query
Commeon Configure » Loading Check @ Enable
» Query Interval 5 (seconds)
v,
.“ » Latency Threshold 3000 (ms)

WAN Type for Ethernet Interface:
Ethernet is the most common WAN and uplink interface for M2M gateways. Usually it is connected with xDSL
or cable modem for you to setup the WAN connection. There are various WAN types to connect with ISP.

e Static IP: Select this option if ISP provides a fixed IP to you when you subsribe the service. Usually is more
expensive but very importat for cooperate requirement.

* Dynamic IP: The assigned IP address for the WAN by a DHCP server is different every time. It is cheaper
and usually for consumer use.

* PPP over Ethernet: As known as PPPoE. This WAN type is widely used for ADSL connection. IP is usually
different for every dial up.

e PPTP: This WAN type is popular in some countries, like Russia.

* L2TP: This WAN type is popular in some countries, like Israel.

Configure Ethernet WAN Setting

When Edit button is applied, Internet Connection Configuration screen will appear. WAN-1 interface is used in
this example.
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WAN Type = Dynamic IP

# Internet Connection Configuration { WAN -1)

Item Setting

» WAN Type | Dynamic IP v |

When you select it, "Dynamic IP WAN Type Configuration" will appear. Items and setting is explained below

* Dynamic IP WAN Type Configuration

ltem Setting
¥ Host Name | | {Optional)
ISP Registered MAC .
K
Address | || Clone | (Optional)

\ Dynamic IP WAN Type Configuration

Item

Value setting Description

Host Name An optional setting Enter the host name provided by your Service Provider.
Enter the MAC address that you have registered with your service provider.
ISP Registered MAC . . Or Click the Clone button to clone your PC’s MAC to this field.
An optional setting . , .
Address Usually this is the PC's MAC address assigned to allow you to connect to
Internet.

WAN Type= Static IP
# Internet Connection Configuration { WAN -1)

ltem Setting

v |

¥ WAN Type | Static IP
When you select it, "Static IP WAN Type Configuration" will appear. Items and setting is explained below

# Static IP WAN Type Configuration

Item

Setting

b WAN IP Address

¥ WAN Subnet Mask

256.265.255.0 (/24)

"]

F WAN Gateway

¥ Primary DNS

¥ Secondary DNS

{Optional)
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Static IP WAN Type Configuration

Item Value setting Description

WAN IP Address A Must filled setting Enter the WAN IP address given by your Service Provider

WAN Subnet Mask A Must filled setting Enter the WAN subnet mask given by your Service Provider

WAN Gateway A Must filled setting Enter the WAN gateway IP address given by your Service Provider
Primary DNS A Must filled setting Enter the primary WAN DNS IP address given by your Service Provider
Secondary DNS An optional setting Enter the secondary WAN DNS IP address given by your Service Provider

WAN Type= PPPoE

# Intemet Connection Configuration ( WAN -1)

Item Setting

» WAN Type | PPPoE Y]
When you select it, "PPPoE WAN Type Configuration" will appear. Items and setting is explained below

= PPPoE WAN Type Configuration ’

ltem Setting

¥ IP Type IPv4 v

» PPPoE Account

» PPPoE Password

|
|
» Primary DNS | | (Optional)
¥ Secondary DNS | | (Optional)
» Service Name | | (Optional)
» Assigned IP Address | | (Optional)

PPPoE WAN Type Configuration

Item Value setting Description

PPPoOE Account A Must filled setting Enter the PPPoE User Name provided by your Service Provider.
PPPoE Password A Must filled setting Enter the PPPoE password provided by your Service Provider.
Primary DNS An optional setting Enter the IP address of Primary DNS server.

Secondary DNS An optional setting Enter the IP address of Secondary DNS server.

Service Name An optional setting Enter the service name if your ISP requires it

Assigned IP Address An optional setting Enter the IP address assigned by your Service Provider.
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WAN Type= PPTP

# Internet Connection Configuration { WAN -1)

Item

Setting

k WAN Type | PPTP

]

When you select it, "PPTP WAN Type Configuration" will appear. Items and setting is explained below

= PPTP WAN Type Configuration ’

Item

Setting

b IP Mode | Dynamic IP Address ¥ |

¥ Server IP Address / Name |

¥ PPTP Account

|
» PPTP Password |
|

¥ Connection ID

{Optional)

» MPPE (] Enable

\ PPTP WAN Type Configuration

\ Item Value setting Description
Select either Static or Dynamic IP address for PPTP Internet connection.
® When Static IP Address is selected, you will need to enter the WAN IP
Address, WAN Subnet Mask, and WAN Gateway.
B WAN IP Address (A Must filled setting): Enter the WAN IP
) . address given by your Service Provider.
IP Mode A Must filled setting H  WAN Subnet Mask (A Must filled setting): Enter the WAN
subnet mask given by your Service Provider.
[ | WAN Gateway (A Must filled setting): Enter the WAN gateway
IP address given by your Service Provider.
[ When Dynamic IP is selected, there are no above settings required.
it:;:reet;lsF/’Name A Must filled setting Enter the PPTP server name or IP Address.
PPTP Account A Must filled setting Enter the PPTP username provided by your Service Provider.
PPTP Password A Must filled setting Enter the PPTP connection password provided by your Service Provider.
Connection ID An optional setting Enter a name to identify the PPTP connection.
MPPE An optional setting Select Enable to enable MPPE (Microsoft Point-to-Point Encryption)

security for PPTP connection.
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WAN Type= L2TP
# Internet Connection Configuration { WAN -1)
Item Setting
» WAN Type |L2TP ]

When you select it, "L2TP WAN Type Configuration" will appear. Items and setting is explained below

% L2TP WAN Type Configuration -

Item

Setting

» IP Mode

' Dynamic IP Address v |

¥ Server IP Address / Name |

b L2TP Account

¥ L2TP Password

¥ Service Port

| User-defined

v | 1702 |

» MPPE

(] Enable

L2TP WAN Type Configuration

Item Value setting Description
Select either Static or Dynamic IP address for L2TP Internet connection.
(] When Static IP Address is selected, you will need to enter the WAN IP
Address, WAN Subnet Mask, and WAN Gateway.
[ | WAN IP Address (A Must filled setting): Enter the WAN IP
. . address given by your Service Provider.
IP Mode A Must filled setting H  WAN Suﬁnet M\;.Zk (A Must filled setting): Enter the WAN
subnet mask given by your Service Provider.
B WAN Gateway (A Must filled setting): Enter the WAN gateway
IP address given by your Service Provider.
® When Dynamic IP is selected, there are no above settings required.
ZZ:;I,ZZL;Name A Must filled setting Enter the L2TP server name or IP Address.
L2TP Account A Must filled setting Enter the L2TP username provided by your Service Provider.
L2TP Password A Must filled setting Enter the L2TP connection password provided by your Service Provider.

Service Port

A Must filled setting

Enter the service port that the Internet service.
There are three options can be selected :
® Auto: Port will be automatically assigned.
() 1701 (For Cisco): Set service port to port 1701 to connect to
CISCO server.
®  User-defined: enter a service port provided by your Service
Provider.

MPPE

An optional setting

Select Enable to enable MPPE (Microsoft Point-to-Point Encryption)
security for PPTP connection.
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Ethernet Connection Common Configuration

¥

\I.r Select
Connection

Control

Setup

I *MTU

*MAT Enable?

Yes
lp Select

*DMNS Query

“ICMP Checking

-L Setup

*Target 1
*Target 2

*Loading Check?
*Check Interval
*Check Timeout
*Latency Threshold
*Fail Threshold

-

-

Enable
IGMP Enable?
WAM IP Alias?

-

S

Connection Control
MTU Setup

NAT

IGMP

WAN IP Alias

Item

Metwork Monitoring

Configuration

Checking Method
Loading Check
Query Interval
Latency Threshold
Fail Thresheld
Target1

Target2

U

Auto-reconnect

Enable

Enable

Disable v

Enable |10.0.0.1

# Enable

DNS Query -
#| Enable
5
3000
5
DMNS1

None

Setting

(seconds)

{ms)

{Times)

v

L

There are some important parameters to be setup no matter which Ethernet WAN type is selected. You should
follow up the rule to configure.

Connection Control.

ISPi

(D Disconnected

DSL

@ Re-connecting
Auto-reconnect

Gateway

ISP-DSLAM

(@ Start Connecting

(8 Disconnect when idle timeout?

Connect-on-demand
(D Reque

st

Gateway

—

ﬁ |01 o bk

oming

Auto-reconnect: This gateway will establish
Internet connection automatically once it has
been booted up, and try to reconnect once the
connection is down. It’s recommended to choose
this scheme if for mission critical applications to
ensure full-time Internet connection.

Connect-on-demand: This gateway won’t start to
establish Internet connection until local data is
going to be sent to WAN side. After normal data
transferring between LAN and WAN sides, this
gateway will disconnect WAN connection if idle
time reaches value of Maximum Idle Time.
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Manually: This gateway won’t start to establish

ISP-DSLAM (@) start Connecting Gateway
— WAN connection until you press “Connect”
""""""" xDSL button on web Ul. After normal data transferring
(@ Disconnect when idle timeout between LAN and WAN sides, this gateway will
Manually I disconnect WAN connection if idle time reaches
\ value of Maximum Idle Time.

Please be noted, if the WAN interface serves as the primary one for another WAN interface in Failover role,
the Connection Control parameter will not be available to you to configure as the system must set it to “Auto-
reconnect (Always on)”.

Network Monitoring
It is necessary to monitor connection status continuous.
St?l" To do it, "ICMP Check" and "FQDN Query" are used to
N check. When there is trafiic of connection, checking
Fail =0 packet will waste bandwidth. Response time of replied
o W packets may also increase. To avoid "Network
[ Emable? Monitoring" work abnormally, enabling "Checking
Ye;l Loading" option will stop connection check when there is
I.E_::::..hg? Yes | oy Maitfor — Tle traffic. It will wait for another "Check Interval" and then

check loading again.

NO.L Select One “ : P .
When you do “Network Monitoring”, if reply time longer

alive checking

Y—>{ -FQDNQuery or than "Latency" or even no response longer than
*ICMP Check "Checking Timeout", "Fail" count will be increased. If it is
\ No No continuous and "Fail" count is more than "Fail Threshold",
“Checking Reply Ti . . . el
Timeout”? —> - mLatency” gateway will do exception handing process and re-initial
Yes|™ Yes'| this connection again . Otherwise, network monitoring
ok process will be start again.
Fail = Fail +1
No Fail >
. Fail Thresh ?

Pves

Exception Handing
System Re-initial

36



4G PoE-WAN Extender

Set up “Ethernet Common Configuration”

Connection Control

Maximum Idle Time

MTU Setup

MTU Setup

NAT

IGMP

WAN IP Alias

A Must filled setting

1. An Optional setting
2. By default 600
seconds is filled-in

1. An Optional setting
2. Uncheck by default

1. A Must filled setting

2. Auto (value zero) is
set by default

3. Manual set range
1200~1500

1. An optional setting

2. NAT is enabled by
default

1. A Must filled setting
2. Disable is set by
default

1. An optional setting
2. Uncheck by default

There are three connection modes.

° Auto-reconnect enables the router to always keep the Internet
connection on.

° Connect-on-demand enables the router to automatically re-
establish Internet connection as soon as user attempts to access
the Internet. Internet connection will be disconnected when it has
been inactive for a specified idle time.

° Connect Manually allows user to connect to Internet manually.
Internet connection will be inactive after it has been inactive for
specified idle time.

Specify the maximum Idle time setting to disconnect the internet
connection when the connection idle timed out.

Value Range: 300 ~ 86400.

Note: This field is available only when Connect-on-demand or Connect
Manually is selected as the connection control scheme.

Check the Enable box to enable the MTU (Maximum Transmission Unit)
limit, and specify the MTU for the 3G/4G connection.

MTU refers to Maximum Transmission Unit. It specifies the largest packet
size permitted for Internet transmission.

Value Range: 1200 ~ 1500.

MTU refers to Maximum Transmission Unit. It specifies the largest packet
size permitted for Internet transmission.

When set to Auto (value ‘0’), the router selects the best MTU for best
Internet connection performance.

Enable NAT to apply NAT on the WAN connection. Uncheck the box to
disable NAT function.

Enable IGMP (Internet Group Management Protocol) would enable the
router to listen to IGMP packets to discover which interfaces are connected
to which device. The router uses the interface information generated by
IGMP to reduce bandwidth consumption in a multi-access network
environment to avoid flooding the entire network.

Enable WAN IP Alias then enter the IP address provided by your service
provider.

WAN IP Alias is used by the device router and is treated as a second set of
WAN IP to provide dual WAN IP address to your LAN network.
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Item

» Network Monitoring
Configuration

¢+ Checking Method
¢+ Loading Check

b Query Interval

¢+ Latency Threshold
# Fail Thresheld

» Targetl

» Target?2

Network Monitoring
Configuration

Checking Method

Loading Check

Query Interval

Check Interval

Latency Threshold

Fail Threshold

Setting
#| Enable
DNS Query
#| Enable
g {seconds)
3000 (ms)
g {Times)
DMS1 v
MNone v

1. An optional setting
2. Box is checked by
default

1. An Optional setting
2. DNS Query is set by
default

1. An optional setting
2. Box is checked by
default

1. An Optional setting
2.5 seconds is selected
by default.

1. An Optional setting
2.5 seconds is selected
by default.

1. An Optional setting
2.3000 ms is set by
default

1. An Optional setting
2.5 times is set by
default

Check the Enable box to activate the network monitoring function.

Choose either DNS Query or ICMP Checking to detect WAN link.

With DNS Query, the system checks the connection by sending DNS Query
packets to the destination specified in Target 1 and Target 2.

With ICMP Checking, the system will check connection by sending ICMP
request packets to the destination specified in Target 1 and Target 2.
Check the Enable box to activate the loading check function.

Enable Loading Check allows the gateway to ignore unreturned DNS
queries or ICMP requests when WAN bandwidth is fully occupied. This is to
prevent false link-down status.

Specify a time interval as the DNS Query Interval.

Query Interval defines the transmitting interval between two DNS Query or
ICMP checking packets.

With DNS Query, the system checks the connection by sending DNS Query
packets to the destination specified in Target 1 and Target 2.

Value Range: 2 ~ 14400.

Specify a time interval as the ICMP Checking Interval.

Query Interval defines the transmitting interval between two DNS Query or
ICMP checking packets.

With ICMP Checking, the system will check connection by sending ICMP
request packets to the destination specified in Target 1 and Target 2.
Value Range: 2 ~ 14400.

Enter a number of detecting disconnection times to be the threshold
before disconnection is acknowledged.

Latency Threshold defines the tolerance threshold of responding time.
Value Range: 2000 ~ 3000 seconds.

Enter a number of detecting disconnection times to be the threshold
before disconnection is acknowledged.

Fail Threshold specifies the detected disconnection before the router
recognize the WAN link down status.
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Target 1

Target 2

Save
Undo

1. An Optional filled
setting

2. DNS1 is selected by
default

1. An Optional filled
setting

2. None is selected by
default

N/A
N/A

Value Range: 1 ~ 10 times.

Targetl specifies the first target of sending DNS query/ICMP request.
DNS1: set the primary DNS to be the target.

DNS2: set the secondary DNS to be the target.

Gateway: set the Current gateway to be the target.

Other Host: enter an IP address to be the target.

Targetl specifies the second target of sending DNS query/ICMP request.

None: no second target is required.

DNS1: set the primary DNS to be the target.

DNS2: set the secondary DNS to be the target.
Gateway: set the Current gateway to be the target.
Other Host: enter an IP address to be the target.
Click Save to save the settings.

Click Undo to cancel the settings.

39



4G PoE-WAN Extender

Internet Connection — 3G/4G WAN

Internet Connect List

# Intemet Connection Configuration { WAN -2

Item Setting

Internet Connect ¥ WAN Type GUAGT

Configure

# JG/4G WAN Type Configuration N

WAN Type= )

ltem Setting
3G/4G WAN Type v Preferred SIM Card SIM-A First ¥ | Failback: [ Enable
Configuration b Auto Flight Mode (0 Enable
el b SIM Switch Policy Policy Setting
Configure
= Connection with SIM-A Card -
SIM-A/ SIM-B
APN Profile List & Connection with SIM-B Card ‘
lmuuw;m¢
APN Profile-x % 3G/4G Connection Common Configuration -
Popup Item Setting
SIM-A/B APN
Profile Configuration + Connection Control |AUt0-TECOﬂnECl v |
» Time Schedule 0) Always ¥
3G/4G Connection b MTU Setup (] Enable

Common Configure

Preferred SIM Card — Dual SIM Fail Over

For 3G/4G embedded device, one embedded cellular module can create only one WAN interface. This device
has featured by using dual SIM cards for one module with special fail-over mechanism. It is called Dual SIM
Failover. This feature is useful for ISP switch over when location is changed. Within “Dual SIM Failover”, there
are various usage scenarios, including "SIM-A First", "SIM-B First” with “Failback” enabled or not, and “SIM-A
Only and “SIM-B Only”.
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SIM-A/SIM-B only: When “SIM-A Only” or “SIM-B Only” is used, the specified SIM slot card is the only one to
be used for negotiation parameters between gateway device and cellular ISP.

SIM-A / SIM-B first without enable Failback

By default, “SIM-A First” scenario is used to connect to cellular ISP for
data transfer. In the case of “SIM-A First” or “SIM-B First” scenario, the
(((g\ {( ))  gateway will try to connect to the Internet by using SIM-A or SIM-B card

Disconnected 5|M_A

first. And when the connection is broken, the gateway will switch to use
the other SIM card for an alternate automatically and will not switch back

ISP1 Fail ver to use original SIM card except current SIM connection is also broken.
(( )) ----- That is, SIM-A and SIM-B are used iteratively, but either one will keep
SIM B being used for data transfer when current connection is still alive.
Cunnected

'5" Not back to SIM-A

SIM-A / SIM-B first with Failback enable

With Failback option enabled, “SIM-A First” scenario is
used to connect when the connection is broken, gateway
system will switch to use SIM-B. And when SIM-A
connection is recovered, it will switch back to use original
SIM-A card

Disconnected .,

((ﬁg) Q

£
I5P1 Failm}ver

() -, L T

ot

,< Connected tm
ISP2 M-8
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Configure 3G/4G WAN Setting

When Edit button is applied, Internet Connection Configuration, and 3G/4G WAN Configuration screens will
appear.

ltem Setting
» WAN Type 3GMAG ~

ltem Setting
» Preferred SIM Card SIM-A First v | Failback: [] Enable
» Auto Flight Mode Enable
b SIM Switch Policy Policy Setting

1.A Must filled setting From the dropdown box, select Internet connection method for 3G/4G
WAN Type 2.3G/4G is set by WAN Connection. Only 3G/4G is available.
default.

Choose which SIM card you want to use for the connection.
When SIM-A First or SIM-B First is selected, it means the connection is built
first by using SIM A/SIM B. And if the connection is failed, it will change to
the other SIM card and try to dial again, until the connection is up.
1. A Must filled setting When SIM-A only or SIM-B only is selected, it will try to dial up only using
2. By default SIM-A First  the SIM card you selected.

Preferred SIM Card is selected When Failback is checked, it means if the connection is dialed-up not using
3. Failback is unchecked  the main SIM you selected, it will failback to the main SIM and try to
by default establish the connection periodically.
Note_1: For the product with single SIM design, only SIM-A Only option is
available.
Note_2: Failback is available only when SIM-A First or SIM-B First is
selected.

Check the Enable box to activate the function.

By default, if you disabled the Auto Flight Mode, the cellular module will
always occupy a physical channel with cellular tower. It can get data
connection instantly, and receive managing SMS all the time on required.
If you enabled the Auto Flight Mode, the gateway will pop up a message
“Flight mode will cause cellular function to be malfunctioned when the
data session is offline.”, and it will make the cellular module into flight
mode and disconnected with cellular tower phycially. In, addition,
whenever the cellular module is going to be used for data connection to
backup the failed primary connection, the cellular module will be active to
connect with cellular tower and get the data connection for use, It takes
few more seconds.

The box is unchecked by

Auto Flight Mode default
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Note: Keep it unchecked unless your cellular ISP asked the connected
gateway to enable the Auto Flight Mode.

Click the Policy Setting button to define the SIM Switch policy or browse
the current policy settings.

= Policy Setting

SIM Switch Policy NA

Item Setting
» Failed connection D (1-10) times
» RSSI Monitor [ Enable Threshold: -[0 | (-90~-113 dBm)
¥ Network Service [} Enable Loss LTE signal: D (1~30 minutes)
» Roaming Service [] Enable Timeout: EI (1~30 minutes)

Configure SIM-A / SIM-B Card

Here you can set configurations for the cellular connection according to your situation or requirement.

= Connection with SIM-A Card e

ltem Setting
¥ MNetwork Type Auto v
* Dial-Up Profile | Manual-configuration ¥
» APN | |
k IP Type
» PIN Code | | (Optional)
¥ Dial Number | | (Optional)
» Account | | (Optional)
» Password | | (Optional)
» Authentication
» IP Mode
» Primary DNS | | (Optional)
» Secondary DNS | | (Optional)
» Roaming [ Enable

Note_1: Configurations of SIM-B Card follows the same rule of Configurations of SIM-A Card, here we list SIM-
A as the example.

Note_2: Both Connection with SIM-A Card and Connection with SIM-B Card will pop up only when the SIM-A
First or SIM-B First is selected, otherwise it only pops out one of them.
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Network Type

Dial-Up Profile

APN

IP Type

PIN code

Dial Number,
Account,
Password

Authentication

IP Mode

1. A Must filled setting
2. By default Auto is
selected

1. A Must filled setting
2. By default Manual-

configuration is selected

1. A Must filled setting
2. String format : any
text

1. A Must filled setting
2. By default IPv4 is
selected

1. An Optional setting
2. String format :
interger

1. An Optional setting
2. String format : any
text

1. A Must filled setting
2. By default Auto is
selected

1. A Must filled setting

2. By default Dynamic IP

is selected

Select Auto to register a network automatically, regardless of the network
type.

Select 2G Only to register the 2G network only.

Select 2G Prefer to register the 2G network first if it is available.

Select 3G only to register the 3G network only.

Select 3G Prefer to register the 3G network first if it is available.

Select LTE only to register the LTE network only.

Note: Options may be different due to the specification of the module.
Specify the type of dial-up profile for your 3G/4G network. It can be
Manual-configuration, APN Profile List, or Auto-detection.

Select Manual-configuration to set APN (Access Point Name), Dial Number,
Account, and Password to what your carrier provides.

Select APN Profile List to set more than one profile to dial up in turn, until
the connection is established. It will pop up a new filed, please go to Basic
Network > WAN & Uplink > Internet Setup > SIM-A APN Profile List for
details.

Select Auto-detection to automatically bring out all configurations needed
while dialing-up, by comparing the IMSI of the SIM card to the record listed
in the manufacturer’s database.

Note_1: You are highly recommended to select the Manual or APN Profile
List to specify the network for your subscription. Your ISP always provides
such network settings for the subscribers.

Note_2: If you select Auto-detection, it is likely to connect to improper
network, or failed to find a valid APN for your ISP.

Enter the APN you want to use to establish the connection.

This is a must-filled setting if you selected Manual-configuration as dial-up
profile scheme.

Specify the IP type of the network serveice provided by your 3G/4G
network. It can be IPv4, IPv6, or IPv4/6.

Enter the PIN (Personal Identification Number) code if it needs to unlock
your SIM card.

Enter the optional Dial Number, Account, and Password settings if your ISP
provided such settings to you.

Note: These settings are only displayed when Manual-configuration is
selected.

Select PAP (Password Authentication Protocol) and use such protocol to be
authenticated with the carrier’s server.

Select CHAP (Challenge Handshake Authentication Protocol) and use such
protocol to be authenticated with the carrier’s server.

When Auto is selected, it means it will authenticate with the server either
PAP or CHAP.

When Dynamic IP is selected, it means it will get all IP configurations from
the carrier’s server and set to the device directly.

If you have specific application provided by the carrier, and want to set IP
configurations on your own, you can switch to Static IP mode and fill in all
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parameters that required, such as IP address, subnet mask and gateway.

Note: IP Subnet Mask is a must filled setting, and make sure you have the
right configuration. Otherwise, the connection may get issues.

1. An Optional setting Enter the IP address to change the primary DNS (Domain Name Server)
Primary DNS 2. String format : IP setting. If it is not filled-in, the server address is given by the carrier while

address (IPv4 type) dialing-up.

1. An Optional setting Enter the IP address to change the secondary DNS (Domain Name Server)
Secondary DNS 2. String format : IP setting. If it is not filled-in, the server address is given by the carrier while

address (IPv4 type) dialing-up.

Check the box to establish the connection even the registration status is
The box is unchecked by ~ roaming, not in home network.

Roaming default

Note: It may cost additional charges if the connection is under roaming.

Create/Edit SIM-A / SIM-B APN Profile List

You can add a new APN profile for the connection, or modify the content of the APN profile you added. It is
available only when you select Dial-Up Profile as APN Profile List.

= SIM-A APN Profile List [0

Profile

Name APN IP Type Account | Password | Authentication| Priority | Enable Actions

List all the APN profile you created, easily for you to check and modify. It is available only when you select
Dial-Up Profile as APN Profile List.

When Add button is applied, an APN Profile Configuration screen will appear.

= SIM-A APN Profile Configuration

Item Setting
» Profile Name |Profile-1 |
b APN | |
1P Type
» Account | | (Optional)
¢ Password | D | (Optional)
¢ Auihentication
» Priority [ ]
+ Profile | Enable
SIM-A/-B APN Profile Configuration
Item Value setting Description
1. By default Profile-x is Enter the profile name you want to describe for this profile.
Profile Name listed
2. String format : any text
APN String format : any text Enter the APN you want to use to establish the connection.
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1. A Must filled setting Specify the IP type of the network serveice provided by your 3G/4G
IP Type 2. By default IPv4 is network. It can be IPv4, IPv6, or IPv4/6.

selected

. Enter the Account you want to use for the authentication.
Account String format : any text
Value Range: 0 ~ 53 characters.

Password String format : any text Enter the Password you want to use for the authentication.

1. A Must filled setting Select the Authentication method for the 3G/4G connection.
Authentication 2. By default Auto is It can be Auto, PAP, CHAP, or None.

selected

1. A Must filled setting Enter the value for the dialing-up order. The valid value is from 1 to 16. It

Priority . . will start to dial up with the profile that assigned with the smallest number.
2. String format : integer
Value Range: 1 ~ 16.
Profile The box is checked by Check the box to enable this profile.
default Uncheck the box to disable this profile in dialing-up action.
Save N/A Click the Save button to save the configuration.
Undo N/A Click the X button to restore what you just configured back to the previous

setting.

Setup 3G/4G Connection Common Configuration

Here you can change common configurations for 3G/4G WAN.

ltem Setting
» Connection Contro Auto-reconnect v
¥ Time Schedule (0) Always ¥
» MTU Setup Enable
* IP Passthrough (Cellular Enable Fixed MAC
Bridge)
b NAT # Enable
F IGMP Disable v
» WAN IP Alias Enable {10.0.0.1

When Auto-reconnect is selected, it means it will try to keep the Internet
connection on all the time whenever the physical link is connected.
When Connect-on-demand is selected, it means the Internet connection
will be established only when detecting data traffic.

When Connect Manually is selected, it means you need to click the
Connect button to dial up the connection manually. Please go to Status >
Basic Network > WAN & Uplink tab for details.

By default Auto-

Connection Control .
reconnect is selected

Note: If the WAN interface serves as the primary one for another WAN
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Maximum Idle Time

Time Schedule

MTU Setup

IP Pass-through
(Cellular Bridge)

NAT
IGMP

WAN IP Alias

[tem

¥ Network Monitoring
Configuration

¢+ Checking Method
¥ Loading Check
¥ Query Interval

¢+ Latency Threshold

¢ Fail Threshold
» Targetl
» Target2

1. An Optional setting
2. By default 600
seconds is filled-in

1. A Must filled setting
2. By default (0) Always
is selected

1. An Optional setting
2. Uncheck by default

1. The box is unchecked
by default

2. String format for Fixed
MAC:

MAC address, e.g.
00:50:18:aa:bb:cc

Check by default

By default Disable is
selected

1. Unchecked by default
2. String format: IP
address (IPv4 type)

interface in Failover role( and vice versa), the Connection Control
parameter will not be available on both WANs as the system must set it to
“Auto-reconnect”

Specify the maximum Idle time setting to disconnect the internet
connection when the connection idle timed out.

Value Range: 300 ~ 86400.

Note: This field is available only when Connect-on-demand or Connect
Manually is selected as the connection control scheme.

When (0) Always is selected, it means this WAN is under operation all the
time. Once you have set other schedule rules, there will be other options to
select. Please go to Object Definition > Scheduling for details.

Check the Enable box to enable the MTU (Maximum Transmission Unit)
limit, and specify the MTU for the 3G/4G connection.

MTU refers to Maximum Transmission Unit. It specifies the largest packet
size permitted for Internet transmission.

Value Range: 1200 ~ 1500.

When Enable box is checked, it means the device will directly assign the
WAN [P to the first connected local LAN client.

However, when an optional Fixed MAC is filled-in a non-zero value, it
means only the client with this MAC address can get the WAN IP address.

Note: When the IP Pass-through is on, NAT and WAN IP Alias will be
unavailable until the function is disabled again.

Uncheck the box to disable NAT (Network Address Translation) function.
Select Auto to enable IGMP function.

Check the Enable box to enable IGMP Proxy.

Check the box to enable WAN IP Alias, and fill in the IP address you want to
assign.

Setting
#| Enable
DNS Query v
#| Enable
5 (seconds)
3000 (ms)
g Times)
DMNS1 ¥
Mone v
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Network Monitoring
Configuration

Checking Method

Loading Check

Query Interval

Check Interval

Latency Threshold

Fail Threshold

Target 1

Target 2

Save
Undo

1. An optional setting
2. Box is checked by
default

1. An Optional setting
2. DNS Query is set by
default

1. An optional setting
2. Box is checked by
default

1. An Optional setting
2.5 seconds is selected
by default.

1. An Optional setting
2.5 seconds is selected
by default.

1. An Optional setting
2.3000 ms is set by
default

1. An Optional setting
2.5 times is set by
default

1. An Optional filled
setting

2. DNS1 is selected by
default

1. An Optional filled
setting

2. None is selected by
default

N/A
N/A

Check the Enable box to activate the network monitoring function.

Choose either DNS Query or ICMP Checking to detect WAN link.

With DNS Query, the system checks the connection by sending DNS Query
packets to the destination specified in Target 1 and Target 2.

With ICMP Checking, the system will check connection by sending ICMP
request packets to the destination specified in Target 1 and Target 2.
Check the Enable box to activate the loading check function.

Enable Loading Check allows the gateway to ignore unreturned DNS
queries or ICMP requests when WAN bandwidth is fully occupied. This is to
prevent false link-down status.

Specify a time interval as the DNS Query Interval.

Query Interval defines the transmitting interval between two DNS Query or
ICMP checking packets.

With DNS Query, the system checks the connection by sending DNS Query
packets to the destination specified in Target 1 and Target 2.

Value Range: 2 ~ 14400.

Specify a time interval as the ICMP Checking Interval.

Query Interval defines the transmitting interval between two DNS Query or
ICMP checking packets.

With ICMP Checking, the system will check connection by sending ICMP
request packets to the destination specified in Target 1 and Target 2.
Value Range: 2 ~ 14400.

Enter a number of detecting disconnection times to be the threshold
before disconnection is acknowledged.

Latency Threshold defines the tolerance threshold of responding time.
Value Range: 2000 ~ 3000 seconds.

Enter a number of detecting disconnection times to be the threshold
before disconnection is acknowledged.

Fail Threshold specifies the detected disconnection before the router
recognize the WAN link down status.

Value Range: 1 ~ 10 times.

Targetl specifies the first target of sending DNS query/ICMP request.
DNS1: set the primary DNS to be the target.

DNS2: set the secondary DNS to be the target.

Gateway: set the Current gateway to be the target.

Other Host: enter an IP address to be the target.

Targetl specifies the second target of sending DNS query/ICMP request.
None: no second target is required.

DNS1: set the primary DNS to be the target.

DNS2: set the secondary DNS to be the target.

Gateway: set the Current gateway to be the target.

Other Host: enter an IP address to be the target.

Click Save to save the settings.

Click Undo to cancel the settings.
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2.1.3 Load Balance

[tem Satting
b Liadl Batance Stiteqy By Spacific Weight »
By Smart Weight |
. By Specific Vslght
By User Palicy
WAN ID Waight Action
Select one
Load Balance b b B
Strategy VAN - 2 13 % Edit
Specific |3mart | User
Weight |Weight | Policy v | Adl:l DEIME

W
v ftam

E [H] Source P MHHH Dllhnl‘ﬂﬂﬂ IF Address Destination Part WAN Interface  Enable Actions

Sefting

When there are multiple WAN interfaces, and when the bandwidth of one WAN connection is not enough for
the traffic loads from the Intranet to the Internet, the WAN load balance function can be considered to

enlarge the total WAN bandwidth.

Load Balance Strategy

There are three optional strategies for load balance: “By Smart Weight”, “By Specific Weight”, and “By User
Policy”. Administrator can select strategy according to application requirement and environment status. The

strategies are explained as below.

Initial
WAN-1: WAN-2 = (Line speed 1): (Line speed 2)
Mext time period, dynamic adjust:

WAN-1 : WAN-2 = Previous records of ratio

by Smart Weight algorithm

WAN-L

AN-2

Session Requests

. Load Balance: Enable
.. | Load Balance Strategy: By Smart Weight

Lo

By Smart Weight

By Smart Weight

If based on "By Smart Weight" strategy, gateway
will take the line speed settings of all WAN
interfaces specified in "Physical Interface"
configuration page as default ratio for data
transfer. Based on the ratio of packet bytes via
these WAN interfaces in past period (maybe 5
minutes), system decides how many sessions will
be transferred via each WAN interface for next
period. Administrator may take it as a fast
approach to maximize the bandwidth utilization of
multiple WAN interfaces in gateway
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Sessions always sent by ratio of
WAMN-1: WAN-2 = (67% : 33%) = m:n

« Ef’ m Mbps

Sub ibe:
Mb ubscribes 6

Session Requests

Administrares

~ Intranet ™

Load Balance: Enable

Load Balance Strategy: By SpecificWeight

WARN-1: 67%
WARN-2:33%

By Specific Weight

) "

.
l“
x3

® Load Balance
[Load Balance]-[Configuration]

Load Balance Strategy: By User Policy
[Load Balance]-[User Policy 1]

Source IP Address: 192.168.123.0/24

WAN Interface: WAN-1

Policy: Enable

‘ CE"UI“l‘G&é&E‘EEE‘
@ A WAN-1: 3G/4G_ &
ellular ( ) :
Cellular 2 (‘g\’ WAN-2: 36/4G g' =

Load Balance: Enable 192.168.123.x/24 E :

[Load Balance]-[User Policy 2]

: WAN Interface: WAN-2
" | Policy: Enable

Source IP Address: 192.168.102.0/24 User Pah'q.r Based : Source JP/ Subnet_

Google: -> WAN-1
Yahoo: -> WAN-2

Cellular 1t(( ))
PR

WAN-1: 3G/4G

® Load Balance Y.
[Load Balance]-[Configuration]

Load Balance: Enable

Load Balance Strategy: By User Policy

[Load Balance]-[User Policy 1]

WAN-2: 3G/4G

Cellular 2 f((g d"‘

Google Access
1

Destination IP: (Domain Name)(www.google.com)
WAN Interface: WAN-1
Policy: Enable

[Load Balance]-[User Policy 2]

Destination IP: (Domain Name){www.yahoo.com)
| WAN Interface: WAN-2
_|_Policy: Enable

User Policy Based :
Destination IP / Domain Name’

By Specific Weight

When you select "By Specific Weight", you need to
set up ratio of WAN-1/WAN-2 to decide sessions
sent ratio. Total ratio should be 100%. Ratio is
usually defined based on practical WAN speed of
environment. Gateway's traffic control process will
operate routing adequately based on the
dedicated weights ratio on all WAN interfaces.

By User Policy

If "By User Policy" load balance strategy is
selected, it can allow you to mapping Source IP,
Destination IP, or Destination Port to assigned
WAN interfece. This IP address is not only a single
IP but also a subnet or IP range. Destination port
can be a single port or port range. You can select
one target for one mapping to setup IP address
and leave others just left as “any”/ ”All”. Besides
this, you can also set protocol as TCP, UDP or
both.

Diagrams shown on left side are examples user
policy. The first diagram illustrates example for
mapping various source IP subnets to different
WAN interface. All packets from different subnet
will be routed to the assigned WAN interfece.
Administrator can manage and balance the
loading among available WAN interfaces
accordingly.

The second diagram illustrates another example
for routing packets with designated destination IP
or domain name to a certain WAN interface.

If packets no belong to user policy rule, the
gateway just routes those packets based on
smart weight algorithm.
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Load Balance Setting

Go to Basic Network > WAN & Uplink > Load Balance Tab.

The Load Balance function is used to manage balance bandwidth usage among multiple WAN connections.
When you choose "By Smart Weight" strategy, system will operate load balance function automatically based
on the embedded Smart Weight algorithm. However, when you choose "By Specific Weight" strategy, the
further "Weight Definition" configuration window will let you define the ratio of transferred sessions between
all WAN interfaces for data transfer. At last, when you choose "By User Policy" strategy, the further "User
Policy List" shows all defined user policy entries, and the "User Policy Configuration" window will let you
create and define one user policy for routing dedicated packet flow via one WAN interface.

Enable/Select Load Balance Strategy

Item Setting
» Load Balance Enahble
» Load Balance Strategy By Specific Weight »
Load Balance Unchecked by default Check the Enable box to activate Load Balance function.

There are up to three load balance strategies. Select the preferred one.
By Smart Weight: System will operate load balance function automatically
based on the embedded Smart Weight algorithm.

1. AMust filled setting By Specific Weight: System will adjust the ratio of transferred sessions among

Load Balance 2. By Smart Weight is

Strategy selected by default all WANs based on the specified weights for each WAN.
’ By User Policy: System will route traffics through available WAN interface based
on user defined rules.
Note: The number of available strategies depends on the model you purchased.
Save NA Click the Save button to save the configuration
Click the Undo button to restore what you just configured back to the previous
Undo NA

setting.

When By Specific Weight is selected, user needs to adjust the percentage of WAN loading. System will give a
value according to the bandwidth ratio of each WAN at first time and keep the value after clicking Save button.
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* Weight Definition -

WAN ID Weight Actien

VAN - 1 A %
YYAN - 2 13 %

\ Weight Definition

Value setting Description

WAN ID NA The Identifier for each available WAN interface..
Enter the weight ratio for each WAN interface.
1. A Must filled setting Initially, the bandwidth ratio of each WAN is set by default.
Weight 2. Set with bandwidth ratio Value Range: 1 ~ 99.

of each WAN by default.
Note: The sum of all weights can’t be greater than 100%.

Save NA Click the Save button to save the configuration
Undo NA Click the Undo button to restore what you just configured back to the previous
setting.

When By User Policy is selected, a User Policy List screen will appear. With properly configured your policy
rules, system will route traffics through available WAN interface based on user defined rules

Create User Policy

® User Policy List -. --

Source |P Address Destination IP Address Destination Port WAN Interface Actions
When Add button is applied, User Policy Configuration screen will appear.
# User Policy Cenfiguration ' x
Item Setting
» Source P Address Any v
» Destination [P Address |AW v |
» Destination Part |fﬂ~” M

» Protocol
WA Interface

» Palicy [} Enahle

User Policy Configuration

\ Item \ Value setting Description

There are four options can be selected :

Any: No specific Source IP is provided. The traffic may come from any source
Subnet: Specify the Subnet for the traffics come from the subnet. Input format

Source IP 1. A Must filled setting
Address 2. Any is selected by default.

52



4G PoE-WAN Extender

Destination IP
Address

Destination
Port

Protocol

WAN Interface

Policy
Save

Undo

1. A Must filled setting

2. Any is selected by default.

1. A Must filled setting
2. All is selected by default.

1. A Must filled setting
2. Both is selected by
default.

1. A Must filled setting
2. WAN-1 is selected by
default.

Unchecked by default

NA

NA

iS 1 XXX XXX.XXX.XXX/XX e.g.192.168.123.0/24.

IP Range: Specify the IP Range for the traffics come from the IPs

Single IP: Specify a unique IP Address for the traffics come from the IP. Input
format is : xxx.xxx.xxx.xxx e.g. 192.168.123.101.

There are five options can be selected :

Any: No specific destination IP is provided. The traffic may come to any
destination.

Subnet: Specify the Subnet for the traffics come to the subnet. Input format is :

XXX.XXX.XXX.XXX/XX e.g.192.168.123.0/24.

IP Range: Specify the IP Range for the traffics come to the IPs

Single IP: Specify a unique IP Address for the traffics come to the IP. Input
format is : xxx.xxx.xxx.xxx e.g. 192.168.123.101.

Domain Name: Specify the domain name for the traffics come to the domain
There are four options can be selected :

All: No specific destination port is provided.

Port Range: Specify the Destination Port Range for the traffics

Single Port: Specify a unique destination Port for the traffics

Well-known Applications: Select the service port of well-known application
defined in dropdown list.

There are three options can be selected. They are Both, TCP, and UDP.

User can select the interface that traffic should go.

Note that the WAN interface dropdown list will only show the available WAN
interfaces.

Check the Enable checkbox to activate the policy rule.

Click the Save button to save the configuration

Click the Undo button to restore what you just configured back to the previous
setting.
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2.2 LAN & VLAN

This section provides the configuration of LAN and VLAN. VLAN is an optional feature, and it depends on the
product specification of the purchased gateway.

2.2.1 Ethernet LAN

3

xDSLand,or
4G Cellular

The Local Area Network (LAN) can be
used to share data or files among

computers attached to a network.
Ethernet LAM

Please follow the following instructions to do IPv4 Ethernet LAN Setup.

» IP Mode

» LAM IP Address

» Subnet Mask

IP Mode

LAN IP
Address

Subnet Mask

Static IP

Following diagram illustrates the
network that wired and interconnects
computers.

Setting

192.168.123.254

2552552550 (/24 v

N/A

1. A Must filled setting
2.192.168.123.254 is set by
default

1. A Must filled setting
2.255.255.255.0 (/24) is set

It shows the LAN IP mode for the gateway according the related configuration.
Static IP: If there is at least one WAN interface activated, the LAN IP mode is
fixed in Static IP mode.

Dynamic IP: If all the available WAN inferfaces are disabled, the LAN IP mode
can be Dynamic IP mode.

Enter the local IP address of this device.

The network device(s) on your network must use the LAN IP address of this
device as their Default Gateway. You can change it if necessary.

Note: /t’s also the IP address of web Ul. If you change it, you need
to type new IP address in the browser to see web UI.

Select the subnet mask for this gateway from the dropdown list.

Subnet mask defines how many clients are allowed in one network or subnet.
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by default The default subnet mask is 255.255.255.0 (/24), and it means maximum 254 |P
addresses are allowed in this subnet. However, one of them is occupied by LAN
IP address of this gateway, so there are maximum 253 clients allowed in LAN

network.
Value Range: 255.0.0.0 (/8) ~ 255.255.255.252 (/30).

Save N/A Click the Save button to save the configuration

Undo N/A Clitctl.< the Undo button to restore what you just configured back to the previous
setting.

Create / Edit Additional IP

This gateway provides the LAN IP alias function for some special management consideration. You can add
additional LAN IP for this gateway, and access to this gateway with the additional IP.

= Additional IP " "

Interface IP Address Subnet Mask Enable Action
When Add button is applied, Additional IP Configuration screen will appear.
= Additional IP Configuration ' %
Item Setting
¥ Mame | |
¥ Interface
» IP Address | |
¥ Subnet Mazk |255.255.255.0 24y - |
» Enahle o

Configuration

Item Value setting Description

Name .1 An Optional Setting Enter the name for the alias IP address.
1. A Must filled setting .
Interface . Specify the Interface type. It can be lo or br0.
2. lois set by default
1. An Optional setting
IP Address 2.192.168.123.254 issetby  Enter the addition IP address for this device.
default
Select the subnet mask for this gateway from the dropdown list.
1. A Must filled setting Subnet mask defines how many clients are allowed in one network or subnet.
Subnet Mask 2.255.255.255.0 (/24) isset  The default subnet mask is 255.255.255.0 (/24), and it means maximum 254 IP
by default addresses are allowed in this subnet. However, one of them is occupied by LAN
IP address of this gateway, so there are maximum 253 clients allowed in LAN
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Save NA

network.
Value Range: 255.0.0.0 (/8) ~ 255.255.255.255 (/32).

Click the Save button to save the configuration
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2.2.2 VLAN

VLAN (Virtual LAN) is a logical network under a certain switch or router device to group client hosts with a
specific VLAN ID. This gateway supports both Port-based VLAN and Tag-based VLAN. These functions allow
you to divide local network into different “virtual LANs”. It is common requirement for some application
scenario. For example, there are various departments within SMB. All client hosts in the same department
should own common access privilege and QoS property. You can assign departments either by port-based
VLAN or tag-based VLAN as a group, and then configure it by your plan. In some cases, ISP may need router to
support “VLAN tag” for certain kinds of services (e.g. IPTV). You can group all devices required this service as
one tag-based VLAN.

If the gateway has only one physical Ethernet LAN port, only very limited configuration is available if you
enable the Port-based VLAN.

> Port-based VLAN

Port-based VLAN function can group Ethernet ports, Port-1 ~ Port-4, and WiFi Virtual Access Points, VAP-1 ~
VAP-8, together for differentiated services like Internet surfing, multimedia enjoyment, VolP talking, and so on.
Two operation modes, NAT and Bridge, can be applied to each VLAN group. One DHCP server can be allocated
for a NAT VLAN group to let group host member get its IP address. Thus, each host can surf Internet via the
NAT mechanism of business access gateway. In bridge mode, Intranet packet flow is delivered out WAN trunk
port with VLAN tag to upper link for different services.

VLAN Group 1 NAT
== T = Wireless Networ F— lr
AR ] = ey
:x C:._I‘\F C::y_;’ ] :D WiFi Bridge St Mocem \k';jy’
\"~-'_'_"______..-r/ ﬁ.f_.

\\'-

. Wireless Network

T

| oo | @ | ...
SEae Y

W Wired Netweork

A port-based VLAN is a group of ports on an Ethernet or Virtual APs of Wired or Wireless Gateway that form a
logical LAN segment. Following is an example.

For example, in a company, administrator schemes out 3 network segments, Lobby/Meeting Room, Office,
and Data Center. In a Wireless Gateway, administrator can configure Lobby/Meeting Room segment with
VLAN ID 3. The VLAN group includes Port-3 and VAP-8 (SSID: Guest) with NAT mode and DHCP-3 server
equipped. He also configure Office segment with VLAN ID 2. The VLAN group includes Port-2 and VAP-1 (SSID:
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Staff) with NAT mode and DHCP-2 server equipped. At last, administrator also configure Data Center segment
with VLAN ID 1. The VLAN group includes Port-1 with NAT mode to WAN interface as shown in following
diagram.

Wireless Gateway (92

\ xD5L and/for

4G Cellular
P[)I't 1| 2 3 VLANID3
VIANID1 VIANID 3
“*‘S =
@ Data Center B
%
VID1: -
DHCP Server: DHCP-1
VID2:
DHCP Server: DHCP-2
VID3: %
DHCP Server: DHCP-3 @ Office Network ./

VLANID 2

Above is the general case for 3 Ethernet LAN ports in the gateway. But if the device just has one Ethernet LAN
port, there will be only one VLAN group for the device. Under such situation, it still supports both the NAT and
Bridge mode for the Port-based VLAN configuration.

» Tag-based VLAN

Tag-based VLAN function can group Ethernet ports, Port-1 ~ Port-4, and WiFi Virtual Access Points, VAP-1 ~
VAP-8, together with different VLAN tags for deploying subnets in Intranet. All packet flows can carry with
different VLAN tags even at the same physical Ethernet port for Intranet. These flows can be directed to
different destination because they have differentiated tags. The approach is very useful to group some hosts
at different geographic location to be in the same workgroup.

Tag-based VLAN is also called a VLAN Trunk. The VLAN Trunk collects all packet flows with different VLAN IDs
from Router device and delivers them in the Intranet. VLAN membership in a tagged VLAN is determined by
VLAN ID information within the packet frames that are received on a port. Administrator can further use a
VLAN switch to separate the VLAN trunk to different groups based on VLAN ID. Following is an example.
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VLAN Group 1

o= T = Wireless Network WiFi - (
R R =) &
{ AL | *DSL Modem \{!J
l\<_l> Q—;}/ I WiFi —

I s Wireless Network
T,

Al
S& Sl | G
NN & O

Wired Network

For example, in a company, administrator schemes out 3 network segments, Lab, Meeting Rooms, and Office.
In a Security VPN Gateway, administrator can configure Office segment with VLAN ID 12. The VLAN group is
equipped with DHCP-3 server to construct a 192.168.12.x subnet. He also configure Meeting Rooms segment
with VLAN ID 11. The VLAN group is equipped with DHCP-2 server to construct a 192.168.11.x subnet for
Intranet only. That is, any client host in VLAN 11 group can’t access the Internet. At last, he configures Lab
segment with VLAN ID 10. The VLAN group is equipped with DHCP-1 server to construct a 192.168.10.x subnet.

Gateway VID10 :
DHCP Server: DHCP-1{192.168.10.x)
VID11 :
xDSL and/or Erncr;ewer: DHCP-2{192.168.11.x)
4G Cellular :

DHCP Server: DHCP-3(192.168.12.x)

Port-3, 4
Portl,2 ViD=11
VID=12 Meeting Rooms "\
Port-3, 4
VID=12 J
Office Office)
g >
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» VLAN Groups Access Control

Administrator can specify the Internet access permission for all VLAN groups. He can also configure which
VLAN groups are allowed to communicate with each other.

VLAN Group Internet Access

Administrator can specify members of one VLAN group to be able to access Internet or not. Following is an
example that VLAN groups of VID is 2 and 3 can access Internet but the one with VID is 1 cannot access
Internet. That is, visitors in meeting room and staffs in office network can access Internet. But the
computers/servers in data center cannot access Internet since security consideration. Servers in data center
only for trusted staffs or are accessed in secure tunnels.

Wireless Gateway ()

xQSL and/or AT
\ 4G~Qe|lu|ar 8]

1 Port-1, 2 3
1 X

vianip: - [f % % VLANID 3

T &

VLANID 3

IE|

oY

o

="

Office Network

&

VLANID 2

V0IANID 2
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Inter VLAN Group Routing:

In Port-based tagging, administrator can specify member hosts of one VLAN group to be able to communicate
with the ones of another VLAN group or not. This is a communication pair, and one VLAN group can join many
communication pairs. But communication pair doesn’t have the transitive property. That is, A can
communicate with B, and B can communicate with C, it doesn’t imply that A can communicate with C. An
example is shown at following diagram. VLAN groups of VID is 1 and 2 can access each other but the ones
between VID 1 and VID 3 and between VID 2 and VID 3 can'’t.

Wireless Gateway ({ ))

\@ xDSL and/or

4G Cellular
Port-1 2 3

-
VLANID 1 %
¥

[ :

VLANID 3

%

@ Meeting Room

W

' Office Network

P
&

V0IANID 2
VLIANID 2
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VLAN Setting

Go to Basic Network > LAN & VLAN > VLAN Tab.

The VLAN function allows you to divide local network into different virtual LANs. There are Port-based and
Tag-based VLAN types. Select one that applies.

v WLAM Types

Item

v Systern Reserved WLAN 1D

VLAN Type

System
Reserved
VLAN ID

Save

Port-based is selected by

Start 1D 1

default

Setting
FPort-based v
(1-4081)~ End ID 5

Select the VLAN type that you want to adopt for organizing you local subnets.
Port-based: Port-based VLAN allows you to add rule for each LAN port, and you
can do advanced control with its VLAN ID.

Tag-based: Tag-based VLAN allows you to add VLAN ID, and select member and
DHCP Server for this VLAN ID. Go to Tag-based VLAN List table.

Specify the VLAN ID range that is reserved for the system operation. For the
Port-based/Tag-based VLAN grouping, only use the ID outside the reserved

1~ 5is reserved by default

NA

range.
Value Range: 1 ~ 4091.
Click the Save button to save the configuration

Port-based VLAN - Create/Edit VLAN Rules

The port-based VLAN allows you to custom each LAN port. There is a default rule shows the configuration of all
LAN ports. Also, if your device has a DMZ port, you will see DMZ configuration, too. The maxima rule numbers
is based on LAN port numbers.

Add Delete
Name WLAN ID T%Slﬂ g NAT / Bridge Port Members LAN IP Address Subnet Mask Joined WAN WAN VID Enable | Actions
DMZ 4094 X AT DMZ Port 192.168.6.254 285.265.254.0 AR - 1 a Edit
LAN Mative WLAMN X AT Detail 192.168.123.254 2552652550 AllWANS a Edit
Apply | Inter VLAN Group Routing

When Add button is applied, Port-based VLAN Configuration screen will appear, which is including 3 sections:
Port-based VLAN Configuration, IP Fixed Mapping Rule List, and Inter VLAN Group Routing (enter through a

button)
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Port-based VLAN - Configuration

¥ Name

» VLANID

» VLAN Tagging
» NAT / Bridge

» Port Members

» LAN to Join

Name

VLAN ID

VLAN Tagging

NAT / Bridge

Port Members

LAN to Join

Save

Undo

Item Setting
VLAN -1
Disable
NAT v
Port: Port-2 Port-3
240G WAP-1 WAP-2 VAP-3 VAP-4 [ VAP-5 VAP-§ VAP-T [ VAP
5G VAP-1 VAP-2 [ WVAP-3 WVAP-4 VAP-E [ VAP-8 [] VAP-7 WVAP-8
Enable |\DHCP 1 »

1. A Must filled setting
2. String format: already
have default texts

A Must filled setting

Disable is selected by
default.

NAT is selected by default.
These boxes are unchecked
by default.

The box is unchecked by
default.

NA

NA

Define the Name of this rule. It has a default text and cannot be modified.

Define the VLAN ID number, range is 1~4094.
The rule is activated according to VLAN ID and Port Members configuration
when Enable is selected.

The rule is activated according Port Members configuration when Disable is
selected.

Select NAT mode or Bridge mode for the rule.

Select which LAN port(s) and VAP(s) that you want to add to the rule.

Note: The available member list can be different for the purchased product.
Check the Enable box and select one of the defined DHCP Server for the List to
define the DHCP server for the VLAN group.

If you enabled this function, all the rest settings will be greyed out, not required
to configured manually.

Click the Save button to save the configuration

Click the Undo button to restore what you just configured back to the previous

setting.

If you didn’t decide to bind the VLAN group to a pre-defined DHCP server, you have to further specify the
following settings.
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*» IP Poo

-

Lease Time

-

-

-

b Gateway

» Enable

WAN & WAN
VID to Join
LAN IP
Address

Subnet Mask

DHCP Server
/Relay

DHCP Server
IP Address
(for DHCP
Relay only)
DHCP Option
82

(for DHCP
Relay only)
DHCP Server
Name

IP Pool

F WAN & WAN VID to Join
¥ LAN IP Address
b Subnet Mask

¥ DHCP Server / Relay

Domain Name
Primary DNS

» Secondary DNS
Primary WINS

b Secondary WINS

All WANs

Mone

192.168.2.254
2552552550 (/24) -

» DHCP Server Name
Starting Address:
Ending Address:

86400

All WANS is selected by
default.

A Must filled setting

255.255.255.0(/24) is
selected by default.

Server is selected by default.

A Must filled setting

An Optional filled setting

A Must filled setting

A Must filled setting

Server v

192.168.2.100
192.168.2.200
seconds

(Optional)
(Optional)
(Optional)
(Optional)
(Optional)

(Optional)

Select which WAN or All WANSs that allow accessing Internet.

Note: If Bridge mode is selected, you need to select a WAN and enter a VID.
Assign an IP Address for the DHCP Server that the rule used, this IP address is a
gateway IP.

Select a Subnet Mask for the DHCP Server.

Define the DHCP Server type.

There are three types you can select: Server, Relay, and Disable.

Relay: Select Relay to enable DHCP Relay function for the VLAN group, and you
only need to fill the DHCP Server IP Address field.

Server: Select Server to enable DHCP Server function for the VLAN group, and
you need to specify the DHCP Server settings.

Disable: Select Disable to disable the DHCP Server function for the VLAN group.

If you select Relay type of DHCP Server, assign a DHCP Server IP Address that
the gateway will relay the DHCP requests to the assigned DHCP server.

If you select Relay type of DHCP Server, you can further enable the DHCP
Option 82 setting if the DHCP server support it.

Define name of the DHCP Server for the specified VLAN group.

Define the IP Pool range.

There are Starting Address and Ending Address fields. If a client requests an IP
address from this DHCP Server, it will assign an IP address in the range of IP
pool.
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Lease Time

Domain Name

Primary DNS

Secondary
DNS

Primary WINS

Secondary
WINS

Gateway
Enable

Save

Undo

A Must filled setting

String format can be any
text
IPv4 format

IPv4 format
IPv4 format
IPv4 format

IPv4 format
The box is unchecked by
default.

NA

NA

Define a period of time for an IP Address that the DHCP Server leases to a new
device. By default, the lease time is 86400 seconds.

The Domain Name of this DHCP Server.
Value Range: 0 ~ 31 characters.

The Primary DNS of this DHCP Server.
The Secondary DNS of this DHCP Server.
The Primary WINS of this DHCP Server.
The Secondary WINS of this DHCP Server.
The Gateway of this DHCP Server.

Click Enable box to activate this rule.

Click the Save button to save the configuration
Click the Undo button to restore what you just configured back to the previous
setting.
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Besides, you can add some IP rules in the IP Fixed Mapping Rule List if DHCP Server for the VLAN groups is
required.

« IP Fixed Mapping Rule List I PR
MAC Address IP Address Enable Actions

When Add button is applied, Mapping Rule Configuration screen will appear.

Mapping Rule Configuration

Item Value setting Description

MAC Address A Must filled setting Define the MAC Address target that the DHCP Server wants to match.
Define the IP Address that the DHCP Server will assign.
. . If there is a request from the MAC Address filled in the above field, the DHCP
IP Address A Must filled setting Server will assign this IP Address to the client whose MAC Address matched the
rule.
The box is unchecked by Click Enable box to activate this rule.
Enable
default.
Save NA Click the Save button to save the configuration

Note: ensure to always click on Apply button to apply the changes after the web browser refreshed taken you
back to the VLAN page.

« Portbased VLAN List I PR « %
Name | VLANID T:;‘;‘iﬂg NAT/Bridge | o LAN IP Address Subnet Mask | Joined WAN = WANVID | Enable Actions
MNative VLAN
LAN Tog 1 X NAT 192.168.66.1 2552552540 | Al WANs i

| Apply | Inter VLAN Group Routing
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Port-based VLAN — Inter VLAN Group Routing

Click VLAN Group Routing button, the VLAN Group Internet Access Definition and Inter VLAN Group Routing
screen will appear.

# VLAN Group Internet Access Definition

VLAN IDs Members Internet Access(WAN)
Port:273
1 2.4G VAP: 12345678 Allow
5G VAP: 12345678

= Inter VLAN Group Routing

VLAN IDs Members Action

Edit

Edit

Edit

Edit

When Edit button is applied, a screen similar to this will appear.
= VLAN Group Intermet Access Definition

VLAN IDs Members Internet Access(WAN)
Port: 23
1 2.4G VAP: 123,456,738 Allow
5G VAP: 12,3456.7.8

| Inter VL AN Group Routing

VLAN IDs Members Action

o1 Edit

Edit

Edit

Edit

Inter VLAN Group Routing
Item Value setting Description

VALN Group By default, all boxes are checked means all VLAN ID members are allow to
Internet All boxes are checked by access WAN interface.

Access default. If uncheck a certain VLAN ID box, it means the VLAN ID member can’t access
Definition Internet anymore.
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Inter VLAN

The box is unchecked by

Group Routing  default.

Save

N/A

Note: VLAN ID 1 is available always; it is the default VLAN ID of LAN rule. The
other VLAN IDs are available only when they are enabled.

Click the expected VLAN IDs box to enable the Inter VLAN access function.

By default, members in different VLAN IDs can’t access each other. The gateway
supports up to 4 rules for Inter VLAN Group Routing.

For example, if ID_1 and ID_2 are checked, it means members in VLAN ID_1 can
access members of VLAN ID_2, and vice versa.

Click the Save button to save the configuration

Tag-based VLAN - Create/Edit VLAN Rules

The Tag-based VLAN allows you to customize each LAN port according to VLAN ID. There is a default rule
shows the configuration of all LAN ports and all VAPs. Also, if your device has a DMZ port, you will see DMZ
configuration, too. The router supports up to a maximum of 128 tag-based VLAN rule sets.

VLAN ID | Internet

Mative
WLAN

Port Members

Add Delete
Paort: Port-2 Port-3
2.4G VAP-1 JAP-2 v VAP-3
5G AP-1 v VAP-2 v VAP-3

Bridge Interface | IP Address | Subnet Mask | Actions

Edit

VAP-7 # VAP-8|  DHCP1

Select

VAP-7 (¢ VAP-3

When Add button is applied, Tag-based VLAN Configuration screen will appear.

» WLAN ID

» Internet Access

¥ Port Members

¢ Bridge Interface

VALN ID

Internet
Access

Port Members

Bridge
Interface

Save

Item Setting
0
¥ Enable
Paort: Port-2 Port-3
24G | VAP /AP-2 ] WAP-3 [ VAP-4 [ VAP-5 (] VAP-6 | | VAP-7 JAP-3
5G: [ VAP-1 () VAP-2 () VAP-3 [ VAP-4 (] VAP-5 (| VAP-6 [ | VAP-7 VAP-5
DHCP 1 v

A Must filled setting

The box is checked by
default.

The boxes are unchecked by
default.

DHCP 1 is selected by
default.

N/A

Define the VLAN ID number, that is outside the system reserved range.
Value Range: 1 ~ 4095.
Click Enable box to allow the members in the VLAN group access to internet.

Check the LAN port box(es) to join the VLAN group.

Check the VAP box(es) to join the VLAN group.

Note: Only the wireless gateway has the VAP list.

Select a predefined DHCP Server , a New to defined a new DHCP server for
these members of this VLAN group.

Click Save button to save the configuration

Note: After clicking Save button, always click Apply button to apply the settings.
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If you select New to create a new DHCP server setting for the VLAN group, you have to further specify the
following configuration.

» IP Address | |

» Subnet Mask |2552552550 (/24) |
» DHCP Relay (] Enable & Server IP - |

+ WAN Interface WAN -1+

» DHCP Relay Option 82 [J Enable

Tag-based VLAN Configuration (part-Il)

Item \ Value setting \ Description
IP Address A Must filled setting Assign an IP Address for the DHCP Server that the rule used, this IP address is a
gateway IP.
Subnet Mask 255.255.255.0(/24) is Select a Subnet Mask for the DHCP Server.
selected by default.
DHCP Rela The box is unchecked by Check the box to enable the DHCP Relay function for the VLAN group, and you
¥ default. only need to fill the DHCP Server IP Address field.
WAN Interface :;Z?:;: is selected by Select which WAN interface that allow accessing Internet.

DHCP Option . . . If you select Relay type of DHCP Server, you can further enable the DHCP
82 An Optional filled setting Option 82 setting if the DHCP server support it.
Save NA Click the Save button to save the configuration
Click the Undo button to restore what you just configured back to the previous
Undo NA

setting.

Tag-based VLAN Summary

The configured tag-based VLAN group information will be displayed in the following screen.

# Tag based VLAN Summary ° %
Port VLAN IDs
Port2 Native VLAN
Port3 MNative WLAM
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2.2.3 DHCP Server

> DHCP Server

The gateway supports up to 4 DHCP servers to fulfill the DHCP requests from different VLAN groups (please
refer to VLAN section for getting more usage details). And there is one default setting for whose LAN IP
Address is the same one of gateway LAN interface, with its default Subnet Mask setting as “255.255.255.0”,
and its default IP Pool ranges is from “.100” to “.200” as shown at the DHCP Server List page on gateway’s

WEB UI.
‘)

Gateway

&

3,

% k 2 B @MeetingROOm
o
SELC

User can add more DHCP server configurations by clicking on the “Add” button behind “DHCP Server List”, or
clicking on the “Edit” button at the end of each DHCP Server on list to edit its current settings. Besides, user
can select a DHCP Server and delete it by clicking on the “Select” check-box and the “Delete” button.
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» Fixed Mapping

User can assign fixed IP address to map the specific client MAC address by select them then copy, when targets
were already existed in the DHCP Client List, or to add some other Mapping Rules by manually in advance,
once the target's MAC address was not ready to connect.

i PC-A: 00-12-34-AB-CD-0A : _ ¢ 192.168.123.150 :
: : Fixed Mapping :
{ PC-B: ——>

PC—C 00-12-34-AB-CD-0C : : 10.10.133.181

----------------------------------------------------------------------------------
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DHCP Server Setting

Go to Basic Network > LAN & VLAN > DHCP Server Tab.

The DHCP Server setting allows user to create and customize DHCP Server policies to assign IP Addresses to
the devices on the local area network (LAN).

Create / Edit DHCP Server Policy

The gateway allows you to custom your DHCP Server Policy. If multiple LAN ports are available, you can define
one policy for each LAN (or VLAN group), and it supports up to a maximum of 4 policy sets.

T Add || Delete || DHCP Client List |

DHCP . . .
LANIP Lease Domain | Primary Secondary Primary  Secondary .
SNear:.'Zr Address Subnet Mask IP Pool Time Name DNS DNS WINS WINS Gateway  Enable Actions
-Edit
DHCP 1192 168.66.1 | 255.255.254.0| 192,168.66.100-| g5, 0000 | 0000 |0000 0000 | 0000 | ¥ : :
1 192168 66.200 Fixed Mapping

When Add button is applied, DHCP Server Configuration screen will appear.

# DHCP Server Configuration

ltem Setting
¥ DHCP Server Name IDHCP 2 |
b LAN IP Address 192.168.2.1 |
» Subnet Mask | 2552652550 (/24) v |
Starting Address: | |
P oot Ending Address: | |
b Lease Time seconds
» Domain Name | | {Opticnal)
¥ Primary DNS | | (Optional)
¥ Secondary DNS | | (Optional)
b Primary WINS | | (Optional)
b Secondary WINS | | (Optional)
b Gateway | | (Opticnal)
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DHCP Server
Name

LAN IP
Address

Subnet Mask

IP Pool

Lease Time

Domain Name

Primary DNS

Secondary
DNS

Primary WINS

Secondary
WINS

Gateway
Server
Save

Undo

Back

1. String format can be any
text

2. A Must filled setting

1. IPv4 format.

2. A Must filled setting
255.0.0.0 (/8) is set by
default

1. IPv4 format.

2. A Must filled setting

1. Numberic string format.
2. A Must filled setting
String format can be any
text

IPv4 format

IPv4 format
IPv4 format
IPv4 format

IPv4 format

The box is unchecked by
default.

N/A

N/A

N/A

Enter a DHCP Server name. Enter a name that is easy for you to understand.

The LAN IP Address of this DHCP Server.

The Subnet Mask of this DHCP Server.

The IP Pool of this DHCP Server. It composed of Starting Address entered in this
field and Ending Address entered in this field.

The Lease Time of this DHCP Server.

Value Range: 300 ~ 604800 seconds.

The Domain Name of this DHCP Server.

The Primary DNS of this DHCP Server.
The Secondary DNS of this DHCP Server.
The Primary WINS of this DHCP Server.
The Secondary WINS of this DHCP Server.

The Gateway of this DHCP Server.
Click Enable box to activate this DHCP Server.

Click the Save button to save the configuration

Click the Undo button to restore what you just configured back to the previous
setting.

When the Back button is clicked the screen will return to the DHCP Server
Configuration page.

Create / Edit Mapping Rule List on DHCP Server

The gateway allows you to custom your Mapping Rule List on DHCP Server. It supports up to a maximum of 64
rule sets. When Fix Mapping button is applied, the Mapping Rule List screen will appear.

Add || Delete

MAC Address

IP Address Enable Actions

When Add button is applied, Mapping Rule Configuration screen will appear.
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b MAC Address

b P Address

ltem

Setting

» Rule Enable
1. MAC Address string
MAC Address  format The MAC Address of this mapping rule.
2. A Must filled setting
1. IPv4 format.
IP Address . . The IP Address of this mapping rule.
2. A Must filled setting
The box is unchecked by . . .
Rule Click Enable box to activate this rule.
default.
Save N/A Click the Save button to save the configuration
Click the Undo button to restore what you just configured back to the previous
Undo N/A .
setting.
When the Back button is clicked the screen will return to the DHCP Server
Back N/A

View / Copy DHCP Client List

When DHCP Client List button is applied, DHCP Client List screen will appear.

Configuration page.

Copy to Fixed Mapping

LAN Interface IP Address Host Name MAC Address Remaining Lease Time | Actions
Ethemnet Dynamic /192.168.123.100 James-P45V 74:D0:2B:62:80:42 00:49:07 Select
Copy to Fixed Mapping
LAN Interface IP Address Host Name MAC Address Remaining Lease Time | Actions

When the DHCP Client is selected and Copy to Fixed Mapping button is applied. The IP and MAC address of
DHCP Client will apply to the Mapping Rule List on specific DHCP Server automatically.

Enable / Disable DHCP Server Options

The DHCP Server Options setting allows user to set DHCP OPTIONS 66, 72, or 114. Click the Enable button to
activate the DHCP option function, and the DHCP Server will add the expected options in its sending out
DHCPOFFER DHCPACK packages.
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Optlon Meaning

TFTP server name RFC 2132
72 Default World Wide Web Server [RFC 2132
114 URL [RFC 3679
Setting
» DHCP Server Options [J Enable

Create / Edit DHCP Server Options

The gateway supports up to a maximum of 99 option settings.

= DHCP Server Option List [[EReN

1D Option Name DHCP Sever Select Option Select Type Value Enable Actions

When Add/Edit button is applied, DHCP Server Option Configuration screen will appear.

% DHCP Server Option Configuration

Setting
» Option Name |Option 1 |
» DHCP Sever Select
» Option Select | DHCP OPTION 66 v |
» Type | Single IP Address v |
» Value |
+ Enable ] Enable

DHCP Server Option Configuration

Item Value setting Description

1. f
. string format can be any Enter a DHCP Server Option name. Enter a name that is easy for you to
Option Name text understand
2. A Must filled setting. '

DHCP Server Dropdown list of all available

Choose the DHCP server this option should apply to.

Select DHCP servers.

1. A Must filled setting. Choose the specific option from the dropdown list. It can be Option 66, Option
Option Select 2. Option 66 is selected by 72, Option 144, Option 42, Option 150, or Option 160.

default. Option 42 for ntp server;
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Dropdown list of DHCP

Type server option value’s type
1. IPv4 format
2. FQDN format
Value 3. 1P list
4. URL format
5. A Must filled setting
Enable The box is unchecked by
default.
Save NA
Undo NA

Create / Edit DHCP Relay

Option 66 for tftp;
Option 72 for www;
Option 144 for url;

Each different options has different value types.

Single IP Address

66 -
Single FQDN
72 IP Addresses List, separated by “,”
114 Single URL
42 IP Addresses List, separated by “,”
150 IP Addresses List, separated by “,”
Single IP Address
160

Single FQDN
Should conform to Type :

Type

Single IP Address
66

Single FQDN
72 IP Addresses List, separated by “,”
114 Single URL

Click Enable box to activate this setting.

Click the Save button to save the setting.

Value

IPv4 format
FQDN format

“wn

IPv4 format, separated by “,

URL format

When the Undo button is clicked the screen will return back with nothing

changed.

The gateway supports up to a maximum of 6 DHCP Relay configurations.

E Add | Delete

ID Agent Name LAN interface

When Add/Edit button is applied, DHCP Relay Configuration screen will appear.

WAN interface Server IP

DHCP Relay
Option 82

Enable Actions
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ltem Setting
» Agent Name | |
¥ LAM interface LAN ¥
» WAN interface WAN -1 v
» Server IP |
» DHCP OPTION 82 a
» Enable o

DHCP Relay Configuration

Item Value setting Description
1. String format can be any
Agent Name text
2. A Must filled setting.

Enter a DHCP Relay name. Enter a name that is easy for you to understand.
Value Range: 1~64 characters.

1. A Must filled setting. Choose a LAN Interface for the dropdown list to apply with the DHCP Relay
2. LAN is selected by default.  function.

1. A Must filled setting.
WAN Interface 2. WAN-1 is selected by

LAN Interface

Choose a WAN Interface for the dropdown list to apply with the DHCP Relay
function. It can be the available WAN interface(s), and L2TP connection.

default.
Server IP 1. A Must filled setting. Assign a DHCP Server IP Address that the gateway will relay the DHCP requests
2. null by default. to the assigned DHCP server via specified WAN interface.

Click Enable box to activate DHCP OPTION 82 function.
DHCP OPTION The box is unchecked by Option 82 is organized as a single DHCP option that contains circuit-ID
82 default. information known by the relay agent. If the relayed DHCP server required the
such information, you have to enable it, otherwise, just leave it as unchecked.

The box is unchecked by

Enable Click Enable box to activate this setting.

default.
Save NA Click the Save button to save the setting.
When the Undo button is clicked the screen will return back with nothing
Undo NA changed
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2.3 WiFi

Wi-Fi Module 1

Configuration

L4 List
Item

Configuration » Operation Band

Wi-Fi Module 2 =

Configuration ltem

.l,uuist
Basic » WiFi Module

Advanced » WiFi System
Configuration » WiFi Operation Mode
lklecl Each
» Green AP
WiFi Module » VAP Isolation
i Popup i Popup » Time Schedule
Module 1 Module 2

Configuration Configuration

|

Setting

|2.4G Single Band ~

Setting

[+ Enable
IAuto -I & By AP Numbers ( By Less Interference

|802.11b/g/n Mixed ~
IAP Router Mode  ~

[~ Enable
v Enable

I (0) Always 'I

o Add Delete
|—, ID | VAP SSID

Authentication Encryption S$TA Isolation

The gateway provides WiFi interface for mobile devices or BYOD devices to connect for Internet/Intranet
accessing. WiFi function is usually modulized design in a gateway, and there can be single or dual modules
within a gateway. The WiFi system in the gateway complies with |IEEE 802.11ac/11n/11g/11b standard in
2.4GHz or 5GHz single band or 2.4G/5GHz concurrent dual bands of operation. There are several wireless
operation modes provided by this device. They are: “AP Router Mode”, “WDS Only Mode”, and “WDS Hybrid

Mode”. You can choose the expected mode from the wireless operation mode list.

There are some sub-sections for you to configure the WiFi function, including “Basic Configuration” and
“Advanced Configuration”. In Basic Configuration section, you have to finish almost all the settings for using
the WiFi function. And the Advanced Configuration section provides more parameters for advanced user to
fine tune the connectivity performance for the WiFi function.
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2.3.1 WiFi Configuration

WiFi Operation
Mode

AP Routi:r Mode |
WD50nyMode |
WDS Hylrid Mode |

Operation Mode
Profile Configuration

Mulktiple AP
Configuration

&

Item
* WiFi Module
» Channel
» WiFi System
* WiFi Operation Mode
» Green AP
» VAP Isolation

¥ Time Schedule

- _Add | Delete
D | VAP ssID
1 we Staff 246G
2 | wp2 default

Item
> VAP
» 881D
» Max. STA
¥ Authentication
* Encryption
» Preshared Key
» STA Isolation
» Broadcast SSID

» Enable

Setting
[ Enable
Auto = {+ By AP Numbers ¢ By Less Interference

802.11b/g/n Mixed =
AP Router Mode  »

I~ Enable
[¥ Enable

(0) Always =

B R
Authentication Encryption STA Isolation Broadcast SSID Enable Actions
WPAZ-PSK AES - 7 = Edit |~ Select

Open None - F F Edit | [~ Select

-1 x
Setting

[staff_2.46

[T Enable

[weazpsk =]

[1234567890

I

I
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Due to optional module(s) and frequency band, you need to setup module one by one. For each module, you
need to specify the operation mode, and then setup the virtual APs for wireless access.

Hereunder are the scenarios for each wireless operation mode, you can get how it works, and what is the
difference among them. To connect your wireless devices with the wireless gateway, make sure your
application scenario for WiFi network and choose the most adequate operation mode.

AP Router Mode

AP Route/r’fMode

(@

Gateway

Global IP: 118.18.8%
Local IP:10.0.75.2 |-‘

WiFi Operation Mode: AP Router
Multiple AP Names: VAP-1
Network ID: WAP1

Channel: Aute

WiFi System: 802.11b/g/n Mixed
Authentication: WPA2-PSK
Encryption: AES

Key: 1234567890

2.4G WiFi
S5SID: VAP-1

10.0.75.0/24

t LAN

This mode allows you to get your wired and wireless

devices connected to form the Intranet of the wireless

gateway, and the Intranet will link to the Internet with

NAT mechanism of the gateway. So, this gateway is
\ working as a WiFi AP, but also a WiFi hotspot for
Internet accessing service. It means local WiFi clients
can associate to it, and go to Internet. With its NAT
mechanism, all of wireless clients don’t need to get
public IP addresses from ISP.
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WDS Only Mode

Gateway 2 & 3 Settings:
[Configuration]-[WiFi Configuration]

WiFi Operation Made: WDS Only
Lazy Mode: Enable

Channel: 3

Authentication: WPA2-PSK
Encryption: AES

Key: 1234567850

Gateway 1 Settings:
[Configuration]-[WiFi Configuration]
WiFi Operation Mode: WDS Only
Lazy Mode: Disable
Channel: 3
Authentication: WPA2-PSK
Encryption: AES
Key: 1234567890

[Configuration]-[Remote AP's MAC]

\
\
\
MAN
< ’

Remote AP MAC1: MAC of Gateway 2
Remote AP MAC2: MAC of Gateway 3
Remote AP MAC3:

Wi-Fi Gateway 3 ({ ))
@ WDS Only Mode

Ethernet LAN =

WDS Only I\Irlode ~
\ v
‘\ (97

Wi-Fi Gateway 2
@ WDS Only Mode

Ethernet LAN

/
/Ethernet LAN

Wi-Fi Gateway 1

@ WDS Only Mode
Globe IP:118.18.81.33
Local IP: 10.0.75.2

WDS (Wireless Distributed System) Only mode
drives a WiFi gateway to be a bridge for its
wired Intranet and a repeater to extend
distance. You can use multiple WiFi gateways
as a WiFi repeater chain with all gateways
setup as "WDS Only" mode. All gateways can
communicate with each other through WiFi.
All wired client hosts within each gateway can
also communicate each other in the scenario.
Only one gateway within repeater chain can be
DHCP server to provide IP for all wired client
hosts of every gateway which being disabled
DHCP server. This gateway can be NAT router
to provide internet access

The diagram illustrates that there are two
wireless gateways 2, 3 running at "WDS Only"

mode. They both use channel 3 to link to local Gateway 1 through WDS. Both gateways connected by WDS
need to setup the remote AP MAC for each other. All client hosts under gateway 2, 3 can request IP address
from the DHCP server at gateway 1. Besides, wireless Gateway 1 also execute the NAT mechanism for all client
hosts Internet accessing.

WDS Hybrid Mode

Gateway 2 / AP 1 Settings:
[Configuration]-[WiFi Configuration]

WiFi Operation Mode: WDS Hybrid
Lazy Mode: Enable

Multiple AP Names: VAP1
Network ID: Extended-WiFi
Channel: same as Router 1
Authentication: same as Router 1
Encryption: same as Router 1

Key: same as Router 1

Gateway 1 Settings:
[Configuration]-[WiFi Configuration]

WiFi Operation Mode: WDS Hybrid
Lazy Mode: Disable

Multiple AP Names: VAP1
Network ID: Extended-WiFi
Channel:3

Authentication: WPA2-PSK
Encryption: AES

Key: 1234567890

[Configuration]-[Remote AP's MAC]

Remote AP MAC1: MAC of Router 2
Remote AP MAC2: MAC of AP 1
Remote AP MAC3:

Wi-FiAP1
(« ))/__@Hwns Hybrid

\‘\
/ S
! A
I N

by
. WDS$ Hybrid Mode\\\

'

\  WDs, ANDS
\\\ ‘\\‘ 4 y

Wi-F?Gateway ]\\ﬁ ))
@ WD§H\ybrid

" Wi-Fi Gateway2

\@WDS Hybrid
\

\

1
|
|
!

WDS hybrid mode includes both WDS and
AP Router mode. WDS Hybrid mode can act
as an access point for its WiFi Intranet and a
WiFi bridge for its wired and WiFi Intranets
at the same time. Users can thus use the
features to build up a large wireless
network in a large space like airports, hotels
or campus.

The diagram illustrates Gateway 1, Gateway
2 and AP 1 connected by WDS. Each
gateway has access point function for WiFi
client access. Gateway 1 has DHCP server to
assign IP to each client hosts. All gateways
and AP are under WDS hybrid mode. To
setup WDS hybrid mode, it need to fill all
configuration items similar to that of AP-
router and WDS modes.
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Multiple VAPs
. VAP (Virtual Access Point) is function to
Gateway Settings: Accessible if . . . :
WiFi Operation Mode: AP Router VAP Isolation disabled partition wireless network into multiple
VAP1 €————- > & & broadcast domains. It can simulate
$5ID: VAP-1 - ) ) . )
Authentication: WPA2-PSK . multiple APs in one physical AP. This
WiFi Networ
Encryption: TKIP wireless gateway supports up to 8 VAPs.
Key: 1234567890 Wi-Fi VAP-1 2'46,/5,‘5 Wi-Fi VAP-2 & y PP P
$SID: VAP-1 Wii SSID: VAP-2 For each VAP, you need to setup SSID,
VAP2 Authentication: WPA2-PSK Authentication: WPA2PSK  guthentication and encryption to control
$S1D: VAP-2 Encryption: TKIP Encryption: TKIP e .
Authentication: WPA2-PSK Wi-Fi client access.
Encryption: TKIP ks A . A . .
Key: 1234567890 5 Besides, there is a VAP isolation option to
RADIUS Server manage the access among VAPs. You can
VAP3 xDSL and/or o . .
SSID: VAP-3 16 Cellular allow or blocks communication for the
ATHETEELT L Wi Network wireless clients connected to different
Encryption: TKIP - . .
RADIUS Server IP: 192.168.168. . Wi-Fi VAP-3 VAPs. As shown in the diagram, the
RADIUS Server Port: 1312 Wireless Gateway SSID: VAP-3 . .
RADIUS Shared Key - @ AP RouterMode  Authentication: WPA2 clients n VAP-1 and VAP-2 Can
Dynamic IP Address: Encryption: TKIP communicate to each other when VAP

192.168.123.x/24 . . .
Isolation is disabled.

Wi-Fi Security — Authentication & Encryption
"""""""""""" Wi-Fi  security provides complete

1 Auto |
| 1. None, WEP encryption | authentication and encryption
1 ]
@ 2 He/asqikey | mechanisms to enhance the data security
Wi-Fi Gateway 0 Shared ) while your data is transferred wirelessly
@ AP Router Mode | 1. WEP encryption | - .
Dynamic IP Address: 8 2 HEX/ASCl Key ] over the air. The wireless gateway

192'15'123"‘/24 ““““““““““““ g supports Shared, WPA-PSK / WPA2-PSK
RE W‘Qf’:::’;:l"d WPAZ-PSK and WPA / WPA2 authentication. You can
TKIP, AES, TKIP / AES encryption select one authentication scheme to
validate the wireless clients while they

are connecting to the AP. As to the data

WPA and WPA2
1. WPA Enterprise
2. TKIP, AES, TKIP / AES encryption

<0 ', _______________________________________________ encryption, the gateway supports WEP,
: L A TKIP and AES. The selected encryption
RADIUS 1 1. Mixed WPA Personal X i i
Server 8 15 Tae acs, TKIP / AES encryption algorithm will be applied to the data
:' e while the wireless connection s
. ''1. Mixed WPA Enterprise established.
b BTNy
3§
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WiFi Configuration Setting

The WiFi configuration allows user to configure 2.4GHz or 5GHz WiFi settings.

Go to Basic Network > WiFi > WiFi Module One Tab. If the gateway is equipped with two WiFi modules, there
will be another WiFi Module Two. You can do the similar configurations on both WiFi modules.

Basic Configuration

* Basic Configuration ' »®

ltem Setting

» Operation Band [ 2.46 Single Band ~|

Basic Configuration

Item Value setting Description

Specify the intended operation band for the WiFi module.

Basically, this setting is fixed and cannot be changed once the module is integrated
Operation Band A Must filled setting into the product. However, there is some module with selectable band for user to

choose according to his network environment. Under such situation, you can specify

which operation band is suitable for the application.

Configure WiFi Setting

= 2.4G WiFi Configuration ’ ®
ltem Setting

» WiFi Module [v Enable

» Channel Im @ By AP Numbers ¢ By Less Interference

» WiFi System | 802.11b/g/n Mixed -

» WiFi Operation Mode | AP Router Mode -]

Configuring Wi-Fi Settings

Item Value setting Description

WiFi Module The box is checked by Check the Enable box to activate Wi-Fi function.
default
Select a radio channel for the VAP. Each channel is corresponding to different radio
1. A Must filled setting.  band. The permissible channels depend on the Regulatory Domain.
Channel 2. Auto is selected be There are two available options when Auto is selected:
default. ® By AP Numbers
The channel will be selected according to AP numbers (The less, the better).

82



4G PoE-WAN Extender

® By Less Interference

The channel will be selected according to interference. (The lower, the better).
Specify the preferred WiFi System. The dropdown list of WiFi system is based on
IEEE 802.11 standard.
® 2.4G WiFi can select b, g and n only or mixed with each other.
® 5G WiFi can select a, n and ac only or mixed with each other.
Specify the WiFi Operation Mode according to your application.
Go to the following table for AP Router Mode, WDS Only Mode, and WDS Hybrid
Mode settings.

WiFi System A Must filled setting

WiFi Operation
Mode

Note: The available operation modes depend on the product specification.

In the following, the specific configuration description for each WiFi operation mode is given.

AP Router Mode & VAPs Configuration

For the AP Router mode, the device not only supports stations connection but also the router function. The
WAN port and the NAT function are enabled.

» WiFi Operation Mode | AP Router Mode ]
b Green AP [T Enable
» VAP Isolation [+ Enable

» Time Schedule |(O) Always 'l

The box is unchecked Check the Enable box to activate Green AP function.
Green AP
by default.
The box is checked b Check the Enable box to activate this function.
VAP Isolation ¥ By default, the box is checked; it means that stations which associated to different

default. . .
VAPs cannot communicate with each other.

Apply a specific Time Schedule to this rule; otherwise leave it as (0) Always.
Time Schedule A Must filled setting If the dropdown list is empty ensure Time Schedule is pre-configured. Refer to Object
Definition > Scheduling > Configuration tab.

. Add | Delete |
Broadcast

ID VAP SSID Authentication Encryption STA Isolation SsID Enable Actions

1 | VAP 1 Staff_2.4G WPA2-PSK AES ™ 2 2 Edit |~ select

By default, VAP 1 is enabled and security key is required to connect to the gateway wirelessly to enhance the
security level and prevent unexpected access of un-authorized devices.

The default wifi key is printed on both the device label and the Security Card. It is created randomly and
differs from devices. So, you can connected to the VAP1 (SSID: Staff _2.4G) with the provided key.

However, it is strongly recommanded that you have to change the security key to a easy-to-remember one
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by clicking the Edit button.

Click Add / Edit button in the VAP List screen to create or edit the settings for a VAP. A VAP Configuration
screen will appear.

For VAP 1:
x
ltem Setting
» VAP VAP1 ~
» SSID [staff_2.4G
» Max. STA [~ Enable
» Authentication IWPAZ—PSI( 'l
» Encryption IE,
» Preshared Key [1234567890
» STA Isolation v
» Broadcast SSID v
» Enable 3
For others:
x
Item Setting
» VAP [var2 ~|
» SSID [default
» Max. STA [~ Enable
+ Authentication Open -
» Encryption None ~
» STA Isolation r
» Broadcast SSID I
» Enable I

VAP Configuration
Item

Value setting

1. String format : Any

Description
Enter the SSID for the VAP, and decide whether to broadcast the SSID or not.

SSID text The SSID is used for identifying from another AP, and client stations will associate
with AP according to SSID.
Max. STA The box is unchecked Check this box and enter a limitation to limit the maximum number of client
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by default. station.
The box is unchecked by default. It means no special limitation on the number of
connected STAs.
For security, there are several authentication methods supported. Client stations
should provide the key when associate with this device.
When Open is selected
The check box named 802.1x shows up next to the dropdown list.
® 802.1x (The box is unchecked by default)
When 802.1x is enabled, it means the client stations will be authenticated by
RADIUS server.
RADIUS Server IP (The default IP is 0.0.0.0)
RADIUS Server Port (The default value is 1812)
RADIUS Shared Key
When Shared is selected
The pre-shared WEP key should be set for authenticating.
When Auto is selected
The device will select Open or Shared by requesting of client automatically.
The check box named 802.1x shows up next to the dropdown list.
® 802.1x (The box is unchecked by default)
When 802.1x is enabled, it means the client stations will be authenticated by

1. A Must filled setting RADIUS server.

2. VAP1: WPA2-PSK is RADIUS Server IP (The default IP is 0.0.0.0)
Authentication selected be default; RADIUS Server Port (The default value is 1812)

Others: Open is RADIUS Shared Key

selected be default. When WPA or WPA2 is selected

They are implementation of IEEE 802.11i. WPA only had implemented part of IEEE
802.11i, but owns the better compatibility.
WPA2 had fully implemented 802.11i standard, and owns the highest security.
® RADIUS Server

The client stations will be authenticated by RADIUS server.

RADIUS Server IP (The default IP is 0.0.0.0)

RADIUS Server Port (The default value is 1812)

RADIUS Shared Key
When WPA / WPA2 is selected
It owns the same setting as WPA or WPA2. The client stations can associate with
this device via WPA or WPA2.
When WPA-PSK or WPA2-PSK is selected
It owns the same encryption system as WPA or WPA2. The authentication uses
pre-shared key instead of RADIUS server.
When WPA-PSK / WPA2-PSK is selected
It owns the same setting as WPA-PSK or WPA2-PSK. The client stations can
associate with this device via WPA-PSK or WPA2-PSK.
Select a suitable encryption method and enter the required key(s).
The available method in the dropdown list depends on the Authentication you

1. A Must filled setting. ;e;i(;md'
2. VAP1: AES is L . .
. It means that the device is open system without encrypting.
Encryption selected be default; WEP

Others: None is

selected be default. Up to 4 WEP keys can be set, and you have to select one as current key. The key

type can set to HEX or ASCII.
If HEX is selected, the key should consist of (0 to 9) and (A to F).
If ASCIl is selected, the key should consist of ASCII table.
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TKIP

TKIP was proposed instead of WEP without upgrading hardware. Enter a Pre-
shared Key for it. The length of key is from 8 to 63 characters.

AES

The newest encryption system in WiFi, it also designed for the fast 802.11n high
bitrates schemes. Enter a Pre-shared Key for it. The length of key is from 8 to 63
characters.

You are recommended to use AES encryption instead of any others for security.
TKIP / AES

TKIP / AES mixed mode. It means that the client stations can associate with this
device via TKIP or AES. Enter a Pre-shared Key for it. The length of key is from 8 to
63 characters.

VAP1: The box is Check the Enable box to activate this function.
STA Isolation checked by default; By default, the box is checked; it means that stations which associated to the same
Others: unchecked by VAP cannot communicate with each other.
default.
VAP1: The box is Check the Enable box to activate this function.
Broadcast SSID checked by default; If the broadcast SSID option is enabled, it means the SSID will be broadcasted, and
Others: unchecked by the stations can associate with this device by scanning SSID.
default.
VAP1: The box is Check the Enable box to activate this VAP.
checked by default;
Enable Others: unchecked by
default.
Save N/A Click the Save button to save the current configuration.
Undo N/A Click the Undo button to restore configuration to previous setting before saving.
Apply N/A Click the Apply button to apply the saved configuration.
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WDS Only Mode

For the WDS Only mode, the device only bridges the connected wired clients to another WDS-enabled WiFi
device which the device associated with. That is, it also means the no wireless clients stat can connect to this
device while WDS Only Mode is selected.

» WIFi Operation Mode [WDS Only Mode -]
b Green AP [T Enable

» Time Schedule I(U) Always "I

» Scan Remote AP's MAC List Scan |

Remote AP MAC A1

Remote AP MAC 2

Remote AP MAC 3

Remote AP MAC 4

The box is Check the Enable box to activate Green AP function.
Green AP unchecked by
default.
Apply a specific Time Schedule to this rule; otherwise leave it as (0) Always.

Time Schedule A ':f,USt filled If the dropdown list is empty ensure Time Schedule is pre-configured. Refer to Object
Setling Definition > Scheduling > Configuration tab.
, Press the Scan button to scan the spatial AP information, and then select one from
Scan Remote AP’s . . . . .
. N/A the AP list, the MAC of selected AP will be auto filled in the following Remote AP
MAC List
MAC table.
A Must filled Enter the remote AP’s MAC manually, or via auto-scan approach, The device will
R te AP MAC 1~4 : ) ) .
emote setting bridge the traffic to the remote AP when associated successfully.
. Add | Delete |
D VAP §SID Authentication Encryption STAlsolation |~ Briateast  Enaple Actions
1 | VAP 1 staff_2.4G WPAZ2-PSK AES ™ = = Edit |~ select

By default, VAP 1 is enabled and security key is required to connect to the gateway wirelessly to enhance the
security level and prevent unexpected access of un-authorized devices.

The default wifi key is printed on both the device label and the Security Card. It is created randomly and
differs from devices. So, you can connected to the VAP1 (SSID: Staff_2.4G) with the provided key.

However, it is strongly recommanded that you have to change the security key to a easy-to-remember one
by clicking the Edit button.
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Under WDS Only mode, only VAP1 is available for further specifying the required authentication and
Encryption settings. Click Edit button in the VAP List screen and a VAP Configuration screen will appear for you
to configure the required settings

=] VAP Configuration ’ %

ltem Setting
» VAP [vapi -]
» SSID [staff_2.4G
» Max. STA [~ Enable
» Authentication IWPAz—PSI( 'I
» Encryption IE,
» Preshared Key |1234567890
» STA Isolation 3
» Broadcast SSID v
» Enable 2

For the detail description about VAP configuration, please refer to the description stated in AP-Router section.
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WDS Hybrid Mode

For the WDS Hybrid mode, the device bridges all the wired LAN and WLAN clients to another WDS or WDS
hybrid enabled WiFi devices which the device associated with.

» WiFi Operation Mode

| WDS Hybrid Mode |

» Lazy Mode [~ Enable
» Green AP [~ Enable
» VAP Isolation [+ Enable

+ Time Schedule

_Sean |

+ Scan Remote AP's MAC List

I(O) Always vl

Remote AP MAC 1

Remote AP MAC 3

|
Remote AP MAC 2 |
|
|

Remote AP MAC 4

The box is checked by

Lazy Mode default.

The box is unchecked
Green AP by default.
VAP Isolation The box is checked by

default.
Time Schedule

A Must filled setting

Scan Remote AP’s
MAC List

Available when Lazy
Mode disabled.

Remote AP MAC  Available when Lazy

Check the Enable box to activate this function.

With the function been enabled, the device can auto-learn WDS peers without
manually entering other AP’s MAC address. But at least one of the APs has to fill
remote AP MAC addresses.

Check the Enable box to activate Green AP function.

Check the Enable box to activate this function.

By default, the box is checked; it means that stations which associated to different
VAPs cannot communicate with each other.

Apply a specific Time Schedule to this rule; otherwise leave it as (0) Always.

If the dropdown list is empty ensure Time Schedule is pre-configured. Refer to Object
Definition > Scheduling > Configuration tab.

Press the Scan button to scan the spatial AP information, and then select one from
the AP list, the MAC of selected AP will be auto filled in the following Remote AP
MAC table.

Enter the remote AP’s MAC manually, or via auto-scan approach, The device will

1~4 Mode disabled. bridge the traffic to the remote AP when associated successfully.
. Add | Delete |
D VAP §SID Authentication Encryption STAlsolation |~ Briateast  Enaple Actions
1 | VAP 1 Staff_2.4G WPAZ-PSK AES - = = Edit |~ select

By default, VAP 1 is enabled and security key is required to connect to the gateway wirelessly to enhance the

security level and prevent unexpected access of un-authorized devices.

The default wifi key is printed on both the device label and the Security Card. It is created randomly and
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differs from devices. So, you can connected to the VAP1 (SSID: Staff_2.4G) with the provided key.
However, it is strongly recommanded that you have to change the security key to a easy-to-remember one
by clicking the Edit button.

Under WDS Hybrid mode, the VAP function is available and you can further specifying the required VAP
settings for connecting with wireless client devices.

Click Add / Edit button in the VAP List screen to create or edit the settings for a VAP. A VAP Configuration
screen will appear.

For VAP 1:
-
ltem Setting
» VAP [var1 -]
» SSID [staff_2.4G
» Max. STA [~ Enable

+ Authentication IWPA2—PSI( 'I
» Encryption IAES 'I

» Preshared Key [1234567890
» STA Isolation v
» Broadcast SSID [+
+ Enable =
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For others:

* VAP Configuration n ®

ltem Setting
» VAP [var2 ~]
» SSID [default
» Max. STA [ Enable
» Authentication Open
» Encryption None ~
» STA Isolation r
» Broadcast SSID r
» Enable r

For the detail description about VAP configuration, please refer to the description stated in AP-Router section.

91




4G PoE-WAN Extender

2.3.2 Wireless Client List

The Wireless Client List page shows the information of wireless clients which are associated with this device.

Go to Basic Network > WiFi > Wireless Client List Tab.

Select Target WiFi
= Target WiFi ’ %
Item Setting
¥ Module Select
+ Operation Band 24G ¥
¥ Multiple AF Names

Target Configuration

Item Value setting Description

. . Select the WiFi module to check the information of connected clients.
Module Select A Must filled setting. For those single WiFi module products, this option is hidden.
Specify the intended operation band for the WiFi module.
Basically, this setting is fixed and cannot be changed once the module is
Operation Band A Must filled setting. integrated into the product. Hoyvever, 'Fhere is some module with selectable
band for user to choose according to his network environment.
Under such situation, you can specify which operation band is suitable for the
application.
1. A Must filled Specify the VAP to show the associated clients information in the following Client List. By
. setting. default, All VAP is selected.
Multiple AP Names 2. All is selected by
default.

Show Client List

The following Client List shows the information for wireless clients that is associated with the selected VAP(s).

IP Address
Configuration &
Address

Host Name MAC Address

Target Configuration

Item Value setting Description

IP Address It shows the Client’s IP address and the deriving method.

Configuration & N/A Dynamic means the IP address is derived from a DHCP server.

Address Static means the IP address is a fixed one that is self-filled by client.

Host Name N/A It shows the host name of client.

MAC Address N/A It shows the MAC address of client.

Mode N/A It shows what kind of Wi-Fi system the client used to associate with this device.
Rate N/A It shows the data rate between client and this device.
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RSSIO, RSSI1
Signal
Interface
Refresh

N/A
N/A
N/A
N/A

It shows the RX sensitivity (RSSI) value for each radio path.
The signal strength between client and this device.

It shows the VAP ID that the client associated with.

Click the Refresh button to update the Client List immediately.
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2.3.3 Advanced Configuration

This device provides advanced wireless configuration for professional user to optimize the wireless
performance under the specific installation environment. Please note that if you are not familiar with the WiFi
technology, just leave the advanced configuration with its default values, or the connectivity and performance

may get worse with improper settings.

Go to Basic Network > WiFi > Advanced Configuration Tab.

Select Target WiFi
= Target WiFi ' "
Item Setting
» Wodule Select
» Operation Band 245 r

Target Configuration

Item Value setting

Module Select

A Must filled setting.

Description
Select the WiFi module to check the information of connected clients.
For those single WiFi module products, this option is hidden.

Operation Band

A Must filled setting.

Specify the intended operation band for the WiFi module.

Basically, this setting is fixed and cannot be changed once the module is
integrated into the product. However, there is some module with selectable
band for user to choose according to his network environment.

Setup Advanced Configuration
* Advanced Configuration

[tem

Setting

r Regulatory Domain

(36, 40, 44, 48, 149, 153, 157, 161, 165)

¥ Beacon Interval

Range: (1~1000 msec)

r DTIM Interval

Range: (1~255)

¢ RTS Threshold

2347 Range: (1~2347)

» Fragmentation

2346 Range: (256~2346)

F WMM Enable
» Short Gl
b TX Rate
» RF Bandwidth Auto ¥

¥ Transmit Power

100% -

» 5G Band Steering

r WIDS

0o IE
m | m
2| 3
W m
o =
o i
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¥ Dynamic Frequency Selection

Regulatory Domain

Beacon Interval

DTIM Interval

RTS Threshold

Fragmentation

WMM

Short Gl

TX Rate
RF Bandwidth

Transmit Power

5G Band Steering

WIDS

Dynamic Frequency
Selection

Save

Undo

«| Enable

The default setting is
according to where
the product sale to

100

2347

2346

The box is checked by
default

By default 400ns is
selected

By default Best is

selected

By default Auto is
selected

By default 100% is
selected

The box is unchecked
by default

The box is unchecked
by default

The box is checked by
default

N/A
N/A

It limits the available radio channel of this device.
The permissible channels depend on the Regulatory Domain.

It shows the time interval between each beacon packet broadcasted.

The beacon packet contains SSID, Channel ID and Security setting.

A DTIM (Delivery Traffic Indication Message) is a countdown informing
clients of the next window for listening to broadcast message. When the
device has buffered broadcast message for associated client, it sends the next
DTIM with a DTIM value.

RTS (Request to send) Threshold means when the packet size is over the
setting value, then active RTS technique.

RTS/CTS is a collision avoidance technique.

It means RTS never activated when the threshold is set to 2347.

Wireless frames can be divided into smaller units (fragments) to improve
performance in the presence of RF interference at the limits of RF coverage.
WMM (WiFi Multimedia) can help control latency and jitter when
transmitting multimedia content over a wireless connection.

Short Gl (Guard Interval) is defined to set the sending interval between each
packet. Note that lower Short Gl could increase not only the transition rate
but also error rate.

It means the data transition rate. When Best is selected, the device will
choose a proper data rate according to signal strength.

The setting of RF bandwidth limits the maximum data rate.

Normally the wireless transmitter operates at 100% power. By setting the
transmit power to control the WiFi coverage.

When the client station associate with 2.4G WiFi, the device will send the
client to 5G WiFi automatically if the client is available on accessing this 5G
Wi-Fi band.

This option is only available on the module that supports 5GHz band.

The WIDS (Wireless Intrusion Detection System) will analyze all packets and
make a statistic table in WiFi status.

Go to Status > Basic Network > WiFi tab for detailed WIDS status.

Dynamic Frequency Selection (DFS) is a legally required feature for all WiFi
devices that share the 5 GHz band with radar.

DFS enables a gateway to detect radar signals and switch their operating
frequency to prevent interference. This process ensures that radar systems
send and receive accurate information.

Note: Dynamic Frequency Selection (DFS) option is only available for the WiFi
module with 5GHz radio.

Click the Save button to save the current configuration.

Click the Undo button to restore configuration to previous setting before
saving.
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2.4 IPv6

The growth of the Internet has created a need for more addresses than are possible with IPv4. IPv6 (Internet
Protocol version 6) is a version of the Internet Protocol (IP) intended to succeed IPv4, which is the protocol
currently used to direct almost all Internet traffic. IPv6 also implements additional features not present in IPv4.
It simplifies aspects of address assignment (stateless address auto-configuration), network renumbering and
router announcements when changing Internet connectivity providers.

2.4.1 IPv6 Configuration

IPve
Configuration ) |Pv6 Configuration ' %

ltem Setting

b IPYE Enafile

» WAN Cannection Type DHCPVE v

* DHCPv6 WAN Type Configuration

b ONS (o From Server () Specific DN3

+ Primary DNS ‘ ‘
xxx WAN Type b Secondary DNG ‘ ‘
Configuration b MLD Snasping @ Enatle

DHCPvG

WAN Connection
Option

%1 LAN Configuration ° X

b Global Address

b Link-loczl Address feB0:: 280 18fF fedadadf

LAN
Configuration

%] Address Auto-configuration ° %

Address Auto- b Auto-corfiguration Enable
Configuration

» Auta-configuration Type Stateless v
, Router Advertisement Lifetime (seconts)

The IPv6 Configuration setting allows user to set the IPv6 connection type to access the IPv6 network. This
gateway supports various types of IPv6 connection, including Static IPv6, DHCPv6, and PPPoEv6

Note: The available WAN connection types can be different, depending on the Interface type of WAN-1.
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IPv6 WAN Connection Type

Static IPv6

Static IPv6 does the same function as static IPv4. The static IPv6 provides manual setting of IPv6 address, IPv6
default gateway address, and IPv6 DNS.

ISP IP:2001:470:871¢::100 /64
DNS 1: 2001:470:20::2 Gateway
ﬂ Cﬁ DNS 2: zotxissu:x;ss (Eass
153 L]
2001:4%0:871c::5 xDSL Modem
PrimaryD 10.0.75.2§8
S —— 2001:470§871:50ff::75:2 /64
2001:470:207
Secondary @ | _ :
Server Q
2001:470:20::6 Q : Q Q NJ
- Intranet

Above diagram depicts the IPv6 IP addressing, type in the information provided by your ISP to setup the IPv6
network.

DHCPv6

DHCP in IPv6 does the same function as DHCP in IPv4. The DHCP server sends IP address, DNS server addresses
and other possible data to the DHCP client to configure automatically. The server also sends a lease time of
the address and time to re-contact the server for IPv6 address renewal. The client has then to resend a
request to renew the IPv6 address.

DNS 1:2001:470:20::2

lsp DNS 2:2001:4860:4860::8888
LAM
L . O ateway

2001:47D:871c::5 xDSL Modem

PrimaryD 10.0.75.2 /8
Serve 0 I 2001:470:871c:500d:250:18ff:fe21:deea/6

= BRET

Above diagram depicts DHCP IPv6 IP addressing, the DHCPv6 server on the ISP side assigns IPv6 address, IPv6
default gateway address, and IPv6 DNS to client host’s automatically.
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PPPoEv6

PPPoEv6 in IPv6 does the same function as PPPoE in IPv4. The PPPoEv6 server provides configuration
parameters based on PPPoEv6 client request. When PPPoEv6 server gets client request and successfully
authenticates it, the server sends IP address, DNS server addresses and other required parameters to
automatically configure the client.

SOl IFVD LUUL . 4/U.0/1C.U.0L45.a00/./000./C3 /)04

DNS 1:2001:470:20::2

ISP DNS 2:2001:4860:4860::8888
|AM

2001:470:871c:5 xDSL Modem

PrimaryD 10.0.75.2 /8
Servk s i 2001:470:871c:500.d:250:18ff.fe21:deea/6

= OO
e —

AAAAAA

The diagram above depicts the IPv6 addressing through PPPoE, PPPoEv6 server (DSLAM) on the ISP side
provides IPv6 configuration upon receiving PPPoEv6 client request. When PPPoEV6 server gets client request
and successfully authenticates it, the server sends IP address, DNS server addresses and other required
parameters to automatically configure the client.

98



4G PoE-WAN Extender

IPv6 Configuration Setting

Go to Basic Network > IPv6 > Configuration Tab.

The IPv6 Configuration setting allows user to set the IPv6 connection type to access the IPv6 network.

# IPv6 Configuration a a

ltem Setting

» IPYE Enahle

AN Connection Type DHCPYE v

IPv6 Configuration

Item Value setting Description
IPv6 The box is unchecked Check the Enable box to activate the IPv6 function.
by default,

Define the selected IPv6 WAN Connection Type to establish the IPv6
connectivity via WAN-1 Interface.

1. A Must filled setting
WAN Connection 2. DHCPv6 is selected
Type by default

Select Static IPv6 when your ISP provides you with a set IPv6 addresses.
Select DHCPv6 when your ISP provides you with DHCPv6 services.
Select PPPoEv6 when your ISP provides you with PPPoEv6 account settings.

Note: The available WAN connection types can be different, depending on the
Interface type of WAN-1.

Static IPv6 WAN Type Configuration

# Static IPv6 WAN Type Configuration n

v IPvE Address \ |

¥ Subnet Prefix Length |:|

v Default Gateway

¥ Primary OMS

¥ Secondary OMNS

|
|
|
» MLD Snooping [) Enable

Static IPvé WAN Type Configuration

Item \ Value setting Description
IPv6 Address A Must filled setting Enter the WAN IPv6 Address for the router.
Subnet Prefix A Must filled setting Enter the WAN Subnet Prefix Length for the router.
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Length

Default Gateway A Must filled setting Enter the WAN Default Gateway IPv6 address.
Primary DNS An optional setting Enter the WAN primary DNS Server.
Secondary DNS An optional setting Enter the WAN secondary DNS Server.

MLD Snooping ;SZ:;XUE unchecked Enable/Disable the MLD Snooping function

LAN Configuration

= LAN Configuration ' a

» Glohal Address | |84

¥ Link-local Address fedl:;: 250 18ff:feda dasf

LAN Configuration

Item Value setting Description

Global Address A Must filled setting Enter the LAN IPv6 Address for the router.
Link-local Address  Value auto-created Show the link-local address for LAN interface of router.

Then go to Address Auto-configuration (summary) for setting LAN environment.

If above setting is configured, click the Save button to save the configuration, and click the Reboot button to
reboot the router.
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DHCPv6 WAN Type Configuration

® DHCPv6 WAN Type Configuration u

» DNS ® From Server () Specific DMS

¥ Primary DMS | |

¥ Secondary DMS | |

» MLD Snaaping [) Enable

DHCPv6 WAN Type Configuration
Item Value setting Description

The opt|.0n [From Select the [Specific DNS] option to active Primary DNS and Secondary DNS. Then

DNS Server] is selected by ) . ;
fill the DNS information.
default
ifi

Primary DNS Can not modified by Enter the WAN primary DNS Server.

default
Secondary DNS EZ?a:ﬁt modified by Enter the WAN secondary DNS Server.

The box is unchecked . . .
MLD by default Enable/Disable the MLD Snooping function

LAN Configuration

* LAN Configuration . n

¥ Global Address

v Link-local Address fedl:: 250 18ff feda: dasf

LAN Configuration

Item \ Value setting Description
Global Address Value auto-created Enter the LAN IPv6 Address for the router.
Link-local Address Value auto-created Show the link-local address for LAN interface of router.

Then go to Address Auto-configuration (summary) for setting LAN environment.

If above setting is configured, click the Save button to save the configuration, and click Reboot button to
reboot the router.
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PPPoEve WAN Type Configuration

* PPPoEv6 WAN Type Configuration ~

¥ Account |admin |

¥ Password

» Service Mame | |

» Connection Control Auto-recannect [(Ahways an)
» MLD Snooping [] Enable

PPPoEv6 WAN Type Configuration

Item { Value setting Description
Enter the Account for setting up PPPoEv6 connection. If you want more
Account A Must filled setting information, please contact your ISP.

Value Range: 0 ~ 45 characters.
Enter the Password for setting up PPPoEv6 connection. If you want more

Password A Must filled setting information, please contact your ISP.
A Must filled Enter the Service Name for setting up PPPoEv6 connection. If you want more
Service Name setting/Option information, please contact your ISP.
Value Range: 0 ~ 45 characters.
Connection Control Fixed value The value is Auto-reconnect(Always on).
Enter the MTU for setting up PPPoEV6 connection. If you want more
MTU A Must filled setting information, please contact your ISP.

Value Range: 1280 ~ 1492.

The box is unchecked

by default Enable/Disable the MLD Snooping function

MLD Snooping

LAN Configuration

% LAN Configuration u ®
¥ Glohal Address

¥ Link-local Address feB0:: 250 18f fedadalf

LAN Configuration

Item Value setting Description

Global Address Value auto-created The LAN IPv6 Address for the router.

Link-local Address Value auto-created Show the link-local address for LAN interface of router.

Then go to Address Auto-configuration (summary) for setting LAN environment.
If above setting is configured, click the save button to save the configuration and click reboot button to reboot
the router.
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Then go to Address Auto-configuration (summary) for setting LAN environment.
If above setting is configured, click the save button to save the configuration and click reboot button to reboot
the router.

Address Auto-configuration

» Auto-configuration ¥ Enable
» Auto-configuration Type Stateless v
, Router Advertisement Lifetime 200 (seconds)

. . The box is unchecked . .
Auto-configuration Check to enable the Auto configuration feature.
by default
Define the selected IPv6 WAN Connection Type to establish the IPv6
connectivity.
Select Stateless to manage the Local Area Network to be SLAAC + RDNSS
Router Advertisement Lifetime (A Must filled setting): Enter the Router
Advertisement Lifetime (in seconds). 200 is set by default.

Value Range: 0 ~ 65535.

1. Only can be Select Stateful to manage the Local Area Network to be Stateful (DHCPv6).
selected when Auto- IPv6 Address Range (Start) (A Must filled setting): Enter the start IPv6 Address
configuration enabled  for the DHCPv6 range for your local computers. 0100 is set by default.

2. Stateless is selected  Value Range: 0001 ~ FFFF.

by default

Auto-configuration
Type

IPv6 Address Range (End) (A Must filled setting): Enter the end IPv6 Address for
the DHCPv6 range for your local computers. 0200 is set by default.
Value Range: 0001 ~ FFFF.

IPv6 Address Lifetime (A Must filled setting): Enter the DHCPV6 lifetime for your

local computers. 36000 is set by default.
Value Range: 0 ~ 65535.

103



4G PoE-WAN Extender

2.5 Port Forwarding

Network address translation (NAT) is a methodology of remapping one IP address space into another by
modifying network address information in Internet Protocol (IP) datagram packet headers while they are in
transit across a traffic routing device. The technique was originally used for ease of rerouting traffic in IP
networks without renumbering every host. It has become a popular and essential tool in conserving global
address space allocations in face of IPv4 address exhaustion. The product you purchased embeds and activates
the NAT function. You also can disable the NAT function in [Basic Network]-[WAN & Uplink]-[Internet Setup]-
[WAN Type Configuration] page.

Widget

' @ Status W “Virtual Server & Virtual Computer - Special AP & ALG DMZ & Pass Through

—

Basic Network
- -

- WAN & Uplink Item Setting

* LAN & VLAN » NAT Loophack ¥ Enable

* WiFi Save | Undo

- IPv6

@ Port Forwarding

- Routing

- DNS & DDNS P
Usually all local hosts or servers behind corporate gateway are protected by NAT firewall. NAT firewall will filter
out unrecognized packets to protect your Intranet. So, all local hosts are invisible to the outside world. Port
forwarding or port mapping is function that redirects a communication request from one address and port
number combination to assigned one. This technique is most commonly used to make services on a host
residing on a protected or masqueraded (internal) network available to hosts on the opposite side of the
gateway (external network), by remapping the destination IP address and port number
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2.5.1 Configuration

NAT Loopback

This feature allows you to access the WAN global IP address from your inside NAT local network. It is useful
when you run a server inside your network. For example, if you set a mail server at LAN side, your local
devices can access this mail server through gateway’s global IP address when enable NAT loopback feature. On
either side are you in accessing the email server, at the LAN side or at the WAN side, you don’t need to change
the IP address of the mail server.

Configuration Setting

Go to Basic Network > Port Forwarding > Configuration tab.

The NAT Loopback allows user to access the WAN IP address from inside your local network.

Enable NAT Loopback

= NAT Loopback -

ltem Setting

» NAT Loopback Enable

Configuration

Item { Value setting Description

NAT Loopback The box is checked by default ~ Check the Enable box to activate this NAT function
Save N/A Click the Save button to save the settings.

Undo N/A Click the Undo button to cancel the settings
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2.5.2 Virtual Server & Virtual Computer

= Configuration ’ .
Item Setting

b Virtual Server ] Enable

» Virtual Computer # Enable

= Virtual Server List [[¥T]

WAN Interface

Server IP Source IP Protocol | Public Port Time Schedule  Enable

=« Virtual Computer List [0 a x

1D Global IP Local IP Enable Actions

There are some important Pot Forwarding functions implemented within the gateway, including "Virtual
Server", "NAT loopback" and "Virtual Computer".

It is necessary for cooperate staffs who travel outside and want to access various servers behind office
gateway. You can set up those servers by using "Virtual Server" feature. After trip, if want to access those
servers from LAN side by global IP, without change original setting, NAT Loopback can achieve it.

"Virtual computer" is a host behind NAT gateway whose IP address is a global one and is visible to the outside
world. Since it is behind NAT, it is protected by gateway firewall. To configure Virtual Computer, you just have
to map the local IP of the virtual computer to a global IP.
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Virtual Server & NAT Loopback

"Virtual Server" allows you to access servers with the

Network-A global IP address or FQDN of the gateway as if they are
G . . .
T emateasnss  servers existed in the Internet. But in fact, these servers
6 _J—\L@ —Qg are located in the Intranet and are physically behind the
Remote User ~Fx gateway. The gateway serves the service requests by port
1 ~3p” [\ 3 forwarding the requests to the LAN servers and transfers
\ .
1.Configure E-mail Server (10.0.75.101) _ _\ the replies from LAN servers to the requester on the
253 virtual Server. _ WAN side. As shown in example, an E-mail virtual server
.Remote User access E-mail Server ] oo X Local User . . .
with Gateway Global IP (118.18.8133). 06,7861 | 10.075.100 is defined to be located at a server with IP address
3.With NAT Loopback enabled, Local E/O'
User can access local E-mail Server File Server 10.0.75.101 in the Intranet of Network-A, including SMTP
ith Global IP (118.18.81.33) II. Global IP:118.18.81.44 A .
e e Local IP: 10.0.75.102 service port 25 and POP3 service port 110. So, the

remote user can access the E-mail server with the
gateway’s global IP 118.18.81.33 from its WAN side. But the real E-mail server is located at LAN side and the
gateway is the port forwarder for E-mail service.

NAT Loopback allows you to access the WAN global IP address from your inside NAT local network. It is useful
when you run a server inside your network. For example, if you set a mail server at LAN side, your local
devices can access this mail server through gateway’s global IP address when enable NAT loopback feature. On
either side are you in accessing the email server, at the LAN side or at the WAN side, you don’t need to change
the IP address of the mail server.

Virtual Computer

"Virtual Computer" allows you to assign LAN hosts to
global IP addresses, so that they can be visible to outside
s world. While so, they are also protected by the gateway
firewall as being client hosts in the Intranet. For example,
if you set a FTP file server at LAN side with local IP
address 10.0.75.102 and global IP address 118.18.82.44,

Network-A

Gateway

Remote User

1. Configure File Server as aVirtual 7 i . L. B
Computer by Global IP (118.18.81.44). | [ s - a remote user can access the file server while it is hidden
2. Remote User access File Server as by o 1 \ X .
global IP (118.18.81.44) directly f < e behind the NAT gateway. That is because the gateway
~-mail erver
WORIO g [ oo takes care of all accessing to the IP address 118.18.82.44,
FleServer = @ s including to forward the access requests to the file
Loeal IP:10.0.75.102 server and to send the replies from the server to outside

world.
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Virtual Server & Virtual Computer Setting

Go to Basic Network > Port Forwarding > Virtual Server & Virtual Computer tab.

Enable Virtual Server and Virtual Computer

e BC

Item Setting

v Virtual Server ] Enable
¥ Virtual Computer [+ Enable

Configuration :
Item Value setting Description

. The box is unchecked b
Virtual Server default Y Check the Enable box to activate this port forwarding function
efau
. The box is checked by . . . .
Virtual Computer default Check the Enable box to activate this port forwarding function
Save N/A Click the Save button to save the settings.
Undo N/A Click the Undo button to cancel the settings.

Create / Edit Virtual Server

The gateway allows you to custom your Virtual Server rules. It supports up to a maximum of 20 rule-based
Virtual Server sets.

= Virtual Server List [[¥T]

Private
1D WAN Interface Server IP Source IP Protocol | Public Port Time Schedule  Enable Actions

Port

When Add button is applied, Virtual Server Rule Configuration screen will appear.
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Item Setting
+ WAN Interface 7| Al WAN-1 WAN-2 WARN-3
» Server IP
b Source IP Any v
¢ Protocol TCP(6) & UDP(17) ¥
+ Public Port Single Port v
» Private Port Single Port v
» Time Schedule (0} Always ¥
» Rule Enable

Define the selected interface to be the packet-entering interface of the

gateway.
If the packets to be filtered are coming from WAN-x then select WAN-x for this
WAN Interface 1. A Must filled setting field.
2. Default is ALL. Select ALL for packets coming into the gateway from any interface.

It can be selected WAN-x box when WAN-x enabled.
Note: The available check boxes (WAN-1 ~ WAN-4) depend on the number of
WAN interfaces for the product.
) ) This field is to specify the IP address of the interface selected in the WAN
Server IP A Must filled setting .
Interface setting above.
) . This field is to specify the Source IP address.

1. A Must filled setting

Source IP 2. By default Any is

selected

Select Any to allow the access coming from any IP addresses.

Select Specific IP Address to allow the access coming from an IP address.

Select IP Range to allow the access coming from a specified range of IP address.
When “ICMPv4” is selected

It means the option “Protocol” of packet filter rule is ICMPv4.

Apply Time Schedule to this rule, otherwise leave it as Always. (refer to
Scheduling setting under Object Definition)

Then check Enable box to enable this rule.

When “TCP” is selected

1. A Must filled setting . . .
It means the option “Protocol” of packet filter rule is TCP.

Protocol 2. TCP & UDP is selected

Public Port selected a predefined port from Well-known Service, and Private
by default.

Port is the same with Public Port number.

Public Port is selected Single Port and specify a port number, and Private Port
can be set a Single Port number.

Public Port is selected Port Range and specify a port range, and Private Port
can be selected Single Port or Port Range.

Value Range: 1 ~ 65535 for Public Port, Private Port.
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Time Schedule

Rule

Save
Undo

1. An optional filled setting
2. (0) Always Is selected
by default.

1. An optional filled setting
2.The box is unchecked by
default.

N/A

N/A

When “UDP” is selected

It means the option “Protocol” of packet filter rule is UDP.

Public Port selected a predefined port from Well-known Service, and Private
Port is the same with Public Port number.

Public Port is selected Single Port and specify a port number, and Private Port
can be set a Single Port number.

Public Port is selected Port Range and specify a port range, and Private Port
can be selected Single Port or Port Range.

Value Range: 1 ~ 65535 for Public Port, Private Port.

When “TCP & UDP” is selected

It means the option “Protocol” of packet filter rule is TCP and UDP.

Public Port selected a predefined port from Well-known Service, and Private
Port is the same with Public Port number.

Public Port is selected Single Port and specify a port number, and Private Port
can be set a Single Port number.

Public Port is selected Port Range and specify a port range, and Private Port
can be selected Single Port or Port Range.

Value Range: 1 ~ 65535 for Public Port, Private Port.

When “GRE” is selected
It means the option “Protocol” of packet filter rule is GRE.

When “ESP” is selected
It means the option “Protocol” of packet filter rule is ESP.

When “SCTP” is selected
It means the option “Protocol” of packet filter rule is SCTP.

When “User-defined” is selected

It means the option “Protocol” of packet filter rule is User-defined.

For Protocol Number, enter a port number.

Apply Time Schedule to this rule; otherwise leave it as (0) Always. (refer to
Scheduling setting under Object Definition)

Check the Enable box to activate the rule.

Click the Save button to save the settings.

Click the X button to cancel the settings and return to previous page.
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Create / Edit Virtual Computer

The gateway allows you to custom your Virtual Computer rules. It supports up to a maximum of 20 rule-based
Virtual Computer sets.

v—

1D Global IP Local IP Enable Actions

When Add button is applied, Virtual Computer Rule Configuration screen will appear.

Global IP Local IP Enable
| | | | =

Virtual Computer Rule Configuration

Item Value setting ' Description

Global IP A Must filled setting This field is to specify the IP address of the WAN IP.
Local IP A Must filled setting This field is to specify the IP address of the LAN IP.
Enable N/A Then check Enable box to enable this rule.

Save N/A Click the Save button to save the settings.
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2.5.3 DMZ & Pass Through

DMZ (De Militarized Zone) Host is a host that is exposed to the Internet cyberspace but still within the
protection of firewall by gateway device. So, the function allows a computer to execute 2-way communication
for Internet games, Video conferencing, Internet telephony and other special applications. In some cases
when a specific application is blocked by NAT mechanism, you can indicate that LAN computer as a DMZ host

to solve this problem.

The DMZ function allows you to ask the gateway pass through all normal packets to the DMZ host behind the
NAT gateway only when these packets are not expected to receive by applications in the gateway or by other
client hosts in the Intranet. Certainly, the DMZ host is also protected by the gateway firewall. Activate the
feature and specify the DMZ host with a host in the Intranet when needed.

Item
+# Enable
r DMz OZ Host -
» Pass Through Enable v IPSec
DMZ Scenario

Global IP:118.18.81.33

Local IP: 10.0.75.2
~ Gateway
2 — S
\/. ——*—@ ——————————— -
2 1

Remote User

1.5et X Server as DMZ Host

2.Request X server service by Gateway Global IP
3.Gateway redirect service request to DMZ host:
10.0.75.100

Al

10.0.75.100
¢ FFTF @ L2TP

X Server

Setting

WAAN-2 WAAN-3 WA

When the network administrator wants to set up
some service daemons in a host behind NAT
gateway to allow remote users request for services
from server actively, you just have to configure this
host as DMZ Host. As shown in the diagram, there
is an X server installed as DMZ host, whose IP
address is 10.0.75.100. Then, remote user can
request services from X server just as it is provided
by the gateway whose global IP address is
118.18.81.33. The gateway will forward those
packets, not belonging to any configured virtual
server or applications, directly to the DMZ host.
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VPN Pass through Scenario

Since VPN traffic is different from that of TCP or
UDP connection, it will be blocked by NAT gateway.
To support the pass through function for the VPN
v _ Falto stablsh VN tumnel  \SREJ connections initiating from VPN clients behind NAT
Server Sfoatabase | pmm === =TT gateway, the gateway must implement some kind

Network-A @ HQ Data Center Gateway without

VPN Pass Through

A N

1k N

ix{../. taéi“ ACS
A “& Server
Yy

+ jeiw‘ of VPN pass through function for such application.

4 \ i - The gateway support the pass through function for

m1 ‘(_ ______ YPNTunnel 7 IPSec, PPTP, and L2TP connections, you just have

with 2 “Static|p* | Establish VPN tunnel to check the corresponding checkbox to activate it.
successfully VPN Pass Through behind NAT Gateway

Global IP: 203.95.80.22
Local IP: 10.0.76.2

DMZ & Pass Through Setting

Go to Basic Network > Port Forwarding > DMZ & Pass Through tab.

The DMZ host is a host that is exposed to the Internet cyberspace but still within the protection of firewall by
gateway device.

Enable DMZ and Pass Through

Item Setting
Enable All WA WAN-2 WAAN-3 WAN-4
» DMz DMZ Hast
» Pass Through Enable # IPSec & PFTP [« LZTF
bMmz 1. A Must filled setting Check the Enable box to activate the DMZ function
2. Default is ALL. Define the selected interface to be the packet-entering interface of the

gateway, and fill in the IP address of Host LAN IP in DMZ Host field

If the packets to be filtered are coming from WAN-x then select WAN-x for
this field.

Select ALL for packets coming into the router from any interfaces.

It can be selected WAN-x box when WAN-x enabled.
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Pass Through Enable  The boxes are checked by

default
Save N/A
Undo N/A

Note: The available check boxes (WAN-1 ~ WAN-4) depend on the number
of WAN interfaces for the product.

Check the box to enable the pass through function for the IPSec, PPTP, and
L2TP.

With the pass through function enabled, the VPN hosts behind the gateway
still can connect to remote VPN servers.

Click the Save button to save the settings.

Click the Undo button to cancel the settings
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2.6 Routing

: ; ) : ) ) Widget
' . Status W Dynamic Routing Routing Information

o

Basic Network

= WAN & Uplink

Item Setting

E—— » Static Routing [} Enable

[v] Destination IP Subnet Mask Gateway IP Interface Metric Enable Actions

= WiFi

- IPv6

- Port Forwarding

- DNS & DDNS

If you have more than one router and subnet, you will need to enable routing function to allow packets to find
proper routing path and allow different subnets to communicate with each other. Routing is the process of
selecting best paths in a network. It is performed for many kinds of networks, like electronic data networks
(such as the Internet), by using packet switching technology. The routing process usually directs forwarding on
the basis of routing tables which maintain a record of the routes to various network destinations. Thus,
constructing routing tables, which are held in the router's memory, is very important for efficient routing. Most
routing algorithms use only one network path at a time.

The routing tables record your pre-defined routing paths for some specific destination subnets. It is static
routing. However, if the contents of routing tables record the obtained routing paths from neighbor routers by
using some protocols, such as RIP, OSPF and BGP. It is dynamic routing. These both routing approaches will be
illustrated one after one. In addition, the gateway also built in one advanced configurable routing software
Quagga for more complex routing applications, you can configure it if required via Telnet CLI.
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2.6.1 Static Routing

Configuration

JI Enable

Static No
Routing?

Yes

Setup

4 Static Routing
Rule List

‘L Check

Finish?
¢ No
Static Routing
Rule Configuration

db

Item Satting
¥ Stab i # Enable
Add | Deleta
I Destination IP Subnat Mask Gatevany IP Interface Matriz  Enable Actions
[bam Satting
v Drestination IP

¥ Subnat Mask

¢ bty P

» Bfenace

200430 A 0(fM4) »

¥

Enable

"Static Routing" function lets you define the routing paths for some dedicated hosts/servers or subnets to
store in the routing table of the gateway. The gateway routes incoming packets to different peer gateways
based on the routing table. You need to define the static routing information in gateway routing rule list.

1) Google(173.194.72.94): -> WAN-1
Yahoo(188.125.73.108): -> WAN-2

ISP-DSLAM

u ( EE oogle

192.168.121.253

))_} (@ Yahoo LAN

) B 192.168.22.1

| Static Routing: Enable |

[Static Routing]-[Static Routing Rule List]

Cellular {((ﬁ

((9)) Gateway

ID1:
Destination IP: 173.194.72.94
Subnet Mask: 255.255.255.255
Gateway: 192.168.121.253
Metric: 255
Rule: Enable

ID2:
Destination IP: 188.125.73.108
Subnet Mask: 255.255.255.255
Gateway: 192.168.22.1
Metric: 255
Rule: Enable

When the administrator of the gateway wants to
specify what kinds of packets to be transferred via
which gateway interface and which peer gateway to
their destination. It can be carried out by the "Static
Routing" feature. Dedicated packet flows from the
Intranet will be routed to their destination via the pre-
defined peer gateway and corresponding gateway
interface that are defined in the system routing table
by manual.

As shown in the diagram, when the destination is
Google access, rule 1 set interface as ADSL, routing
gateway as IP-DSLAM gateway 192.168.121.253. All the
packets to Google will go through WAN-1. And the
same way applied to rule 2 of access Yahoo. Rule 2 sets
3G/4G as interface.

116



4G PoE-WAN Extender

Static Routing Setting

Go to Basic Network > Routing > Static Routing Tab.

There are three configuration windows for static routing feature, including "Configuration", "Static Routing
Rule List" and "Static Routing Rule Configuration" windows. "Configuration" window lets you activate the
global static routing feature. Even there are already routing rules, if you want to disable routing temporarily,
just uncheck the Enable box to disable it. "Static Routing Rule List" window lists all your defined static routing
rule entries. Using "Add" or "Edit" button to add and create one new static routing rule or to modify an
existed one.

When "Add" or "Edit" button is applied, the "Static Routing Rule Configuration" window will appear to let you
define a static routing rule.

Enable Static Routing

Just check the Enable box to activate the "Static Routing" feature.

ltem Setting

¥ Static Routing # Enable

The box is unchecked by
default

Static Routing Check the Enable box to activate this function

Create / Edit Static Routing Rules

The Static Routing Rule List shows the setup parameters of all static routing rule entries. To configure a static
routing rule, you must specify related parameters including the destination IP address and subnet mask of
dedicated host/server or subnet, the IP address of peer gateway, the metric and the rule activation.

Add || Delete

1D Destination IP Subnet Mask Gateway P Interface Metric Enable Actions

The gateway allows you to custom your static routing rules. It supports up to a maximum of 64 rule sets. When
Add button is applied, Static Routing Rule Configuration screen will appear, while the Edit button at the end
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of each static routing rule can let you modify the rule.

% |Pvd4 Static Routing Rule Configuration

Iltem Setting

v Destination IFP | |
» Subnet Mask 12552552550 (/24) v |

b Gateway 1P | |

¥ Interface
¥ Metric I:l

» Rule [ Enable

IPv4 Static Routing
Item Value setting Description

N 1. IPv4 Format . S . . .
Destination IP . . Specify the Destination IP of this static routing rule.
2. A Must filled setting

255.255.255.0(/24) isset b
Subnet Mask default (/24)1 v Specify the Subnet Mask of this static routing rule.
efau

1. IPv4 Format . . . .
Gateway IP . . Specify the Gateway IP of this static routing rule.
2. A Must filled setting

Select the Interface of this static routing rule. It can be Auto, or the available

Interface Auto is set by default .
WAN / LAN interfaces.
Metric 1. Numberic String Format The Metric of this static routing rule.
2. A Must filled setting Value Range: 0 ~ 255.
The box is unchecked b
Rule v Click Enable box to activate this rule.
default.
Save NA Click the Save button to save the configuration
Undo NA Click the Undo button to restore what you just configured back to the previous
setting.
When the Back button is clicked the screen will return to the Static Routing
Back NA

Configuration page.
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2.6.2 Dynamic Routing

= RIP Configuration ’ a
RIP Item Setting
Configuration » RIF Enable [Disable =]
= OSPF Configuration ’ a
Item Setting
+ OSPF [ Enable
» Router ID ]
» Authentication [None =]
+ Backbone Subnet ]
OSPF Area List? e -
ID Area Subnet Area D Enable Actions
OFPF Area = BGP Configuration ’ a
Configuration Item Setting
» BGP [~ Enable
» ASN ]
+ Router ID —

Dynamic Routing, also called adaptive routing, describes the capability of a system, through which routes are
characterized by their destination, to alter the path that the route takes through the system in response to a

change in network conditions.

This gateway supports dynamic routing protocols, including RIPv1/RIPv2 (Routing Information Protocol), and
OSPF (Open Shortest Path First), for you to establish routing table automatically. The feature of dynamic
routing will be very useful when there are lots of subnets in your network. Generally speaking, RIP is suitable
for small network. OSPF is more suitable for medium network.

The supported dynamic routing protocols are described as follows.
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RIP Scenario
Network-A
@Routing Table #1 |
ISP-DSLAM (@ @
RIP Enabled
M WAN-1: ADSL
\@ C 118188133 Gateway
118.18.81.1 - e
203958022 @ Routing Table#1 +#2
@ Basic Network-Routinl; —
[Dynamic Routing]-[RIP §onfiguration] ((( ))) LAM

RIP: RIPv1 or RIPV2 ,
izf 203.95.80.1

Cellular Network

@©Routing Table#2 |

OSPF Scenario

GatewaySettings:

[Dynamic Routing]-{0SPF Configuratig

OSPF:Enable
Backbone Subnet: 192.168.0.0/16

[Oynamic Routing]-{OSPF Area List]
D1:
Area Subnet: 192.168.101.0/24
Area ID: 192.168.101.254
Area: Enable
D2:
Area Subnet: 192.168.102.0/24
Area ID: 192.168.102.254
Area: Enable

The Routing Information Protocol (RIP) is one of the
oldest distance-vector routing protocols, which
employs the hop count as a routing metric. RIP
prevents routing loops by implementing a limit on the
number of hops allowed in a path from the source to a
destination. The maximum number of hops allowed
for RIP is 15. This hop limit, however, also limits the
size of networks that RIP can support. A hop count of
16 is considered an infinite distance, in other words
the route is considered unreachable. RIP implements
the split horizon, route poisoning and hold-down
mechanisms to prevent incorrect routing information
from being propagated.

Open Shortest Path First (OSPF) is a routing protocol
that uses link state routing algorithm. It is the most
widely used interior gateway protocol (IGP) in large
enterprise networks. It gathers link state information
from available routers and constructs a topology map
of the network. The topology is presented as a routing
table which routes datagrams based solely on the
destination IP address.

Network administrator can deploy OSPF gateway in
large enterprise network to get its routing table from
the enterprise backbone, and forward routing
information to other routers, which are no linked to
the enterprise backbone. Usually, an OSPF network is
subdivided into routing areas to simplify
administration and optimize traffic and resource
utilization.

As shown in the diagram, OSPF gateway gathers routing information from the backbone gateways in area 0,
and will forward its routing information to the routers in area 1 and area 2 which are not in the backbone.
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Dynamic Routing Setting

Go to Basic Network > Routing > Dynamic Routing Tab.

The dynamic routing setting allows user to customize RIP, and OSPF protocols through the router based on
their office setting.

In the "Dynamic Routing" page, there are several configuration windows for dynamic routing feature. They are
the "RIP Configuration" window, "OSPF Configuration" window, "OSPF Area List", and "OSPF Area
Configuration" window. RIP, and OSPF protocols can be configured individually.

The "RIP Configuration" window lets you choose which version of RIP protocol to be activated or disable it.
The "OSPF Configuration" window can let you activate the OSPF dynamic routing protocol and specify its
backbone subnet. Moreover, the "OSPF Area List" window lists all defined areas in the OSPF network.

RIP Configuration

The RIP configuration setting allows user to customize RIP protocol through the router based on their office
setting.

ltem Setting

» RIP Enable |Disable -I

Select Disable will disable RIP protocol.
RIP Enable Disable is set by default Select RIP v1 will enable RIPv1 protocol.
Select RIP v2 will enable RIPv2 protocol.

OSPF Configuration

The OSPF configuration setting allows user to customize OSPF protocol through the router based on their
office setting.
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* OSPF Configuration ’ ®
ltem Setting

» OSPF [~ Enable

» Router ID |

» Authentication None ~

+ Backbone Subnet |

OSPF Configuration

Item Value setting Description

OSPF Disable is set by default Click Enable box to activate the OSPF protocol.
1. IPv4 Format .

Router ID The Router ID of this router on OSPF protocol

2. A Must filled setting

The Authentication method of this router on OSPF protocol.

Select None will disable Authentication on OSPF protocol.

Select Text will enable Text Authentication with entered the Key in this field on
OSPF protocol.

Select MD5 will enable MD5 Authentication with entered the ID and Key in
these fields on OSPF protocol.

Authentication None is set by default

1. Classless Inter Domain

Routing (CIDR) Subnet

Mask Notation. (Ex: The Backbone Subnet of this router on OSPF protocol.
192.168.1.0/24)

2. A Must filled setting

Backbone
Subnet

Create / Edit OSPF Area Rules

The gateway allows you to custom your OSPF Area List rules. It supports up to a maximum of 32 rule sets.

Area Subnet

When Add button is applied, OSPF Area Rule Configuration screen will appear.
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= OSPF Area Configuration

ltem Setting
+ Area Subnet |
» Area D |
» Area [~ Enable

OSPF Area Configuration

Item

Area Subnet

Value setting

1. Classless Inter Domain
Routing (CIDR) Subnet
Mask Notation. (Ex:
192.168.1.0/24)

2. A Must filled setting

Description

The Area Subnet of this router on OSPF Area List.

Area ID

1. IPv4 Format
2. A Must filled setting

The Area ID of this router on OSPF Area List.

Area

The box is unchecked by
default.

Click Enable box to activate this rule.

Save

N/A

Click the Save button to save the configuration
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2.6.3 Routing Information

The routing information allows user to view the routing table and policy routing information. Policy Routing
Information is only available when the Load Balance function is enabled and the Load Balance Strategy is By

User Policy.

Go to Basic Network > Routing > Routing Information Tab.

* Routing Table - x

Destination IP Subnet Mask Gateway IP Metric Interface
10010516772 255255255252 0000 0 WAN-2
192 168.66.0 2552552550 0000 0 LAN
1921681270 2552552550 0000 0 WAN-1
169.254.0.0 255.255.0.0 0.0.00 0 LAN
127000 255000 0000 0 lo

Routing Table

Item Value setting Description

Destination IP N/A Routing record of Destination IP. IPv4 Format.
Subnet Mask N/A Routing record of Subnet Mask. IPv4 Format.
Gateway IP N/A Routing record of Gateway IP. IPv4 Format.
Metric N/A Routing record of Metric. Numeric String Format.
Interface N/A Routing record of Interface Type. String Format.

= Policy Routing Information

Policy Routing Source

Source IP

Destination IP

Destination Port

WAN Interface

Load Balance

Policy Routing Information

Item Value setting Description

Policy Routing Source N/A Policy Routing of Source. String Format.

Source IP N/A Policy Routing of Source IP. IPv4 Format.
Destination IP N/A Policy Routing of Destination IP. IPv4 Format.
Destination Port N/A Policy Routing of Destination Port. String Format.
WAN Interface N/A Policy Routing of WAN Interface. String Format.
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2.7 DNS & DDNS

How does user access your server if your WAN IP address changes all the time? One way is to register a new
domain name, and maintain your own DNS server. Another simpler way is to apply a domain name to a third-
party DDNS service provider. The service can be free or charged. If you want to understand the basic concepts
of DNS and Dynamic DNS, you can refer to Wikipedia website "%,

2.7.1 DNS & DDNS Configuration

Dynamic DNS

Inform
D DDNs server Network-A >
ammmmm———ll _ _ Global IP:118.18.81.33 > .44 WANIP
TeAL ~FQDN: mygw.no-ip.org Changed

internet s Gateway
" —
§ _________ \"\ Local IP: 10.0.75.2
0

~
\

\

1

No-IP
DDNS Server

;
Root Name Server Public

DNS Servers ' "
!

N
E-mail Server ‘5
Local IP: 10.0.75.101 §

File Server
Local IP: 10.0.75.102
Global IP: 118.18.81.44

Remote User

Access E-mail Server
(mygw.no-ip.org) from Internet

To host your server on a changing IP address, you
have to use dynamic domain name service (DDNS).
Therefore, anyone wishing to reach your host only
needs to know the domain name. Dynamic DNS will
map the name of your host to your current IP
address, which changes each time you connect your
Internet service provider.

The Dynamic DNS service allows the gateway to alias
a public dynamic IP address to a static domain name,
allowing the gateway to be more easily accessed
from various locations on the Internet. As shown in
the diagram, user registered a domain name to a

third-party DDNS service provider (NO-IP) to use DDNS function. Once the IP address of designated WAN
interface has changed, the dynamic DNS agent in the gateway will inform the DDNS server with the new IP
address. The server automatically re-maps your domain name with the changed IP address. So, other hosts or
remote users in the Internet world are able to link to your gateway by using your domain name regardless of

the changing global IP address.

7 http://en.wikipedia.org/wiki/Domain_Name_System
8 http://en.wikipedia.org/wiki/Dynamic_DNS
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DNS & DDNS Setting

Go to Basic Network > DNS & DDNS > Configuration Tab.

The DNS & DDNS setting allows user to setup Dynamic DNS feature and DNS redirect rules.

Setup Dynamic DNS

The gateway allows you to custom your Dynamic DNS settings.

= Dynamic DNS ' =
ltem Setting

» DDNS [ Enable

» WAN Interface IWAN‘l 'I

b Provider | DynDNS.org(Dynamic) -]

» Host Name I

» User Name / E-Mail |

» Passward / Key I

DDNS (Dynamic DNS) Configuration

Item Value setting Description
DDNS The boxis unchecked by Check the Enable box to activate this function.
default
WAN Interface WAN 1 is set by default Select the WAN Interface IP Address of the gateway.
Provider DynDNS.org (Dynamic) is Select your DDNS provider of Dynamic DNS. It can be DynDNS.org(Dynamic),
set by default DynDNS.org(Custom), NO-IP.com, etc...
Host Name tle.)itrlng format can be any Your registered host name of Dynamic DNS.
2. A Must filled setting Value Range: 0™ 63 characters.
User Name / E- 1. String format can be any ‘ ‘
Mail text Enter your User name or E-mail addresss of Dynamic DNS.
2. A Must filled setting
1. String format can be any
Password / Key  text Enter your Password or Key of Dynamic DNS.
2. A Must filled setting
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

126




4G PoE-WAN Extender

Setup DNS Redirect

DNS redirect is a special function to redirect certain traffics to a specified host. Administator can manage the
internet / intranet traffics that are going to access some restricted DNS and force those traffics to be redirected
to a specified host.

# DNS Redirect ®

ltem Setting

» DNS Redirect [ Enable

DNS Redirect Configuration

Item Value setting Description
. The box i hecked b
DNS Redirect € box I unchecked by Check the Enable box to activate this function.
default
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

If you enabled the DNS Redirect function, you have to further specify the redirect rules. According to the rules,
the gateway can redirect the traffic that matched the DNS to corresponding pre-defined IP address.

= RedirectRule | .l Delete

Mapping Rule Condition Description

When Add button is applied, Redirect Rule screen will appear.

= Redirect Rule m ’ %

ltem Setting

Domain Name IP
Mapping Rule

| (* for Any)

Condition I Always - |

Description |

Enable ™ Enable

Redirect Rule Configuration

Item Value setting Description
. 1. String format can be any  Enter a domain name to be redirect. The traffic to specified domain name will
Domain Name
text be redirect to the following IP address.
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Condition

Description

Enable

Save
Undo

2. A Must filled setting
1. IPv4 format
2. A Must filled setting

1. A Must filled setting
2. Always is selected by
default.

1. String format can be any
text

2. A Must filled setting

The box is unchecked by
default

N/A

N/A

Value Range: at least 1 character is required; “*’ for any.
Enter an IP Address as the target for the DNS redirect.

Specify when will the DNS redirect action can be applied.
It can be Always, or WAN Block.

Always: The DNS redirect function can be applied to matched DNS all the time.

WAN Block: The DNS redirect function can be applied to matched DNS only
when the WAN connection is disconneced, or un-reachable.

Enter a brief description for this rule.
Value Range: 0 ~ 63 characters.
Click the Enable button to activate this rule.

Click Save to save the settings
Click Undo to cancel the settings
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Chapter 3 Object Definition

3.1 Scheduling

Scheduling provides ability of adding/deleting time schedule rules, which can be applied to other functionality.

3.1.1 Scheduling Configuration

Go to Object Definition > Scheduling > Configuration tab.

= Time Schedule List | /.%| Delete

Button description

Item Value setting Description
Add N/A Click the Add button to configure time schedule rule
Delete N/A Click the Delete button to delete selected rule(s)

When Add button is applied, Time Schedule Configuration and Time Period Definition screens will appear.

= Time Schedule Configuration
Item

Setting

» Rule Name |

 Rule POIiC‘y" Inactivate = the Selected DEI.YS and Hours Below.

Time Schedule Configuration

Item Value Setting Description
Rule Name String: any text Set rule name
Rule Policy Default Inactivate Inactivate/activate the function been applied to in the time period below
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% Time Period Definition

D Week Day Start Time (hh:mm) End Time (hh:mm)
1 | -- choose one — +| |— I—
2 | -- choose one -- j |— I—
3 | -- choose one — +| |— I—
4 | -- choose one -- j |— I—
5 | — choose one — | I— |—
6 | — choose one — | I— |—
7 | -- choose one — j I— |—
8 | — choose one — | I— |—

Time Period Definition

Item Value Setting Description

Week Day Select from menu Select everyday or one of weekday

Start Time Time format (hh :mm) Start time in selected weekday

End Time Time format (hh :mm) End time in selected weekday

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings

Refresh N/A Click the Refresh button to refresh the time schedule list.
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3.2 User (not supported)

Not supported feature for the purchased product, leave it as blank.
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3.3 Grouping

The Grouping function allows user to make group for some services.

3.3.1 Host Grouping

Go to Object Definition > Grouping > Host Grouping tab.

The Host Grouping function allows user to make host group for some services, such as QoS, Firewall, and
Communication Bus. The supported service types could be different for the purchased product.

= Host Group List | /10ifi| Delete "

ID Group Name Group Type Member List Bound Services Enable Actions

When Add button is applied, Host Group Configuration screen will appear.

* Host Group Configuration

Item Setting
¥ Group Name I
» Group Type |IP Address-based EI
» Member to Join | Join
+ Member List |
» Bound Services [ Firewal
» Group | " Enable

Host Group Configuration

Item \ Value setting Description
1. String format can
Group Name be any text Enter a group name for the rule. It is a name that is easy for you to understand.

2. A Must filled setting

Select the group type for the host group. It can be IP Address-based, MAC
Address-based, or Host Name-based.
1. IP Address-based is  When IP Address-based is selected, only IP address can be added in Member to
Group Type selected by default. Join.
2. A Must filled setting When MAC Address-based is selected, only MAC address can be added in
Member to Join.
When Host Name-based is selected, only host name can be added in Member
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Member to Join

Member List

Bound Services

Group

Save
Undo

N/A

NA

The boxes are
unchecked by default

The box is unchecked
by default

N/A

N/A

to Join.
Note: The available Group Type can be different for the purchased model.
Add the members to the group in this field.

You can enter the member information as specified in the Member Type above,

and press the Join button to add.

Only one member can be add at a time, so you have to add the members to the

group one by one.

This field will indicate the hosts (members) contained in the group.
Binding the services that the host group can be applied. If you enable the
Firewall, the produced group can be used in firewall service.

Note: The supported service type can be different for the purchased product.
Check the Enable checkbox to activate the host group rule. So that the group
can be bound to selected service(s) for further configuration.

Click Save to save the settings

Click Undo to cancel the settings
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3.4 External Server

Go to Object Definition > External Server > External Server tab.

The External Server setting allows user to add external server.

Create External Server

= External Server List

Server Name Server Type Server IP[FQDN Server Port Actions
When Add button is applied, External Server Configuration screen will appear.
* External Server Configuration n x

ltem Setting

» Server Name |

I Email Server j

» Server Type User Name: |

Password: |

» Server IPFFQDN |

+ Server Port |25

» Server [ Enable

134



4G PoE-WAN Extender

Sever Name

1. String format can be
any text
2. A Must filled setting

Enter a server name. Enter a name that is easy for you to understand.

Server Type

A Must filled setting

Specify the Server Type of the external server, and enter the required settings

for the accessing the server.

Email Server (A Must filled setting) :

When Email Server is selected, User Name, and Password are also required.

User Name (String format: any text)
Password (String format: any text)

RADIUS Server (A Must filled setting) :

When RADIUS Server is selected, the following settings are also required.
Primary :

Shared Key (String format: any text)

Authentication Protocol (By default CHAP is selected)
Session Timeout (By default 1)

The values must be between 1 and 60.

Idle Timeout: (By default 1)

The values must be between 1 and 15.

Secondary :

Shared Key (String format: any text)

Authentication Protocol (By default CHAP is selected)
Session Timeout (By default 1)

The values must be between 1 and 60.

Idle Timeout: (By default 1)

The values must be between 1 and 15.

Active Directory Server (A Must filled setting) :

When Active Directory Server is selected, Domain setting is also required.

Domain (String format: any text)

LDAP Server (A Must filled setting) :

When LDAP Server is selected, the following settings are also required.
Base DN (String format: any text)

Identity (String format: any text)

Password (String format: any text)

UAM Server (A Must filled setting) :

When UAM Server is selected, the following settings are also required.
Login URL (String format: any text)

Shared Secret (String format: any text)

NAS/Gateway ID (String format: any text)

Location ID (String format: any text)

Location Name (String format: any text)
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TACACS+ Server (A Must filled setting) :

When TACACS+ Server is selected, the following settings are also required.
Shared Key (String format: any text)

Session Timeout (String format: any number)

The values must be between 1 and 60.

SCEP Server (A Must filled setting) :

When SCEP Server is selected, the following settings are also required.
Path (String format: any text, By default cgi-bin is filled)

Application (String format: any text, By default pkiclient.exe is filled)

FTP(SFTP) Server (A Must filled setting) :

When FTP(SFTP) Server is selected, the following settings are also required.
User Name (String format: any text)

Password (String format: any text)

Protocol (Select FTP or SFTP)

Encryprion (Select Plain, Explicit FTPS or Implicit FTPS)

Transfer mode (Select Passive or Active)

Server IP/FQDN

A Must filled setting

Specify the IP address or FQDN used for the external server.

Server Port

A Must filled setting

Specify the Port used for the external server. If you selected a certain server
type, the default server port number will be set.

For Email Server 25 will be set by default;

For Syslog Server, port 514 will be set by default;

For RADIUS Server, port 1812, 1823 will be set by default;
For Active Directory Server, port 389 will be set by default;
For LDAP Server, port 389 will be set by default;

For UAM Server, port 3990, 4990 will be set by default;

For TACACS+ Server, port 49 will be set by default;

For SCEP Server, port 80 will be set by default;

For FTP(SFTP) Server, port 21 will be set by default;

For LoRa Server, port 1700 will be set by default;

Value Range: 1 ~ 65535.

Account Port

1. A Must filled setting
2. 1813 is set by default

Specify the accounting port used if you selected external RADIUS server.
Value Range: 1 ~ 65535.

The box is checked by

Server Click Enable to activate this External Server.
default
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
Refresh N/A Click the Refresh button to refresh the external server list.
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3.5 Certificate

In cryptography, a public key certificate (also known as a digital certificate or identity certificate) is an
electronic document used to prove ownership of a public key. The certificate includes information about the
key, information about its owner's identity, and the digital signature of an entity that has verified the
certificate's contents are genuine. If the signature is valid, and the person examining the certificate trusts the
signer, then they know they can use that key to communicate with its owner”.

In a typical public-key infrastructure (PKI) scheme, the signer is a certificate authority (CA), usually a company
such as VeriSign which charges customers to issue certificates for them. In a web of trust scheme, the signer is
either the key's owner (a self-signed certificate) or other users ("endorsements") whom the person examining
the certificate might know and trust. The device also plays as a CA role.

Certificates are an important component of Transport Layer Security (TLS, sometimes called by its older name
SSL), where they prevent an attacker from impersonating a secure website or other server. They are also used
in other important applications, such as email encryption and code signing. Here, it can be used in IPSec
tunneling for user authentication.

3.5.1 Configuration (not supported)

Not supported feature for the purchased product, leave it as blank.

9 http://en.wikipedia.org/wiki/Public_key_certificate.
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3.5.2 My Certificate

My Certificate includes a Local Certificate List. Local Certificate List shows all generated certificates by the root
CA for the gateway. And it also stores the generated Certificate Signing Requests (CSR) which will be signed by
other external CAs. The signed certificates can be imported as the local ones of the gateway.

Self-signed Certificate Usage Scenario

Network-A @ HQ Data Center Network-B @ Branch Office

ACS

n / Server
SN

Ap:licétion % n‘ Batabian \ |n|frzt
erver — Server -
(D Create HQ Root 34 ( O
- VPN Tunnel (IPSec IKE+X.509)
®Creatle Loca RootCA
@ Import. CRT

B Create IPSec (IKE + X.509)

. — ; VPN Tunnel )

Security Gateway 1 Security Gateway 2

with Root CA and Trusted with Trusted CA &

Client Certificates Client Certificates
Global IP: 203.95.80.22 Global IP: 118.18.81.33
Local IP: 10.0.76.2 Local IP: 10.0.75.2

Scenario Application Timing

When the enterprise gateway owns the root CA and VPN tunneling function, it can generate its own
local certificates by being signed by itself or import any local certificates that are signed by other
external CAs. Also import the trusted certificates for other CAs and Clients. In addition, since it has the
root CA, it also can sign Certificate Signing Requests (CSR) to form corresponding certificates for others.
These certificates can be used for two remote peers to make sure their identity during establishing a
VPN tunnel.

Scenario Description

Gateway 1 generates the root CA and a local certificate (HQCRT) signed by itself. Import a trusted
certificate (BranchCRT) —a BranchCSR certificate of Gateway 2 signed by root CA of Gateway 1.

Gateway 2 creates a CSR (BranchCSR) to let the root CA of the Gateway 1 sign it to be the BranchCRT
certificate. Import the certificate into the Gateway 2 as a local certificate. In addition, also import the
certificates of the root CA of the Gateway 1 into the Gateway 2 as the trusted ones. (Please also refer
to following two sub-sections)

Establish an IPSec VPN tunnel with IKE and X.509 protocols by starting from either peer, so that all
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client hosts in these both subnets can communicate with each other.

Parameter Setup Example

For Network-A at HQ

Following tables list the parameter configuration as an example for the "My Certificate" function used
in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in following two sections to complete the

whole user scenario.

Use default value for those parameters that are not mentioned in the tables.

Configuration Path

[My Certificate]-[Root CA Certificate Configuration]

Name

HQRootCA

Key

Key Type: RSA Key Length: 1024-bits

Subject Name

Country(C): TW State(ST): Taiwan Location(L): Tainan
Organization(0): AMITHQ Organization Unit(OU): HQRD
Common Name(CN): HQRootCA E-mail: hgrootca@amit.com.tw

Configuration Path

[My Certificate]-[Local Certificate Configuration]

Name

HQCRT Self-signed: m

Key

Key Type: RSA Key Length: 1024-bits

Subject Name

Country(C): TW State(ST): Taiwan Location(L): Tainan
Organization(O): AMITHQ Organization Unit(OU): HQRD
Common Name(CN): HQCRT E-mail: hqgcrt@amit.com.tw

Configuration Path

[IPSec]-[Configuration]

IPSec

m Enable

Configuration Path

[IPSec]-[Tunnel Configuration]

Tunnel m Enable
Tunnel Name s2s-101
Interface WAN 1
Tunnel Scenario Site to Site
Operation Mode Always on

Configuration Path

[IPSec]-[Local & Remote Configuration]

Remote Gateway

Local Subnet 10.0.76.0
Local Netmask 255.255.255.0
Full Tunnel Disable
Remote Subnet 10.0.75.0
Remote Netmask 255.255.255.0
118.18.81.33
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Configuration Path

[IPSec]-[Authentication]

Key Management

IKE+X.509 Local Certificate: HQCRT Remote Certificate: BranchCRT

Local ID

User Name Network-A

Remote ID

User Name Network-B

Configuration Path

[IPSec]-[IKE Phase]

Negotiation Mode

Main Mode

X-Auth

None

For Network-B at Branch Office

Following tables list the parameter configuration as an example for the "My Certificate" function used
in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in following two sections to complete the

whole user scenario.

Use default value for those parameters that are not mentioned in the tables.

Configuration Path

[My Certificate]-[Local Certificate Configuration]

Name

BranchCRT Self-signed: O

Key

Key Type: RSA Key Length: 1024-bits

Subject Name

Country(C): TW State(ST): Taiwan Location(L): Tainan
Organization(O): AMITBranch Organization Unit(OU): BranchRD
Common Name(CN): BranchCRT E-mail: branchcrt@amit.com.tw

Configuration Path

[IPSec]-[Configuration]

IPSec

m Enable

Configuration Path

[IPSec]-[Tunnel Configuration]

Tunnel m Enable
Tunnel Name s2s-102
Interface WAN 1
Tunnel Scenario Site to Site
Operation Mode Always on

Configuration Path

[IPSec]-[Local & Remote Configuration]

Local Subnet 10.0.75.0
Local Netmask 255.255.255.0
Full Tunnel Disable
Remote Subnet 10.0.76.0
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Remote Netmask

255.255.255.0

Remote Gateway

203.95.80.22

Configuration Path

[IPSec]-[Authentication]

Key Management

IKE+X.509 Local Certificate: BranchCRT Remote Certificate: HQCRT

Local ID

User Name Network-B

Remote ID

User Name Network-A

Configuration Path

[IPSec]-[IKE Phase]

Negotiation Mode

Main Mode

X-Auth

None

Scenario Operation Procedure

In above diagram, "Gateway 1" is the gateway of Network-A in headquarters and the subnet of its
Intranet is 10.0.76.0/24. It has the IP address of 10.0.76.2 for LAN interface and 203.95.80.22 for WAN-
1 interface. "Gateway 2" is the gateway of Network-B in branch office and the subnet of its Intranet is
10.0.75.0/24. It has the IP address of 10.0.75.2 for LAN interface and 118.18.81.33 for WAN-1 interface.
They both serve as the NAT security gateways.

Gateway 1 generates the root CA and a local certificate (HQCRT) that is signed by itself. Import the
certificates of the root CA and HQCRT into the "Trusted CA Certificate List" and "Trusted Client
Certificate List" of Gateway 2.

Gateway 2 generates a Certificate Signing Request (BranchCSR) for its own certificate (BranchCRT)
(Please generate one not self-signed certificate in the Gateway 2, and click on the "View" button for
that CSR. Just downloads it). Take the CSR to be signed by the root CA of Gateway 1 and obtain the
BranchCRT certificate (you need rename it). Import the certificate into the "Trusted Client Certificate
List" of the Gateway 1 and the "Local Certificate List" of Gateway 2.

Gateway 2 can establish an IPSec VPN tunnel with "Site to Site" scenario and IKE and X.509 protocols to
Gateway 1.

Finally, the client hosts in two subnets of 10.0.75.0/24 and 10.0.76.0/24 can communicate with each
other.
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My Certificate Setting

Go to Object Definition > Certificate > My Certificate tab.

The My Certificate setting allows user to create local certificates. In "My Certificate" page, there are two
configuration windows for the "My Certificate" function. The "Local Certificate List" window shows the stored
certificates or CSRs for representing the gateway. The "Local Certificate Configuration" window can let you fill
required information necessary for corresponding certificate to be generated by itself, or corresponding CSR
to be signed by other CAs.

Create Local Certificate

- Add | Import | Delete

ID | Name Subject Issuer Vaild To Actions

When Add button is applied, Local Certificate Configuration screen will appear. The required information to be
filled for the certificate or CSR includes the name, key and subject name. It is a certificate if the "Self-signed"
box is checked; otherwise, it is a CSR.

Item Setting

» Name | Self-signed - [7

b Key Key Type : I RSA .l Key Length : I 1024-hits .l Digest Algorithm : ISHA‘I ,,l
Country(C) : I State(ST) : I Location(L) : I

» Subject Name Organization(O) - | Organization Unit(OU) -

Common Name(CHN) - | E-mail - |

Challenge Password: | Unstructured Name:
» Extra Attributes I

Enable: [ SCEP Server: | Option — j Add Object |

» SCEP Enrollment CA Certificate: I amit-IDG761AM-IH.crt j CA Encryption Certificate:
| Option --- | (Optional) CA Identifier | (Optional)
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Name

Key

Subject Name

Extra Attributes

SCEP Enrollment

Save
Back

1. String format can be any
text

2. A Must filled setting

A Must filled setting

A Must filled setting

A Must filled setting

A Must filled setting

N/A
N/A

Enter a certificate name. It will be a certificate file name

If Self-signed is checked, it will be signed by root CA. If Self-signed is not
checked, it will generate a certificate signing request (CSR).

This field is to specify the key attributes of certificate.

Key Type to set public-key cryptosystems. Currently, only RSA is supported.

Key Length to set the length in bits of the key used in a cryptographic algorithm.
It can be 512/768/1024/1536/2048.

Digest Algorithm to set identifier in the signature algorithm identifier of
certificates. It can be MD5/SHA-1.

This field is to specify the information of certificate.

Country(C) is the two-letter I1SO code for the country where your organization is
located.

State(ST) is the state where your organization is located.

Location(L) is the location where your organization is located.

Organization(O) is the name of your organization.

Organization Unit(OU) is the name of your organization unit.

Common Name(CN) is the name of your organization.

Email is the email of your organization. It has to be email address setting only.
This field is to specify the extra information for generating a certificate.
Challenge Password for the password you can use to request certificate
revocation in the future.

Unstructured Name for additional information.

This field is to specify the information of SCEP.

If user wants to generate a certificate signing request (CSR) and then signed by
SCEP server online, user can check the Enable box.

Select a SCEP Server to identify the SCEP server for use. The server detailed
information could be specified in External Servers. Refer to Object Definition >
External Server > External Server. You may click Add Object button to
generate, and the settings are the same as those defined in Section 3.4 External
Server.

Select a CA Certificate to identify which certificate could be accepted by SCEP
server for authentication. It could be generated in Trusted Certificates.

Select an optional CA Encryption Certificate, if it is required, to identify which
certificate could be accepted by SCEP server for encryption data information. It
could be generated in Trusted Certificates.

Fill in optional CA Identifier to identify which CA could be used for signing
certificates.

Click the Save button to save the configuration.
When the Back button is clicked, the screen will return to previous page.
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When Import button is applied, an Import screen will appear. You can import a certificate from an existed
certificate file, or directly paste a PEM encoded string as the certificate.

Apply | Cancel

Bl | wmims -

Value setting Description
Import A Must filled setting Select a certificate file from user’s computer, and click the Apply button to
import the specified certificate file to the gateway.
PEM Encoded 1. String format can be any  This is an alternative approach to import a certificate.
text You can directly fill in (Copy and Paste) the PEM encoded certificate string, and
2. A Must filled setting click the Apply button to import the specified certificate to the gateway.
Apply N/A Click the Apply button to import the certificate.
Cancel N/A Click the Cancel button to discard the import operation and the screen will
return to the My Certificates page.
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3.5.3 Trusted Certificate

Trusted Certificate includes Trusted CA Certificate List, Trusted Client Certificate List, and Trusted Client Key
List. The Trusted CA Certificate List places the certificates of external trusted CAs. The Trusted Client
Certificate List places the others' certificates what you trust. And the Trusted Client Key List places the others’
keys what you trusted.

Self-signed Certificate Usage Scenario

Network-A @ HQ Data Center Network-B @ Branch Office

s
&F% :i‘ o ACS
.,- ;’.’ —&57 Server
Application & Database \
Server —L;'D Server

(D Creatg HQ Root (14

S
LY.

VPN Tunnel (IPSec IKE+X.509)O

@ Create Localt RootCA
@Impornt Sranth ¢ | ® CreateIPSec (IKE + X.509) CRT
; —— VPN Tunnel .
Security Gateway 1 Security Gateway 2
with Root CA and Trusted with Trusted CA &
Client Certificates Client Certificates
Global IP: 203.95.80.22 Global IP: 118.18.81.33
Local IP: 10.0.76.2 Local IP: 10.0.75.2

Scenario Application Timing (same as the one described in "My Certificate" section)

When the enterprise gateway owns the root CA and VPN tunneling function, it can generate its own
local certificates by being signed by itself. Also imports the trusted certificates for other CAs and Clients.
These certificates can be used for two remote peers to make sure their identity during establishing a
VPN tunnel.

Scenario Description (same as the one described in "My Certificate" section)

Gateway 1 generates the root CA and a local certificate (HQCRT) signed by itself. Import a trusted
certificate (BranchCRT) —a BranchCSR certificate of Gateway 2 signed by root CA of Gateway 1.

Gateway 2 creates a CSR (BranchCSR) to let the root CA of the Gateway 1 sign it to be the BranchCRT
certificate. Import the certificate into the Gateway 2 as a local certificate. In addition, also imports the
certificates of the root CA of Gateway 1 into the Gateway 2 as the trusted ones. (Please also refer to
"My Certificate" and "Issue Certificate" sections).

Establish an IPSec VPN tunnel with IKE and X.509 protocols by starting from either peer, so that all
client hosts in these both subnets can communicate with each other.

Parameter Setup Example (same as the one described in "My Certificate" section)
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For Network-A at HQ

Following tables list the parameter configuration as an example for the "Trusted Certificate" function
used in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in "My Certificate" and "Issue Certificate"
sections to complete the setup for the whole user scenario.

Configuration Path [Trusted Certificate]-[Trusted Client Certificate List]

Command Button Import

Configuration Path [Trusted Certificate]-[Trusted Client Certificate Import from a File]
File BranchCRT.crt

For Network-B at Branch Office

Following tables list the parameter configuration as an example for the "Trusted Certificate" function
used in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in "My Certificate" and "Issued Certificate"
sections to complete the setup for the whole user scenario.

Configuration Path [Trusted Certificate]-[Trusted CA Certificate List]

Command Button Import

Configuration Path [Trusted Certificate]-[Trusted CA Certificate Import from a File]
File HQRootCA.crt

Configuration Path [Trusted Certificate]-[Trusted Client Certificate List]

Command Button Import

Configuration Path [Trusted Certificate]-[Trusted Client Certificate Import from a File]
File HQCRT.crt

Scenario Operation Procedure (same as the one described in "My Certificate" section)

In above diagram, the "Gateway 1" is the gateway of Network-A in headquarters and the subnet of its
Intranet is 10.0.76.0/24. It has the IP address of 10.0.76.2 for LAN interface and 203.95.80.22 for WAN-
1 interface. The "Gateway 2" is the gateway of Network-B in branch office and the subnet of its
Intranet is 10.0.75.0/24. It has the IP address of 10.0.75.2 for LAN interface and 118.18.81.33 for WAN-
1 interface. They both serve as the NAT security gateways.

In Gateway 2 import the certificates of the root CA and HQCRT that were generated and signed by
Gateway 1 into the "Trusted CA Certificate List" and "Trusted Client Certificate List" of Gateway 2.
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Import the obtained BranchCRT certificate (the derived BranchCSR certificate after Gateway 1’s root
CA signature) into the "Trusted Client Certificate List" of the Gateway 1 and the "Local Certificate List"
of the Gateway 2. For more details, refer to the Network-B operation procedure in "My Certificate"
section of this manual.

Gateway 2 can establish an IPSec VPN tunnel with "Site to Site" scenario and IKE and X.509 protocols to
Gateway 1.

Finally, the client hosts in two subnets of 10.0.75.0/24 and 10.0.76.0/24 can communicate with each
other.
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Trusted Certificate Setting

Go to Object Definition > Certificate > Trusted Certificate tab.

The Trusted Certificate setting allows user to import trusted certificates and keys.

Import Trusted CA Certificate

#* Trusted CA Certificate List |1 [s¢/5¢

Vaild To

When Import button is applied, a Trusted CA import screen will appear. You can import a Trusted CA
certificate from an existed certificate file, or directly paste a PEM encoded string as the certificate.

= Trusted CA Certificate Import from a File | Vi7i]ol\0 | L85 e
2. | FIEIFEE -

* Trusted CA Certificate Import from a PEM | 1ol | 10505

Trusted CA Certificate List

Item Value setting Description

Import from a A Must filled setting Select a CA certificate file from user’s computer, and click the Apply button to

File import the specified CA certificate file to the gateway.

Import from a 1. String format can be any This is an alternative approach to import a CA certificate.

PEM text You can directly fill in (Copy and Paste) the PEM encoded CA certificate string,
2. A Must filled setting and click the Apply button to import the specified CA certificate to the gateway.

Apply N/A Click the Apply button to import the certificate.

Cancel N/A Click the Cancel button to discard the import operation and the screen will

return to the Trusted Certificates page.
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Instead of importing a Trusted CA certificate with mentioned approaches, you can also get the CA certificate
from the SECP server.

If SCEP is enabled (Refer to Object Definition > Certificate > Configuration), you can click Get CA button, a Get
CA Configuration screen will appear.

= Get CA Configuration

Item Setting
» SCEP Sever | | — Option — v || Add Object |
» CA Identifier L | (Optional)

Get CA Configuration

\ Item Value setting Description
SCEP Server A Must filled setting Select a SCEP Server to identify the SCEP server for use. The server detailed
information could be specified in External Servers. Refer to Object Definition >
External Server > External Server. You may click Add Object button to

generate.
CA Identifier 1. String format can be any  Fill in optional CA Identifier to identify which CA could be used for signing
text certificates.
Save N/A Click Save to save the settings.
Close N/A Click the Close button to return to the Trusted Certificates page.

Import Trusted Client Certificate

= Trusted Client Certificate List

Vaild To

When Import button is applied, a Trusted Client Certificate Import screen will appear. You can import a
Trusted Client Certificate from an existed certificate file, or directly paste a PEM encoded string as the
certificate.
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* Trusted Client Certificate Import from a File |/:1s/0l\2 | |[LL&=T 0z

B, | FEIFER -

# Trusted Client Certificate Import from a PEM | /:7s)e} 7| Lo [ex]

Trusted Client Certificate List

\ Item Value setting Description
Import from a A Must filled setting Select a certificate file from user’s computer, and click the Apply button to import the
File specified certificate file to the gateway.
Import from a 1. String format can be any  This is an alternative approach to import a certificate.
PEM text You can directly fill in (Copy and Paste) the PEM encoded certificate string, and click the
2. A Must filled setting Apply button to import the specified certificate to the gateway.
Apply N/A Click the Apply button to import certificate.
Cancel N/A Click the Cancel button to discard the import operation and the screen will return to the
Trusted Certificates page.

Import Trusted Client Key

® Trusted Client Key List [()[v]g [0

1D Name Actions

When Import button is applied, a Trusted Client Key Import screen will appear. You can import a Trusted
Client Key from an existed file, or directly paste a PEM encoded string as the key.
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e

* Trusted Client Key Import from a PEM | /:1e]o\ 2 [L18=][¢E]

Trusted Client Key List

\ Item Value setting Description
Import from a A Must filled setting Select a certificate key file from user’s computer, and click the Apply button to import
File the specified key file to the gateway.
Import from a 1. String format can be any  This is an alternative approach to import a certificate key.
PEM text You can directly fill in (Copy and Paste) the PEM encoded certificate key string, and click
2. A Must filled setting the Apply button to import the specified certificate key to the gateway.
Apply N/A Click the Apply button to import the certificate key.
Cancel N/A Click the Cancel button to discard the import operation and the screen will return to the
Trusted Certificates page.
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Chapter 4 Field Communication (not supported)

Not supported feature for the purchased product, leave it as blank.
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Chapter 5 Security

5.1 VPN

A virtual private network (VPN) extends a private network across a public network, such as the Internet. It
enables a computer to send and receive data across shared or public networks as if it were directly connected
to the private network, while benefitting from the functionality, security and management policies of the
private network. This is done by establishing a virtual point-to-point connection through the use of dedicated
connections, encryption, or a combination of the two. The tunnel technology supports data confidentiality,
data origin authentication and data integrity of network information by utilizing encapsulation protocols,
encryption algorithms, and hashing algorithms.

--------------- .
VPN Concentrator M2M-loT : Multio  Meter )
Gateway | m !

|
Serial Cable : S :
‘m RS 232/485 , i
| 1
VPN Servic ! FRTU/IED !
OpenVPN OpenvP b ' CEER ﬂ I';:- !

I e -
Data over IP Packet | Serial-based devices
Contml ermy via VPN Tunnel I
(“ATM  POS  Host T
VPN Servic : 7 @ |
1 % 1
1 1
1 1
| R
X Digital 1
% T[T e—— signage ]
Appl Ethernet Cable : Ll :
ication
Pspervers RJ-45 i :
. - y
Access & Control Ethernet-based devices

The product series supports different tunneling technologies to establish secure tunnels between multiple
sites for data transferring, such as IPSec, OpenVPN, L2TP (over IPSec), PPTP and GRE. Besides, some advanced
functions, like Full Tunnel, Tunnel Failover, Tunnel Load Balance, NetBIOS over IPSec, NAT Traversal and
Dynamic VPN, are also supported.
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5.1.1 IPSec

Internet Protocol Security (IPSec) is a protocol suite for securing Internet Protocol (IP) communications by
authenticating and encrypting each IP packet of a communication session. IPSec includes protocols for
establishing mutual authentication between agents at the beginning of the session and negotiation of
cryptographic keys to be used during the session.

An IPSec VPN tunnel is established between IPSec client and server. Sometimes, we call the IPSec VPN client as
the initiator and the IPSec VPN server as the responder. This gateway can be configured as different roles and
establish number of tunnels with various remote devices. Before going to setup the VPN connections, you may
need to decide the scenario type for the tunneling.

IPSec Tunnel Scenarios
To build IPSec tunnel, you need to fill in

Network-A @ .
Control Center Network 8 @ remote gateway global IP, and optional
Remote Site . .
Host -DC @} subnet if the hosts behind IPSec peer
. s'rbr!et:.tO‘OJS.x - M2M s;;l:ne.zsz.zss.z.x can access to remote site or hosts.
\ v S it Gat . .
%{ i .~ Gateway Site t ateway, i Under such configuration, there are
................ <1 [ 2.5itetoHost | | s
\ L5 b's_'ﬂos_tt‘oﬂtg_ n g four scenarios:
S 4. Host to Host g ___ — . .
Global IP: 203.8580.52 Responder ————mitiocor] Gebaimiaassras "ot ®|  Site to Site: You need to setup remote
Local IP:10.0.76.253 Local IP: 192.168.1.253
(server) (Client) gateway IP and subnet of both
gateways. After the IPSec tunnel
€-——== > Site to Site: Tunnel between M2M gateway /w 192.168.1.x subnetand UTM /w 10.0.76.x subnet . .
] established, hosts behind both
e > Siteto Host: Tunnel between M2M gateway /w 192.168.1.x subnet and Host-DC under UTM

€— - —> Host to Site: Tunnel between Host-Re under M2M Gateway and UTM /w 10.0.76.x subnet gateways can communication eaCh

<€— — > Hostto Host: Tunnel between Host-Re under M2M Gateway and Host-DC under UTM Other through the tunnel'

Site to Host: Site to Host is suitable for tunneling between clients in a subnet and an application server (host).
As in the diagram, the clients behind the M2M gateway can access to the host "Host-DC" located in the
control center through Site to Host VPN tunnel.

Host to Site: On the contrast, for a single host (or mobile user to) to access the resources located in an
intranet, the Host to Site scenario can be applied.

Host to Host: Host to Host is a special configuration for building a VPN tunnel between two single hosts.

154



4G PoE-WAN Extender

IPSec Setting

Go to Security > VPN > IPSec tab.

The IPSec Setting allows user to create and configure IPSec tunnels.

Enable IPSec

« Configuration ’ %
Item Setting
» IPSec [] Enable
» Max. Concurrent IPSec Tunnels 3
Configuration Window
Item Value setting Description
IPsec Unchecked by default  Click the Enable box to enable IPSec function.
Max. Concurrent Depends on Product The specified value will limit the maximum number of simultaneous IPSec
IPSec Tunnels specification. tunnel connection. The default value can be different for the purchased model.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

Create/Edit IPSec tunnel

Ensure that the IPSec enable box is checked to enable before further configuring the IPSec tunnel settings.

= IPSec Tunnel List

Tunnel Name | Interface Remote Gateway Remote Subnet Enable Actions

When Add/Edit button is applied, a series of configuration screens will appear. They are Tunnel Configuration,
Local & Remote Configuration, Authentication, IKE Phase, IKE Proposal Definition, IPSec Phase, and IPSec
Proposal Definition. You have to configure the tunnel details for both local and remote VPN devices.
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Item

+ Tunnel

+ Tunnel Name

+ Interface

+ Tunnel Scenario
+ Tunnel TCP MSS

+ ICMP Keep alive

+ Encapsulation Protocol

+ IKE Version

Tunnel

Tunnel Name

Interface

Tunnel Scenario

Tunel TCP MSS

ICMP Keep Alive

Encapsulation
Protocol

IKE Version

Setting
Enable
IPSec #1
WAMN-1 ¥
Site-to-Site(Tunnel mode) v
Auto T | [0 (64~1500 Bytes)

Enable Max. fail times |3

ESF ¥
viw

Unchecked by default
1. A Must fill setting

2. String format can be
any text

1. A Must fill setting

2. WAN 1 is selected
by default

1. A Must fill setting
2. Site to site is
selected by default

1. An optional setting
2. Auto is set by
default

1. An optional setting
2. Unchecked by
default

1. A Must fill setting
2. ESP is selected by
default

1. A Must fill setting
2. vl is selected by
default

Interval |30 (secs.) Source Addr. Destination Addr.

Check the Enable box to activate the IPSec tunnel

Enter a tunnel name. Enter a name that is easy for you to identify.
Value Range: 1 ~ 19 characters.

Select the interface on which IPSec tunnel is to be established. It can be the
available WAN and LAN interfaces.

Select an IPSec tunneling scenario from the dropdown box for your application.
Select Site-to-Site, Site-to-Host, Host-to-Site, or Host-to-Host. If LAN interface
is selected, only Host-to-Host scenario is available.

With Site-to-Site or Site-to-Host or Host-to-Site, IPSec operates in tunnel mode.
The difference among them is the number of subnets. With Host-to-Host, IPSec
operates in transport mode.

Select from the dropdown box to define the size of Tunel TCP MSS.

Select Auto, and all devices will adjust this parameter automatically.

Select Manual, and specify an expected vaule for Tunel TCP MSS.

Value Range: 64 ~ 1500 bytes.

Check the Enable box to activate the ICMP keep alive function for the tunnel.

If the keep alive function is enabled, you have to define the numner of fail trials,
check interval, and source/destination IP address for the ICMP packets.

Value Range: 1~999 for fail trials and time interval.

Select the Encapsulation Protocol from the dropdown box for this IPSec tunnel.
Available encapsulations are ESP and AH.

Specify the IKE version for this IPSec tunnel. Select v1 or v2.
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= Local & Remote Configuration

Item Setting
1D Subnet IP Address Subnet Mask Actions
» Local Subnet List 1 [192.168.660 | [ Delete |
Add
D Subnet IP Address Subnet Mask Actions
» Remote Subnet List 1 . [ Delete |
» Remote Gateway [ 1 up addressiFoDN)

Local & Remote Configuration Window

Item Value setting Description
Specify the Local Subnet IP address and Subnet Mask.
Click the Add or Delete button to add or delete a Local Subnet.

. . Note_1: When Dynamic VPN option in Tunnel Scenario is selected, there will be
. A Must fill setting .
Local Subnet List only one subnet available.
Note_2: When Host-to-Site or Host-to-Host option in Tunnel Scenario is
selected, Local Subnet will not be available.
Note_3: When Hub and Spoke option in Hub and Spoke is selected, there will be
only one subnet available.
Specify the Remote Subnet IP address and Subnet Mask.
Click the Add or Delete button to add or delete Remote Subnet setting.

Remote Subnet List A Must fill setting

1. A Must fill setting.
Remote Gateway 2. Format can be a Specify the Remote Gateway.
ipv4 address or FQDN

ltem Setting
» Key Management |IKE+Pre-shared Key v | | | (Min. 8 characters)
» Local ID Type: |UserName v | |D: (Optional)
» Remote 1D Type: [UserMame v | D: [ |

Authentication Configuration Window

Item Value setting Description
Select Key Management from the dropdown box for this IPSec tunnel.
1. A Must fill setting IKE+Pre-shared Key: user needs to set a key (8 ~ 32 characters).
Key Management 2. Pre-shared Key 8 to  IKE+X.509: user needs Certificate to authenticate. IKE+X.509 will be available
32 characters. only when Certificate has been configured properly. Refer to Certificate section

of this manual and also Object Definition > Certificate in web-based utility.

Specify the Local ID for this IPSec tunnel to authenticate.

Select User Name for Local ID and enter the username. The username may
Local ID An optional setting include but can’t be all numbers.

Select FQDN for Local ID and enter the FQDN.

Select User@FQDN for Local ID and enter the User@FQDN.

157



4G PoE-WAN Extender

Select Key ID for Local ID and enter the Key ID (English alphabet or number).
Specify the Remote ID for this IPSec tunnel to authenticate.
Select User Name for Remote ID and enter the username. The username may

include but can’t be all numbers.

Select FQDN for Local ID and enter the FQDN.

Select User@FQDN for Remote ID and enter the User@FQDN.

Select Key ID for Remote ID and enter the Key ID (English alphabet or number).
Note: Remote ID will be not available when Dynamic VPN option in Tunnel
Scenario is selected.

Remote ID An optional setting

ltem Setting
» Megotiation Mode Main Mode v
v ¥-Auth None ¥ || X-Auth Account |(Optional)
UserName: [ | Password: [ |
» Dead FeerDetecton (DFD) %n‘ﬂ)ﬁl? (seconds) Delay: [30 | (seconds)
» Phase Key Life Time [3800 | (seconds) (Max. 86400}

IKE Phase Window

\ Item Value setting Description
Negotiation Mode Main Mode is set by Specify the Negotiation Mode for this IPSec tunnel. Select Main Mode or
default default Aggressive Mode.

Specify the X-Auth role for this IPSec tunnel. Select Server, Client, or None.
Selected None no X-Auth authentication is required.
Selected Server this gateway will be an X-Auth server. Click on the X-Auth
None is selected by Account button to create remote X-Auth client account.
default Selected Client this gateway will be an X-Auth client. Enter User name and
Password to be authenticated by the X-Auth server gateway.
Note: X-Auth Client will not be available for Dynamic VPN option selected in
Tunnel Scenario.

X-Auth

. 1. Checked by default Click Enable box to enable DPD function. Specify the Timeout and Delay time in
Dead Peer Detection )
(DPD) 2. Default Timeout seconds.
180s and Delay 30s Value Range: 0 ~ 999 seconds for Timeout and Delay.
1. A Must fill setting
2. Default 3600s
3. Max. 86400s

« IKE Proposal Definition

Phasel Key Life
Time

Specify the Phasel Key Life Time.
Value Range: 30 ~ 86400.

[[n] Encryption Authentication DH Group Definition
1 [AES-128 7] SHAT v [Group2 v] [# Enable
2 MD5 v ¥ Enable
3 SHAT v 4 Enzble
4 [3DES | [SHA1 v [Group2 v # Enable

IKE Proposal Definition Window
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Item Value setting Description

Specify the Phase 1 Encryption method. It can be DES / 3DES / AES-128 / AES-
192 / AES-256.

Specify the Authentication method. It can be None / MD5 / SHA1 / SHA2-256.
IKE Proposal

Definition A Must fill setting

Specify the DH Group. It can be None / Groupl / Group2 / Group5 / Groupl14 /
Group15 / Group16 / Group17 / Group18.

Check Enable box to enable this setting

» Phase2 Key Life Time |288{]I] | (seconds) (Max. 86400)

\ IPSec Phase Window

Item Value setting Description

1. A Must fill setting
Phase2 Key Life 2.28800s is set by Specify the Phase2 Key Life Time in second.
Time default Value Range: 30 ~ 86400.

3. Max. 86400s

= IPSec Proposal Definition

[[n]} Encryption Authentication PFS Group Definition
1 AES-128 v SHA1 A # Enable
2 AES-128 v MD5 v # Enable
3 DES v SHA1 v # Enable
4 [3DES | | SHA1 v # Enable

IPSec Proposal Definition Window

Item Value setting Description
Specify the Encryption method. It can be DES / 3DES / AES-128 / AES-192 / AES-
256.
Note: None is available when Encapsulation Protocol is set as AH.

Specify the Authentication method. It can be None / MD5 / SHA1 / SHA2-256.
IPSec Proposal Note: None and SHA2-256 are available only when Encapsulation Protocol is set

.. A Must fill setting . .
Definition as ESP; they are not available for AH Encapsulation.

Specify the PFS Group. It can be None / Groupl / Group2 / Group5 / Group14 /
Group15 / Group16 / Group17 / Group18.

Click Enable to enable this setting
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
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Back N/A Click Back to return to the previous page.
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5.1.2 OpenVPN

OpenVPN is an application that implements virtual private network (VPN) techniques for creating secure
point-to-point or site-to-site connections in routed or bridged configurations and remote access facilities. It
uses a custom security protocol that utilizes SSL/TLS for key exchange. It is capable of traversing network
address translators (NATs) and firewalls.

OpenVPN allows peers to authenticate each other using a Static Key (pre-shared key) or certificates. When
used in a multi-client-server configuration, it allows the server to release an authentication certificate for
every client, using signature and certificate authority. It uses the OpenSSL encryption library extensively, as
well as the SSLv3/TLSv1 protocol, and contains many security and control features.

OpenVPN Tunneling is a Client and Server based tunneling technology. The OpenVPN Server must have a
Static IP or a FQDN, and maintain a Client list. The OpenVPN Client may be a mobile user or mobile site with
public IP or private IP, and requesting the OpenVPN tunnel connection. The product can only behave as a
OpenVPN Client role for an OpenVPN tunnel connection.

There are two OpenVPN connection scenarios. They are the TAP and TUN scenarios. The product can create
either a layer-3 based IP tunnel (TUN), or a layer-2 based Ethernet TAP that can carry any type of Ethernet
traffic. In addition to configuring the device as a Server or Client, you have to specify which type of OpenVPN
connection scenario is to be adopted.

OpenVPN TUN Scenario

[ NetworkA@ Gontrol Ceter | ——— [ Networks @ Remotesie | The term "TUN" mode is referred to routing mode and
= wﬂigia — operates with layer 3 packets. In routing mode, the VPN

sl o

& S fodirect | ) client is given an IP address on a different subnet than

hd . edirect .. - . .
scaoa . | Meplaton | Enabled .~~~ the local LAN under the OpenVPN server. This virtual
6 i subnet is created for connecting to any remote VPN

computers. In routing mode, the OpenVPN server

e e e = -

VPN Gateway/Concentrator| n n o . .
with 3 “Static P or AFODN- | icoess from M2M-1oT Gateway creates a "TUN" interface with its own IP address pool
and RootCA. with "Public/Private IP” | - \which is different to the local LAN. Remote hosts that
OpenVPN TUN Server OpenVPNTUN Client . . . . . .
GW  Global IP: 60249.211.108 GW: WAN IP: 192.168.168.111 dial-in will get an IP address inside the virtual network
FQDN : main-gw.ddns.net LAN IP: 192.168.123.254 VPN IP: 10.8.0.2 .
Local IP: 192.168.100.100 ne: ;19216812221 veneitos022  and will have access only to the server where OpenVPN
1. M2M-loT Gateway (as OpenVPN TUN Client) connects to peer VPN resides_

Gateway/Concentrator (as OpenVPN TUN Server).
2. M2M-loT Gateway will be assigned 10.8.0.2 IP Address after OpenVPNTUN

Connection estabilshed. (10.8.0xis a virtual subnet) If you want to offer remote access to a VPN server from

3. local networked device will get a virtual IP 10.8.0.x if its trafficgoes through the
OpenVPN TUN connection (when NAT disabled & Redirect Internet Traffic enabled). CIient(S), and inhibit the access to remote LAN resources

4. SCADA Serverin Control Center can access remote attached device(s) with the

assigned [P Address 10.8.0.2. under VPN server, OpenVPN TUN mode is the simplest
solution.

As shown in the diagram, the M2M-loT Gateway is configured as an OpenVPN TUN Client, and connects to an
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OpenVPN UN Server. Once the OpenVPN TUN connection is established, the connected TUN client will be
assigned a virtual IP (10.8.0.2) which is belong to a virtual subnet that is different to the local subnet in Control
Center. With such connection, the local networked devices will get a virtual IP 10.8.0.x if its traffic goes
through the OpenVPN TUN connection when Redirect Internet Traffic settings is enabled; Besides, the SCADA
Server in Control Center can access remote attached serial device(s) with the virtual IP address (10.8.0.2).

OpenVPN TAP Scenario
'S S ';j
SCADA \\ N Serial Cable
tane Application
\ servers (( ))
8
Admin User;
-(.. — _ _ OpenVPN TAP D 5
VPN Gateway/Concentrator
with a “Static IP” or “FQDN” M2M-loT Gateway
and RootCA. with a “Public or
OpenVPN TAP Server Private IP”
GW  Global IP: 60.249.211.108 OpenVPNTAP Client
FQDN : main-gw.ddns.net WAN IP: 192.168.168.111

Local IP: 192.168.100.100 Local IP: 192.168.123.254

1. M2M-loT Gateway (as OpenVPN TAP Client) connects to peer VPN
Gateway/Concentrator (as OpenVPN TAP Server).

2. M2M-loT Gateway will be assigned 192.168.100.210 IP Address after
OpenVPN TAP Connection estabilshed. (same subnetasin Control Center)

3. SCADA Serverin Control Center can access remote attached device(s) with
the assigned IP Address 192.168.100.210.

The term "TAP" is referred to bridge mode and operates
with layer 2 packets. In bridge mode, the VPN client is
given an IP address on the same subnet as the LAN
resided under the OpenVPN server. Under such
configuration, the OpenVPN client can directly access to
the resources in LAN. If you want to offer remote access
to the entire remote LAN for VPN client(s), you have to
setup OpenVPN in “TAP” bridge mode.

As shown in the diagram, the M2M-loT Gateway is
configured as an OpenVPN TAP Client, and connects to an
OpenVPN TAP Server. Once the OpenVPN TAP connection
is established, the connected TAP client will be assigned a
virtual IP (192.168.100.210) which is the same subnet as

that of local subnet in Control Center. With such connection, the SCADA Server in Control Center can access
remote attached serial device(s) with the virtual IP address (192.168.100.210).
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Open VPN Setting

Go to Security > VPN > OpenVPN tab.

The OpenVPN setting allows user to create and configure OpenVPN tunnels.

Enable OpenVPN
= Configuration ’ *®
Item Setting
» OpenVPN [_] Enable
» Client
¥ OpenVPN Configuration file Enabl

Configuration

Item Value setting Description

OpenVPN The box is unchecked by Check the Enable box to activate the OpenVPN function.

default
Client Client is selected by Only Client is available, you can specify the client settings in another client

default. configuration window.
OpenVPN 1. An Optional setting. Click the Enable box to activate the OpenVPN Client configuration via a pre-
Configuration 2. The box is unchecked by  defined .ovpn configuration file. You have to further click the Upgrade button
file default. to upload the configuration from a .ovpn file.

If you enabled this function, you can’t add any OpenVPN clients manually.

Create/Edit OpenVPN Client

= OpenVPN Client List JERE]

ﬁﬁgir?:: NAT Autherization | Encryption

Traffic Mode Cipher

Remote | Remote

Algorithm Enable | Actions

When Add button is applied, OpenVPN Client Configuration screen will appear. OpenVPN Client Configuration
window let you specify the required parameters for an OpenVPN VPN client, such as "OpenVPN Client Name",
"Interface", "Protocol", "Tunnel Scenario", "Remote IP/FQDN", "Remote Subnet", "Authorization Mode",
"Encryption Cipher", "Hash Algorithm" and tunnel activation.
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Item

» OpenVPN Client Name
b Interface
+ Protocol
» Tunnel Scenario
» Remote IP/FQDN

Remote Subnet
+ Redirect Internet Traffic

¥ MAT
» Authorization Mode

» Encryption Cipher

» Hash Algorithm

¥ LZ0 Compression

7]
5]

rsist Key

P
P

2]
5]
o

t Tun
» Advanced Configuration

» Tunne|

Setting

OpenVPN Client #1

WAN 1
TCP r
TUN ¥

Enable 255.255

v

Port: (443

Enable

# Enable

TLS
CA Cert

v

© | v | Client Cert: | v | ClientKey: | ¥ | Please set the Certificate.

Blowfish ¥

SHA-1

v

Adaptive ¥

# Enable

¥ Enable

Edit

Enable

OpenVPN Client
Name
Interface

Protocol

Port

Tunnel Scenario

Remote IP/FQDN

Remote Subnet

Redirect Internet

Traffic

NAT

A Must filled setting

1. A Must filled setting
2. By default WAN-1 is
selected.

1. A Must filled setting
2. By default TCP is
selected.

1. A Must filled setting
2. By default 443 is
set.

1. A Must filled setting
2. By default TUN is
selected.

A Must filled setting

1. An Optional setting.
2. The box is

unchecked by default.
1. An Optional setting.
2. The box is

unchecked by default.
1. An Optional setting.

The OpenVPN Client Name will be used to identify the client in the tunnel list.
Value Range: 1 ~ 32 characters.
Define the physical interface to be used for this OpenVPN Client tunnel.

Define the Protocol for the OpenVPN Client.

e Select TCP

->The OpenVPN will use TCP protocol, and Port will be set as 443 automatically.
e Select UDP

->The OpenVPN will use UDP protocol, and Port will be set as 1194
automatically.

Specify the Port for the OpenVPN Client to use.

Value Range: 1 ~ 65535.

Specify the type of Tunnel Scenario for the OpenVPN Client to use. It can be
TUN for TUN tunnel scenario, or TAP for TAP tunnel scenario.

Specify the Remote IP/FQDN of the peer OpenVPN Server for this OpenVPN
Client tunnel.

Fill in the IP address or FQDN.

Check the Enable box to activate remote subnet function, and specify Remote
Subnet of the peer OpenVPN Server for this OpenVPN Client tunnel.

Fill in the remote subnet address and remote subnet mask.

Check the Enable box to activate the Redirect Internet Traffic function.

Check the Enable box to activate the NAT function.
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Authorization Mode

Local Endpoint IP
Address

Remote Endpoint IP
Address

Static Key

Encryption Cipher
Hash Algorithm
LZO Compression

Multicast

Persis Key

Persis Tun

Advanced
Configuration

Tunnel

Save
Undo

2. The box is checked
by default.

1. A Must filled setting
2. By default TLS is
selected.

A Must filled setting

A Must filled setting

A Must filled setting

By default Blowfish is
selected.

By default SHA-1 is
selected.

By default Adaptive is
selected.

1. An Optional setting.
2. The box is checked
by default.

1. An Optional setting.
2. The box is checked
by default.

1. An Optional setting.
2. The box is checked
by default.

N/A

The box is unchecked
by default

N/A

N/A

Specify the authorization mode for the OpenVPN Server.

o TLS

->The OpenVPN will use TLS authorization mode, and the following items CA
Cert., Client Cert. and Client Key will be displayed.

CA Cert. could be selected in Trusted CA Certificate List. Refer to Object
Definition > Certificate > Trusted Certificate.

Client Cert. could be selected in Local Certificate List. Refer to Object Definition
> Certificate > My Certificate.

Client Key could be selected in Trusted Client key List. Refer to Object Definition
> Certificate > Trusted Certificate.

e StaticKey

->The OpenVPN will use static key authorization mode, and the following items
Local Endpoint IP Address, Remote Endpoint IP Address and Static Key will be
displayed.

Specify the virtual Local Endpoint IP Address of this OpenVPN gateway.

Value Range: The IP format is 10.8.0.x, the range of x is 1~254.

Note: Local Endpoint IP Address will be available only when Static Key is chosen
in Authorization Mode.

Specify the virtual Remote Endpoint IP Address of the peer OpenVPN gateway.
Value Range: The IP format is 10.8.0.x, the range of x is 1~254.

Note: Remote Endpoint IP Address will be available only when Static Key is
chosen in Authorization Mode.

Specify the Static Key.

Note: Static Key will be available only when Static Key is chosen in Authorization
Mode.

Specify the Encryption Cipher.

It can be Blowfish/AES-256/AES-192/AES-128/None.

Specify the Hash Algorithm.

It can be SHA-1/MD5/MD4/SHA2-256/SHA2-512/None/Disable.

Specify the LZO Compression scheme.

It can be Adaptive/YES/NO/Default.

Check the Enable box to activate the Multicast function.

Note: Multicast function is only available for TAP tunnel scenario.
Check the Enable box to activate the Persis Key function.

Check the Enable box to activate the Persis Tun function.

Click the Edit button to specify the Advanced Configuration setting for the
OpenVPN server.

If the button is clicked, Advanced Configuration will be displayed below.

Check the Enable box to activate this OpenVPN tunnel.

Click Save to save the settings.
Click X to cancel the changes and return to last page.
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When Advanced Configuration is selected, an OpenVPN Client Advanced Configuration screen will appear.

» TLS Cipher

¥ User Name(Optional)
¥ Pazsword(Optional)
» Bridge TAF to

¥ Firewall Protection

b Client IP Address

b Tunnel MTU

» Tunnel UDP Fragment

» Tunnel UDP MSS-Fix

r nsCertType Verification

r DNS

» Additional Configuration

Item

» TLS Auth. Key(Opfional)

» TLS Renegofiation Time(seconds)

» Connection Refry(seconds)

None

Setting

#\(Optional)
(Cptional)
(Optional)

VLAN 1 ¥

Enable

Dynamic I[P *

1500
1500

Enable
Enable
3600
-1

(seconds)

(seconds)

Automatically ¥

TLS Cipher

TLS Auth. Key

User Name

Password

Bridge TAP to

Firewall Protection

1. A Must filled setting.
2. TLS-RSA-WITH-
AES128-SHA is selected
by default

1. An Optional setting.
2. String format: any text

An Optional setting.

An Optional setting.

By default VLAN 1 is
selected

The box is unchecked by
default.

Specify the TLS Cipher from the dropdown list.

It can be None / TLS-RSA-WITH-RC4-MD5 / TLS-RSA-WITH-AES128-SHA / TLS-
RSA-WITH-AES256-SHA / TLS-DHE-DSS-AES128-SHA / TLS-DHE-DSS-AES256-
SHA.

Note: TLS Cipher will be available only when TLS is chosen in Authorization
Mode.

Specify the TLS Auth. Key for connecting to an OpenVPN server, if the server
required it.

Note: TLS Auth. Key will be available only when TLS is chosen in Authorization
Mode.

Enter the User account for connecting to an OpenVPN server, if the server
required it.

Note: User Name will be available only when TLS is chosen in Authorization
Mode.

Enter the Password for connecting to an OpenVPN server, if the server
required it.

Note: User Name will be available only when TLS is chosen in Authorization
Mode.

Specify the setting of “Bridge TAP to” to bridge the TAP interface to a certain
local network interface or VLAN.

Note: Bridge TAP to will be available only when TAP is chosen in Tunnel
Scenario and NAT is unchecked.

Check the box to activate the Firewall Protection function.

Note: Firewall Protection will be available only when NAT is enabled.
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Client IP Address

Tunnel MTU

Tunnel UDP
Fragment

Tunnel UDP MSS-
Fix

nsCerType
Verification

TLS Renegotiation
Time (seconds)
Connection
Retry(seconds)

DNS

Additional
Configuration
Save

Undo

By default Dynamic IP is
selected

1.A Must filled setting
2.The value is 1500 by
default

The value is 1500 by
default

The box is unchecked by
default.

The box is unchecked by
default.

The value is 3600 by
default
The value is -1 by default

By default Automatically
is selected

An Optional setting.

N/A
N/A

Specify the virtual IP Address for the OpenVPN Client.
It can be Dynamic IP/Static IP.

Specify the value of Tunnel MTU.

Value Range: 0 ~ 1500.

Specify the value of Tunnel UDP Fragment.

Value Range: 0 ~ 1500.

Note: Tunnel UDP Fragment will be available only when UDP is chosen in
Protocol.

Check the Enable box to activate the Tunnel UDP MSS-Fix function.

Note: Tunnel UDP MSS-Fix will be available only when UDP is chosen in
Protocol.

Check the Enable box to activate the nsCerType Verification function.

Note: nsCerType Verification will be available only when TLS is chosen in
Authorization Mode.

Specify the time interval of TLS Renegotiation Time.

Value Range: -1 ~ 86400.

Specify the time interval of Connection Retry.

The default -1 means that it is no need to execute connection retry.

Value Range: -1 ~ 86400, and -1 means no retry is required.

Specify the setting of DNS.

It can be Automatically/Manually.

Enter optional configuration string here. Up to 256 characters is allowable.
Value Range: 0 ~ 256characters.

Click Save to save the settings.

Click X to cancel the changes and return to last page.
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Item Setting
¥ L2TF Enable
v Client Client
Item Setting
¥ LZTP Client Enable
- Add || Delete || Refres
1D Tunnel Name Interface Virtual IP IIE?I%ESE Remote Subnet Status Enable Actions

Layer 2 Tunneling Protocol (L2TP) is a tunneling protocol used to support virtual private networks (VPNs) or as
part of the delivery of services by ISPs. It does not provide any encryption or confidentiality by itself. Rather, it
relies on an encryption protocol that it passes within the tunnel to provide privacy. This Gateway can only
behave as a L2TP client for a L2TP VPN tunel.

L2TP Client: It can be mobile users or gateways in remote offices with dynamic IP. To setup tunnel, it should
get “user name”, “password” and server’s global IP. In addition, it is required to identify the operation mode
for each tunnel as main connection, failover for another tunnel, or load balance tunnel to increase overall
bandwidth. It needs to decide “Default Gateway” or “Remote Subnet” for packet flow. Moreover, you can also
define what kind of traffics will pass through the L2TP tunnel in the “Default Gateway / Remote Subnet”
parameter.

Network-A @ HQ Data Center Network-B @ Remote Office BeSldeS, for the L2TP Cllent peer’ a RemOte

i w@gﬁ% Subnet item is required. It is for the Intranet
pplication " lickr .
server Datsbase T ey of L2TP server peer. So, at L2TP client peer,

the packets whose destination is in the
dedicated subnet will be transferred via the

Security - M2M L2TP tunnel. Others will be transferred based
Gateway Gateway . I f h
“Static|P” : ! "y “Dynamic IP” on current routing policy of the gateway at
GIDbaIIP:ZDS.QS.BB.ZZ\ N - - 1 = = Global IP: 118.18.81.33 L2TP CIlent peer' BUt’ If you entered O'O'O'O/O
Local IP:10.0.76.2 Local IP:10.0.75.2 in the Remote Subnet field, it will be treated
[L2TP]-[L2TP Server Configuration] Create tunnel by Client, [L2TP]-[L2TP Client Configuration] n m .
1P over PSecs 1 Aithentication by Sarver. [ 0o ararion Mo e s o as a "Default Gateway" setting for the L2TP
Enable Preshare Key, 12345678 . " L2TP IPSeac: Enable H H H
SenrerIVirtual IP::dSZ.IE&IDJ.E.? 2 #ﬁmeerl?:izlagtne:{nualm Presh:\:rkey:ell:l.‘l:;ﬁ?lﬁ Cllent peer' a” paCketS, InCIUdIng the Internet
IP P S ing A 110 5
e e e ; Cllentaubnetcan scess | Remote UISIPFQDN:203.95.80.22 accessing of L2TP client peer, will go through
Authentication Protacol: Ms-cHap |~ HQservervia tunnel User Name: Client-1 the established L2TP tunnel. That means the
MPPE Encryption: Enable, 128 bits Internet packets go through | Password: 1234
Service Port: 1701 4 Tunnel if "Default Gateway” | Remote Subnet: 10.0.76.0/24 remote L2TP server peer controls the flow of
D1: option Is enabled. Authentication Protocol: MS-CHAP k f h LZTP I
R MPPE Encryption: Enable,128bies | ANy Ppackets from the client peer.
Password: 1234 Service Port: Auto
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Certainly, those packets come through the L2TP tunnel.

L2TP Setting

Go to Security > VPN > L2TP tab.

The L2TP setting allows user to create and configure L2TP tunnels.

Enable L2TP

= Configuration a %
Item Setting
b L2TP [l Enable
b Client
Value setting Description
L2TP Unchecked by default  Click the Enable box to activate L2TP function.
. . . Specify the role of L2TP. Only Client role is available for this gateway. Below are
Client A Must filled setting ) . . .
the configuration windows for L2TP Client.

Save N/A Click Save button to save the settings

As a L2TP Client

@] L2TP Client Configuration ' ®

Item Setting

» L2TP Client L Enable

Value setting Description
L2TP Client The box is unchecked
Check the Enable box to enable L2TP client role of the gateway.
by default
Save N/A Click Save button to save the settings.
Undo N/A Click Undo button to cancel the settings.

Create/Edit L2TP Client
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R - [ oo | - I - | -

[n] Tunnel Name Interface Virtual IP IE?I%%:I Remote Subnet Status Enable Actions

1 L2TP #1 WAN 1 0000 |192.168.127.72 0 Select

When Add/Edit button is applied, a series of configuration screen will appear. You can add up to 8 L2TP
Clients.

= L2TP Client Configuration

Item Setting
» Tunnel Name |L2TP #1 |
» Interface WANT v
» L2TP over IPsec [ Enable Preshared Key | | (Min. 8 characters)
» Remote LNS IP/FQDN L 1
» MTU
+ Remote LNS Port [1701
» User Mame |:|
» Password [ ]
» Tunneling Password (Optional) | |
+ Remote Subnet |:|
» Authentication Protocol [0 PAP O CHAP O MS-CHAP [0 MS-CHAF v2
» MPPE Encryption [ Enable
» NAT before Tunneling ) Enable

Auto v

> LCP Echo Type Interval 30 | seconds Max Fallure Time [§ | times
» Service Port | Auto | o |
» Tunnel [CJ) Enable

L2TP Client Configuration

Item Setting Value setting Description
Enter a tunnel name. Enter a name that is easy for you to identify.

Tunnel Name A Must filled setting
Value Range: 1 ~ 32 characters.

Define the selected interface to be the used for this L2TP tunnel
Interface A Must filled setting (WAN-1 is available only when WAN-1 interface is enabled)
The same applies to other WAN interfaces (e.g. WAN-2).
The box is unchecked Check the Enable box to activate L2TP over IPSec, and further specify a Pre-

L2TP over IPSec

by default shared Key (8~32 characters).
Remote LNS . . .
IP/FQDN A Must filled setting Enter the public IP address or the FQDN of the L2TP server.

1.A Must filled setting .

. Specify the MTU.
MTU 2.The value is 1500 by
Value Range: 0 ~ 1500.

default

Remote LNS Port 1. A Must filled setting  Enter the Remote LNS Port for this L2TP tunnel.
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User Name

Password

Tunneling
Password(Optional)

Remote Subnet

Authentication
Protocol

MPPE Encryption

NAT before
Tunneling

LCP Echo Type

Service Port

Tunnel

2.1701 is set by
default

A Must filled setting

A Must filled setting

An Optional filled
setting

A Must filled setting

1. A Must filled setting
2. Unchecked by
default

1. Unchecked by
default

2. an optional setting

1. A Must filled setting
2. Unchecked by
default

1. Auto is set by
default

A Must filled setting

Unchecked by default

Value Range: 1 ~ 65535.

Enter the User Name for this L2TP tunnel to be authenticated when connect to
L2TP server.

Value Range: 1 ~ 32 characters.

Enter the Password for this L2TP tunnel to be authenticated when connect to
L2TP server.

Enter the Tunneling Password for this L2TP tunnel to authenticate.

Specify the remote subnet for this L2TP tunnel to reach L2TP server.

The Remote Subnet format must be IP address/netmask (e.g. 10.0.0.2/24).

It is for the Intranet of L2TP VPN server. So, at L2TP client peer, the packets
whose destination is in the dedicated subnet will be transferred via the L2TP
VPN tunnel. Others will be transferred based on current routing policy of the
security gateway at L2TP client peer.

If you entered 0.0.0.0/0 in the Remote Subnet field, it will be treated as a
default gateway setting for the L2TP client peer, all packets, including the
Internet accessing of L2TP Client peer, will go through the established L2TP VPN
tunnel. That means the remote L2TP VPN server controls the flow of any
packets from the L2TP client peer. Certainly, those packets come through the
L2TP VPN tunnel.

Specify one ore multiple Authentication Protocol for this L2TP tunnel.
Available authentication methods are PAP / CHAP / MS-CHAP / MS-CHAP v2.

Specify whether L2TP server supports MPPE Protocol. Click the Enable box to
enable MPPE.

Note: when MPPE Encryption is enabled, the Authentication Protocol PAP /
CHAP options will not be available.

Specify whether NAT is required or not for this L2TP tunnel.

Specify the LCP Echo Type for this L2TP tunnel. It can be Auto, User-defined, or
Disable.

Auto: the system sets the Interval and Max. Failure Time.

User-defined: enter the Interval and Max. Failure Time. The default value for
Interval is 30 seconds, and Maximum Failure Times is 6 Times.

Disable: disable the LCP Echo.

Value Range: 1 ~ 99999 for Interval Time, 1~999 for Failure Time.

Specify the Service Port for this L2TP tunnel to use. It can be Auto, (1701) for
Cisco), or User-defined.

Auto: The system determines the service port.

1701 (for Cisco): The system use port 1701 for connecting with CISCO L2TP
Server.

User-defined: Enter the service port. The default value is 0.

Value Range: 0 ~ 65535.

Check the Enable box to enable this L2TP tunnel.
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Save N/A Click Save button to save the settings.
Undo N/A Click X button to cancel the settings and back to last page.
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Item Setting
» PPTP Enable
» Client Client
Item Setting
» PPTP Client Enable
- Add Delete Refres
ID Tunnel Name Interface Virtual IP IE?E?]ES?'«I Remote Subnet Status Enable Actions

Point-to-Point Tunneling Protocol (PPTP) is a method for implementing virtual private networks. PPTP uses a
control channel over TCP and a GRE tunnel operating to encapsulate PPP packets. It is a client-server based
technology. There are various levels of authentication and encryption for PPTP tunneling, usually natively as
standard features of the Windows PPTP stack. The security gateway can only play "PPTP Client" role for a PPTP
VPN tunnel. PPTP tunnel process is nearly the same as L2TP.

PPTP Client: It can be mobile users or gateways in remote offices with dynamic IP. To setup tunnel, it should
get “user name”, “password” and server’s global IP. In addition, it is required to identify the operation mode
for each tunnel as main connection, failover for another tunnel, or load balance tunnel to increase overall
bandwidth. It needs to decide “Default Gateway” or “Remote Subnet” for packet flow. Moreover, you can also
define what kind of traffics will pass through the PPTP tunnel in the “Default Gateway / Remote Subnet”

parameter.

Network-A @ HQ Data Center ﬁﬂ Network-B @ Remote Office BeSideS/ for the PPTP C“ent peer; a RemOte
Application 2 Subnet item is required. It is for the Intranet

Database o Ba of PPTP server peer. So, at PPTP client peer,
the packets whose destination is in the
dedicated subnet will be transferred via the

Security Nt === === — = i - M2M PPTP tunnel. Others will be transferred based
Gateway 7 o ----EELE.I‘!WFJ_--.{ > Gateway . .
“staticIP” B : iy “Dynamic 1P on current routing policy of the gateway at
erver |EI‘I . .
GIDbaIIP:ZDS.BS.SD.ZZ\ e 1 = = Global IP: 118.18.81.33 PPTP Cllent peer' BUt’ If you entered 0000/0
Local IP: 10.0.76.2 Local IP: 10.0.75.2

in the Remote Subnet field, it will be treated
as a "Default Gateway" setting for the PPTP

[PPTP]-[PPTP Server Configuration] [PPTP]-[PPTP Client Configuration]

1 Create tunnel by Client,

Server Virtual IP; 192.168.101.253 Authentication by Server. | go0 2tion Mode: Always on
IP Pool Starting Address: 10 2 Server assign Virtual IP, Remote IP/FQDN: 203.95.80.22 client peer' a” packets’ including the |nternet
IP Pool Ending Address: 50 Tunnel created. User Name: Client-1 f | ” h h
Authentication Protocol: MS-CHAP . Password: 1234 i i i
MPPE Encryption: Enable, 128 bits 3 EIE;:::::"‘::::LI""::T“ Remote Subnet: 10.0.76.0/24 acceSSIng O PPTP client peer’ Wi go t roug

: Authentication: MS-CHAP the established PPTP tunnel. That means the
1D1: ) Internet packets go through = MPPE Encryption: Enable, 128 bits
User Name: Client-1 4 Tunnel if “Default Gateway” remote PPTP server peer controls the flow of

Password: 1234 option Is bled

173



4G PoE-WAN Extender

any packets from the PPTP client peer. Certainly, those packets come through the PPTP tunnel.

PPTP Setting

Go to Security > VPN > PPTP tab.

The PPTP setting allows user to create and configure PPTP tunnels.

Enable PPTP

= Configuration a ®
Item Setting
» PPTP [ Enable
 Cien
\ Enable PPTP Window \

Item Value setting Description

PPTP Unchecked by default  Click the Enable box to activate PPTP function.

. Specify the role of PPTP. Only Client role is available for this gateway. Below are
Client A Must fill setting pectty . . . Y . & Y
the configuration windows for PPTP Client.

Save N/A Click Save button to save the settings.

As a PPTP Client

= PPTP Client Configuration . n

Item Setting

» PPTP Client - Enable

PPTP Client Configuration

Item Value setting Description

PPTP Client Unchecked by default ~ Check the Enable box to enable PPTP client role of the gateway.
Save N/A Click Save button to save the settings.

Undo N/A Click Undo button to cancel the settings.

Create/Edit PPTP Client
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= PPTP Chent List & Status .l I Delete | Refresh
ID Tunnel Name Interface Virtual IP “RJ?I%%ﬁ Remote Subnet Status Enable Actions

When Add/Edit button is applied, a series PPTP Client Configuration will appear.

* PPTP Client Configuration

Item Setting
» Tunnel Name |PPTP #1 |
¥ Interface
» Remote IP/FQDN L ]
» MTU
¥ User Name l:l
» Password [ ]

L ]

[ PAP [ CHAP [ MS-CHAP [ MS-CHAP v2

» Remote Subnet

» Authentication Protocol

» MPPE Encryption [l Enable
» NAT before Tunneling (1] Enable
Auto v
> LCP Echo Type Interval seconds Max. Failure Time D times
+ Tunnel ] Enable

PPTP Client Configuration Window

Description

Enter a tunnel name. Enter a name that is easy for you to identify.
Value Range: 1 ~ 32 characters.

Define the selected interface to be the used for this PPTP tunnel
(WAN-1 is available only when WAN-1 interface is enabled)

Value setting
A Must fill setting

Item

Tunnel Name

1. A Must fill setting

Interface 2. WANL1 is selected by

default

The same applies to other WAN interfaces (e.g. WAN-2).

Remote IP/FQDN

1. A Must fill setting.
2. Format can be a
ipv4 address or FQDN

Enter the public IP address or the FQDN of the PPTP server.

1.A Must filled setting

Specify the MTU.

MTU 2.The value is 1500 by  Value Range: 0 ~ 1500.
default
A Must fill setting Enter the User Name for this PPTP tunnel to be authenticated when connect to
User Name PPTP server.
Value Range: 1 ~ 32 characters.
password A Must fill setting Enter the Password for this PPTP tunnel to be authenticated when connect to

PPTP server.

Remote Subnet

A Must fill setting

Specify the remote subnet for this PPTP tunnel to reach PPTP server.

The Remote Subnet format must be IP address/netmask (e.g. 10.0.0.2/24).
It is for the Intranet of PPTP VPN server. So, at PPTP client peer, the packets
whose destination is in the dedicated subnet will be transferred via the PPTP

175



4G PoE-WAN Extender

Authentication
Protocol

MPPE Encryption

NAT before
Tunneling

LCP Echo Type

Tunnel
Save
Undo

1. A Must fill setting
2. Unchecked by
default

1. Unchecked by
default

2. an optional setting

1. A Must filled setting
2. Unchecked by
default

Auto is set by default

Unchecked by default
N/A
N/A

VPN tunnel. Others will be transferred based on current routing policy of the
security gateway at PPTP client peer.

If you entered 0.0.0.0/0 in the Remote Subnet field, it will be treated as a
default gateway setting for the PPTP client peer, all packets, including the
Internet accessing of PPTP Client peer, will go through the established PPTP VPN
tunnel. That means the remote PPTP VPN server controls the flow of any
packets from the PPTP client peer. Certainly, those packets come through the
PPTP VPN tunnel.

Specify one ore multiple Authentication Protocol for this PPTP tunnel.

Available authentication methods are PAP / CHAP / MS-CHAP / MS-CHAP v2.

Specify whether PPTP server supports MPPE Protocol. Click the Enable box to
enable MPPE.

Note: when MPPE Encryption is enabled, the Authentication Protocol PAP /
CHAP options will not be available.

Specify whether NAT is required or not for this PPTP tunnel.

Specify the LCP Echo Type for this PPTP tunnel. It can be Auto, User-defined, or
Disable.

Auto: the system sets the Interval and Max. Failure Time.

User-defined: enter the Interval and Max. Failure Time. The default value for
Interval is 30 seconds, and Maximum Failure Times is 6 Times.

Disable: disable the LCP Echo.

Value Range: 1 ~ 99999 for Interval Time, 1~999 for Failure Time.

Check the Enable box to enable this PPTP tunnel.

Click Save button to save the settings.

Click X button to cancel the settings and back to last page.
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5.1.5 GRE

Generic Routing Encapsulation (GRE) is a tunneling protocol developed by Cisco Systems that encapsulates a
wide variety of network layer protocols inside virtual point-to-point links over an Internet Protocol
internetwork.

Deploy a M2M gateway for remote site and establish a virtual private network with control center by using
GRE tunneling. So, all client hosts behind M2M gateway can make data communication with server hosts
behind control center gateway.

GRE Tunneling is similar to IPSec Tunneling, client requesting the tunnel establishment with the server. Both
the client and the server must have a Static IP or a FQDN. Any peer gateway can be worked as either a client
or a server, even using the same set of configuration rule.

GRE Tunnel Scenario

To setup a GRE tunnel, each peer needs to

Network-A @ HQ Data Center Network-B @ Remote Office

Application
Server

\

Database _-3 [T

< o
A5 10.0.76.0/24 |
i
SIS J

Security —m === == - M2M

Gateway 2 .___Q_R_E_'I;u_n_n_e_l____( Gateway

Staticlp” “Static IP”
~ Y Server Cl

Global IP:203.95.80.22 ~ = = = = = = = — 4 = ~ Global IP:118.18.81.33

Local IP: 10.0.76.2

[GRE]-[GRE Rule Configuration]

Tunnel Name: GRE_A_B
Interface: WAN-1

Operation Mode: Always on
Tunnel IP: 203.95.80.22
Remote IP: 118.18.81.33

Key: 1234

TTL: 255

Remote Subnet: 10.0.75.0/24
DMVPN Spoke: Disable
Tunnel: Enable

1 Create tunnel by Client,
Authentication by Server.

2 Any peer gateway can be
both Client & Server, and
must have Static IP or FQDN.

Client subnet can access
3 serversubnetvia tunnel.

Internet packets go through
4 Tunnel if “Default Gateway”
option Is enabled.

Local IP: 10.0.75.2

[GRE]-[GRE Rule Configuration]

Tunnel Name: GRE_A_B
Interface: WAN-1

Operation Mode: Always on
Tunnel IP: 118.18.81.33
Remote IP: 203.95.80.22

Key: 1234

TTL: 255

Remote Subnet: 10.0.76.0/24
DMVPN Spoke: Disable
Tunnel: Enable

setup its global IP as tunnel IP and fill in the
other's global IP as remote IP.

Besides, each peer must further specify the
Remote Subnet item. It is for the Intranet of
GRE server peer. So, at GRE client peer, the
packets whose destination is in the dedicated
subnet will be transferred via the GRE tunnel.
Others will be transferred based on current
routing policy of the gateway at GRE client peer.
But, if you entered 0.0.0.0/0 in the Remote
Subnet field, it will be treated as a "Default
Gateway" setting for the GRE client peer, all
packets, including the Internet accessing of GRE
client peer, will go through the established GRE

tunnel. That means the remote GRE server peer controls the flow of any packets from the GRE client peer.
Certainly, those packets come through the GRE tunnel.

If the GRE server supports DMVPN Hub function, like Cisco router as the VPN concentrator, the GRE client can
active the DMVPN spoke function here since it is implemented by GRE over IPSec tunneling.
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GRE Setting

Go to Security > VPN > GRE tab.

The GRE setting allows user to create and configure GRE tunnels.

Enable GRE
= Configuration ‘ ®
Item Setting
» GRE Tunnel () Enable
» Max. Concurrent GRE 32
Tunnels
Enable GRE Window
Item Value setting Description
GRE Tunnel Unchecked by default  Click the Enable box to enable GRE function.
Max. Concurrent Depends on Product The specified value will limit the maximum number of simultaneous GRE tunnel
GRE Tunnels specification. connection. The default value can be different for the purchased model.
Save N/A Click Save button to save the settings
Undo N/A Click Undo button to cancel the settings

Create/Edit GRE tunnel

# GRE Tunnel List .. --

I Tunnel Name Interface Tunnel IP Remote IP MTU Key 1L Remote Subnet Enable Actions
When Add/Edit button is applied, a GRE Rule Configuration screen will appear.
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Item Setting
¥ Tunnel Name |GF!E #1 |
¥ Interface WANT »
» Tunnel IP IP: | | MASK' | - select one — v | (Option

¥ Remote IP

¥ MTU

[ ]

» Key

| (Optional)

» TTL

[ ]

¥ Remote Subnet

» Tunnel

|
() Enable

GRE Rule Configuration Window

Item Value setting

Tunnel Name A Must fill setting

Description
Enter a tunnel name. Enter a name that is easy for you to identify.
Value Range: 1 ~ 9 characters.

1. A Must fill setting

Select the interface on which GRE tunnel is to be established. It can be the

Interface 2. WAN 1 is selected . .
available WAN and LAN interfaces.
by default
Tunnel IP An Optional setting Enter the Tunnel IP address and corresponding subnet mask.
. . Enter the Remote IP address of remote GRE tunnel gateway. Normally this is the
Remote IP A Must fill setting

public IP address of the remote GRE gateway.

1. A Must filled setting
MTU 2. Auto (value zero or
blank) is set by default

MTU refers to Maximum Transmission Unit. It specifies the largest packet size
permitted for Internet transmission.

When set to Auto (value ‘0’ or blank), the router selects the best MTU for best
Internet connection performance.
Value Range: 0 ~ 1500.

Key An Optional setting

Enter the Key for the GRE connection.
Value Range: 0 ~ 9999999999.

1. A Must fill setting
2.1to 255 range

TTL

Specify TTL hop-count value for this GRE tunnel.
Value Range: 1 ~ 255.

Remote Subnet A Must fill setting

Specify the remote subnet for this GRE tunnel.

The Remote Subnet format must be IP address/netmask (e.g. 10.0.0.2/24).

It is for the Intranet of GRE server peer. So, at GRE client peer, the packets
whose destination is in the dedicated subnet will be transferred via the GRE
tunnel. Others will be transferred based on current routing policy of the security
gateway at GRE client peer.

If you entered 0.0.0.0/0 in the Remote Subnet field, it will be treated as a
default gateway setting for the GRE client peer, all packets, including the
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Internet accessing of GRE client peer, will go through the established GRE
tunnel. That means the remote GRE server peer controls the flow of any packets
from the GRE client peer. Certainly, those packets come through the GRE

tunnel.
Tunnel Unchecked by default ~ Check Enable box to enable this GRE tunnel.
Save N/A Click Save button to save the settings.
Undo N/A Click X button to cancel the settings and back to last page.
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5.2 Firewall

Internet
Sessions | — - - o -
M2M-loT <——— Allow/ Sspecific destination port TCP/UDP
-—
Gateway =.|“" Deny Specific Destination IP Address

1 o
(( )) .._: Allow | specific key word of URL
I

MAC Control
1
—.8;: Block  Specific P2P Software
Application Filter
B et Rt el T Applicati
3=, Block Lotsof TCP/UDP/ICMP Fervers |
| attack packe
ttack kets
IPS

Local
Access & Control

The firewall functions include Packet Filter, URL Blocking, Content Filter, MAC Control, Application Filter, IPS
and some firewall options. The supported function can be different for the purchased gateway.

5.2.1 Packet Filter

ltem Setting
» Packet Filters « Enahble
v Black List 7 White List Deny those match the following rules.
» Log Alert Log Alert
- Add Delete
D Rule From To Destination | Source Source |Destination Time

Source IP P MAC Protocol Schedule Enable Actions

Name | Interface Interface Port Port
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"Packet Filter" function can let you define some filtering rules for incoming and outgoing packets. So the
gateway can control what packets are allowed or blocked to pass through it. A packet filter rule should
indicate from and to which interface the packet enters and leaves the gateway, the source and destination IP
addresses, and destination service port type and port number. In addition, the time schedule to which the rule
will be active.

Packet Filter with White List Scenario

As shown in the diagram, specify "Packet Filter Rule

Denied to pass for non-http packets.

(packets not dest. to TCP port 80 / 443) List" as white list (Allow those match the following
™. X""-ﬂff” fipi/fip-abecom/puby rules) and define the rules. Rule-1 is to allow HTTP
. m%e-.‘%\ Ny @ @ ﬁ packets to pass, and Rule-2 is to allow HTTPS packets
- ~ Gateway S
Allowed to Pass "\,\ % % ~ ; to pass.
{packets with TCP POF{Q’U’M-_“ User Group 192.168.123.2007250 ] ] )
Access “http://www.abc.com/” Under such configuration, the gateway will allow only
Black st/ White List:Alow those | Rule Name : Allow HTTP_HTIPS | Destination P: Any HTTP and HTTPS packets, issued from the IP range
match the following rules rom Interface : Any estination Port : )
: Tolnterface : Any HTTP (TCP:80) for Rule-1, 192.168.123.200 to 250, which are targeted to TCP
Source IP: 192.168.123.200 HTTPs (TCP:443) for Rule-2 .
192.168:125.250 " | | Prosscal: TeP port 80 or 443 to pass the WAN interface.

Packet Filter Setting

Go to Security > Firewall > Packet Filter Tab.

The packet filter setting allows user to create and customize packet filter policies to allow or reject specific
inbound/outbound packets through the router based on their office setting.

Enable Packet Filter

Item Setting
» Packet Filters Enable
» Black List / WWhite List Deny those match the following rules. »
¥ Log Alert Lag Alert

. The box i hecked b
Packet Filter g ? (I)tx I Unchecked by Check the Enable box to activate Packet Filter function
efau
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When Deny those match the following rules is selected, as the name suggest,
. Deny those match the e . . .
Black List / . . packets specified in the rules will be blocked —black listed. In contrast, with
. following rules is set by . - s
White List default Allow those match the following rules, you can specifically white list the
packets to pass and the rest will be blocked.
The box is unchecked b
Log Alert Y Check the Enable box to activate Event Log.
default
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

Create/Edit Packet Filter Rules

The gateway allows you to customize your packet filtering rules. It supports up to a maximum of 20 filter rule
sets.

= Packet Filter List Rl [FEECH

Source IP

Destination Source |Destination

IP

Protocol Enable Actions

Schedule

When Add button is applied, Packet Filter Rule Configuration screen will appear.

#1 Packet Filter Rule Configuration

Item Setting
» Rule Name |Ru|e‘l |
¥ From Interface Any v
» Tolnterface Ay v
» Source P |Aﬂy v |
» Destination IP |Any v |
b Source MAC |Aﬂy v |
» Protocol
» Source Paort |User—defined Service ¥ | | - |
» Destination Port User-defined Senvice v | | - |
¥ Time Schedule
» Rule [ Enahle

Packet Filter Rule Configuration

Item Name Value setting Description
1. String format can be . .
Enter a packet filter rule name. Enter a name that is easy for you to remember.
Rule Name any text
. . Value Range: 1 ~ 30 characters.
2. A Must filled setting
From Interface 1. A Must filled setting Define the selected interface to be the packet-entering interface of the router.
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To Interface

Source IP

Destination IP

Source MAC

Protocol

2. By default Any is
selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any(0) is
selected

If the packets to be filtered are coming from LAN to WAN then select LAN for
this field. Or VLAN-1 to WAN then select VLAN-1 for this field. Other examples
are VLAN-1 to VLAN-2. VLAN-1 to WAN.

Select Any to filter packets coming into the router from any interfaces.

Please note that two identical interfaces are not accepted by the router. e.g.,
VLAN-1 to VLAN-1.

Define the selected interface to be the packet-leaving interface of the router. If
the packets to be filtered are entering from LAN to WAN then select WAN for
this field. Or VLAN-1 to WAN then select WAN for this field. Other examples are
VLAN-1 to VLAN-2. VLAN-1 to WAN.

Select Any to filter packets leaving the router from any interfaces.

Please note that two identical interfaces are not accepted by the router. e.g.,
VLAN-1 to VLAN-1.

This field is to specify the Source IP address.

Select Any to filter packets coming from any IP addresses.

Select Specific IP Address to filter packets coming from an IP address.

Select IP Range to filter packets coming from a specified range of IP address.
Select IP Address-based Group to filter packets coming from a pre-defined
group. Note: group must be pre-defined before this option become available.
Refer to Object Definition > Grouping > Host grouping. You may also access to
create a group by the Add Rule shortcut button.

This field is to specify the Destination IP address.

Select Any to filter packets that are entering to any IP addresses.

Select Specific IP Address to filter packets entering to an IP address entered in
this field.

Select IP Range to filter packets entering to a specified range of IP address
entered in this field.

Select IP Address-based Group to filter packets entering to a pre-defined group
selected. Note: group must be pre-defined before this selection become
available. Refer to Object Definition > Grouping > Host grouping. You may also
access to create a group by the Add Rule shortcut button. Setting done through
the Add Rule button will also appear in the Host grouping setting screen.

This field is to specify the Source MAC address.

Select Any to filter packets coming from any MAC addresses.

Select Specific MAC Address to filter packets coming from a MAC address.
Select MAC Address-based Group to filter packets coming from a pre-defined
group selected. Note: group must be pre-defined before this selection become
available. Refer to Object Definition > Grouping > Host grouping. You may also
access to create a group by the Add Rule shortcut button.

For Protocol, select Any to filter any protocol packets

Then for Source Port, select a predefined port dropdown box when Well-known
Service is selected, otherwise select User-defined Service and specify a port
range.

Then for Destination Port, select a predefined port dropdown box when Well-
known Service is selected, otherwise select User-defined Service and specify a
port range.
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Value Range: 1 ~ 65535 for Source Port, Destination Port.

For Protocol, select ICMPv4 to filter ICMPv4 packets
For Protocol, select TCP to filter TCP packets
Then for Source Port, select a predefined port dropdown box when Well-known
Service is selected, otherwise select User-defined Service and specify a port
range.
Then for Destination Port, select a predefined port dropdown box when Well-
known Service is selected, otherwise select User-defined Service and specify a
port range.
Value Range: 1 ~ 65535 for Source Port, Destination Port.
For Protocol, select UDP to filter UDP packets
Then for Source Port, select a predefined port dropdown box when Well-known
Service is selected, otherwise select User-defined Service and specify a port
range.
Then for Destination Port, select a predefined port dropdown box when Well-
known Service is selected, otherwise select User-defined Service and specify a
port range.
Value Range: 1 ~ 65535 for Source Port, Destination Port.
For Protocol, select GRE to filter GRE packets
For Protocol, select ESP to filter ESP packets
For Protocol, select SCTP to filter SCTP packets
For Protocol, select User-defined to filter packets with specified port number.
Then enter a pot number in Protocol Number box.
Apply Time Schedule to this rule, otherwise leave it as Always.

Time Schedule A Must filled setting If the dropdown list is empty ensure Time Schedule is pre-configured. Refer to

Object Definition > Scheduling > Configuration tab.
The box is unchecked by

Rule Click Enable box to activate this rule then save the settings.
default.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
When the Back button is clicked the screen will return to the Packet Filter
Back N/A

Configuration page.
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5.2.2 URL Blocking

"URL Blocking" function can let you define blocking or allowing rules for incoming and outgoing Web request
packets. With defined rules, gateway can control the Web requests containing the complete URL, partial
domain name, or pre-defined keywords. For example, one can filter out or allow only the Web requests based
on domain input suffixes like .com or .org or keywords like “bct” or “mpe”.

An URL blocking rule should specify the URL, partial domain name, or included keywords in the Web requests
from and to the gateway and also the destination service port. Besides, a certain time schedule can be applied
to activate the URL Blocking rules during pre-defined time interval(s).

The gateway will logs and displays the disallowed web accessing requests that matched the defined URL
blocking rule in the black-list or in the exclusion of the white-list.

When you choose "Allow all to pass except those match the following rules" for the "URL Blocking Rule List",
you are setting the defined URL blocking rules to belong to the black list. The packets, listed in the rule list, will
be blocked if one pattern in the requests matches to one rule. Other Web requests can pass through the
gateway. In contrast, when you choose "Deny all to pass except those match the following rules" for the "URL
Blocking Rule List", you are setting the defined packet filtering rules to belong to the white list. The Web
requests, listed in the rule, will be allowed if one pattern in the requests matches to one rule. Other Web
requests will be blocked.

URL Blocking Rule with Black List

When the administrator of the gateway wants to
block the Web requests with some dedicated
patterns, he can use the "URL Blocking" function
to block specific Web requests by defining the
black list as shown in above diagram. Certainly,
when the administrator wants to allow only the
Web requests with some dedicated patterns to
go through the gateway, he can also use the
"URL Blocking" function by defining the white
list to meet the requirement.

Denied to access those URLs with “sex”, “girl” or “playboy”, like
http://www.sex.com; www.girl.com, www.playboy.com”

Allow to Pass for URL Access

o

without “sex’, “girl

-

or “playboy”

URL Blocking: Enable el :lDeny e

Black List / White List: Deny those URL[IE}umaln Name/ Keyword:
Sex; girl; playboy . .
e e TR As shown in the diagram, enable the URL
Rule: Enable blocking function and create the first rule to
deny the Web requests with "sex" or "sexygirl" patterns and the other to deny the Web requests with

"playboy" pattern to go through the gateway. System will block the Web requests with "sex", "sexygirl" or
"playboy" patterns to pass through the gateway.

match the following rules
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URL Blocking Setting

Go to Security > Firewall > URL Blocking Tab.

In "URL Blocking" page, there are three configuration windows. They are the "Configuration" window, "URL
Blocking Rule List" window, and "URL Blocking Rule Configuration" window.

The "Configuration" window can let you activate the URL blocking function and specify to black listing or to
white listing the packets defined in the "URL Blocking Rule List" entry. In addition, log alerting can be enabled
to record on-going events for any disallowed Web request packets. Refer to "System Status" in "6.1.1 System
Related" section in this user manual for how to view recorded log.

The "URL Blocking Rule List" window lists all your defined URL blocking rule entry. And finally, the "URL
Blocking Rule Configuration" window can let you define URL blocking rules. The parameters in a rule include
the rule name, the Source IP or MAC, the URL/Domain Name/Keyword, the destination service ports, the
integrated time schedule rule and the rule activation.

Enable URL Blocking

Item Setting
» URL Blocking # Enable
» Black List/ White List Deny those match the following rules. v
» Log Alert Enable

The box is unchecked Check the Enable box to activate URL Blocking function.

URL Blocking by default
Specify the URL Blocking Policy, either Black List or White List.

Deny those match the Black List: When Deny those match the following rules is selected, as the name

Black List / following rules is set suggest, the matched Web request packets will be blocked.

White List by default White List: When Allow those match the following rules is selected, the matched
Web request packets can pass through the Gateway, and the others that don’t match
the rules will be blocked.

The box is unchecked Check the Enable box to activate Event Log.

Log Alert

by default
Save NA Click Save button to save the settings
Undo NA Click Undo button to cancel the settings

Create/Edit URL Blocking Rules

The Gateway supports up to a maximum of 20 URL blocking rule sets. Ensure that the URL Blocking is enabled before we
can create blocking rules.
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Add Delete

Time
Schedule

Destination
Port

When Add button is applied, the URL Blocking Rule Configuration screen will appear.

D Rule Name Source IP Source MAC URL / Demain Name ! Keyword Enable | Actions

ltem Setting
» Rule Name Rule1
» Source P Any v
» Source MAC Any v
» URL / Domain Mame / Keyword
¢ Destination Port Any M
» Time Schedule Rule (0) Always ¥
» Rule Enable
1. String format can be any  Specify an URL Blocking rule name. Enter a name that is easy for you to
Rule Name text understand.
2. A Must filled setting
This field is to specify the Source IP address.
e Select Any to filter packets coming from any IP addresses.
Source IP 1. A Must filled setting o Select Specific IP Address to filter packets coming from an IP address entered in
2. Any is set by default this field.
e Select IP Range to filter packets coming from a specified range of IP address
entered in this field.
This field is to specify the Source MAC address.
Source MAC 1. A Must filled setting e Select Any to filter packets coming from any MAC addresses.
2. Any is set by default e Select Specific MAC Address to filter packets coming from a MAC address
entered in this field.
1. A Must filled setting Specify URL, Domain Name, or Keyword list for URL checking.
URL / Domain 2. Supportsup to a o In the Black List mode, if a matched rule is found, the packets will be dropped.
Name / maximum of 10 Keywords e In the White List mode, if a matched rule is found, the packets will be accepted
Keyword in a rule by using the and the others which don’t match any rule will be dropped.
delimiter “;”.
This field is to specify the Destination Port number.
Destination 1. A Must filled setting e Select Any to filter packets going to any Port.
Port 2. Any is set by default o Select Specific Service Port to filter packets going to a specific Port entered in this field.
o Select Port Range to filter packets going to a specific range of Ports entered in this field.
Time Apply a specific Time Schedule to this rule; otherwise leave it as (0) Always.

Schedule Rule

Rule

Save
Undo
Back

A Must filled setting

The box is unchecked by
default.

NA

NA

NA

If the dropdown list is empty ensure Time Schedule is pre-configured. Refer to Object
Definition > Scheduling > Configuration tab.
Click the Enable box to activate this rule.

Click the Save button to save the settings.
Click the Undo button to cancel the changes.
Click the Back button to return to the URL Blocking Configuration page.
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5.2.3 MAC Control

Item

» MAC Control + Enahle

» Black List / White List

» Log Alert Enahble

b Known MAC from LAN PC List v | Copyto
Add Delste

1D Rule Name MAC Address

Setting

Deny MAC Address Below. v

Time Schedule Rule Enahle Actions

"MAC Control" function allows you to assign the accessibility to the gateway for different users based on
device’s MAC address. When the administrator wants to reject the traffics from some client hosts with specific
MAC addresses, he can use the "MAC Control" function to reject with the black list configuration.

MAC Control with Black List Scenario

MACAddress : “20:6A:6A:6A:6A:6B”
Denied to access Internet.

WAN

A Gateway

]

N
MAC Address : “00:50:18:99:99:01
Allowed to access Internet. |

j2udEy3a

Staff

Black List / White List:

Deny MAC Address Below. MAC Address : 20:6A:6A:6A:6A:68

Rule Name : Deny_JP

20:6A:6A:6A:6A:6B

00:50:18:99:99:01

As shown in the diagram, enable the MAC control
function and specify the "MAC Control Rule List" is
a black list, and configure one MAC control rule for
the gateway to deny the connection request from
the "JP NB" with its own MAC address
20:6A:6A:6A:6A:6B.

System will block the connecting from the "JP NB"
to the gateway but allow others.
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MAC Control Setting

Go to Security > Firewall > MAC Control Tab.

The MAC control setting allows user to create and customize MAC address policies to allow or reject packets
with specific source MAC address.

Enable MAC Control

® Configuration ' %

Item Setting
» MAC Control [ Enable
» Black List / White List | Deny MAC Address Below. v
¥ Log Alert Enahle
¥ Known MAC from LAN PC List EI

Configuration Window

Item Value setting Description

The box is unchecked by

MAC Control default Check the Enable box to activate the MAC filter function
When Deny MAC Address Below is selected, as the name suggest, packets

Black List / Deny MAC Address Below  specified in the rules will be blocked —black listed. In contrast, with Allow MAC

White List is set by default Address Below, you can specifically white list the packets to pass and the rest
will be blocked.

The box is unchecked b
Log Alert default v Check the Enable box to activate to activate Event Log.
efau

Known MAC N/A Select a MAC Address from LAN Client List. Click the Copy to to copy the

from LAN PC List selected MAC Address to the filter rule.

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings
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Create/Edit MAC Control Rules

The gateway supports up to a maximum of 20 filter rule sets. Ensure that the MAC Control is enabled before
we can create control rules.

® MAC Control Rule List -' ..

MAC Address

Rule Name Time Schedule Rule Actions

When Add button is applied, Filter Rule Configuration screen will appear.

# MAC Control Rule Configuration ®

Rule Name MAC Address (Use : to Compose) Time Schedule | Enable

Rule1 | || | [(0)Aways v | | )

MAC Control Rule Configuration

Item [ Value setting Description
1. String format can be any
Rule Name text Enter a MAC Control rule name. Enter a name that is easy for you to remember.

2. A Must fill setting
MAC Address 1. MAC Address string
(Use: to Format Specify the Source MAC Address to filter rule.
Compose) 2. A Must fill setting

Apply Time Schedule to this rule; otherwise leave it as (0) Always.
Time Schedule A Must fill setting If the dropdown list is empty, ensure Time Schedule is pre-configured. Refer to
Object Definition > Scheduling > Configuration tab

The box is unchecked by

Enable Click Enable box to activate this rule, and then save the settings.
default.

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings
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5.2.4 Content Filter (not supported)

Not supported feature for the purchased product, leave it as blank.
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5.2.5 Application Filter (not supported)

Not supported feature for the purchased product, leave it as blank.
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5.2.6 IPS

Item
v IPS Enable
» Log Alert Enable

Item
» SYN Flood Defense Enable (300
» UDP Flood Defense Enable (300
v ICMP Flood Defense Enable (300
v Port Scan Defense Enable (200

Setting

Setting
Packets/zecond (10~10000)
Fackets/second (10~10000)
Packets/second (10~10000)

Packets/zecond (10~10000)

To provide application servers in the Internet, administrator may need to open specific ports for the services.
However, there are some risks to always open service ports in the Internet. In order to avoid such attack risks,

it is important to enable IPS functions.

Intrusion Prevention System (IPS) is network security appliances that monitor network and/or system
activities for malicious activity. The main functions of IPS are to identify malicious activity, log information
about this activity, attempt to block/stop it and report it. You can enable the IPS function and check the listed
intrusion activities when needed. You can also enable the log alerting so that system will record Intrusion

events when corresponding intrusions are detected.

IPS Scenario

Block lots of TCP attack packets to
Remote administration port: 8080 X Gateway
Global IP: 118.18.81.200

Local IP:192.168.1.253

Attackers

Block lots of TCP attack packets to
Mail Server :SMTP 25, POP3 110

[1PS]-[Configuration]

Block lots of TCP attack packets to
Web Server : HTTP 80, HTTPS 443

| IPS: Enable |
Intrusion Prevention \

SYN Flood Defense Mail Server (port: 25,110)
Port Scan Detection Local IP:192.168.1.2
Block IP Spoof

Block TCP Flag Scan

Wed Server (port: 80, 443)
Local IP: 192.168.1.3

As shown in the diagram, the gateway serves
as an E-mail server, Web Server and also
provides TCP port 8080 for remote
administration. So, remote users or unknown
users can request those services from Internet.
With IPS enabled, the gateway can detect
incoming attack packets, including the TCP
ports (25, 80, 110, 443 and 8080) with services.
It will block the attack packets and let the
normal access to pass through the gateway
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IPS Setting

Go to Security > Firewall > IPS Tab.

The Intrusion Prevention System (IPS) setting allows user to customize intrusion prevention rules to prevent
malicious packets.

Enable IPS Firewall

= Configuration . ®
ltem Setting

v IPS [ Enable

r Log Alert Enable

Configuration Window

Item Value setting Description
The box is unchecked b
IPS default Y Check the Enable box to activate IPS function

The box is unchecked by

Log Alert Check the Enable box to activate to activate Event Log.
default

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings

Setup Intrusion Prevention Rules

The router allows you to select intrusion prevention rules you may want to enable. Ensure that the IPS is
enabled before we can enable the defense function.
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= |ntrusion Prevention

ltem Setting
» SYN Flood Defense Enable Packets/second (10~10000)
» UDP Flood Defense Enable Packets/second (10~10000)
» ICMP Flood Defense Enable Packets/second (10~10000)
» Port Scan Defense Enable Packets/second (10~10000)
b Block Land Attack Enable
» Block Ping of Death Enable
» Block IP Spoof Enable
» Block TCP Flag Scan Enable
¥ Block Smurf Enable
» Block Traceroute Enable
» Block Fraggle Attack Enable
» ARP Spoofing Defense Enable Packets/second (10~10000)

Setup Intrusion Prevention Rules

Item Name Value setting Description
SYN Flood Click Enable box to activate this intrusion prevention rule and
Defense 1. A Must filled setting enter the traffic threshold in this field.
UDP Flood 2. The box is unchecked by default. Click Enable box to activate this intrusion prevention rule and
Defense 3. Traffic threshold is set to 300 by default enter the traffic threshold in this field.
ICMP Flood 4. The value range can be from 10 to Click Enable box to activate this intrusion prevention rule and
Defense 10000. enter the traffic threshold in this field.
Value Range: 10 ~ 10000.

1. A Must filled setting
Port Scan 2. The box is unchecked by default. Click Enable box to activate this intrusion prevention rule and
Defection 3. Traffic threshold is set to 200 by default enter the traffic threshold in this field.

4. The value range can be from 10 to Value Range: 10 ~ 10000.

10000.
Block Land
Attack
Block Ping of
Death
Block IP Spoof
Block TCP Flag  The box is unchecked by default. Click Enable box to activate this intrusion prevention rule.
Scan
Block Smurf
Block
Traceroute
Block Fraggle
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Attack
1. A Must filled setting
ARP Spoofing 2. The box is unchecked by default. Click Enable box to activate this intrusion prevention rule and
Defence 3. Traffic threshold is set to 300 by default enter the traffic threshold in this field.
4. The value range can be from 10 to Value Range: 10 ~ 10000.
10000.
Save NA Click Save to save the settings
Undo NA Click Undo to cancel the settings
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5.2.7 Options

Item Setting
» Stealth Mode Enable
» SP| #| Enable
v Discard Ping from WAN Enable
Service
ID | Interface Protocol IP Subnet Mask Enable | Action
Port
Al WAN HTTPS Any IF MIA 443 Edit
2 | Al WAN HTTPS Any IP N/A 443 Edit
3| All'WAN HTTPS Any IP MIA 443 Edit
4 | Al WAN HTTFS Any IP MIA 443 Edit
5 | All'WAN HTTPS Any IF MIA 443 Edit

There are some additional useful firewall options in this page.

“Stealth Mode” lets gateway not to respond to port scans from the WAN so that makes it less susceptible to
discovery and attacks on the Internet. ”SPI” enables gateway to record the packet information like IP address,
port address, ACK, SEQ number and so on while they pass through the gateway, and the gateway checks every
incoming packet to detect if this packet is valid.

“Discard Ping from WAN” makes any host on the WAN side can’t ping this gateway. And finally, “Remote
Administrator Hosts” enables you to perform administration task from a remote host. If this feature is enabled,
only specified IP address(es) can perform remote administration.
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Enable SPI Scenario

Dst IP and Port Network-A
118.18.81.200: 1999 Dst [P and Port

SrcIPand Port 203.95.80.22 : 80

200.10.10.10: 80 SrcIPand Port Gateway

118.18.81.200:1999
Global IP: 118.18.81.200

Unknown User
With Portscan Utility
Global IP: 200.10.10.10

Cloud Server
Global IP: 203.95.80.22

DstIP and Port
118.18.81.200: 1999
SrclP and Port
203.95.80.22: 80

As shown in the diagram, Gateway has the I[P
address of 118.18.81.200 for WAN interface and
192.168.1.253 for LAN interface. It serves as a NAT
gateway. Users in Network-A initiate to access
cloud server through the gateway. Sometimes,
unknown users will simulate the packets but use
different source IP to masquerade. With the SPI
feature been enabled at the gateway, it will block
such packets from unknown users.

Discard Ping from WAN & Remote Administrator Hosts Scenario

Use “Ping tool” to detect if Global IP is existed,

- The gateway doesn’t reply such requests.

S -
—
=~ -
-

Unknown User -
=~ ~  Global IP:118.18.81.200
~ \Lnl:al IP: 192.168.1.253

XY

Ll
N y
\ - -
. \ == 3
) _o=C
. - o

Remote Admin. Remote Admin. can access Gateway GUI
via Browser “Http.// 118.18.81.200:8080"

Gateway

“Discard Ping from WAN” makes any host on the
WAN side can't ping this gateway reply any ICMP
packets. Enable the Discard Ping from WAN function
to prevent security leak when local users surf the
internet.

Remote administrator knows the gateway’s global IP,
and he can access the Gateway GUI via TCP port
8080.
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Firewall Options Setting

Go to Security > Firewall > Options Tab.

The firewall options setting allows network administrator to modify the behavior of the firewall and to enable
Remote Router Access Control.

Enable Firewall Options

« Firewall Options . .
[tem Setting

b Stealth Mode [[] Enable

» SPI Enable

» Discard Ping from WAN [[J Enable

Firewall Options

Item Value setting Description

The box i hecked b

Stealth Mode q ? (I)tx 's Unchecked by Check the Enable box to activate the Stealth Mode function
efau

The box is checked by . .
SPI Check the Enable box to activate the SPI function

default
Discard Ping The box is unchecked by ) ) . .
from WAN default Check the Enable box to activate the Discard Ping from WAN function

Define Remote Administrator Host

The router allows network administrator to manage router remotely. The network administrator can assign
specific IP address and service port to allow accessing the router via designated WAN interface.
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= Remote Administrator Host Definition - | x
Service
ID | Interface Protocol IP Subnet Mask Enable | Action
Port

1 | AIWAN HTTPS Any IP N/A 443 O
2 | AIlWAN HTTPS Any IP N/A 443 O
3 | AllWAN HTTPS Any IP N/IA 443 O
4 | AIWAN HTTPS Any IP N/A 443 O
5 | AllWAN HTTPS Any IP N/A 443 O

Remote Administrator Host Definition

Item Value setting Description

Protocol HTTPS is set by default Select HTTP or HTTPS method for remote administration.

This field is to specify the remote host to assign access right for remote access.
Select Any IP to allow any remote hosts

IP A Must filled setting Select Specific IP to allow the remote host coming from a specific subnet. An IP
address entered in this field and a selected Subnet Mask to compose the
subnet.

1. 80 for HTTP by default o . . .
This field is to specify a Service Port to HTTP or HTTPS connection.

Service Port 2. 443 for HTTPS by
default Value Range: 1 ~ 65535.
Enabling the The box is unchecked by Click Enable box to activate this rule.
rule default.
Save N/A Click Enable box to activate this rule then save the settings.
Undo N/A Click Undo to cancel the settings
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Chapter 6 Administration

6.1 Configure & Manage

M2M-loT 4 k
Gateway

— , TRO69
Oy S y
TR-0629
Management FCTTT T T TTT T T »
Server /[ Tools : amit Proprietary Standard :
| 1

Access & Control : ﬁ SNMP :
| C— 1
\ y

SNMP

{ & . console )

e | 1

| |

Management
e Ser!h'erg,:'E Tools : w :
\ e 0 2w ”
Local Access & Control Teinet / Console with CLI

Configure & Manage refers to enterprise-wide administration of distributed systems including (and commonly
in practice) computer systems. Centralized management has a time and effort trade-off that is related to the
size of the company, the expertise of the IT staff, and the amount of technology being used. This device
supports many system management protocols, such as Command Script, TR-069, SNMP, and Telnet with CLI.
You can setup those configurations in the "Configure & Manage" section.
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6.1.1 Command Script

Command script configuration is the application that allows administrator to setup the pre-defined
configuration in plain text style and apply configuration on startup.

Go to Administration > Command Script > Configuration Tab.

Enable Command Script Configuration

Item

Command Script

Backup Script

Upload Script

Script Name

Version

Description

Update time

Command Script

Backup Script

Upload Script

Script Name

Version

Description

Update time

Enable

Via Web Ul
Via Web Ul

2019-04-08T1

The box is unchecked by
default

N/A

N/A

1.An Optional setting
2.Any valid file name

1.An Optional setting
2.Any string

1.An Optional setting
2.Any string

N/A

Setting

oo

8:05:31

Check the Enable box to activate the Command Script function.

Click the Via Web Ul or Via Storage button to backup the existed command

script in a .txt file. You can specify the script file name in Script Name below.

Click the Via Web Ul or Via Storage button to Upload the existed command
script from a specified .txt file.

Specify a script file name for script backup, or display the selected upload script

file name.

Value Range: 0 ~ 32 characters.

Specify the version number for the applied Command script.
Value Range: 0 ~ 32 characters.

Enter a short description for the applied Command script.

It records the upload time for last commad script upload.

203



4G PoE-WAN Extender

Edit/Backup Plain Text Command Script

* Command Script Editor

01765280

You can edit the plain text configuration settings in the configuration screen as above.

Plain Text Configuration
Item Value setting Description

Clean NA Clean text area. (You should click Save button to further clean the configuration
already saved in the system.)

Backup NA Backup and download configuration.

Save NA Save configuration

The supported plain text configuration items are shown in the following list. For the settings that can be
executed with standard Linux commands, you can put them in a script file, and apply to the system configure
with STARTUP command. For those configurations without corresponding Linux command set to configure,
you can configure them with proprietary command set.

Configuration Content

\ Key \ Value setting \ Description
OPENVPN_ENABLED 1:enable Enable or disable OpenVPN Client function.
0 : disable
OPENVPN_DESCRIPTION A Must filled Specify the tunnel name for the OpenVPN Client connection.
Setting
OPENVPN_PROTO udp Define the Protocol for the OpenVPN Client.
tcp e Select TCP or TCP /UDP

->The OpenVPN will use TCP protocol, and Port will be set as 443
automatically.

e Select UDP

->The OpenVPN will use UDP protocol, and Port will be set as 1194
automatically.

OPENVPN_PORT A Must filled Specify the Port for the OpenVPN Client to use.
Setting
OPENVPN_REMOTE_IPADDR IP or FQDN Specify the Remote IP/FQDN of the peer OpenVPN Server for this

OpenVPN Client tunnel.
Fill in the IP address or FQDN.
OPENVPN_PING_INTVL seconds Specify the time interval for OpenVPN keep-alive checking.
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OPENVPN_PING_TOUT
OPENVPN_COMP
OPENVPN_AUTH

OPENVPN_CA_CERT
OPENVPN_LOCAL_CERT
OPENVPN_LOCAL_KEY
OPENVPN_EXTRA_OPTS
IP_ADDR1

IP_NETM1
PPP_MONITORING

PPP_PING

PPP_PING_IPADDR

PPP_PING_INTVL

STARTUP

seconds
Adaptive
Static Key/TLS

A Must filled
Setting

A Must filled
Setting

A Must filled
Setting
Options

Ip

Net mask

1: enable

0 : disable

0 : DNS Query
1:ICMP Query

IP
seconds

Script file

Specify the timeout value for OpenVPN Client keep-alive checking.
Specify the LZO Compression algorithm for OpenVPN client.

Specify the authorization mode for the OpenVPN tunnel.

e TLS

->The OpenVPN will use TLS authorization mode, and the following
items CA Cert., Client Cert. and Client Key need to specify as well.
Specify the Trusted CA certificate for the OpenVPN client. It will go
through Base64 Conversion.

Specify the local certificate for OpenVPN client. It will go through
Base64 Conversion.

Specify the local key for the OpenVPN client. It will go through Base64
Conversion.

Specify the extra options setting for the OpenVPN client.

Ethernet LAN IP

Ethernet LAN MASK

When the Network Monitoring feature is enabled, the router will use
DNS Query or ICMP to periodically check Internet connection —
connected or disconnected.

With DNS Query, the system checks the connection by sending DNS
Query packets to the destination specified in PPP_PING_IPADDR.
With ICMP Query, the system will check connection by sending ICMP
request packets to the destination specified in PPP_PING_IPADDR.
Specify an IP address as the target for sending DNS query/ICMP
request.

Specify the time interval for between two DNS Query or ICMP
checking packets.

For the configurations that can be configured with standard Linux
commands, you can put them in a script file, and apply the script file
with STARTUP command.

For example,

STARTUP=#!/bin/sh

STARTUP=echo “startup done” > /tmp/demo

Plain Text System Configuration with Telnet

In addition to the web-style plain text configuration as mentioned above, the gateway system also allow the
configuration via Telnet CLI. Administrator can use the proprietary telnet command “txtConfig” and related
action items to perform the plain system configuration.

The command format is: txtConfig (action) [option]

clone Output file

Duplicate the configuration content from database and stored as a
configuration file.

(ex: txtConfig clone /tmp/config)

The contents in the configuration file are the same as the plain text commands
mentioned above. This action is exactly the same as performing the “Backup”
plain text configuration.
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commit

enable

disable
run_immediately

run_immediately

a existing file
NA
NA
NA

a existing file

Commit the configuration content to database.

(ex: txtConfig commit /tmp/config)

Enable plain text system config.

(ex: txtConfig enable)

Disable plain text system config.

(ex: txtConfig disable)

Apply the configuration content that has been committed in database.
(ex: txtConfig run_immediately)

Assign a configuration file to apply.

(ex: txtConfig run_immediately /tmp/config)
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6.1.2 TR-069

TR-069 (Technical Report 069) is a Broadband Forum technical specification entitled CPE WAN Management
Protocol (CWMP). It defines an application layer protocol for remote management of end-user devices, like this
gateway device. As a bidirectional SOAP/HTTP-based protocol, it provides the communication between
customer-premises equipment (CPE) and Auto Configuration Servers (ACS). The Security Gateway is such CPE.

TR-069 is a customized feature for ISP. It is not recommend that you change the configuration for this. If you
have any problem in using this feature for device management, please contact with your ISP or the ACS
provider for help. At the right upper corner of TR-069 Setting screen, one “[Help]” command let you see the
same message about that.

Scenario - Managing deployed gateways through an ACS Server

Gatewayn
Gateway 2
/ ]
S
i Gateway 1
Global IP:
ACS 118.18.81.33
Server

Scenario Application Timing

When the enterprise data center wants to use an ACS server to manage remote gateways
geographically distributed elsewhere in the world, the gateways in all branch offices must have an
embedded TR-069 agent to communicate with the ACS server. So that the ACS server can configure,
FW upgrade and monitor these gateways and their corresponding Intranets.

Scenario Description
The ACS server can configure, upgrade with latest FW and monitor these gateways.
Remote gateways inquire the ACS server for jobs to do in each time period.

The ACS server can ask the gateways to execute some urgent jobs.
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Parameter Setup Example

Following tables list the parameter configuration as an example for the Gateway 1 in above diagram
with "TR-069" enabling.

Use default value for those parameters that are not mentioned in the tables.

Configuration Path [TR-069]-[Configuration]
TR-069 m Enable

ACS URL http://qa.acslite.com/cpe.php
ACS User Name ACSUserName

ACS Password ACSPassword
ConnectionRequest Port 8099

ConnectionRequest User Name ConnReqUserName
ConnectionRequest Password ConnReqPassword

Inform m Enable Interval 900

Scenario Operation Procedure

In above diagram, the ACS server can manage multiple gateways in the Internet. The "Gateway 1" is
one of them and has 118.18.81.33 IP address for its WAN-1 interface.

When all remote gateways have booted up, they will try to connect to the ACS server.

Once the connections are established successfully, the ACS server can configure, upgrade with latest
FW and monitor these gateways.

Remote gateways inquire the ACS server for jobs to do in each time period.

If the ACS server needs some urgent jobs to be done by the gateways, it will issue the "Connection
Request" command to those gateways. And those gateways make immediate connections in response
to the ACS server’s immediate connection request for executing the urgent jobs.
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TR-069 Setting

Go to Administration > Configure & Manage > TR-069 tab.

In "TR-069" page, there is only one configuration window for TR-069 function. In the window, you must
specify the related information for your security gateway to connect to the ACS. Drive the function to work by
specifying the URL of the ACS server, the account information to login the ACS server, the service port and the
account information for connection requesting from the ACS server, and the time interval for job inquiry.
Except the inquiry time, there are no activities between the ACS server and the gateways until the next inquiry
cycle. But if the ACS server has new jobs that are expected to do by the gateways urgently, it will ask these
gateways by using connection request related information for immediate connection for inquiring jobs and
executing.

Enable TR-069

= Configuration ’ %
Item Setting

» TR-069 Enable

¥ Interface

¢ Data model | ACS Cloud Data Model |

» ACS URL |

b ACS UserName | |

+ ACS Password | |
¥ Connection Request Port 8099

b Connection Request UserMame | |

b Connection Request Password | |

v Inform # Enable Interval

o default

» Certification Setup Select from Certificate List

Certificate:

TR-069

Item Value setting Description
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TR-069

Interface

Data Model

ACS URL
ACS Username
ACS Password

ConnectionRequest
Port

ConnectionRequest
UserName

ConnectionRequest
Password

Inform

Certification Setup

Save
Undo

The box is unchecked by
default

WAN-1 is selected by
default.

ACS Cloud Data Model
is selected by default.

A Must filled setting
A Must filled setting
A Must filled setting

1. A Must filled setting.
2. By default 8099 is set.

A Must filled setting

A Must filled setting

1. The box is checked by

default.
2. The Interval value is
300 by default.

The default box is
selected by default

N/A
N/A

Check the Enable box to activate TR-069 function.

When you finish set basic network WAN-1 ~ WAN-n, you can choose WAN-1 ~
WAN-n

When you finish set Security > VPN > IPSec/OpenVPN/PPTP/L2TP/GRE, you
can choose IPSec/OpenVPN/PPTP/L2TP/GRE tunnel, the interface just like
“IPSec #1”

Select the TR-069 dat model for the remote management.

Standard : the ACS Server is a standard one, which is fully comply with TR-
069.

ACS Cloud Data Model : Select this data model if you intend to use Cloud ACS
Server to managing the deployed gateways.

You can ask ACS manager provide ACS URL and manually set

You can ask ACS manager provide ACS username and manually set

You can ask ACS manager provide ACS password and manually set

You can ask ACS manager provide ACS ConnectionRequest Port and manually
set

Value Range: 0 ~ 65535.

You can ask ACS manager provide ACS ConnectionRequest Username and
manually set

You can ask ACS manager provide ACS ConnectionRequest Password and
manually set

When the Enable box is checked, the gateway (CPE) will periodicly send
inform message to ACS Server according to the Interval setting.
Value Range: 0 ~ 86400 for Inform Interval.

You can leave it as default or select an expected certificate and key from the
drop down list.

Refer to Object Definition > Certificate Section for the Certificate
configuration.

Click Save to save the settings.

Click Undo to cancel the modifications.

When you finish set ACS URL ACS Username ACS Password, your gateway (CPE, Client Premium Equipment)
can send inform to ACS Server.
When you finish set ConnectionRequest Port ConnectionRequest Username ConnectionRequest Password,
ACS Server can ask the gateway (CPE) to send inform to ACS Server.

Enable STUN Server
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« STUN Settings ' %

Item Setting

v STUN + Enable

F Server Address | |

¥ Server Port (1~65535)
» Keep Alive Period 0 | (0~65535)second(s)

STUN Settings Configuration

Item ‘ Value setting Description

The box is checked by

STUN Check the Enable box to activate STUN function.
default
1. String format: any .

Server Address IPva address Specify the IP address for the expected STUN Server.

2. Itis an optional item.

. . Specify the port number for the expected STUN Server.
1. An optional setting

2.3478 is set by default

Server Port
Value Range: 1 ~ 65535.
Specify the keep alive time period for the connection with STUN Server.

1. An optional setting

Keep Alive Period
2.0 is set by default

Value Range: 0 ~ 65535.
Save N/A Click Save to save the settings.
Undo N/A Click Undo to cancel the modifications.
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6.1.3 SNMP

In brief, SNMP, the Simple Network Management Protocol, is a protocol designed to give a user the capability
to remotely manage a computer network by polling and setting terminal values and monitoring network
events.

In typical SNMP uses, one or more administrative computers, called managers, have the task of monitoring or
managing a group of hosts or devices on a computer network. Each managed system executes, at all times, a
software component called an agent which reports information via SNMP to the manager.

SNMP agents expose management data on the managed systems as variables. The protocol also permits active
management tasks, such as modifying and applying a new configuration through remote modification of these
variables. The variables accessible via SNMP are organized in hierarchies. These hierarchies, and other
metadata (such as type and description of the variable), are described by Management Information Bases
(MIBs).

The device supports several public MIBs and one private MIB for the SNMP agent. The supported MIBs are as
follow: MIB-II (RFC 1213, Include IPv6), IF-MIB, IP-MIB, TCP-MIB, UDP-MIB, SMIv1 and SMIv2, SNMPv2-TM and
SNMPv2-MIB, and AMIB (a Proprietary MIB)

SNMP Management Scenario

a3

Remote NMS
118.18.81.22

Gatewayn

Gateway 2

8 & Gateway 1
Remote NMS LAN IP: 10.0.75.2
118.18.81.11 t:10.0.75.0/24

i Intranet

10.0.75.100

Scenario Application Timing

There are two application scenarios of SNMP Network Management Systems (NMS). Local NMS is in
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the Intranet and manage all devices that support SNMP protocol in the Intranet. Another one is the
Remote NMS to manage some devices whose WAN interfaces are connected together by using a
switch or a router with UDP forwarding. If you want to manage some devices and they all have
supported SNMP protocol, use either one application scenario, especially the management of devices
in the Intranet. In managing devices in the Internet, the TR-069 is the better solution. Please refer to
last sub-section.

Scenario Description

The NMS server can monitor and configure the managed devices by using SNMP protocol, and those
devices are located at where UDP packets can reach from NMS.

The managed devices report urgent trap events to the NMS servers.
Use SNMPv3 version of protocol can protected the transmitting of SNMP commands and responses.
The remote NMS with privilege IP address can manage the devices, but other remote NMS can't.

Parameter Setup Example

Following tables list the parameter configuration as an example for the Gateway 1 in above diagram
with "SNMP" enabling at LAN and WAN interfaces.

Use default value for those parameters that are not mentioned in the tables.

Configuration Path

[SNMP]-[Configuration]

SNMP Enable

m LAN m WAN

Supported Versions

mvl mv2c mv3

Get / Set Community

ReadCommunity / WriteCommunity

Trap Event Receiver 1

118.18.81.11

WAN Access IP Address

118.18.81.11

Configuration Path [SNMP]-[User Privacy Definition]

ID 1 2 3

User Name UserNamel UserName2 UserName3
Password Password1 Password2 Disable
Authentication MD5 SHA-1 Disable
Encryption DES Disable Disable
Privacy Mode authPriv authNoPriv noAuthNoPriv
Privacy Key 12345678 Disable Disable
Authority Read/Write Read Read

Enable m Enable m Enable m Enable

Scenario Operation Procedure

In above diagram, the NMS server can manage multiple devices in the Intranet or a UDP-reachable
network. The "Gateway 1" is one of the managed devices, and it has the IP address of 10.0.75.2 for
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LAN interface and 118.18.81.33 for WAN-1 interface. It serves as a NAT router.

At first stage, the NMS manager prepares related information for all managed devices and records
them in the NMS system. Then NMS system gets the status of all managed devices by using SNMP get
commands.

When the manager wants to configure the managed devices, the NMS system allows him to do that by
using SNMP set commands. The "UserNamel" account is used if the manager uses SNMPv3 protocol
for configuring the "Gateway 1". Only the "UserName1l" account can let the "Gateway 1" accept the
configuration from the NMS since the authority of the account is "Read/Write".

Once a managed device has an urgent event to send, the device will issue a trap to the Trap Event
Receivers. The NMS itself could be one among them.

If you want to secure the transmitted SNMP commands and responses between the NMS and the
managed devices, use SNMPv3 version of protocol.

The remote NMS without privilege IP address can't manage the "Gateway 1", since "Gateway 1" allows
only the NMS with privilege IP address can manage it via its WAN interface.
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SNMP Setting

Go to Administration > Configure & Manage > SNMP tab.

The SNMP allows user to configure SNMP relevant setting which includes interface, version, access control
and trap receiver.

Enable SNMP
= Configuration ° %
ltem Setting

¥ SNMP Enable [ LAN ] WAN

» WAN Interface All' WANs »

» Supported Versions ¥ vl v2c [ v3

» SNMP Port
'IP Range v
| | - | | [} Enable
| | - | | [J Enable

¥ Limited Remote Access IP | | ) | | | Enable
| | - | | [ Enable
| | - | | O Enable

SNMP
Item Value setting Description

Select the interface for the SNMP and enable SNMP functions.
When Check the LAN box, it will activate SNMP functions and you can access

SNMP Enable SNMP from LAN side;
unchecked by default

1.The boxes are

When Check the WAN box, it will activate SNMP functions and you can access
SNMP from WAN side.
1.A Must filled setting ~ Specify the WAN interface that a remote SNMP host can access to the device.

WAN Interface 2. ALL WANSs is By default, All WANS is selected, and there is no limitation for the WAN
selected by default inferface.

Select the version for the SNMP
When Check the v1 box.
1.A Must filled setting It means you can access SNMP by version 1.
Supported Versions 2 The boxes are When Check the v2c box.
unchecked by default It means you can access SNMP by version 2c.
When Check the v3 box.
It means you can access SNMP by version 3.
SNMP Port 1. String format: any Specify the SNMP Port.
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Limited Remote
Aceess IP

Save
Undo

port number

2. The default SNMP
portis 161.

3. A Must filled setting

1. String format: any
IPv4 address

2. It is an optional
item.

N/A
N/A

Create/Edit Multiple Community

You can fill in any port number. But you must ensure the port number is not to
be used.
Value Range: 1 ~ 65535.

Specify the Remote Access IP for WAN and check the box to enable it as well.
Select Specific IP Address, and fill in a certain IP address. It means only this IP
address can access SNMP from LAN/WAN side.

Select IP Range, and fill in a range of IP addresses. It means the IP address
within specified range can access SNMP from LAN/WAN side.

If you left it as blank, it means any IP address can access SNMP from WAN side.
Click Save to save the settings

Click Undo to cancel the settings

The SNMP allows you to custom your access control for version 1 and version 2 user. The router supports up to
a maximum of 10 community sets.

Add Delete

Community

Enable Actions

When Add button is applied, Multiple Community Rule Configuration screen will appear.

» Community

¥ Enable

Community

Enable

Save

Setting

Read Only -

#| Enable

1. Read Only is
selected by default

2. A Must filled setting
3. String format: any
text

1.The box is checked
by default

N/A

Specify this version 1 or version v2c user’s community that will be allowed Read
Only (GET and GETNEXT) or Read-Write (GET, GETNEXT and SET) access
respectively.

The maximum length of the community is 32.

Click Enable to enable this version 1 or version v2c user.

Click the Save button to save the configuration. But it does not apply to SNMP
functions. When you return to the SNMP main page. It will show “Click on save
button to apply your changes” remind user to click main page Save button.
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Undo N/A Click the Undo button to cancel the settings.
Back N/A Click the Back button to return to last page.

Create/Edit User Privacy

The SNMP allows you to custom your access control for version 3 user. The router supports up to a maximum

of 128 User Privacy sets.
= User Privacy List [EXC]
Password | Authentication | Encryption

QID Filter
Prefix

Enable | Actions

When Add button is applied, User Privacy Rule Configuration screen will appear.

® User Privacy Rule Configuration

¥ Privacy Key

ltem Setting
» User Name | |
» Passwiord |
» Authentication
» Encryption
» Privacy Mode
|

¥ Authority Read »

¥ OID Filter Prefix

—

Y
m
=
=
o
o

¥ Enable 4

User Privacy Rule Configuration
Item Value setting Description

User Name 1. A Must filled setting  Specify the User Name for this version 3 user.
2. String format: any Value Range: 1 ~ 32 characters.
text
Password 1. String format: any When your Privacy Mode is authNoPriv or authPriv, you must specify the
text Password for this version 3 user.
Value Range: 8 ~ 64 characters.
Authentication 1. None is selected by ~ When your Privacy Mode is authNoPriv or authPriv, you must specify the
default Authentication types for this version 3 user.
Selected the authentication types MD5/ SHA-1 to use.
Encryption 1. None is selected by ~ When your Privacy Mode is authPriv, you must specify the Encryption
default protocols for this version 3 user.
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Privacy Mode

Privacy Key

Authority

OID Filter Prefix

Enable

Save

Undo
Back

1. noAuthNoPriv is
selected by default

1. String format: any
text

1. Read is selected by
default

1. The default value is
1

2. A Must filled setting
3. String format: any
legal OID

1.The box is checked
by default

N/A

N/A
N/A

Create/Edit Trap Event Receiver

The SNMP allows you to custom your trap event receiver. The router supports up to a maximum of 4 Trap

Event Receiver sets.

ID Server | Server| SNMP | Community | User
P Port Version

When Add button is applied, Trap Event Receiver Rule Configuration screen will appear. The default SNMP

Add

Name

Name

Selected the encryption protocols DES / AES to use.

Specify the Privacy Mode for this version 3 user.

Selected the noAuthNoPriv.

You do not use any authentication types and encryption protocols.

Selected the authNoPriv.

You must specify the Authentication and Password.

Selected the authPriv.

You must specify the Authentication, Password, Encryption and Privacy Key.
When your Privacy Mode is authPriv, you must specify the Privacy Key (8 ~ 64
characters) for this version 3 user.

Specify this version 3 user’s Authority that will be allowed Read Only (GET and
GETNEXT) or Read-Write (GET, GETNEXT and SET) access respectively.

The OID Filter Prefix restricts access for this version 3 user to the sub-tree
rooted at the given OID.

Value Range: 1 ~2080768.

Click Enable to enable this version 3 user.

Click the Save button to save the configuration. But it does not apply to SNMP
functions. When you return to the SNMP main page. It will show “Click on save
button to apply your changes” remind user to click main page Save button.
Click the Undo button to cancel the settings

Click the X button to return the last page.

Delete

Privacy

Password Mode

Authentication | Encryption F‘rli{x;cy Enable | Actions

Version is v1. The configuration screen will provide the version 1 must filled items.
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# Trap Event Receiver Rule Configuration

ltem Setting
b Server IP | | (IP Address/FQDN)
¥ Server Port 162
¥ SNMP Version vl v
¥ Community Name | |
¥ Enable Enable

When you selected v2c, the configuration screen is exactly the same as that of v1, except the version.

When you selected v3, the configuration screen will provide more setting items for the version 3 Trap.

= Trap Event Receiver Rule Configuration

ltem Setting
b Server IP | | (IP Address/FQDMN)
¥ Server Port 1162
» SNMP Version v3 v

¥ Community Name |

r User Name |

b Password |

¥ Privacy Mode

' noAuthNoPriv v |

r Authentication

None -

¥ Encryption

¥ Privacy Key

» Enable

Enable

| Trap Event Receiver Rule Configuration |

Trap Event Receiver Rule Configuration

Item

Server IP

Value setting

1. A Must filled setting
2. String format: any
IPv4 address or FQDN

Description

Specify the trap Server IP or FQDN.
The DUT will send trap to the server IP/FQDN.

Server Port

1. String format: any
port number

2. The default SNMP
trap portis 162

3. A Must filled setting

Specify the trap Server Port.

You can fill in any port number. But you must ensure the port number is not to
be used.

Value Range: 1 ~ 65535.

SNMP Version

1. vl is selected by

Select the version for the trap
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Community Name

User Name

Password

Privacy Mode

Authentication

Encryption

Privacy Key

Enable

Save

Undo
Back

default

1. A vl and v2c Must
filled setting

2. String format: any
text

1. Av3 Must filled
setting

2. String format: any
text

1. Av3 Must filled
setting

2. String format: any
text

1. Av3 Must filled
setting

2. noAuthNoPriv is
selected by default

1. A v3 Must filled
setting

2. None is selected by
default

1. Av3 Must filled
setting

2. None is selected by
default

1. Av3 Must filled
setting

2. String format: any
text

1.The box is checked
by default

N/A

N/A
N/A

Selected the v1.

The configuration screen will provide the version 1 must filled items.
Selected the v2c.

The configuration screen will provide the version 2c must filled items.
Selected the v3.

The configuration screen will provide the version 3 must filled items.

Specify the Community Name for this version 1 or version v2c trap.
Value Range: 1 ~ 32 characters.

Specify the User Name for this version 3 trap.
Value Range: 1 ~ 32 characters.

When your Privacy Mode is authNoPriv or authPriv, you must specify the
Password for this version 3 trap.
Value Range: 8 ~ 64 characters.

Specify the Privacy Mode for this version 3 trap.

Selected the noAuthNoPriv.

You do not use any authentication types and encryption protocols.

Selected the authNoPriv.

You must specify the Authentication and Password.

Selected the authPriv.

You must specify the Authentication, Password, Encryption and Privacy Key.

When your Privacy Mode is authNoPriv or authPriv, you must specify the
Authentication types for this version 3 trap.
Selected the authentication types MD5/ SHA-1 to use.

When your Privacy Mode is authPriv, you must specify the Encryption
protocols for this version 3 trap.
Selected the encryption protocols DES / AES to use.

When your Privacy Mode is authPriv, you must specify the Privacy Key (8 ~ 64

characters) for this version 3 trap.

Click Enable to enable this trap receiver.

Click the Save button to save the configuration. But it does not apply to SNMP
functions. When you return to the SNMP main page. It will show “Click on save

button to apply your changes” remind user to click main page Save button.
Click the Undo button to cancel the settings.
Click the X button to return to last page.
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Specify SNMP MIB-2 System
If required, you can also specify the required information for the MIB-2 System.

& SNMP MIB-2 System

Item

Setting

b sysContact

» sysLocation

SNMP MIB-2 System Configuration

Item
sysContact

\ Value setting

1. An Optional filled
setting

2. String format: any
text

Description
Specify the contact information for MIB-2 system.
Value Range: 0 ~ 64 characters.

sysLocation

1. An Optional filled
setting

2. String format: any
text

Specify the location information for MIB-2 system.
Value Range: 0 ~ 64 characters.

Edit SNMP Options

If you use some particular private MIB, you must fill the enterprise name, number and OID.

= Options

ltem

Setting

¥ Enterprise Name

¥ Enterprise Number

12823

¥ Enterprise QID

136141 12823.4.4.9

Options

\ Item

Enterprise Name

Value setting

1. The default value is
Default

2. A Must filled setting
3. String format: any
text

Description

Specify the Enterprise Name for the particular private MIB.
Value Range: 1 ~ 10 characters, and only string with A~Z, a~z, 0~9, '/, *_".

Enterprise Number

The default value is
12823
(Default Enterprise

Specify the Enterprise Number for the particular private MIB.
Value Range: 1 ~2080768.
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Enterprise OID

Save

Undo

Number)

2. A Must filled setting
3. String format: any
number

1. The default value is
1.3.6.1.4.1.12823.4.4.9
(Default Enterprise OID)
2. A Must filled setting
3. String format: any
legal OID

N/A

N/A

Specify the Enterprise OID for the particular private MIB.

The range of the each OID number is 1-2080768.

The maximum length of the enterprise OID is 31.

The seventh number must be identical with the enterprise number.

Click the Save button to save the configuration and apply your changes to
SNMP functions.

Click the Undo button to cancel the settings.

222



4G PoE-WAN Extender

6.1.4 Telnet & SSH

A command-line interface (CLI), also known as command-line user interface, and console user interface are
means of interacting with a computer program where the user (or client) issues commands to the program in
the form of successive lines of text (command lines). The interface is usually implemented with a command
line shell, which is a program that accepts commands as text input and converts commands to appropriate
operating system functions. Programs with command-line interfaces are generally easier to automate via
scripting. The device supports both Telnet and SSH (Secure Shell) CLI with default service port 23 and 22,
respectively.

Telnet & SSH Scenario

Network-A

Gateway

3%---sskrncn----(r

Remote Admin
140.116.82.98

Local Admin
10.0.75.100

Scenario Application Timing

When the administrator of the gateway wants to manage it from remote site in the Intranet or
Internet, he may use "Telnet with CLI" function to do that by using "Telnet" or "SSH" utility.

Scenario Description

The Local Admin or the Remote Admin can manage the Gateway by using "Telnet" or "SSH" utility
with privileged user name and password.

The data packets between the Local Admin and the Gateway or between the Remote Admin and the
Gateway can be plain texts or encrypted texts. Suggest they are plain texts in the Intranet for Local
Admin to use "Telnet" utility, and encrypted texts in the Internet for Remote Admin to use "SSH"

223



4G PoE-WAN Extender

utility.

Parameter Setup Example

Following table lists the parameter configuration as an example for the Gateway in above diagram
with "Telnet with CLI" enabling at LAN and WAN interfaces.

Use default value for those parameters that are not mentioned in the table.

Configuration Path [Telnet & SSH]-[Configuration]

Telnet LAN: m Enable WAN: I Enable
Service Port: 23

SSH LAN: m Enable WAN: m Enable
Service Port: 22

Scenario Operation Procedure

In above diagram, "Local Admin" or "Remote Admin" can manage the "Gateway" in the Intranet or
Internet. The "Gateway" is the gateway of Network-A, and the subnet of its Intranet is 10.0.75.0/24.
It has the IP address of 10.0.75.2 for LAN interface and 118.18.81.33 for WAN-1 interface. It serves

as a NAT gateway.
The "Local Admin" in the Intranet uses "Telnet" utility with privileged account to login the Gateway.

Or the "Remote Admin" in the Internet uses "SSH" utility with privileged account to login the
Gateway.

The administrator of the gateway can control the device as like he is in front of the gateway.
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Telnet & SSH Setting

Go to Administration > Configure & Manage > Telnet & SSH tab.

The Telnet & SSH setting allows administrator to access this device through the traditional Telnet or SSH
Telnet program. Before you can telnet (login) to the device, please configure the related settings with care.

Ep—— - Tx

Item Setting
LAM ¥ Enable
WAN [ Enable { WAN-1 v WAN-4 )
b Telnet | - |
Service Port |23 |
LAM [« Enable
WAN [ Enable { WAN-1 » WAN-4 )

» S5H |

" |

Service Port |22 |

Configuration

Item Value setting Description
Telnet 1. The LAN Enable box is Check the Enable box to activate the Telnet function for connecting from LAN or WAN
checked by default. interfaces.
2. By default Service You can set which number of Service Port you want to provide for the corresponding
Port is 23. service.
Value Range: 1 ~65535.
SSH 3. The LAN Enable box is Check the Enable box to activate the SSH Telnet function for connecting from LAN or
checked by default. WAN interfaces.
4. By default Service You can set which number of Service Port you want to provide for the corresponding
Port is 22. service.
Value Range: 1 ~65535.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

Note: The Telnet/SSH login password is the same one as the administrator’s login password for the device
web GUI.
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6.2 System Operation

System Operation allows the network administrator to manage system, settings such as web-based utility
access password change, system information, system time, system log, firmware/configuration backup &
restore, and reset & reboot.

6.2.1 Password & MMI

Go to Administration > System Operation > Password & MMI tab.

Setup Host Name

Host Name screen allows network administrator to setup / change the host name of the gateway. Click the
Modify button and provide the new username setting.

# Host Name ° ®

ltem Setting

» Host Name I:l

Username Configuration

Item Value setting Description

Host Name 1. An Optional setting Enter the host name of the gateway

2. It is blanked by default '
Save N/A Click Save button to save the settings
Undo N/A Click Undo button to cancel the settings

Change UserName

Username screen allows network administrator to change the web-based MMI login account to access
gateway. Click the Modify button and provide the new username setting.

# Usemname ° ®

ltem Setting
» Username admin | Modify
» New Username |:|
» Password I:l
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Username Configuration

Item Value setting

1. The default Username
for web-based MMl is
‘admin’.

Username

Description

Display the current MM login account (Username).

New Username String: any text

Enter new Username to replace the current setting.

Enter current password to verify if you have the permission to change the

Password String: any text .

username setting.
Save N/A Click Save button to save the settings
Undo N/A Click Undo button to cancel the settings

Change Password

Change password screen allows network administrator to change the web-based MMI login password to

access gateway.

= Password

[tem

-]«

Setting

» Old Password

» New Password

L

¢ New Password Confirmation

[ ]

Password Configuration

Item Value setting

1. String: any text

2. The default password
for web-based MMI is
‘admin’.

Old Password

Description

Enter the current password to enable you unlock to change password.

New Password String: any text

Enter new password

New Password

Confirmation String: any text

Enter new password again to confirm

Save N/A

Click Save button to save the settings

Undo N/A

Click Undo button to cancel the settings

Change MMI Setting for Accessing

This is the gateway’s web-based MMI access which allows administrator to access the gateway for
management. The gateway’s web-based MMI will automatically logout when the idle time has elapsed. The
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setting allows administrator to enable automatic logout and set the logout idle time. When the login timeout
is disabled, the system won’t logout the administrator automatically.

ltem

*» Login
» Login Timeout

¥ GUI Access Protocol

¥ HTTPs Certificate Setup
¥ HTTP Comprassion

¥ HTTP Binding

¥ System Boot Mode

Login

Login Timeout

GUI Access Protocol

HTTPs Certificate
Setup

HTTP Compression

HTTP Binding

System Boot Mode

Setting

Password-Guessing Attack & MAX: (3 (times)
# Enable 300 (seconds)
http/hitps
e default

Select from Certificate List
Certificate: | TrustedCertD v | Key: | TrustedKey0 v
¥ gzip deflate

DHCP 1

Mormal Mode

3 times is set by default

The Enable box is
checked, and 300 is set
by default.

http/https is selected by
default.

The default box is
selected by default

The box is unchecked by

default.
1. An Optional setting

2. DHCP-1 is checked by
default

Normal Mode is selected
by default.

Enter the login trial counting value.

Value Range: 3 ~ 10.

If someone tried to login the web GUI with incorrect password for more
than the counting value, an warning message “Already reaching maximum
Password-Guessing times, please wait a few seconds!” will be displayed
and ignore the following login trials.

Check the Enable box to activate the auto logout function, and specify the
maximum idle time as well.

Value Range: 30 ~ 65535.

Select the protocol that will be used for GUI access. It can be http/https,
http only, or https only.

If the https Access Protocol is selected, the HTTPs Certificate Setup option
will be available for further configuration.

You can leave it as default or select a expected certificate and key from the
drop down list.

Refer to Object Definition > Certificate Section for the Certificate
configuration.

Check the box (gzip, or deflate) if any comprerssion method is preferred.

Select the DHCP Server to bind with http access.

Select the system boot mode that will be adopted to boot up the device.
Normal Mode: It takes longer boot up time, with complete firmware image
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check during the device booting.

Save N/A Click Save button to save the settings
Undo N/A Click Undo button to cancel the settings
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6.2.2 System Information

System Information screen gives network administrator a quick look up on the device information for the

purchades gate

way.

Go to Administration > System Operation > System Information tab.

= System Information

ltem

Setting

¢ Model Name

VHGETBAM_0TO001

¥ Device Serial Number

¢ Kernel Version

2.6.36

» FW Version

0000Y50.J31_e32 BETA_04021700

¥ System Time

Thu, 18 Apr 2019 16:18:16 +0800

+ Davice Up-Time

15day 22hr 30min 35sec

System Information

Item Value Setting Description

Model Name N/A It displays the model name of this product.

Device Serial . . .

Number N/A It displays the serial number of this product.

Kernel Version N/A It displays the Linux kernel version of the product

FW Version N/A It displays the firmware version of the product

Memory Usage N/A It displays the percentage of device memory utilization.

System Time N/A It displays the current system time that you browsed this web page.
Device Up-Time N/A It displays the statistics for the device up-time since last boot up.
Refresh N/A Click the Refresh button to update the system Information immediately.
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6.2.3 System Time

The gateway provides manually setup and auto-synchronized approaches for the administrator to setup the
system time for the gateway. The time supported synchronization methods can be Time Server, Manual, PC,
Cellular Module, or GPS Signal. Select the method first, and then configure rest settings.

Instead of manually configuring the system time for the gateway, there are two simple and quick solutions for
you to set the correct time information and set it as the system time for the gateway.

The first one is “Sync with Timer Server”. Based on your selection of time zone and time server in above time
information configuration window, system will communicate with time server by NTP Protocol to get system
date and time after you click on the Synchronize immediately button.

The second one is “Sync with my PC”. Select the method and the system will synchronize its date and time to
the time of the administration PC.

Go to Administration > System Operation > System Time tab.

Synchronize with Time Server

Item Setting
» Synchronization method Time Server v
» Time Zone (GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lisbon, London v
¥ Auto-synchronization Time Server:

Available Time Servers (RFC-863): | Auto v

» Daylight Saving Time Enable
» NTP Service Enable
¥ Synchronize immediately Active

1. A Must-filled item.
2. Time Server is Select the Time Server as the synchronization method for the system time.
selected by default.

1. A Must-filled item.
Time Zone 2. GMT+00 :00 is Select a time zone where this device locates.

selected by default.

Synchronization
method

Auto- 1. A Must-filled item. Enter the IP or FQDN for the NTP time server you expected, or leave it as auto
synchronization 2. Auto is selected by mode so that the available server will be used for time synchronization one by
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Daylight Saving
Time

NTP Service

Synchronize
immediately

Save
Refresh

default.
1. Itis an optional item.

2. Un-checked by default

1. It is an optional item.
2. Un-checked by default

N/A

N/A
N/A

one.

Check the Enable button to activate the daylight saving function.

When you enabled this function, you have to specify the start date and end date
for the daylight saving time duration.

Check the Enable button to activate the NTP Service function.

When you enabled this function, the gateway can provide NTP server service for
its local connected devices.

Click the Active button to synchronize the system time with specified time
server immediately.

Click the Save button to save the settings.

Click the Refresh button to update the system time immediately.

Note: Remember to select a correct time zone for the device, otherwise, you will just get the UTC
(Coordinated Universal Time) time, not the local time for the device.

Synchronize with Manually Setting

ltem

¥ Synchronization method

¥ Time Zone

¥ Daylight Saving Time

¥ Set Date & Time Manually

¥ NTP Service

Synchronization
method

Time Zone

Daylight Saving
Time

Set Date & Time
Manually

NTP Service

Manual

Setting

v

(GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lisbon, Londan

Enable

2019 -
16
Enable:

1. A Must-filled item.
2. Time Server is
selected by default.

1. A Must-filled item.
2. GMT+00 :00 is
selected by default.

1. Itis an optional item.
2. Un-checked by default
1. It is an optional item.

1. It is an optional item.

24 v

18 » | (Year/Month/Day)

{Hour:Minute:Second)

April v
27

Select the Manual as the synchronization method for the system time. It means
administrator has to set the Date & Time manually.

Select a time zone where this device locates.

Check the Enable button to activate the daylight saving function.

When you enabled this function, you have to specify the start date and end date
for the daylight saving time duration.

Manually set the date (Year/Month/Day) and time (Hour:Minute:Second) as the
system time.

Check the Enable button to activate the NTP Service function.
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2. Un-checked by default  When you enabled this function, the gateway can provide NTP server service for
its local connected devices.
Save N/A Click the Save button to save the settings.

Synchronize with PC

= System Time Configuration ° X
ltem Setting

» Synchronization method |PC |

» NTP Service [[] Enable

» Synchronize immediately

System Time Information

Item Value Setting Description
s N 1. A Must-filled item. N .
ynchronization 5 Time Server s Select PC as the synchronization method for the system time to let system
method . . . . . .. .
selected by default. synchronize its date and time to the time of the administration PC.
. . . Check the Enable button to activate the NTP Service function.
. 1. It is an optional item. . . . .
NTP Service When you enabled this function, the gateway can provide NTP server service for
2. Un-checked by default .
its local connected devices.
Synchronize N/A Click the Active button to synchronize the system time with specified time
immediately server immediately.
Save N/A Click the Save button to save the settings.
Refresh N/A Click the Refresh button to update the system time immediately.
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Synchronize with Cellular Time Service

# System Time Configuration ° %
Item Setting

» Synchronization method  Cellular Module v |

» Time Zone | (GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lisbon, London |

» NTP Service O Enable

» Synchronize immediately Active

System Time Information

Item Value Setting Description

Select Cellular Module as the synchronization method for the system time to let
system synchronize its date and time to the time provided from the connected
mobile ISP.

1. A Must-filled item.
2. Time Server is
selected by default.

Synchronization
method

Note: this option is only available for the product with Cellular WAN interface.

1. A Must-filled item.
Time Zone 2. GMT+00 :00 is Select a time zone where this device locates.
selected by default.

. . . Check the Enable button to activate the NTP Service function.
1. It is an optional item.

NTP Service When you enabled this function, the gateway can provide NTP server service for
2. Un-checked by default . .
its local connected devices.

Synchronize Click the Active button to synchronize the system time with specified time
immediately N/A server immediately.

Save N/A Click the Save button to save the settings.

Refresh N/A Click the Refresh button to update the system time immediately.
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Synchronize with GPS Time Service

= System Time Configuration ° x
[tem Setting

» Synchronization method ' GPS Signal v |

» Time Zone | (GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lisbon, London |

» NTP Service O Enable

» Synchronize immediately Active

System Time Information

Item Value Setting Description

Select GPS Signal as the synchronization method for the system time to let
system synchronize its date and time to the time provided from the GNSS
service.

1. A Must-filled item.
2. Time Server is
selected by default.

Synchronization
method

Note: this option is only available for the product with GNSS interface.

1. A Must-filled item.
Time Zone 2. GMT+00 :00 is Select a time zone where this device locates.
selected by default.

. . . Check the Enable button to activate the NTP Service function.
1. It is an optional item.

NTP Service When you enabled this function, the gateway can provide NTP server service for
2. Un-checked by default . .
its local connected devices.

Synchronize Click the Active button to synchronize the system time with specified time
immediately N/A server immediately.

Save N/A Click the Save button to save the settings.

Refresh N/A Click the Refresh button to update the system time immediately.
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6.2.4 System Log

System Log screen contains various event log tools facilitating network administrator to perform local event
logging and remote reporting.

Go to Administration > System Operation > System Log tab.

S | Emaitvow | oc

Item Setting

» Web Log Type Category System Attacks Drop Login message [ ) Debug
[) Enable

Server: Add Object

» Email Alert E-mail Addresses:

Subject: | |

Log type Category: [ System [ Attacks [ ) Drop [ Login message [ Debug

) Enable Server: Add Object

Log type Category: [ System [ Attacks [ ) Drop [ Login message [ Debug
Enable

Select Device: [|nternal v

Log file name: |syslog |
Splitfile: [ Enable Size: |200 KB ¥

» Log to St
0g 1o oiorage Interval: [} Enable 1440 {1~ 10080 Minutes)

Max Records: 3000 | (5~10000)

» Syslogd

Download log file | clear logs ‘

Log type Category: System Attacks Drop Login message Debug

View & Email Log History

View button is provided for network administrator to view log history on the gateway. Email Now button
enables administrator to send instant Email for analysis.

View & Email Log History

Item Value setting Description

View button N/A Click the View button to view Log History in Web Log List Window.
Email Now . i . . .

button N/A Click the Email Now button to send Log History via Email instantly.
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% Web Log List R ="e]l1

Time Log
Apr106:01:36 dnsmasg-dhcp[6016]: Ignoring domain amit.com_tw for DHCP host name NB-msnb
Apr106:08:31 dnsmasg-dhcp[6016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr106:15:30 dnsmasg-dhcp[B016]: Ignoring domain amit.com tw for DHCP host name NB-msnb
Apr106:22:06 dnsmasg-dhcp[6016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr 1062842 dnsmasg-dhcp[6016]: Ignoring domain amit.com tw for DHCP host name NB-msnb
Apr106:35:42 dnsmasg-dhcp[6016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr 1064220 dnsmasg-dhcp[6016]: Ignoring domain amit.com tw for DHCP host name NB-msnb
\ Web Log List Window \
\ Item Value Setting Description \
Time column N/A It displays event time stamps
Log column N/A It displays Log messages

Web Log List Button Description

Item Value setting Description
Previous N/A Click the Previous button to move to the previous page.
Next N/A Click the Next button to move to the next page.
First N/A Click the First button to jump to the first page.
Last N/A Click the Last button to jump to the last page.
Download N/A Click the Download button to download log to your PC in tar file format.
Clear N/A Click the Clear button to clear all log.
Back N/A Click the Back button to return to the previous page.
Web Log Type Category

Web Log Type Category screen allows network administrator to select the type of events to log and be
displayed in the Web Log List Window as described in the previous section. Click on the View button to view
Log History in the Web Log List window.

» Web Log Type Category System Attacks Drop Login message [ Debug

Item Value Setting Description

System Checked by default Check to log system events and to display in the Web Log List window.
Attacks Checked by default Check to log attack events and to display in the Web Log List window.

Drop Checked by default Check to log packet drop events and to display in the Web Log List window.
Login message Checked by default Check to log system login events and to display in the Web Log List window.
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Debug Un-checked by default Check to log debug events and to display in the Web Log List window.

Email Alert

Email Alert screen allows network administrator to select the type of event to log and be sent to the destined
Email account.
Enable
Server: | — Option - v || Add Object

» Email Alert E-mail Addresses:

Subject

Log type Category: System Attacks Drop Login message Debug

Check Enable box to enable sending event log messages to destined Email
Enable Un-checked by default . . .

account defined in the E-mail Addresses blank space.

Select one email server from the Server dropdown box to send Email. If none

has been available, click the Add Object button to create an outgoing Email
Server N/A server.

You may also add an outgoing Email server from Object Definition > External

Server > External Server tab.

Enter the recipient’s Email address. Separate Email addresses with comma / or

. ing : il f
E-mail address String : email format

semicolon *;’

Enter the Email address in the format of ‘myemail@domain.com’

Subject String : any text Enter an Email subject that is easy for you to identify on the Email client.
Select the type of events to log and be sent to the designated Email account.

Log type category  Default unchecked . .
Available events are System, Attacks, Drop, Login message, and Debug.
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Syslogd

Syslogd screen allows network administrator to select the type of event to log and be sent to the designated

Syslog server.

» Syslogd

[J) Enable Server: Add Object

Log type Category: [ System [ Attacks [ Drop [ Login message [ Debug

Syslogd Setting Window

Item Value Setting

Enable Un-checked by default Check Enable box to activate the Syslogd function, and send event logs to a syslog server

Description

Select one syslog server from the Server dropdown box to sent event log to.
If none has been available, click the Add Object button to create a system log server.

Server N/A
You may also add an system log server from the Object Definition > External Server >
External Server tab.
Log type Select the type of event to log and be sent to the destined syslog server. Available
Un-checked by default .
category events are System, Attacks, Drop, Login message, and Debug.

Log to Storage

Log to Storage screen allows network administrator to select the type of events to log and be stored at an
internal or an external storage.

¥ Log to Storage

# Enable

Select Device [|pternal v

Log file name: |5y5log |

Split file: [) Enable Size: [200 KB v
Interval: (] Enable |1440 (1~10080 Minutes)
Max Records: |3{}[}D | {5~10000)

| Download log file | clear logs |
Log type Category: [# System [# Attacks & Drop [# Login message (¥ Debug

\ Item Value Setting Description \
Enable Un-checked by default Check to enable sending log to storage.
. Internal is selected by .
Select Device Select internal or external storage.
default
Log file name Un-checked by default Enter log file name to save logs in designated storage.
Split file Enable Un-checked by default Check enable box to split file whenever log file reaching the specified limit.
e Enter the file size limit for each split log file.
Split file Size 200 KB is set by default P18
Value Range: 10 ~ 1000.
Interval Enable Un-checked by default Check enable box to enable the log interval setting.
Enter the log interval setting.
Log Interval 1440 is set by default & 'g
Value Range: 1 ~ 10080 Minute.
Enter the maximum number of records to be stored in the log storage.
Max Records 3000 is set by default 8 &
Value Range: 5 ~ 10000.
Log type category  Un-checked by default Check which type of logs to send: System, Attacks, Drop, Login message, Debug
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Log to Storage Button Description

Item Value setting Description

Download log N/A Click the Download log file button to download log files to a log.tar file.
file

Clear Logs N/A Click the Clear logs button to delete the log files from the storage.
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6.2.5 Backup & Restore

In the Backup & Restore window, you can upgrade the device firmware when new firmware is available and
also backup / restore the device configuration.

In addition to the factory default settings, you can also customize a special configuration setting as a
customized default value. With this customized default value, you can reset the device to the expected default

setting if needed.

Go to Administration > System Operation > Backup & Restore tab.

Item Setting
» FW Upgrade Via Web Ul v | | FW Upgrade
» Backup Configuration Settings | | Download v || Via Web UI
» Auto Restore Configuration Enable | Save Conf | Clean Conf | Conf. Info.
» Self-defined Logo Download v || Via Web Ul || Reset
» Self-defined CSS Edit
Download v || Via Web Ul || Reset

Via Web Ul is selected by

FW Upgrade
default
Back‘up . Download is selected by
Configuration
Settings default

The Enable box is
unchecked by default

Auto Restore
Configuration

If new firmware is available, click the FW Upgrade button to upgrade the device
firmware via Web Ul, or Via Storage.

After clicking on the “FW Upgrade” command button, you need to specify the
file name of new firmware by using “Browse” button, and then click “Upgrade”
button to start the FW upgrading process on this device. If you want to upgrade
a firmware which is from GPL policy, please check “Accept unofficial firmware”
You can backup or restore the device configuration settings by clicking the Via
Web Ul button.

Download: for backup the device configuration to a config.bin file.

Upload: for restore a designated configuration file to the device.

Via Web Ul: to retrieve the configuration file via Web GUI.

Chick the Enable button to activate the customized default setting function.
Once the function is activated, you can save the expected setting as a
customized default setting by clicking the Save Conf. button, or clicking the
Clean Conf. button to erase the stored customized configuration.
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6.2.6 Reboot & Reset

For some special reason or situation, you may need to reboot the gateway or reset the device configuration to
its default value. In addition to perform these operations through the Power ON/OFF, or pressing the reset
button on the device panel, you can do it through the web GUI too.

Go to Administration > System Operation > Reboot & Reset tab.

In the Reboot & Reset window, you can reboot this device by clicking the “Reboot” button, and reset this
device to default settings by clicking the “Reset” button.

Item
» Reboaot

» Reset to Default

Reboot

Reset to Default

Setting
Now v | | Reboot

Reset

Chick the Reboot button to reboot the gateway immediately or on a pre-defined
time schedule.

Now is selected by Now: Reboot immediately

default Time Schedule: Select a pre-defined auto-reboot time schedule rule to reboot
the auto device on a designated tim. To define a time schedule rule, go to
Object Definition > Scheduling > Configuration tab.

N/A Click the Reset button to reset the device configuration to its default value.
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6.3 FTP (not supported)

Not supported feature for the purchased product, leave it as blank.
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6.4 Diagnostic

This gateway supports simple network diagnosis tools for the administrator to troubleshoot and find the root
cause of the abnormal behavior or traffics passing through the gateway. There can be a Packet Analyzer to
help record the packets for a designated interface or specific source/destination host, and another Ping and
Tracert tools for testing the network connectivity issues.

6.4.1 Diagnostic Tools

The Diagnostic Tools provide some frequently used network connectivity diagnostic tools (approaches) for the
network administrator to check the device connectivity.

Go to Administration > Diagnostic > Diagnostic Tools tab.

» Ping Test

¥ Tracert Test

¥ Wake on LAN

Ping Test

Tracert Test

Wake on LAN

Save

Item

Host IP
Default

Host IP

Optional Setting

Optional setting

Optional setting

N/A

Ping

Setting

Outer Interface: [ a4 v | LAN Source:

Interface: | Ayt v | (UDP =~ Tracert

Wake up

This allows you to specify an IP / FQDN, the Outer interface (auto, WAN, LAN,

or VLAN), and LAN source (default, LAN, or VLAN) as well, so system will try
to ping the specified device to test whether it is alive after clicking on the
Ping button. A test result window will appear beneath it.

Trace route (tracert) command is a network diagnostic tool for displaying the
route (path) and measuring transit delays of packets across an IP network.
Trace route proceeds until all (three) sent packets are lost for more than
twice, then the connection is lost and the route cannot be evaluated.

First, you need to specify an IP / FQDN, the test interface (LAN, WAN, or
Auto) and the protocol (UDP or ICMP), and by default, it is UDP.

Then, system will try to trace the specified host to test whether it is alive

after clicking on Tracert button. A test result window will appear beneath it.

Wake on LAN (WOL) is an Ethernet networking standard that allows a
computer to be turned on or awakened by a network message. You can
specify the MAC address of the computer, in your LAN network, to be
remotely turned on by clicking on the Wake up command button.

Click the Save button to save the configuration.
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6.4.2 Packet Analyzer

The Packet Analyzer can capture packets depend on user settings. User can specify interfaces to capture
packets and filter by setting rule. Ensure the log storage is available (either embedded SD-Card or external USB

Storage), otherwise Packet Analyzer cannot be enabled.

Go to Administration > Diagnostic > Packet Analyzer tab.

ltem
» Packet Analyzer
b File Mame

b Split Files

+ Packet Interfaces

Packet Analyzer

File Name

Split Files

Packet Interfaces

Enable

Enable File Size -

The box is unchecked by
default.

1. An optional setting
2. Blank is set by default, and
the default file name is

<Interface>_<Date>_<index>.

1. An optional setting
2. The default value of File
Size is 200 KB.

An optional setting

Setting
200 KB -
-2 WAN-3 WAN-4
de v |
VAP-2 VAP-3 VAP-4 VAP-5 VAP-& VAP-T

Check Enable box to activate the Packet Analyzer function.
If you cannot enable the checkbox, please check if the storage is available
or not. Plug in the USB storage and then enable the Package Analyzer
function.
Enter the file name to save the captured packets in log storage.
If Split Files option is also enabled, the file name will be appended with
an index code “_<index>".
The extension file name is .pcap.
Check enable box to split file whenever log file reaching the specified
limit.
If the Split Files option is enabled, you can further specify the File Size
and Unit for the split files.
Value Range: 10 ~ 99999.
NOTE: File Size cannot be less than 10 KB
Define the interface(s) that Packet Analyzer should work on.
At least, one interface is required, but multiple selections are also
accepted.
The supported interfaces can be:

(] WAN: When the WAN is enabled at Physical Interface, it can be

selected here.
[ ASY: This means the serial communication interface. It is used to
capture packets appearing in the Field Communication.
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Therefore, it can only be selected when specific field
communication protocol, like Modbus, is enabled.
Select Binary mode or String mode for the serial interface.
(] VAP: This means the virtual AP. When WiFi and VAP are enabled,
it can be selected here.
Save N/A Click the Save button to save the configuration.
Click the Undo button to restore what you just configured back to the
previous setting.

Undo N/A

Once you enabled the Packet Analyzer function on specific Interface(s), you can further specify some filter
rules to capture the packets which matched the rules.

= Capture Filters n .

Item Setting

» Filter | Enable

» Source MACs

» Source IPs

» Source Ports

¢ Destination MACs

» Destination IPs

» Destination Ports

Capture Fitters

Item Value setting Description
Filter Optional setting Check Enable box to activate the Capture Filter function.
Source MACs Optional setting Define the filter rule with Source MACs, which means the source MAC address of
packets.

Packets which match the rule will be captured.
Up to 10 MACs are supported, but they must be separated with “;”,
e.g. AA:BB:CC:DD:EE:FF; 11:22:33:44:55:66
The packets will be captured when match any one MAC in the rule.
Source IPs Optional setting Define the filter rule with Source IPs, which means the source IP address of
packets.

246




4G PoE-WAN Extender

Packets which match the rule will be captured.
Up to 10 IPs are supported, but they must be separated with “;”,
e.g.192.168.1.1; 192.168.1.2
The packets will be captured when match any one IP in the rule.
Source Ports Optional setting Define the filter rule with Source Ports, which means the source port of packets.
The packets will be captured when match any port in the rule.
Up to 10 ports are supported, but they must be separated with “;”,
e.g. 80; 53
Value Range: 1 ~ 65535.
Destination MACs Optional setting Define the filter rule with Destination MACs, which means the destination MAC
address of packets.
Packets which match the rule will be captured.
Up to 10 MACs are supported, but they must be separated with “;”,
e.g. AA:BB:CC:DD:EE:FF; 11:22:33:44:55:66
The packets will be captured when match any one MAC in the rule.
Destination IPs Optional setting Define the filter rule with Destination IPs, which means the destination IP address
of packets.
Packets which match the rule will be captured.
Up to 10 IPs are supported, but they must be separated with “;”,
e.g.192.168.1.1; 192.168.1.2
The packets will be captured when match any one IP in the rule.
Destination Ports Optional setting Define the filter rule with Destination Ports, which means the destination port of
packets.
The packets will be captured when match any port in the rule.
Up to 10 ports are supported, but they must be separated with “;”,
e.g. 80; 53
Value Range: 1 ~ 65535.
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Chapter 7 Service

7.1 Cellular Toolkit

Data Usage Monitoring |
1. Statisticsof data usage thru 3G/LTE ]
2. SIMswitchor drop if reach quota limit |

(@) SMS [Short Message Service)

&\ 1. Compose SM35message ongateway
CG_:HuI.ar 2. Receive SMSmessage from remote
Tower

Mobile Network ((( M SIM PIN Management

! i
! 1. SIM card PIN lock or PIN unlock !

Operator  fo i 2. PINcode change or PUK unlock | :
© Tower R AMIT M2M
K’ | Mobile Network Scan | Cellular Gateway
£ i 1. Actively mobile networksearch j

Cellular 12 Manually select mobile network i
Tower Nl y
%* # ! USSD Communication !

- i 1. Instant communication with MNO i

9ol )1 2. subscriberinquiry or settingchange |

|

inserted to device before you continue settings in this section.

' @ Status SIM PIN USSD Network Scan
1q - 7 Add || Delete |
1D SIM info Carrier Name | Cycle Period Start Date

'@ Field Communication |

(&) secumy. |
'e Administration |

() service |

- 'SMS & Event

Besides cellular data connection, you may
also like to monitor data usage of cellular
WAN, sending text message through SMS,
changing PIN code of SIM card,
communicating with carrier/ISP by USSD
command, or doing a cellular network scan
for diagnostic purpose.

In Cellular Toolkit section, it includes several
useful features that are related to cellular
configuration or application. You can
configure settings of Data Usage, SMS, SIM
PIN, USSD, and Network Scan here. Please
note at least a valid SIM card is required to be

Connection
Data Limitation Enable Action

Restrict
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7.1.1 Data Usage

Most of data plan for cellular connection is with a limited amount of data usage. If data usage has been over
limited quota, either you will get much lower data throughput that may affect your daily operation, or you will
get a ‘bill shock’ in the next month because carrier/ISP charges a lot for the over-quota data usage.

With help from Data Usage feature, device will monitor cellular data usage continuously and take actions. If
data usage reaches limited quota, device can be set to drop the cellular data connection right away. Otherwise,
if secondary SIM card is inserted, device will switch to secondary SIM and establish another cellular data
connection with secondary SIM automatically.

If Data Usage feature is enabled, all history of cellular data usage can be viewed at Status > Statistics &
Reports > Cellular Usage tab.

ID 5IM info Carrier Name | Cycle Period Start Date
, , . Mon Apr 01 2019
1 3G/MA4G SIM A ISP A 1 Monthly 00-00-00 GMT£0800
3G/4G Data Usage
ISP A SIMA

Add || Delete

gill Start: every20t ((9))
Un Data limit: 1Gb

(D)
K

ISPB

TSR
:'Eg::_;hﬁ____

SIM A Settings
-Cycle Period: monthly

-Start Date: 2017 [ Feb [ 20
-Data Limitation: 1Gb
-Connection Restrict: Enable

Connection

Data Limitation Enable Action
Restrict
1GB Edit Select

Data Usage feature enabling gateway device to
continuously monitor cellular data usage and take
actions. In the diagram, quota limit of SIM A is 1Gb
per month and bill start date is 20" of every month.
The device is smart to start a new calculation of
data usage on every 20" of month. Enable
Connection Restrict will force gateway device to
drop cellular connection of SIM A when data usage
reaches quota limit (1Gb in this case). If SIM
failover feature is configured in Internet Setup,
then gateway will switch to SIM B and establish a
new cellular data connection automatically.
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Data Usage Setting

Go to Service > Cellular Toolkit > Data Usage tab.

Before finished settings for Data Usage, you need to know bill start date, bill period, and quota limit of data
usage according to your data plan. You can ask this information from your carrier or ISP.

Create / Edit 3G/4G Data Usage Profile

| 3G/4G Data Usage Profile List X1 R

Connection

ID SIM info Carrier Name | Cycle Period Start Date Data Limitation Enable Action

Restrict

When Add button is applied, 3G/4G Data Usage Profile Configuration screen will appear. You can create up to
four data usage profiles, one profile for each SIM card used in the Gateway.

# 3G/4G Data Usage Profile Configuration

Item Setting

» SIM Select (3GM4G v | [SIMA v |

b Carner Mame | |

¥ Cycle Period Days v/ | |

» Start Date (2019 v | /[ April SRR
» Data Limitation | | [KB v |

b Connection Restrict [ Enable

+ Enable [« Enable

Value setting
3G/4G-1 and SIM A by
default.

SIM Select

Description

Choose a cellular interface (3G/4G-1 or 3G/4G-2), and a SIM card bound to the
selected cellular interface to configure its data usage profile.

Note: 3G/4G-2 is only available for for the product with dual cellular module.

Carrier Name

It is an optional item.

Fill in the Carrier Name for the selected SIM card for identification.

Cycle Period

Days by default

The first box has three types for cycle period. They are Days, Weekly and Monthly.
Days: For per Days cycle periods, you have to further specify the number of days in
the second box.

Value Range: 1 ~ 90 days.

Weekly, Monthly: The cycle period is one week or one month.

Start Date N/A

Specify the date to start measure network traffic.
Please don’t select the day before now, otherwise, the traffic statistics will be
incorrect.

Data Limitation N/A

Specify the allowable data limitation for the defined cycle period.
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Connection Un-Checked by default. Check the Enable box to activate the connection restriction function.

Restrict During the specified cycle period, if the actual data usage exceeds the allowable data
limitation, the cellular connection will be forced to disconnect.

Enable Un-Checked by default. Check the Enable box to activate the data usage profile.
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7.1.2 SMS

Short Message Service (SMS) is a text messaging service, which is used to be widely-used on mobile phones. It
uses standardized communications protocols to allow mobile phones or cellular devices to exchange short text
messages in an instant and convenient way.

SMS Setting

Go to Service > Cellular Toolkit > SMS tab

With this gateway device, you can send SMS text messages or browse received SMS messages as you usually
do on a cellular phone.

Setup SMS Configuration

¥ Physical Interface

F SMS

¥ SMS Storage
¥ SMS Space

Physical
Interface

SMS

SIM Status

SMS Storage

SMS Space

Save

SMS Setup Managing Events Setup Notifying Events Setup

Item Setting
3GM4G1r
Enable SIM Status: SIM_A
SIM Card Only v
Enable & Keep Available Space (1-10)

The box is 3G/4G-1 by
default

The box is checked by
default

N/A

The box is SIM Card Only
by default

The box is unchecked by
default

N/A

Choose a cellular interface (3G/4G-1 or 3G/4G-2) for the following SMS function
configuration.

Note: 3G/4G-2 is only available for for the product with dual cellular module.
This is the SMS switch. If the box checked that the SMS function enable, if the
box unchecked that the SMS function disable.

Depend on currently SIM status. The possible value will be SIM_A or SIM_B.

This is the SMS storage location. Currently the option only SIM Card Only.

Check the Enable box and specify a number (1-10) for message count to reserve
some available storage space and prevent it from run out of storage.

The oldest message(s) will be deleted when the SMS storage is going to full.
Click the Save button to save the settings

252



4G PoE-WAN Extender

SMS Summary

Show Unread SMS, Received SMS, Sent SMS, Remaining SMS, and edit SMS context to send, read SMS from
SIM card.

SR\ ow SMS Bl SMS Inbox || SMS Sent Folder a %
Item Setting

+ Unread SMS 0

» Received SMS 10

» Sent SMS 0

* Remaining SMS 0

\ SMS Summary

Item Value setting Description
If SIM card insert to router first time, unread SMS value is zero. When received the
Unread SMS N/A ] )
new SMS but didn’t read, this value plus one.
This value record the existing SMS numbers from SIM card, When received the new

SMS, this value plus one.

Received SMS  N/A

Sent SMS N/A This value record the number of out going SMS, When sent one SMS, this value

plus one.
This value is SMS capacity minus received SMS, When received the new SMS, this

Remaining SMS  N/A .
value minus one.

Click New SMS button, a New SMS screen appears. User can set the SMS setting

New SMS N/A . :
from this screen. Refer to New SMS in the next page.
Click SMS Inbox button, a SMS Inbox List screen appears. User can read or delete
SMS Inbox N/A SMS, reply SMS or forward SMS from this screen. Refer to SMS Inbox List in the
next page.
Refresh N/A Click the Refresh button to update the SMS summary immediately.
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New SMS
You can set the SMS setting from this screen.

= New SMS .- n -

b Item Setting

{Use '+’ for International Format and *;' to Compose Multiple Receivers)

» Receivers

» Text Message

Length of Current Input: 0

+ Result
Item Value setting Description
. Write the receivers to send SMS. User need to add the semicolon and compose
Receivers N/A

multiple receivers that can group send SMS.

Write the SMS context to send SMS. The router supports up to a maximum of
1023 character for SMS context length.

Send N/A Click the Send button, above text message will be sent as a SMS.

If SMS has been sent successfully, it will show Send OK, otherwise Send Failed
will be displayed.

Text Message N/A

Result N/A

SMS Inbox List
You can read or delete SMS, reply SMS or forward SMS from this screen.

From Phone

Nd}ber

Timestamp SMS Text Preview Actions

SMS Inbox List

Item Value setting Description

ID N/A The number of SMS.

From Phone . .

Number N/A Sender List (Phone Number) for the received SMS

Timestamp N/A What time the SMS is received

SMS Text . . A .

Preview N/A Preview the SMS text. Click the Detail button to read a certain message.
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Click the Detail button to read the SMS detail; Click the Reply / Forward button

Action The box is unchecked by to reply/forward SMS.

default Besides, you can check the box(es), and then click the Delete button to delete

the checked SMS(s).

Refresh N/A Refresh the SMS Inbox List.

Delete N/A Delete the SMS for all checked box from Action.

Close N/A Close the Detail SMS Message screen.

SMS Sent Folder

You can read or delete SMS from this screen.

Y oetete ] iose [ Proveus [0 - [ x|

SMS Text Preview

Receivers Actions

Timestamp

SMS Sent Folder

Item Value setting Description

ID N/A The number of SMS.

Receivers N/A Receiver list for the sent SMS.

Timestamp N/A What time the SMS is sent

SMS Text . . . .

Preview N/A Preview the SMS text. Click the Detail button to read a certain message.

. Click the Detail button to read the SMS detail
The box is unchecked by

Action Besides, you can check the box(es), and then click the Delete button to delete
default
the checked record(s).
Refresh N/A Refresh the SMS Sent Folder.
Delete N/A Delete the SMS for all checked box from Action.
Close N/A Close the Detail SMS Message screen.
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7.1.3 SIM PIN

With most cases in the world, users need to insert a SIM card (a.k.a. UICC) into end devices to get on cellular
network for voice service or data surfing. The SIM card is usually released by mobile operators or service
providers. Each SIM card has a unique number (so-called ICCID) for network owners or service providers to
identify each subscriber. As SIM card plays an important role between service providers and subscribers, some
security mechanisms are required on SIM card to prevent any unauthorized access.

Enabling a PIN code in SIM card is an easy and effective way of protecting cellular devices from unauthorized
access. This gateway device allows you to activate and manage PIN code on a SIM card through its web GUI.

Activate PIN code on SIM Card

This gateway device allows you to activate PIN code on SIM card. This
example shows how to activate PIN code on SIM-A for 3G/4G-1 with
default PIN code “0000”.

SIM A Settings
-SIM Lock: Enable

-PIN Code: 0000

Change PIN code on SIM Card

This gateway device allows you to change PIN code on SIM card.
Following the example above, you need to type original PIN code
“0000”, and then type new PIN code with ‘1234’ if you like to set new
PIN code as ‘1234’. To confirm the new PIN code you type is what you
want, you need to type new PIN code ‘1234’ in Verified New PIN Code
again.

_

H ! U )
with PIN Code ‘0000 Gateway

Change PIN Code Settings
-Current PIN Code: 0000
-New PIN Code: 1234
Verified New PIN Code: 1234

Unlock SIM card by PUK Code

If you entered incorrect PIN code at configuration page for 3G/4G-1

’-\
. @@ WAN over three times, and then it will cause SIM card to be locked by
(tg O | PUK code. Then you have to call service number to get a PUK code to
MNO SIMA locked - unlock SIM card. In the diagram, the PUK code is “12345678” and new
by PUK code Gateway .
12345678’ PIN code is “5678".

PUK Unlock Settings
-PUK Code: 12345678

-New PIN Code: 5678
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SIM PIN Setting

Go to Service > Cellular Toolkit > SIM PIN Tab

With the SIM PIN Function window, it allows you to enable or disable SIM lock (which means protected by PIN
code), or change PIN code. You can also see the information of remaining times of failure trials as we
mentioned earlier. If you run out of these failure trials, you need to get a PUK code to unlock SIM card.

Select a SIM Card

ltem Setting

» Physical Interface 3GMA4G-1

» SIM Status SIM-A Ready

» SIM Selection SIM-A ¥ || Switch
Physical The box is 3G/4G-1 by Choose a cellular interface (3G/4G-1 or 3G/4G-2) to change the SIM PIN setting
Interface default for the selected SIM Card.

Note: 3G/4G-2 is only available for for the product with dual cellular module.

SIM Status N/A Indication for the selected SIM card and the SIM card status.

The status could be Ready, Not Insert, or SIM PIN.
Ready -- SIM card is inserted and ready to use. It can be a SIM card without PIN
protection or that SIM card is already unlocked by correct PIN code.
Not Insert -- No SIM card is inserted in that SIM slot.
SIM PIN -- SIM card is protected by PIN code, and it’s not unlocked by a correct
PIN code yet. That SIM card is still at locked status.

SIM Selection N/A Select the SIM card for further SIM PIN configuration.
Press the Switch button, then the Gateway will switch SIM card to another one.
After that, you can configure the SIM card.

257



4G PoE-WAN Extender

Enable / Change PIN Code

Enable or Disable PIN code (password) function, and even change PIN code function.

Sdve nange FiiN L.oae

Item Setting
» PIN Lock Enable PIN Code: (4~B digits)
¥ Remaining times N/A
SIM lock Depend on SIM card Click the Enable button to activate the SIM lock function.

For the first time you want to enable the SIM lock function, you have to
fill in the PIN code as well, and then click Save button to apply the setting.

Remaining times Depend on SIM card Represent the remaining trial times for the SIM PIN unlocking.
Save N/A Click the Save button to apply the setting.
Change PIN Code  N/A Click the Change PIN code button to change the PIN code (password).

If the SIM Lock function is not enabled, the Change PIN code button is
disabled. In the case, if you still want to change the PIN code, you have to
enable the SIM Lock function first, fill in the PIN code, and then click the Save
button to enable. After that, You can click the Change PIN code button to
change the PIN code.

When Change PIN Code button is clicked, the following screen will appear.

ftem Setting

» Current PIN Code {4~8 digits)

F Mew PIN Code (4~8 digits)

Foyeified Mew PIR Code (4~8 digits)

Apply | Cancel

Current PIN A Must filled setting Fill in the current (old) PIN code of the SIM card.
Code
New PIN Code A Must filled setting Fill in the new PIN Code you want to change.
Verified New A Must filled setting Confirm the new PIN Code again.
PIN Code
Apply N/A Click the Apply button to change the PIN code with specified new PIN code.
Cancel N/A Click the Cancel button to cancel the changes and keep current PIN code.

Note: If you changed the PIN code for a certain SIM card, you must also change the corresponding PIN code

specified in the Basic Network > WAN & Uplink > Internet Setup > Connection with SIM Card page.
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Otherwise, it may result in wrong SIM PIN trials with invalid (old) PIN code.

Unlock with a PUK Code

The PUK Function window is only available for configuration if that SIM card is locked by PUK code. It means
that SIM card is locked and needs additional PUK code to unlock. Usually it happens after too many trials of
incorrect PIN code, and the remaining times in SIM Function table turns to 0. In this situation, you need to
contact your service provider and request a PUK code for your SIM card, and try to unlock the locked SIM card
with the provided PUK code. After unlocking a SIM card by PUK code successfully, the SIM lock function will be
activated automatically.

Save

Item Setting
¥ PUK status PUK unlock.
» Remaining times N/A
» PUK Code (8 digits)
» New PIN Code (4~8 digits)
PUK status PUK Unlock Indication for the PUK status.
/ PUK Lock The status could be PUK Lock or PUK Unlock. As mentioned earlier, the SIM card

will be locked by PUK code after too many trials of failure PIN code. In this case,
the PUK Status will turns to PUK Lock. In a normal situation, it will display PUK
Unlock.

Remaining times Depend on SIM card Represent the remaining trial times for the PUK unlocking.
Note : DO NOT make the remaining times down to zero, it will damage the SIM
card FOREVER ! Call for your ISP’s help to get a correct PUK and unlock the SIM if
you don’t have the PUK code.

PUK Code A Must filled setting Fill in the PUK code (8 digits) that can unlock the SIM card in PUK unlock status.

New PIN Code A Must filled setting Fill in the New PIN Code (4~8 digits) for the SIM card.
You have to determine your new PIN code to replace the old, forgotten one.
Keep the PIN code (password) in mind with care.

Save N/A Click the Save button to apply the setting.

Note: If you changed the PUK code and PIN code for a certain SIM card, you must also change the

corresponding PIN code specified in the Basic Network > WAN & Uplink > Internet Setup > Connection with
SIM Card page. Otherwise, it may result in wrong SIM PIN trials with invalid (old) PIN code.
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7.1.4 USSD

Unstructured Supplementary Service Data (USSD) is a protocol used by GSM cellular telephones to
communicate with the service provider's computers. USSD can be used for WAP browsing, prepaid callback
service, mobile-money services, location-based content services, menu-based information services, and as
part of configuring the phone on the network.

An USSD message is up to 182 alphanumeric characters in length. Unlike Short Message Service (SMS)
messages, USSD messages create a real-time connection during an USSD session. The connection remains
open, allowing a two-way exchange of a sequence of data. This makes USSD more responsive than services
that use SMS.

% Configuration ' ®
Item Setting

» Physical Interface 3G/M4G-1 v | SIM Status: SIM_A
= usso prome =t 17 T

Profile Name

USSD Command

= ussorenses I I 21

Comments Actions

Item Setting

» USSD Command |

USSD Scenario

USSD allows you to have an instant bi-directional
communication with carrier/ISP. In the diagram, the USSD
Cariorss - command *135# is referred to data roaming services.
After sending that USSD command to carrier, you can get

wlDSL and/or

4G Cellular )
*sg ussTA =358 N
toen roami Mce,’f

- a response at window USSD Response. Please note the
@*gﬂﬁfﬁiﬂ‘ﬂm’"ﬁ .;:."c:'.fﬁe’; ' USSD command varies for different carriers/ISP.
USSD Server
& Service Provider
Local Administrator

10.0.75.100
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USSD Setting

Go to Service > Cellular Toolkit > USSD tab.

In "USSD" page, there are four windows for the USSD function. The "Configuration" window can let you specify
which 3G/4G module (physical interface) is used for the USSD function, and system will show which SIM card in
the module is the current used one. The second window is the "USSD Profile List" and it shows all your defined
USSD profiles that store pre-commands for activating an USSD session. An "Add" button in the window can let
you add one new USSD profile and define the command for the profile in the third window, the "USSD Profile
Configuration". When you want to start the activation of an USSD connection session to the USSD server,
select the USSD profile or type in the correct pre-command, and then click on the "Send" button for the
session. The responses from the USSD server will be displayed beneath the "USSD Command" line. When
commands typed in the "USSD Command" field are sent, received responses will be displayed in the "USSD
Response" blank space. User can communicate with the USSD server by sending USSD commands and getting
USSD responses via the gateway.

USSD Configuration

Item Setting

» Physical Interface 3GM4G1 SIM Status: SIM_A

Choose a cellular interface (3G/4G-1 or 3G/4G-2) to configure the USSD setting
for the connected cellular service (identified with SIM_A or SIM_B).

Note: 3G/4G-2 is only available for for the product with dual cellular module.
SIM Status N/A Show the connected cellular service (identified with SIM_A or SIM_B).

The box is 3G/4G-1 by

Physical Interface
default.

Create / Edit USSD Profile

The cellular gateway allows you to custom your USSD profile. It supports up to a maximum of 35 USSD profiles.
- Add || Delete

ID Profile Name USSD Command Comments Actions

When Add button is applied, USSD Profile Configuration screen will appear.
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=) ussoreaue= 21 20 220

Item Setting

» USSD Command |

\ USSD Profile Configuration

Item Value setting Description

Profile Name N/A Enter a name for the USSD profile.

Enter the USSD command defined for the profile.

Normally, it is a command string composed with numeric keypad “0~9”, “*”,
and “#”. The USSD commands are highly related to the cellular service, please
check with your service provider for the details.

Comments N/A Enter a brief comment for the profile.

USSD Command N/A

Send USSD Request

When send the USSD command, the USSD Response screen will appear.
When click the Clear button, the USSD Response will disappear.

= ussoreases 021 0 20

Item Setting

¥+ USSD Command | |

Value setting Description
USSD Profile N/A Select a USSD profile name from the dropdown list.
USSD Command  N/A The USSD Command string of the selected profile will be shown here.
Click the Send button to send the USSD command, and the USSD Response
USSD Response N/A screen will appear. You will see the response message of the corresponding
service, receive the service SMS.
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7.1.5 Network Scan

"Network Scan" function can let administrator specify the device how to connect to the mobile system for
data communication in each 3G/4G interface. For example, administrator can specify which generation of
mobile system is used for connection, 2G, 3G or LTE. Moreover, he can define their connection sequence for
the gateway device to connect to the mobile system automatically. Administrator also can scan the mobile
systems in the air manually, select the target operator system and apply it. The manual scanning approach is
used for problem diagnosis.

Network Scan Setting

Go to Service > Cellular Toolkit > Network Scan tab.

In "Network Scan" page, there are two windows for the Network Scan function. The "Configuration" window
can let you select which 3G/4G module (physical interface) is used to perform Network Scan, and system will
show the current used SIM card in the module. You can configure each 3G/4G WAN interface by executing the
network scanning one after another. You can also specify the connection sequence of the targeted generation
of mobile system, 2G/3G/LTE.

Network Scan Configuration

Item Setting
3 Physica| Interface 3G/M4G-1 r S Status: S”\]_A
¥ Network Type LTE Only v
¥ Scan Approach Auto o
Physical The box is 3G/4G-1 by Choose a cellular interface (3G/4G-1 or 3G/4G-2) for the network scan function.
Interface default Note: 3G/4G-2 is only available for for the product with dual cellular module.
SIM Status N/A Show the connected cellular service (identified with SIM_A or SIM_B).

Specify the network type for the network scan function.

) It can be Auto, 2G Only, 2G prefer, 3G Only, 3G prefer, or LTE Only.
Auto is selected by

Network Type default When Auto is selected, the network will be register automatically;
efault.
If the prefer option is selected, network will be register for your option first;
If the only option is selected, network will be register for your option only.
When Auto selected, cellular module register automatically.
Auto is selected by If the Manually option is selected, a Network Provider List screen appears.
Scan Approach )
default. Press Scan button to scan for the nearest base stations. Select (check the box)

the preferred base stations then click Apply button to apply settings.
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‘ Save N/A Click Save to save the settings

The second window is the "Network Provider List" window and it appears when the Manually Scan Approach
is selected in the Configuration window. By clicking on the "Scan" button and wait for 1 to 3 minutes, the found
mobile operator system will be displayed for you to choose. Click again on the "Apply" button to drive system

to connect to that mobile operator system for the dedicated 3G/4G interface.

* Network Provider List [ 200

Provider Name

Mobile System Network Status

Action
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7.2 SMS & Event

SMS & Event handling is the application that allows administrator to setup the pre-defined events, handlers, or
response behavior with individual profiles. With properly configuring the event handling function,
administrator can easily and remotely obtain the status and information via the purchased gateway.

The supported events are categorized into two groups: the managing events and notifying events.

The managing events are the events that are used to manage the gateway or change the setting / status of the
specific functionality of the gateway. On receiving the managing event, the gateway will take action to change
the functionality, and collect the required status for administration simultaneously.

The notifying events are the events that some related objects have been triggered and take corresponding
actions on the occurrence of the events. It could be an event for alerting the administrator something
happened with SMS message, Email, and SNMP Trap, etc...

For ease of configuration, administrator can create and edit the common pre-defined managing / notifying
event profiles for taking instant reaction on a certain event or managing the devices for some advanced useful
purposes. For example, sending/receiving remote managing SMS for the gateway’s routine maintaining, and so
on. All of such management and notification function can be realized effectively via the Event Handling feature.

The following is the summary lists for the provided profiles, and events:

® Profiles (Rules):
e SMS Configuration and Accounts
e Email Accounts
* Remote Host profiles
® Managing Events:
* Trigger Type: SMS, SNMP Trap
e Actions: Get the Network Status; or Configure the LAN/VLAN behavior, WIFI behavior, NAT
behavior, Firewall behavior, VPN behavior, System Management, Administration, and Remote
Host.
® Notifying Events:
* Trigger Type: Connection Change (WAN, LAN & VLAN, WiFi, DDNS), Administration, Data Usage.
e Actions: Notify the administrator with SMS, Syslog, SNMP Trap or Email Alert; Sending collected
information to Remote Host.

To use the event handling function, First of all, you have to enable the event management setting and
configure the event details with the provided profile settings. You can create or edit pre-defined profiles for
individual managing / notifying events. The profile settings are separated into several items; they are the SMS
Account Definition, Email Service Definition, and Remote Host Configuration. Then, you have to configure each
managing / notifying event with identifying the event’s trigger condition, and the corresponding actions
(reaction for the event) for the event. For each event, more than one action can be activated simultaneously.

265



4G PoE-WAN Extender

7.2.1 Configuration
Go to Service > SMS & Event > Configuration Tab.

Event handling is the service that allows administrator to setup the pre-defined events, handlers, or response
behavior with individual profiles.

Enable Event Management

* Configuration u u

Item Setting

» Event Management [ Enable

Configuration

\ Item \ Value setting Description
Event The box is unchecked by Check the Enable box to activate the Event Management function.
Management default

Enable SMS Management

To use the SMS management function, you have to configure some important settings first.
= SMS Configuration a x

Item Settin
I} [}

» Message Prefix () Enable | ‘

» Physical Interface 3G/4AG-1 v | SIM Status: SIM_A

» Delete Managed SMS after [ Enable
Processing

' SMS Configuration

Item Value setting Description

Message Prefix The box is unchecked Click the Enable box to enable the SMS prefix for validating the received SMS.
by default Once the function is enabled, you have to enter the prefix behind the checkbox.
The received managing events SMS must have the designated prefix as an initial
identifier, then corresponding handlers will become effective for further
processing.
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Physical Interface , Choose a cellular interface (3G/4G-1 or 3G/4G-2) to configure the SMS

The box is 3G/4G-1 by .

default management setting.

' Note: 3G/4G-2 is only available for for the product with dual cellular module.

SIM Status N/A Show the connected cellular service (identified with SIM_A or SIM_B).
Delete Managed The box is unchecked Check the Enable box to delete the received managing event SMS after it has
SMS after by default been processed.
Processing

Create / Edit SMS Account

Setup the SMS Account for managing the gateway through the SMS. It supports up to a maximum of 5
accounts.

Add Delete

ID Phone Number Phone Description Application Send g?mn;irmed Enable Actions

You can click the Add / Edit button to configure the SMS account.

Item Setting
» Phone Number Specific Number »

» Phone Description

» Application Event Trigger Notify Handle
¥ Send confirmed SMS Enable
» Enable ¥/ Enable
Save
Phone 1. Mobile phone number Select the Phone number policy from the drop list, and specify a mobile phone
Number format number as the SMS account identifier if required.
2. A Must filled setting It can be Specific Number, or Allow Any. If Specific Number is selected, you

have to specify the phone number as the SMS account identifier.
Value Range: -1 ~ 32 digits.

Phone 1. Any text Specify a brief description for the SMS account.

Description 2. An Optional setting

Application A Must filled setting Specify the application type. It could be Event Trigger, Notify Handle, or both.
If the Phone Number policy is Allow Any, the Noftify Handle will be unavailable.

Send 1. An Optional setting Click Enable box to active the SMS response function.

confirmed 2. The box is unchecked by The gateway will send a confirmed message back to the sender whenever it

SMS default. received a SMS managing event. The confirmed message is similar to following

267



4G PoE-WAN Extender

format: “Device received a SMS with command xxxxx.”
Enable The box is unchecked by Click Enable box to activate this account.
default.
Save NA Click the Save button to save the configuration.

Create / Edit Email Service Account

Setup the Email Service Account for event notification. It supports up to a maximum of 5 accounts.

Email Server Email Addresses Actions

You can click the Add / Edit button to configure the Email account.

% Email Service Configuration x

Item Setting

+ Email Server

¥ Email Addresses | ‘

* Enable Enable

Email Service Configuration

\ Item \ Value setting Description \
Email Server --- Option -- Select an Email Server profile from External Server setting for the email account
setting.
Email 1. Internet E-mail address Specify the Destination Email Addresses.
Addresses format
2. A Must filled setting
Enable The box is unchecked by Click Enable box to activate this account.
default.
Save NA Click the Save button to save the configuration
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Create / Edit Remote Host Profile

Setup the Remote Host Profile. It supports up to a maximum of 10 profiles.

Port
Number

Protocol
Type

ID | Host Name Prefix Message Suffix Message Actions

You can click the Add / Edit button to configure the profile.

* Remote Host Configuration ®

Item Setting

» Host Name

» Host IP

» Protocol Type

¥ Prefix Message

¢ Suffix Message

» Port Number |:|
|
|
o

» Enable

Remote Host Configuration \

Item Value setting Description

Host Name 1. String format Specify the Remote Host profile name.
2. A Must filled setting Value Range: -1 ~ 64 characters.
Host IP 1. A Must filled setting Specify the IP address for the Remote Host. IPv4 Format.
2.IP Address format.
Protocol Type 1. A Must filled setting Specify the protocol to access the Remote Host. It could be TCP or UDP.
2. TCP is selected by default
Port Number 1. A Must filled setting Specify the Port number for accessing the Remote Host.
Value Range: 1 ~ 65535.
Prefix 1. String format Specify the Prefix Message string as pre-defined identification for accessing the
Message 2. An Optional filled setting remote host, if required.
Value Range: -1 ~ 64 characters.
Suffix 1. String format Specify the Suffix Message string as pre-defined identification for accessing the
Message 2. An Optional filled setting remote host, if required.
Value Range: -1 ~ 64 characters.
Enable The box is unchecked by Click Enable box to activate this profile setting.
default.
Save NA Click the Save button to save the configuration
Undo NA Click the Undo button to restore what you just configured back to the previous
setting.
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7.2.2 Managing Events

Managing Events allow administrator to define the relationship (rule) among event trigger, handlers and
response.

Go to Service > SMS & Event > Managing Events Tab.

Enable Managing Events

= Configuration ' ®

Item Setting

¥ Managing Events () Enable

Configuration

Item Value setting Description

Managing The box is unchecked by Check the Enable box to activate the Managing Events function.
Events default

Create / Edit Managing Event Rules

Setup the Managing Event rules. It supports up to a maximum of 128 rules.

Event Name Trigger Type Description Actions

When Add or Edit button is applied, the Managing Event Configuration screen will appear.
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% Managing Event Configuration ®

Item Setting

¥ Event
Name

» Trigger Period v
Type

»inteval | [0 | (0~86400 seconds)

¥ Description |

|

[ Network Status

» Action

[ System Manage
(] Administration
() Digital Output
[) Remote Host

» Managing Enable
Event

Managing Event Configuration

Item Value setting Description

Event None by default Specify the Event type (SMS, or SNMP Trap) and an event identifier / profile. Up
to 3 event conditions can be specified for defining an event, and the event will
be triggered when all the conditions hold simutaneously (AND relation).

The supported Event types could be:

SMS: Select SMS and fill the message in the textbox to as the trigger condition
for the event;

SNMP: Select SNMP Trap and fill the message in the textbox to specify SNMP
Trap Event;

Note: The available Event Type could be different for the purchased product.
Trigger Type Period is selected by default  Specify the type of event trigger, either Period or Once.
Period: Select Period and specify a time interval, the event will be repeatedly
triggered on every time interval when the specified event condition holds.
Once: Select Once and the event will be just triggered just one time when the
specified event condition holds.
Interval 0 is set by default Specify the repeatedly event trigger time interval.

Value Range: 0 ~86400 seconds.
Description String format : any text. Enter a brief description for the Managing Event.
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Action All box is unchecked by Specify Network Status, or at least one rest action to take when the expected
default. event is triggered.

Network Status: Select Network Status Checkbox to get the network status as
the action for the event;
LAN&VLAN: Select LAN&VLAN Checkbox and the interested sub-items (Port link
On/Off), the gateway will change the settings as the action for the event;
WiFi: Select WiFi Checkbox and the interested sub-items (WiFi radio On/Off),
the gateway will change the settings as the action for the event;
NAT: Select NAT Checkbox and the interested sub-items (Virtual Server Rule
On/Off, DMZ On/Off), the gateway will change the settings as the action for the
event;
Firewall: Select Firewall Checkbox and the interested sub-items (Remote
Administrator Host ID On/Off), the gateway will change the settings as the
action for the event;
VPN: Select VPN Checkbox and the interested sub-items (IPSec Tunnel ON/Off,
PPTP Client On/Off, L2TP Client On/Off, OpenVPN Client On/Off), the gateway
will change the settings as the action for the event;
GRE: Select GRE Checkbox and the interested sub-items (GRE Tunnel On/Off),
the gateway will change the settings as the action for the event;
System Manage: Select System Manage Checkbox and the interested sub-items
(WAN SSH Service On/Off, TR-069 On/Off), the gateway will change the settings
as the action for the event;
Administration: Select Administration Checkbox and the interested sub-items
(Backup Config, Restore Config, Reboot, Save Current Setting as Default), the
gateway will change the settings as the action for the event;
Digital Output: Select Digital Output checkbox and a DO profile you defined as
the action for the event;
Remote Host: Select Remote Host checkbox and a Remote Host profile you
defined as the action for the event;

Note: The available Event Type could be different for the purchased product.

Managing The box is unchecked by Click Enable box to activate this Managing Event setting.

Event default.

Save NA Click the Save button to save the configuration

Undo NA Click the Undo button to restore what you just configured back to the previous
setting.
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7.2.3 Notifying Events

Go to Service > SMS & Event > Notifying Events Tab.

Notifying Events Setting allows administrator to define the relationship (rule) between event trigger and
handlers.

Enable Notifying Events
% Configuration u %

Item Setting

» Notifying Events Enable

Configuration |

Item Value setting Description

Notifying Events The box is unchecked by Check the Enable box to activate the Notifying Events function.
default

Create / Edit Notifying Event Rules

Setup your Notifying Event rules. It supports up to a maximum of 128 rules.

Enable | Actions

Schedule

When Add or Edit button is applied, the Notifying Event Configuration screen will appear.

Item Setting
» Event | |
Mame
|None v
» Event and | None \a
and | None v
F Trigger :
o
¥ Interval D {0~86400 seconds)
¥ Description |
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> Delay to (0~3600 seconds)
send
SM3
Syslog
- SNMP Trap (Only Support v1 and v2c)
> Action Email Alert
Remote Host
System
r Time v
Schedule (0) Always

¥ Mofifying #| Enable

Events
Event Name Blank by default Specify a name or identifier for this notifying event rule.
Value Range: 0 ~ 64 characters.
Event None by default Specify the Event type and corresponding event configuration. Up to 3 event

conditions can be specified for defining an event, and the event will be
triggered when all the conditions hold simutaneously (AND relation).

The supported Event Type could be:

Power Change: Select Power Change and a trigger condition to specify the
event on a certain power source.

WAN: Select WAN and a trigger condition to specify a certain WAN Event;
LAN&VLAN: Select LAN&VLAN and a trigger condition to specify a certain
LAN&VLAN Event;

WiFi: Select WiFi and a trigger condition to specify a certain WiFi Event;
DDNS: Select DDNS and a trigger condition to specify a certain DDNS Event;
Administration: Select Administration and a trigger condition to specify a
certain Administration Event;

Data Usage: Select Data Usage, the SIM Card (Cellular Service) and a trigger
condition to specify a certain Data Usage Event;

Note: The available Event Type could be different for the purchased product.
Trigger Type Period is selected by default  Specify the type of event trigger, either Period or Once.
Period: Select Period and specify a time interval, the event will be repeatedly
triggered on every time interval when the specified event condition holds.
Once: Select Once and the event will be just triggered just one time when the
specified event condition holds.
Interval 0 is set by default Specify the repeatedly event trigger time interval.

Value Range: 0 ~86400 seconds.

Description String format : any text. Enter a brief description for the Notifying Event.

Delay to Send Blank by default Specify a delay time, if required, to send out the notifying event once it had
been triggered.

Value Range: 0 ~3600 seconds.
Action All box is unchecked by Specify at least one action to take when the expected event is triggered.
default. SMS: Select SMS, and the gateway will send out a SMS to all the defined SMS
accounts as the action for the event;
Syslog: Select Syslog and select/unselect the Enable Checkbox to as the action
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Time Schedule

Notifying
Events
Save
Undo

(0) Always is selected by
default

The box is unchecked by
default.

NA

NA

for the event;

SNMP Trap: Select SNMP Trap, and the gateway will send out SNMP Trap to
the defined SNMP Event Receivers as the action for the event;

Email Alert: Select Email Alert, and the gateway will send out an Email to the
defined Email accounts as the action for the event;

Remote Host: Select Remote Host checkbox and a Remote Host profile you
defined as the action for the event;

System: Select Reboot after 30 sec. checkbox as the action for the event;

Note: The available Event Type could be different for the purchased product.
Select a time scheduling rule for the Notifying Event.

Click Enable box to activate this Notifying Event setting.
Click the Save button to save the configuration

Click the Undo button to restore what you just configured back to the previous
setting.
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7.3 Location Tracking

Location tracking applications are usually referred to applications that take benefits from Global Navigation
Satellite System (GNSS). GNSS is the infrastructure that allows devices to determine its position, velocity, and
time by processing satellites signals from outer space. GNSS includes varieties of satellite systems and
Satellite-Based Augmentation Systems (SBAS). SBAS is usually used for improving positioning accuracy. The
tables below show 4 major GNSS system in the world, and SBAS system in different areas.

Major GNSS System in the world

GPS USA

GLONASS Russia

Galileo European Union
BeiDou (COMPASS) China

Satellite-Based Augmentation System (SBAS)

EGNOS Europe

WAAS North America
GAGAN India

MSAS Japan

Position applications are widely-used by varieties of industrial applications, including Location-Based Services
(LBS), Automatic Vehicle Location (AVL), Fleet Management, or assets tracking. However, in most case, GNSS is
a one-way communication. That means GNSS-compatible device can only locate its location by receiving GNSS
signal, but it can’t forward its location data to any other identity through GNSS system. According to this
limitation by GNSS system, devices usually need to equip other technology to transmit their location data to
back-end server for track or further analysis. Furthermore, as the position applications are more applied on
moving objects, a kind of wireless technology would be more suitable to be adopted to transmit location data.
Nowadays, thanks to popularity and wide coverage of cellular technology (GSM, 3G, 4G/LTE), transmitting
location data to remote center in real time is no longer a hurdle. In addition, the data format of location data
is NMEA 0183 compatible, so the back-end server will be easy to interpret the collected location data.

Hereunder are the main features of GNSS function in cellulargateway, if optional GNSS function is supported.
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Retrieve GNSS data from satellites and send to remote operation center periodically or save in local
storage.

Global positioning with multiple GNSS systems, including GPS, and optional for GLONASS, Galileo, or
BeiDou.

Mandatory for varieties of LBS (Location-Based Service) applications, such as advertisement, emergent
call.

Easy integration with AVL (Automatic Vehicle Location) applications, for managing fleet of service
vehicles.

Other value-added applications, such as asset tracking, electronic toll collection, intelligent transport
system.

7.3.1 GNSS

With GNSS configuration page, you can configure those functions that are mentioned above. Please note the
available GNSS features on different models may be different. Please check product datasheet for details.
The configuration steps include following items.

Activate GNSS feature in gateway and finish settings of cellular WAN.

Support NMEA 0183 (compatible to 3.0) protocol, and allow customized prefix and suffix.
Configurable GPS data logging on local microSD card storage for route record tracking.
Indicate remote host, time interval, TCP/UDP, and type of GPS data that would be sent.

® GPS Message Type

This item shows all supported types of NMEA 0183 data format. NMEA 0183 data format was defined and
maintained by National Marine Electronics Association (NMEA). Select one or more types that you want to use
for transmitting GPS data. In most case, this configuration depends on which data format that your central
server can recognize. Only select the type you need, otherwise it will consume unnecessary network
bandwidth. The table below shows more information for different types of NMEA 0183 message.

GGA
GLL

Fix Information SGPGGA,123519,4807.038,N,01131.000,E,1,08,0.9,545.4,M,46.9,M,,*47
Lat/Lon Data SGPGLL,4916.45,N,12311.12,W,225444,A,*1D
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GSA Overall Satellite Data SGPGSA,A,3,04,05,,09,12,,,24,,,,,2.5,1.3,2.1*39
GSV Detailed Satellite Data = $GPGSV,2,1,08,01,40,083,46,02,17,308,41,12,07,344,39,14,22,228,45*75

RMC Recommended SGPRMC,123519,A,4807.038,N,01131.000,E,022.4,084.4,230394,003.1, W*6A
Minimum Data

VTG Vector Track and SGPVTG,054.7,T,034.4,M,005.5,N,010.2,K*48
Speed Over the
Ground

Please note this option is hardware dependent. The available options of GPS message type show on this page
is according to product specification. You may not see all options if your product doesn’t support all of them.
® SBAS

SBAS is Satellite-Based Augmentation Systems that is used to improve accuracy of location data. There are
several SBAS systems for different areas in the world.

EGNOS Europe

WAAS North America
GAGAN India

MSAS Japan

Please note this option is hardware dependent. You may not see this option if your product doesn’t support it.

® Assisted GPS

Assisted GPS (as known as A-GPS) is used for speeding up location fix, especially when satellite signal is weak.
If activating this option, gateway will download almanac data from A-GPS server through IP network instead of
from satellite. You can also choose different valid period of almanac data. The shorter almanac data will get
higher accuracy. However, the almanac data with shorter valid period needs to be updated more frequently. It
will consume more network bandwidth. Please note this option is hardware dependent. You may not see this
option if your product doesn’t support it.

® Data to Storage

Besides transmitting location data to remote server, you can also store location data into internal storage (e.g.
microSD card) or external storage (e.g. USB drive) if any. Regarding to data format, either can be NMEA 0183
raw data format or save it as GPX file format. The location data will be saved to a new file if the original file
size is bigger than the pre-defined file size. The “Download log file” button allows you to browse all saved log
files and download to your personal devices.
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»  Scenario of location tracking for fleet management

A fleet owner would like to see the locations of his trucks in real time. He also likes to know where his trucks
have been passed through with time information. In his operation office, there is a server (IP: 100.100.100.1)
which can interpret NMEA RMC data format and shows truck’s location and track on map. This server is
listening on TCP port 888 to receive NMEA RMC packet from trucks. IMEI number will be added before NMEA
RMC data for identification of each truck. Hereunder is the configuration on each truck.

Basic Settings:

GNSS Enable
GNSS Type GPS
GPS Message Types RmC
SBAS Enable
Assisted GPS Enable, 1
Data to Storage Disable

Settings for Remote Host:

Host Name Truck-1

Host IP 100.100.100.1
Protocol Type TCp

Port Number 888

Interval(s) 15

Prefix Message 123456789012345
Suffix Message [blank]

Enable Checkbox [Checked]
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GNSS Setting

Go to Service>Location Tracking> GNSS Tab.

The GNSS allows user to set the configuration of GNSS, log NMEA data to storage, and send data to remote
host.Ensure GNSS is enabled and saved

Setup GNSS Configuration

Item

F GNSS
r GNSS Type

r GNSS Message Types

r Data to Storage

GNSS Enable

GNSS Type

GNSS Message Types

SBAS

Assisted GPS

Data to Storage

[+/] Enable

Setting

|GPS

M

[]6GGA []GLL []GSA []GSV W RMC []VTG

DEHENE Select Device: |Internal %

Interval: |5

Data format:

(s)

RAW

Data file name: RAW_yyyyMMddhhmm

Split file: & Enable

|| Download log file

The box is unchecked
by default

GPS is selected by
default

RMC is checked by
default

The box is unchecked
by default

The box is checked by
default

The box is unchecked

Type: | Time % | (15 Minutes (Range is 15~720)

Delete log file Delete all log file

Check Enable box to activate GNSS functions.

Select a GNSS Type (GNSS System) that you want to use. It can be GPS, or
GPS+GLONASS.

Please note this option is hardware dependent. The available options of GNSS
type show on this page is according to product specification. You may not see
all of these four options if your product doesn’t support all of them.

Select one or more GNSS Message Types that you want to use for transmitting
or recording GPS data.

There are many sentences in the NMEA standard for selection, GGA, GLL, GSA,
GSV, RMC and VTG. Only select the type you need, otherwise it will consume
unnecessary network bandwidth.

Note: The supported message type is hardware dependent.

Check Enable box to activate satellite-based augmentation system (SBAS).
Note: Some devices do not support this function.

Check Enable box to activate Assisted GPS (A-GPS).

Select the duration for downloading the Differential Almanac Corrections data
from A-GPS server through IP network.

Note: Some devices may not support this function.

) Enable (The box is unchecked by default)
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by default Check Enable box to activate data to storage function.

® Select Device (A Must filled setting)
Select Internal or External device to store log data.

(] Interval (A Must filled setting)
Specify the time interval between two continuous data log. By default, 5
second is set.
Value Range:5 ~ 60 seconds.

) Data Format(A Must filled setting)
Select data format (RAW, or GPX) to store.

(] Data file name(A Must filled setting)
Define file name to store.

([ ] Split Enable
Check Enable box to activate file splitting function.

(] Split Type
Select the split type for how to split the GNSS data into small files.
It can be Time or Size.
Time: Define time interval for log file split (Range: 15~720minutes)
Size: Define file size and unit for log file split. (Range: >= 10KB).

° Download log file
Select a log file from the file list and Click Download log file to download
through Web GUL. If the log format which is specified to download is
GPX, we will convert standard GPX format for used.

[ ) Delete log file
Select a log file from the file list and Click Delete log file to delete it from
the storage.

(] Delete all log file
Click Delete log file to delete all log files from the storage.

Save NA Click the Save button to save the configuration

Create / Edit Remote Host

The Remote Host allows you to customize your rules for sending NMEA data to specific IP address and Port.
The router supports up to a maximum of 10 rule sets.

. | Add | | Delete |
ID | Host Name Host IP Protocol Port Interval(s) Amé:ss Prefix Sufiix Enable Actions
Type Number Message Message Message

When Add button is applied, Remote Host Configuration screen will appear.
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Item Setting

+ Host Mame

+ Host IP

» Protocol Type

|
|
* Port Number |:|
¥
|
|
U

» Interval(s)

F MAC Address Message

» Prefix Message

r Suffix Message

+ Enable

Host Name String format: any text  Enter the host name for the designated remote host.
Value Range:-1 ~ 64 characters.
Host IP A Must filled setting Specify the IP Addressof remote host. It will be use as destination IP for sending
NMEA packets.
Protocol Type TCP is selected by Specify the Protocol (TCP or UDP) to use for sending NMEA packets.
default
Port Number A Must filled setting Specify a Port Number as destination port for sending NMEA packets.
Value Range:1 ~ 65535.
Interval(s) A Must filled setting Specify the time interval (seconds) between two NMEA packets.
Value Range:1 ~255 seconds.
MAC Address The box is checked by ~ Check Enable box to send the device MAC address with the NMEA packets, and
Message default then your backend server can recognize this GPS data is sent from this device.
Prefix Message String format: any text  Specify optional prefix string with specific information if your backend server

can recognize.

For example, you can input the IMEI code of this device here, and then your
backend server can recognize this GPS data is sent from this device. You can
also leave this field blank.

Suffix Message String format: any text  Specify optional suffix string with specific information if your backend server
can recognize.
Enable The box is unchecked Check Enable box to activate this remote host rule.
by default
Save NA Click the Save button to save the configuration
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Chapter 8 Status

8.1 Dashboard

Device Up-Time: 3day Ohr ZZmin 32sec

CPU: § 8%

Memory:
- Statistics & Reports -

| Basic Network . -
[- 1]

@ Object Definition | Current
I I Device| Type | Upload Traffic D':."r:nf:_?:d Uplg:g ?;fﬁ i Download

Traffic
|@ Field Communication | eth? | Cthemet| 190 (MB) 311 (MB) 3(KB) 2 (KB)

‘Connection Sessions:

l Security I eth2.1 Etnernet” 24 (MB) . 44 (KB) | 18 (Bytes) | 0 (Bytes)

S22 | Ethemet| 147 (MB) 273 (MB) 1(KB) 2 (KB)

|9 e | 10:04:40 10:04:50 100500 100510 10:05:20 10:05:30

bl |Ethemet| 13 (MB) 30 (MB) 0 (Bytes) 0 (Bytes)

8.1.1 Device Dashboard

The Device Dashboard window shows the current status in graph or tables for quickly understanding the
operation status for the gateway. They are the System Information, System Information History, and Network
Interface Status. The display will be refreshed once per second.

From the menu on the left, select Status > Dashboard > Device Dashboard tab.

System Information Status
The System Information screen shows the device Up-time and the resource utilization for the CPU, Memory,
and Connection Sessions.

% System Information . x

Device Up-Time: J3day 1hr 21min 48sec

CPU: § 10%
Memory: s 59%
Connection Sessions: 0%
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System Information History
The System Information History screen shows the statistic graphs for the CPU and memory.

“ Sy o . Sec v
g 250 MB
; Memory
100% s
- CPU 1
i CPU2 200 MB
80% Il CFU3 175 MB
D
70% M CPU 4
1BOMBl——
60%
125 MB
50%
o 100 MB
o 75 MB
20% ) sl mat 1A 50 MB
10% D D _ 25 MB
AL ~aassi 0 MB
SO B S D S 0 11:05:20 11:05:30 11:05:40 11:0550 11:06:00 11:06:10

Network Interface Status

The Network Interface Status screen shows the statistic information for each network interface of the
gateway. The statistic information includes the Interface Type, Upload Traffic, Download Traffic, and Current
Upload / Download Traffic.

s X

Upload = Download Current Current

Device Type : - Upload | Download
Traffic Traffic Traffic Traffic
eth2 | Ethernet| 211 (MB) | 321 (MB) 3 (KB) 3 (KB)

eth2.1 | Ethernet| 24 (MB) | 71(KB) | 64 (Bytes) | O (Bytes)

eth2.2  Ethernet| 168 (MB) | 283 (MB) 3 (KB) 3 (KB)

br0 | Ethemnet| 19(MB) | 31(MB) | 42 (Bytes) O (Bytes)

rap | VWIS |y iEy 1(MB) | 0(Bytes) | O (Bytes)
LAN

raio | VIS 21(MB) | 42(MB) | 0(Bytes) O (Bytes)

rat W[f\'ﬁss 0(Bytes) | 0(Bytes) | O(Bytes) O (Bytes)

Wireless 362

rai1 AN (Bytes) 4 (KB) 0 (Bytes) | O (Bytes)

tun0 | Ethemet| O (Bytes) | O(Bytes) | O(Byles) | 0 (Bytes)
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8.2 Basic Network

8.2.1 WAN & Uplink Status

Go to Status > Basic Network > WAN & Uplink tab.

The WAN & Uplink Status window shows the current status for different network type, including network
configuration, connecting information, modem status and traffic statistics. The display will be refreshed on
every five seconds.

WAN interface IPv4 Network Status

WAN interface IPv4 Network Status screen shows status information for IPv4 network.

ID |Interface | WAN Type Network Type IP Addr. Subnet Mask Gateway DNS MAC Address | Conn. Status | Action
WAN-1| 3GH4G | 3G/4G NAT 10.50.152.73 |255.256.255.252| 105915274 | ,Lao2oll. N/A G%gj';;t?‘;g Edit
WAN-2 Disable Edit
ID N/A It displays corresponding WAN interface WAN IDs.

It displays the type of WAN physical interface.
Interface N/A play yp phy

Depending on the model purchased, it can be Ethernet, 3G/4G, etc...

It displays the method which public IP address is obtained from your ISP.
WAN Type N/A Depending on the model purchased, it can be Static IP, Dynamic IP, PPPoE,

PPTP, L2TP, 3G/4G.

It displays the network type for the WAN interface(s).

Network Type N/A Depending on the model purchased, it can be NAT, Routing, Bridge, or IP Pass-
through.
1P Addr. N/A It displays the public IP address obtained from your ISP for Internet

connection. Default value is 0.0.0.0 if left unconfigured.
It displays the Subnet Mask for public IP address obtained from your ISP for

Subnet Mask N/A
Internet connection. Default value is 0.0.0.0 if left unconfigured.

Gateway N/A It displays the Gateway IP address obtained from your ISP for Internet
connection. Default value is 0.0.0.0 if left unconfigured.

DNS N/A It displays the IP address of DNS server obtained from your ISP for Internet
connection. Default value is 0.0.0.0 if left unconfigured.
It displ ISP . :

MAC Address N/A t displays the MAC Address for your ISP to allow you for Internet access. Note
Not all ISP may require this field.

Conn. Status N/A It displays the connection status of the device to your ISP.
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Status are Connected or disconnected.
This area provides functional buttons.

Renew button allows user to force the device to request an IP address from
the DHCP server. Note: Renew button is available when DHCP WAN Type is
used and WAN connection is disconnected.

Release button allows user to force the device to clear its IP address setting to
disconnect from DHCP server. Note: Release button is available when DHCP
WAN Type is used and WAN connection is connected.

Action N/A
Connect button allows user to manually connect the device to the Internet.
Note: Connect button is available when Connection Control in WAN Type
setting is set to Connect Manually (Refer to Edit button in Basic Network >
WAN & Uplink > Internet Setup) and WAN connection status is disconnected.

Disconnect button allows user to manually disconnect the device from the
Internet. Note: Connect button is available when Connection Control in WAN

Type setting is set to Connect Manually (Refer to Edit button in Basic Network
> WAN & Uplink > Internet Setup) and WAN connection status is connected.

WAN interface IPv6 Network Status

WAN interface IPv6 Network Status screen shows status information for IPv6 network.

ID | Interface WAN %pe Link-local IP Address Global IP Address Conn. Status Action
".-“\-'Z»?'*J- 3G/4G IPVE 154 3iscon_wectec Edit
ID N/A It displays corresponding WAN interface WAN IDs.

It displ f WAN physical i .
Interface N/A t displays the type of WAN physical interface
Depending on the model purchased, it can be Ethernet, 3G/4G, etc...
WAN Type N/A It displays the method which public IP address is obtained from your ISP. WAN

type setting can be changed from Basic Network > IPv6 > Configuration.
Link-local IP Address N/A It displays the LAN IPv6 Link-Local address.
It displays the IPv6 global IP address assigned by your ISP for your Internet

Global IP Address N/A
connection.
It displays the connection status. The status can be connected, disconnected
Conn. Status N/A )
and connecting.
. This area provides functional buttons.
Action N/A P

Edit Button when pressed, web-based utility will take you to the IPv6
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configuration page. (Basic Network > IPv6 > Configuration.)

LAN Interface Network Status

LAN Interface Network Status screen shows IPv4 and IPv6 information of LAN network.
# LAN Interface Network Status

IPv4 Address IPv4 Subnet Mask IPv6 Link-local Address IPv6 Global Address MAC Address Action

192.165.66.1 255.255.254.0 fed0::250: 15 fe3a 4asf /64 00:50:18:3A4A5F ‘ Edit IPv4 | Edit IPv6 |

LAN Interface Network Status
Item Value setting Description
It displays the current IPv4 IP Address of the gateway

IPv4 Address N/A o .
This is also the IP Address user use to access Router’s Web-based Utility.
IPv4 Subnet Mask N/A It displays the current mask of the subnet.
IPv6 Link-local N/A It displays the current LAN IPv6 Link-Local address.
Address This is also the IPv6 IP Address user use to access Router’s Web-based Utility.

IPv6 Global Address  N/A It displays the cu.rrent IPv6 global IP address assigned by your ISP for your
Internet connection.
MAC Address N/A It displays the LAN MAC Address of the gateway

This area provides functional buttons.

Edit IPv4 Button when press, web-based utility will take you to the Ethernet
Action N/A LAN configuration page. (Basic Network > LAN & VLAN > Ethernet LAN tab).
Edit IPv6 Button when press, web-based utility will take you to the IPv6

configuration page. (Basic Network > IPv6 > Configuration.)

3G/4G Modem Status

3G/4G Modem Status List screen shows status information for 3G/4G WAN network(s).
= 3G/AG Modem Status List ° X

Interface Card Information Link Status Signal Strength Network Name Action

3GM4G ZMB620 Connected 70% (-569dBm) Chunghwa Telecom (LTE)

Item Value setting Description

It displays the type of WAN physical interface.
N/A Note: Some device model may support two 3G/4G modules. Their physical interface
name will be 3G/4G-1 and 3G/4G-2.

Physical
Interface
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Card
Information

Link Status

Signal
Strength
Network
Name

Refresh

Action

N/A

N/A

N/A

N/A

N/A

N/A

It displays the vendor’s 3G/4G modem model name.

It displays the 3G/4G connection status. The status can be Connecting, Connected,
Disconnecting, and Disconnected.

It displays the 3G/4G wireless signal level.

It displays the name of the service network carrier.

Click the Refresh button to renew the information.

This area provides functional buttons.

Detail Button when press, windows of detail information will appear. They are the
Modem Information, SIM Status, and Service Information. Refer to next page for
more.

When the Detail button is pressed, 3G/4G modem information windows such as Modem Information, SIM
Status, Service Information, Signal Strength / Quality, and Error Message will appear.

Interface Traffic Statistics

Interface Traffic Statistics screen displays the Interface’s total transmitted packets.

ID Interface
v ‘?“ 3G/4G
WAN-

2
1D
Interface

Received Packets

(Mb)

Transmitted Packets

(Mb)

N/A

N/A

N/A

N/A

Received Packets(Mb) Transmitted Packets(Mb) Action

21713 167.09 Reset

It displays corresponding WAN interface WAN IDs.

It displays the type of WAN physical interface.

Depending on the model purchased, it can be Ethernet, 3G/4G, etc...
It displays the downstream packets (Mb). It is reset when the device is
rebooted.

It displays the upstream packets (Mb). It is reset when the device is rebooted.
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8.2.2 LAN & VLAN Status

Go to Status > Basic Network > LAN & VLAN tab.

Client List

The Client List shows you the LAN Interface, IP address, Host Name, MAC Address, and Remaining Lease Time
of each device that is connected to this gateway.

_

LAN Interface

IP Address

Host Name MAC Address

Remaining Lease Time

Ethemet

Dynamic / 192.165.66.100

amit25613572 00-13-3B-0E-5B-1D

00:15:00

LAN Client List

Item Value setting

: Description

Time

LAN Interface N/A Client record of LAN Interface. String Format.
IP Address N/A Client record of IP Address Type and the IP Address. Type is String Format and
the IP Address is IPv4 Format.
Host Name N/A Client record of Host Name. String Format.
MAC Address N/A Client record of MAC Address. MAC Address Format.
Remaining Lease . - . .
N/A Client record of Remaining Lease Time. Time Format.
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8.2.3 WIiFi Status

Go to Status > Basic Network > WiFi tab.

The WiFi Status window shows the overall statistics of WiFi VAP entries.

WiFi Virtual AP List

The WiFi Virtual AP List shows all of the virtual AP information on each WiFi module. The Edit button allows
for quick configuration changes.

= WiFi Module One Virtual AP List ' ®

Op.Band| ID | WiFi Enable Op. Mode SSID Channel WiFi System | Auth.&Security MAC Address Action
2.4G V‘ﬂqp' v AP Router | Staff_2 4G 1 big/in Mixed | WPA2-PSK(AES) | 00:50:18:3A 44 5F ‘ Edit H QR Code ‘
2.4G V‘;P' v AP Router | default 1 bigin Mixed Open(None) | 02:50:18:30:4A'5F ‘ Edit H QR Code ‘
246 | VAP AP Router | default 1 bigin Mixed | WPAZ-PSK(AES) | 02:50:18:31:4A5F | Edit | QR Code |
246 | VOF AP Router | default 1 bigin Mixed | WPAZ PSK(AES) | 02:50:18:32:4A5F | Edit || QR Code |
246 | V¥ AP Router | default 1 bigin Mixed | WPAZ-PSK(AES) | 02:50:18:33:4A5% | Edit || QR Code |
246 | VP AP Router | default 1 bigin Mixed | WPA2-PSK(AES) | 02:50:18:34:4A'5F | Edit || QR Code |
246 | VA AP Router | default 1 bigin Mixed | WPA2-PSK(AES) | 02:50:18:35.4A'5F | Edit || QR Code |
246 | VB AP Router | Guest 24G| 1 bigin Mixed | WPA2-PSK(AES) | 02:50:18:36:4A'5F | Edit || QR Code |

WiFi Virtual AP List

\ Item Value setting Description
Op. Band N/A It displays the WiFi Operation Band (2.4G or 5G) of VAP.
ID N/A It displays the ID of VAP.
WiFi Enable N/A It displays whether the VAP wireless signal is enabled or disabled.
Op. Mode N/A The WiFi Operation Mode of VAP. Depends of device model, modes are AP Router,
WDS Only and WDS Hybrid, Universal Repeater and Client.
SSID N/A It displays the network ID of VAP.
Channel N/A It displays the wireless channel used.
WiFi System N/A The WiFi System of VAP.
Auth. & Security N/A It displays the authentication and encryption type used.
MAC Address N/A It displays MAC Address of VAP.

Click the Edit button to make a quick access to the WiFi configuration page. (Basic
Network > WiFi > Configuration tab)

Action N/A .
The QR Code button allow you to generate QR code for quick connect to the VAP

by scanning the QR code.
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WiFi IDS Status
The WiFi IDS Status shows all the WIDS statistics on each WiFi module.

= WiFi Module One IDS Status ' ®

Authentication  Association Re-association RF;“::Z‘ Disassociation  Deauthentication ReE‘:Pest Mal!::ta:;:us Action
Frame Request Frame Request Frame a Frame Frame q
Frame Frame Frame
0 0 0 0 0 0 0 0 Reset

WiFi IDS Status

\ Item Value setting Description
Authentication It displays the receiving Authentication Frame count.
N/A
Frame
Association N/A It displays the receiving Association Request Frame count.
Request Frame
Re-association N/A It displays the receiving Re-association Request Frame count.
Request Frame
Probe Request It displays the receiving Probe Request Frame count.
N/A
Frame
Disassociation It displays the receiving Disassociation Frame count.
N/A
Frame
Deauthentication It displays the receiving Deauthentication Frame count.
F N/A
rame
EAP Request Frame N/A It displays the receiving EAP Request Frame count.
Malicious Data N/A It displays the number of receiving unauthorized wireless packets.
Frame
Action N/A Click the Reset button to clear the entire statistic and reset counter to 0.

Ensure WIDS function is enabled
Go to Basic Network > WiFi > Advanced Configuration tab

Note that the WIDS of 2.4GHz or 5GHz WiFi should be configured separately.

291



4G PoE-WAN Extender

WiFi Traffic Statistic
The WiFi Traffic Statistic shows all the received and transmitted packets on each WiFi module.

& WiFi Module One Traffic Statistics

Op.Band| ID Received Packets Transmitted Packets Action
246 | VA7 11592 3617
246 |V 0 0
246 |V 0 0
246 |7 0 0
240 |V 0 0
246 | VB 0 0
246 | VA 0 0
246 | V& 0 0

WiFi Traffic Statistic

\ Item Value setting Description
Op. Band N/A It displays the Wi-Fi Operation Band (2.4G or 5G) of VAP.
ID N/A It displays the VAP ID.
Received Packets N/A It displays the number of reveived packets.
Transmitted Packet N/A It displays the number of transmitted packets.
Action N/A Click the Reset button to clear individual VAP statistics.
Refresh Button N/A Click the Refresh button to update the entire VAP Traffic Statistic instantly.
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8.2.4 DDNS Status

Go to Status > Basic Network > DDNS tab.

The DDNS Status window shows the current DDNS service in use, the last update status, and the last update
time to the DDNS service server.

DDNS Status

Host Name Provider Effective IP Last Update Status Last Update Time

DDNS Status

Item Value Setting Description

Host Name N/A It displays the name you entered to identify DDNS service provider

Provider N/A It displays the DDNS server of DDNS service provider

Effective IP N/A It displays the public IP address of the device updated to the DDNS server

Last Update N/A It displays whether the last update of the device public IP address to the DDNS
Status server has been successful (Ok) or failed (Fail).

Last Update Time  N/A It displays time stamp of the last update of public IP address to the DDNS server.
Refresh N/A The refresh button allows user to force the display to refresh information.
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8.3 Security

- Widget
| @' Status VPN Firewall L
» Dashboard
- Basic Network = IPSec Tunnel Status 209 ° n
Em_ ID Tunnel Name Tunnel Scenario Local Subnets Remote IP/FQDN Remote Subnets Conn. Time Status
- Administration
= OpenVPN Client Status R 8 Ri2ET
- Statistics & Reports
1D OpenVPN Client Name Interface Remote IP/FQDN Remote Subnet Virtual IP Conn. Time Conn. Status
| Basic Network
= L2TP Client Status ° n
|' @ Obj ——— D LZTP Client Name Interface Virtual IP Remote IP/FQDN Default Gateway/Remote Subnet Conn. Time | Status
&) Securiy = PPTP Client Status - | x|
' 0 Administration 1D PPTP Client Name Interface Virtual IP Remote IP/FQDN Default Gateway/Remote Subnet Conn. Time | Status

|© Service

8.3.1 VPN Status

Go to Status > Security > VPN tab.

The VPN Status widow shows the overall VPN tunnel status. The display will be refreshed on every five
seconds.

IPSec Tunnel Status

IPSec Tunnel Status windows show the configuration for establishing IPSec VPN connection and current
connection status.

« IPSec Tunnel Status = 3

Tunnel Scenario Local Subnets Remote Subnets Conn. Time

Remote IP/FQDN

Tunnel Name

IPSec Tunnel Status

Item Value setting Description

Tunnel Name N/A It displays the tunnel name you have entered to identify.
Tunnel Scenario N/A It displays the Tunnel Scenario specified.

Local Subnets N/A It displays the Local Subnets specified.

Remote IP/FQDN N/A It displays the Remote IP/FQDN specified.

Remote Subnets N/A It displays the Remote Subnets specified.
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Conn. Time N/A It displays the connection time for the IPSec tunnel.

Status N/A It displays the Status of the VPN connection. The status displays are

Connected, Disconnected, Wait for traffic, and Connecting.

Edit Button N/A Click on Edit Button to change IPSec setting, web-based utility will take you

to the IPSec configuration page. (Security > VPN > IPSec tab)

OpenVPN Client Status

= OpenVPN Client Status[[R LI

OpenVPN Client Name

OpenVPN Client Status
Item Value setting Description

Interface Remote IP/FQDN Remote Subnet Virtual IP Conn. Time Conn. Status

OpenVPN Client N/A It displays the Client name you have entered for identification.

Name

Interface N/A It displays the WAN interface specified for the OpenVPN client connection.

Remote N/A It displays the peer OpenVPN Server’s Public IP address (the WAN IP address) or

IP/FQDN FQDN.

Remote Subnet N/A It displays the Remote Subnet specified.

TUN/TAP N/A It displays the TUN/TAP Read Bytes of OpenVPN Client.

Read(bytes)

TUN/TAP N/A It displays the TUN/TAP Write Bytes of OpenVPN Client.

Write(bytes)

TCP/UDP N/A It displays the TCP/UDP Read Bytes of OpenVPN Client.

Read(bytes)

TCP/UDP N/A It displays the TCP/UDP Write Bytes of OpenVPN Client.

Write(bytes) Connection

Conn. Time N/A It displays the connection time for the corresponding OpenVPN tunnel.

Conn. Status N/A It displays the connection status of the corresponding OpenVPN tunnel.
The status can be Connected, or Disconnected.

L2TP Client Status

L2TP Client Status shows the configuration for establishing LT2TP tunnel and current connection status.
= L2TP Client Status |21

L2TP Client Name | Interface Virtual IP Remote IP/FQDN Default Gateway/Remote Subnet Conn. Time | Status

\ L2TP Client Status
Item Value setting Description
Client Name N/A It displays Name for the L2TP Client specified.
Interface N/A It displays the WAN inte'rface with which the gateway will use to request
PPTP tunneling connection to the PPTP server.
Virtual IP N/A It displays the IP address assigned by Virtual IP server of L2TP server.
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It displays the L2TP Server’s Public IP address (the WAN IP address) or

Remote IP/FQDN N/A
FQDN.

Default It displays the specified IP address of the gateway device used to connect to

efau

the internet to connect to the L2TP server —the default gateway. Or other

Gateway/Remote N/A o i i

Subnet specified subnet if the default gateway is not used to connect to the L2TP
server —the remote subnet.

Conn. Time N/A It displays the connection time for the L2TP tunnel.

Status N/A It displays the Status of the VPN connection. The status displays Connected,
Disconnect, and Connecting.

Edit N/A Click on Edit Button to change L2TP client setting, web-based utility will take
you to the L2TP client page. (Security > VPN > L2TP tab)

PPTP Client Status

PPTP Client Status shows the configuration for establishing PPTP tunnel and current connection status.

Edit
ID| PPTP Client Name | Interface Virtual IP Remote IP/FQDN Default Gateway/Remote Subnet| Conn. Time | Status
Client Name N/A It displays Name for the PPTP Client specified.
Interface N/A It displays the WAN |nte.rface with which the gateway will use to request
PPTP tunneling connection to the PPTP server.
Virtual IP N/A It displays the IP address assigned by Virtual IP server of PPTP server.
It di he PPTP ’s Public IP N IP
Remote IP/FQDN N/A t displays the Server’s Public IP address (the WA address) or
FQDN.
It displays the specified IP address of the gateway device used to connect to
Default Gateway / N/A the internet to connect to the PPTP server —the default gateway. Or other
Remote Subnet specified subnet if the default gateway is not used to connect to the PPTP
server —the remote subnet.
Conn. Time N/A It displays the connection time for the PPTP tunnel.
It di h f the VPN ion. T ispl
Status N/A t displays the Status of the VPN connection. The status displays Connected,
Disconnect, and Connecting.
Edit Button N/A Click on Edit Button to change PPTP client setting, web-based utility will

take you to the PPTP server page. (Security > VPN > PPTP tab)
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8.3.2 Firewall Status

Go to Status > Security > Firewall Status Tab.
The Firewall Status provides user a quick view of the firewall status and current firewall settings. It also keeps

the log history of the dropped packets by the firewall rule policies, and includes the administrator remote
login settings specified in the Firewall Options. The display will be refreshed on every five seconds.

By clicking the icon [+], the status table will be expanded to display log history. Clicking the Edit button the
screen will be switched to the configuration page.

Packet Filter Status

%] Packet Filters

Activated Filter Rule Detected Contents

Packet Filter Status

Item Value setting Description
Activated Filter o .
Rule N/A This is the Packet Filter Rule name.

This is the logged packet information, including the source IP, destination IP,

Detected N/A protocol, and destination port —the TCP or UDP.
Contents String format:

Source IP to Destination IP : Destination Protocol (TCP or UDP)
IP N/A The Source IP (IPv4) of the logged packet.

. The Date and Time stamp of the logged packet. Date & time format. ("Month"
Time N/A

"Day" "Hours":"Minutes":"Seconds")
Note: Ensure Packet Filter Log Alert is enabled.
Refer to Security > Firewall > Packet Filter tab. Check Log Alert and save the setting.

MAC Control Status

Activated Control Rule

MAC Control Status

Blocked MAC Addresses

Item Value setting Description
Activated N/A This is the MA | Rul

Control Rule / isis the C Control Rule name.

Blocked MAC N/A This is the MAC address of the logged packet.
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Addresses

IP N/A The Source IP (IPv4) of the logged packet.

Time N/A The Date and Time stamp of the logged packet. Date & time format. ("Month"
"Day" "Hours":"Minutes":"Seconds")

Note: Ensure MAC Control Log Alert is enabled.
Refer to Security > Firewall > MAC Control tab. Check Log Alert and save the setting.

IPS Status

Detected Intrusion

IPS Firewall Status

Item Value setting Description

Detected N/A This is the intrusi f the packets being blocked
Intrusion / is is the intrusion type of the packets being blocked.
IP N/A The Source IP (IPv4) of the logged packet.

The Date and Time stamp of the logged packet. Date & time format. ("Month" "Day"
"Hours":"Minutes":"Seconds")

Note: Ensure IPS Log Alert is enabled.

Refer to Security > Firewall > IPS tab. Check Log Alert and save the setting.

Time N/A

Firewall Options Status

Stealth Mode Remote Administrator Management

Discard Ping from WAN

Firewall Options Status

Item Value setting Description

Enable or Disable setting status of Stealth Mode on Firewall Options.

Stealth Mode N/A ) )
String Format: Disable or Enable

SPI N/A Enable or Disable setting status of SPI on Firewall Options.
String Format : Disable or Enable

Enable or Disable setting status of Discard Ping from WAN on Firewall

Discard Ping from .
N/A Options.

WAN
String Format: Disable or Enable
Enable or Disable setting status of Remote Administrator.
Remote - . . .
. . If Remote Administrator is enabled, it shows the currently logged in
Administrator N/A o ] o
Management administrator’s source IP address and login user name and the login time.

Format:
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IP : "Source IP", User Name: "Login User Name", Time: "Date time"
Example:
IP: 192.168.127.39, User Name: admin, Time: Mar 3 01:34:13
Note: Ensure Firewall Options Log Alert is enabled.
Refer to Security > Firewall > Options tab. Check Log Alert and save the setting.
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8.4 Administration

8.4.1 Configure & Manage Status

Go to Status > Administration > Configure & Manage tab.

The Configure & Manage Status window shows the status for managing remote network devices. The type of
management available in your device is depended on the device model purchased. The commonly used ones
are the SNMP, TR-069, and UPnP. The display will be refreshed on every five seconds.

SNMP Linking Status

SNMP Link Status screen shows the status of current active SNMP connections.
= SNMP Linking Status

User Name IP Address Community Privacy Mode SNMP Version
SNMP Link Status
Item Value setting Description
It displays the user name for authentication. This is only available for SNMP
User Name N/A
version 3.
IP Address N/A It displays the IP address of SNMP manager.
It displays the port number used to maintain connection with the SNMP
Port N/A
manager.
Community N/A It displays the community for SNMP version 1 or version 2c only.
Auth. Mode N/A It displays the authentication method for SNMP version 3 only.
Privacy Mode N/A It displays the privacy mode for version 3 only.
SNMP Version N/A It displays the SNMP Version employed.

SNMP Trap Information

SNMP Trap Information screen shows the status of current received SNMP traps.

= SNMP Trap Information

Trap Level Trap Event

SNMP Trap Information

Item Value setting Description

Trap Level N/A It displays the trap level.

Time N/A It displays the timestamp of trap event.

Trap Event N/A It displays the IP address of the trap sender and event type.
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TR-069 Status

TR-069 Status screen shows the current connection status with the TR-068 server.

« TR-069 Status ’ ®

Link Status

Off

TR-069 Status

Item Value setting Description
It displays the current connection status with the TR-068 server. The connection
Link Status N/A status is either On when the device is connected with the TR-068 server or Off

when disconnected.
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8.4.2 Log Storage Status
Go to Status > Administration > Log Storage tab.

The Log Storage Status screen shows the status for selected device storage.

Log Storage Status

Log Storage Status screen shows the status of current the selected device storage. The status includes Device
Description, Usage, File System, Speed, and status.

Device Description File System
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8.4.3 GNSS Status

Go to Status > Administration > GNSS tab.

The GNSS Information screen shows the status for current GNSS positioning information for the gateway.

« GNSS Information . x

. No. of Satellites ID / - .
Condition s atgllﬁ:es Sign ala ;tnleﬁgth (dBm) Position (Lat, Long) Altitude (meters) | True Course Ground Speed (km/h)
Not Fixed 0 , 0 0.00

The available GNSS information includes GNSS Condition, No. of Satellites, Satellites ID / Signal Strength,
Position (Lat., Long.), Altitude (meters), True Course, and the equivalent Ground Speed (km/h).
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8.5 Statistics & Report

8.5.1 Connection Session

Go to Status > Statistics & Reports > Connection Session tab.

Internet Surfing Statistic shows the connection tracks on this router.

# Internet Surfing List (14 entries)B (=} [+]15

Last || Export ((xml) | Export (.csv)

Reftesh
User Name Protocol Internal IP & Port MAC External IP & Port Duration Time
UDP 192.168.127.58:3847 58.198.95.100:1194 2019/04/01 12:09~
UDP 192.168.127.558:4486 192.168.123.10:53 2019/04/01 12:09~
UDP 192.168.127.58:2899 192.168.123.10:53 2019/04/01 12:09~
UDP 192.168.127.58:1251 192.168.123.10:53 2019/04/01 12:09~
UDP 192.168.127.58:3145 192.166.123.10:53 2019/04/01 12:09~

Internet Surfing Statistic

Item Value setting Description

Previous N/A Click the Previous button; you will see the previous page of track list.
Next N/A Click the Next button; you will see the next page of track list.

First N/A Click the First button; you will see the first page of track list.

Last N/A Click the Last button; you will see the last page of track list.

Export (.xml) N/A Click the Export (.xml) button to export the list to xml file.

Export (.csv) N/A Click the Export (.csv) button to export the list to csv file.

Refresh N/A Click the Refresh button to refresh the list.
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8.5.2 Network Traffic (not supported)

Not supported feature for the purchased product, leave it as blank.
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8.5.3 Login Statistics

Go to Status > Statistics & Reports > Login Statistics

Login Statistics shows the login information.

# Device Manager Login Statistics B 2=l 0TE i Export {.cav)

User Name Protocol Type IP Address Info Duration Time
admin HTTP 192.168.123.190 Admin 2018/01/01 00:00~
admin HTTP 192 168.123.190 Admin 2018/01/01 00:02~
admin HTTP 192.168.123.190 Login Fail 2019/06/05 16:30~
admin HTTP 192 168.123.190 Admin 2019/06/05 16:30~

Device Manager Login Statistic

Item Value setting Description

Previous N/A Click the Previous button; you will see the previous page of login statistics.
Next N/A Click the Next button; you will see the next page of login statistics.

First N/A Click the First button; you will see the first page of login statistics.

Last N/A Click the Last button; you will see the last page of login statistics.

Export (.xml) N/A Click the Export (.xml) button to export the login statistics to xml file.
Export (.csv) N/A Click the Export (.csv) button to export the login statistics to csv file.
Refresh N/A Click the Refresh button to refresh the login statistics.
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8.5.4 Cellular Usage

Go to Status > Statistics & Reports > Cellular Usage tab.

Cellular Usage screen shows data usage statistics for the selected cellular interface. The cellular data usage
can be accumulated per hour or per day.

" Data Usage Records
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Appendix A GPL WRITTEN OFFER

This product incorporates open source software components covered by the terms of third party copyright notices
and license agreements contained below.

GPSBabel

Version 1.4.4

Copyright (C) 2002-2005 Robert Lipe<robertlipe@usa.net>
GPL License: https://www.gpsbabel.org/

Curl

Version 7.19.6

Copyright (c) 1996-2009, Daniel Stenberg, <daniel@haxx.se>.
MIT/X derivate License: https://curl.haxx.se/

OpenSSL

Version 1.0.2m

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
GPL License: https://www.openssl.org/

brctl - ethernet bridge administration

Stephen Hemminger <shemminger@osdl.org>
Lennert Buytenhek <buytenh@gnu.org>

version 1.1

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

tc - show / manipulate traffic control settings
Stephen Hemminger<shemminger@osdl.org>
Alexey Kuznetsov<kuznet@ms2.inr.ac.ru>

version iproute2-ss050330

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

dhcp-fwd — starts the DHCP forwarding agent

Enrico Scholz <enrico.scholz@informatik.tu-chemnitz.de>
version 0.7

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

Iftp - Sophisticated file transfer program

Alexander V. Lukyanov <lav@yars.free.net>

version:4.5.x

Copyright (c) 1996-2014 by Alexander V. Lukyanov (lav@yars.free.net)

dnsmasq - A lightweight DHCP and caching DNS server.
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Simon Kelley <simon@thekelleys.org.uk>
version:2.72
dnsmasq is Copyright (c) 2000-2014 Simon Kelley

socat - Multipurpose relay

Version: 2.0.0-b8

GPLv2
http://www.dest-unreach.org/socat/

LibModbus

Version: 3.0.3

LGPLv2
http://libmodbus.org/news/

LibIEC60870
GPLv2

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-

1307 USA
https://sourceforge.net/projects/mrts/

Openswan
Version: v2.6.38 GNU GENERAL PUBLIC LICENSE Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-

1307 USA

Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.
https://www.openswan.org/

Opennhrp

Version: v0.14.1

OpenNHRP is an NHRP implementation for Linux. It has most of the RFC2332
and Cisco |0S extensions.

Project homepage: http://sourceforge.net/projects/opennhrp

Git repository: git://opennhrp.git.sourceforge.net/gitroot/opennhrp
LICENSE

OpenNHRP is licensed under the MIT License. See MIT-LICENSE.txt for
additional details.

OpenNHRP embeds libev. libev is dual licensed with 2-clause BSD and
GPLv2+ licenses. See libev/LICENSE for additional details.

OpenNHRP links to c-ares. c-ares is licensed under the MIT License.
https://sourceforge.net/projects/opennhrp/

IPSec-tools
Version: v0.8
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No GPL be written
http://ipsec-tools.sourceforge.net/

PPTP

Version: pptp-1.7.1

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 675 Mass Ave, Cambridge, MA 02139, USA
Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed.

http://pptpclient.sourceforge.net/

PPTPServ

Version: 1.3.4

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 675 Mass Ave, Cambridge, MA 02139, USA
Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed. http://poptop.sourceforge.net/

L2TP

Version: 0.4

Copying All software included in this package is Copyright 2002 Roaring
Penguin Software Inc. You may distribute it under the terms of the
GNU General Public License (the "GPL"), Version 2, or (at your option)
any later version.

http://www.roaringpenguin.com/

L2TPServ

Version: v 1.3.1 GNU GENERAL PUBLIC LICENSEVersion 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.59 Temple Place, Suite 330, Boston, MA 02111-
1307 USA

Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed.

http://www.xelerance.com/software/xI2tpd/

Mpstat: from sysstat, system performance tools for Linux
Version: 10.1.6
Copyright: (C) 1999-2013 by Sebastien Godard (sysstat <at> orange.fr)

SSHD: dropbear, a SSH2 server
Version: 0.53.1
Copyright: (c) 2002-2008 Matt Johnston

Libncurses: The ncurses (new curses) library is a free software emulation of curses in System V Release 4.0
(SVr4), and more.
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Version: 5.9
Copyright: (c) 1998,2000,2004,2005,2006,2008,2011,2015 Free Software Foundation, Inc., 51 Franklin Street,
Boston, MA 02110-1301, USA

MiniUPnP: The miniUPnP daemon is an UPnP IGD (internet gateway device) which provide NAT traversal
services to any UPnP enabled client on the network.

Version: 1.7

Copyright: (c) 2006-2011, Thomas BERNARD

CoovaChilli is an open-source software access controller for captive portal (UAM) and 802.1X access
provisioning.

Version: 1.3.0

Copyright: (C) 2007-2012 David Bird (Coova Technologies) <support@coova.com>

Krb5: Kerberos is a network authentication protocol. It is designed to provide strong authentication for
client/server applications by using secret-key cryptography.

Version: 1.11.3

Copyright: (C) 1985-2013 by the Massachusetts Institute of Technology and its contributors

OpenlLDAP: a suite of the Lightweight Directory Access Protocol (v3) servers, clients, utilities, and development
tools.

Version: 2.4

Copyright: 1998-2014 The OpenLDAP Foundation

Samba3311: the free SMB and CIFS client and server for UNIX and other operating systems
Version: 3.3.11
Copyright: (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

NTPClient: an NTP (RFC-1305, RFC-4330) client for unix-alike computers
Version: 2007_365
Copyright: 1997, 1999, 2000, 2003, 2006, 2007 Larry Doolittle

exFAT: FUSE-based exFAT implementation
Version: 0.9.8
Copyright: (C) 2010-2012 Andrew Nayenko

ONTFS_3G: The NTFS-3G driver is an open source, freely available read/write NTFS driver for Linux, FreeBSD,
Mac OS X, NetBSD, Solaris and Haiku.

Version: 2009.4.4

Copyright: (C) 1989, 1991 Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-
1301 USA

mysql-5_1_72: a release of MySQL, a dual-license SQL database server
Version: 5.1.72
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Copyright: (c) 2000, 2013, Oracle and/or its affiliates

FreeRadius: a high performance and highly configurable RADIUS server
Version: 2.1.12

Copyright: (C) 1999-2011 The FreeRADIUS server project and contributors

Linux IPv6 Router Advertisement Daemon — radvd

Version: V 1.15

Copyright (c) 1996,1997 by Lars Fenneberg<If@elemental.net>
BSD License: http://www.litech.org/radvd/

WIDE-DHCPv6

Dynamic Host Configuration Protocol for IPv6 (DHCPV6) clients, servers, and relay agents.

Version: 20080615
Copyright (C) 1998-2004 WIDE Project.
BSD License: https://sourceforge.net/projects/wide-dhcpv6/

Python version 2.7.12

This Python distribution contains no GNU General Public Licensed
(GPLed) code so it may be used in proprietary projects just like prior
Python distributions. There are interfaces to some GNU code but these
are entirely optional

OpenPAM Radula

This software was developed for the FreeBSD Project by ThinkSec AS and
Network Associates Laboratories, the Security Research Division of

Network Associates, Inc. under DARPA/SPAWAR contract N66001-01-C-8035
("CBOSS"), as part of the DARPA CHATS research program.

ISC DHCP Version 4.3.5
Copyright (c) 2004-2016 by Internet Systems Consortium, Inc. ("I1SC")
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